@ 4012

VITA/TCE Volunteer Resource Guide BXiyl:¥:lai2INe

Volunteer Income Tax Assistance (VITA) / Tax Counseling for the Elderly (TCE)

v

. N ¢ A X \ " " / 3 \ \ \ \ \
it | ! (A ! I & /[ X\ N \
N 3 ‘.:" ": ﬂ A | 7 v il :c 1 h “‘, \ g
- = « /2 /1 1% ¢ T\ 7/ e \ \
7 ‘ / X | 1A
i o LM < dattated \‘ y 4 W/ | / |- \ \
- . \ % / 40 A A |
T R TR S f I Ly | 1) \
F X3 BT F ie coE ¥ R Y S\ 4 ¥ f e
¢ ¥ AR 8t /'& /P { "ﬁ'; $ N 7 / |
" 1 | al i / /1 \
HES IR | il B M ]
ailn i i i i N\ / \
ﬂ: 5 i] = : !; g [ | U‘ <\ A\ 14677 |t
" $ \ | ! i = | ) B
A 3 K 3 L J.‘.‘l 4 S8 Pl s oSNNI

Take your VITA/TCE training online at www.irs.gov (keyword: Link

k & Learn Taxes). Link to the Practice Lab to gain experience using
LearnTaxes tax software and take the certification test online, with immediate
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How to Get Technical Updates?

Updates to the volunteer training materials will be contained in Publication 4491X, VITA/TCE Training
Supplement. The most recent version can be downloaded at: https://www.irs.gov/pub/irs-pdf/p4491x.pdf

Volunteer Standards of Conduct
VITA/TCE Programs

The mission of the VITA/TCE return preparation programs is to assist eligible taxpayers in satisfying
their tax responsibilities by providing free tax return preparation. To establish the greatest degree of
public trust, volunteers are required to maintain the highest standards of ethical conduct and provide
quality service.

All VITA/TCE volunteers (whether paid or unpaid workers) must complete the Volunteer Standards of
Conduct (VSC) certification and agree to adhere to the VSC by signing Form 13615, Volunteer Standards
of Conduct Agreement, prior to working at a VITA/TCE site. In addition, return preparers, quality
reviewers, and VITA/TCE tax law instructors must certify in tax law prior to signing this form. This form is
not valid until the site coordinator, sponsoring partner, instructor, or IRS contact confirms the volunteer’s
identity and signs and dates the form.

As a volunteer in the VITA/TCE Programs, you must:

1. Follow the Quality Site Requirements (QSR).

2. Not accept payment, solicit donations, or accept refund payments for federal or state tax return
preparation.

3. Not solicit business from taxpayers you assist or use the knowledge you gained (their
information) about them for any direct or indirect personal benefit for you or any other specific
individual.

4. Not knowingly prepare false returns.

5. Not engage in criminal, infamous, dishonest, notoriously disgraceful conduct, or any other
conduct deemed to have a negative effect on the VITA/TCE Programs.

6. Treat all taxpayers in a professional, courteous, and respectful manner.

Failure to comply with these standards could result in, but is not limited to, the following:

Your removal from all VITA/TCE Programs;

Inclusion in the IRS Volunteer Registry to bar future VITA/TCE activity indefinitely;
Deactivation of your sponsoring partner’s site VITA/TCE EFIN (electronic filing ID number);
Removal of all IRS products, supplies, loaned equipment, and taxpayer information from your
site;

Termination of your sponsoring organization’s partnership with the IRS;

e Termination of grant funds from the IRS to your sponsoring partner; and

e Referral of your conduct for potential TIGTA and criminal investigations.

TaxSlayer® is a copyrighted software program owned by Rhodes Computer Services. All screen shots that
appear throughout the official Volunteer Income Tax Assistance (VITA) and Tax Counseling for the Elderly
(TCE) training materials are used with the permission of Rhodes Computer Services. The screen shots used in
this publication—or any other screen shots from TaxSlayer or its affiliated programs—may not be extracted,
copied, or distributed without written approval from the IRS SPEC Office of Products, Systems, & Analysis.

Confidentiality Statement:

All tax information you receive from taxpayers in your volunteer capacity is strictly confidential and should not,
under any circumstances, be disclosed to unauthorized individuals.
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DEPARTMENT OF THE TREASURY
INTERNAL REVENUE SERVICE
ATLANTA, GA 30308

WAGE AND INVESTMENT DIVISION

October 3, 2016

Greetings Volunteers!

Thank you for a phenomenal 2016 Filing Season. Without your commitment and
superior technical expertise, we would not have been able to serve millions of taxpayers
across the country. | commend each of you for your dedication, perseverance, and
continued support.

The 2016 Filing Season presented many challenges for the Volunteer Income Tax
Assistance (VITA) and Tax Counseling for the Elderly (TCE) programs. Once again, the
implementation of the Affordable Care Act (ACA) legislation required significant
resources and training. However, you still achieved record breaking results by preparing
more than 3.7 million tax returns with a 94 % accuracy rate. You are our most important
asset.

This year we will continue to encourage consistent site operations and accurate tax
return preparation. We will provide additional ACA training, as well as training on the
Earned Income Tax Credit, Online Services, and Identity Theft. The following updates
are new for the upcoming filing season:

First year of our new tax preparation software — TaxSlayer.
Development of a new certification test for Circular 230 Tax Professionals (i.e.,
certified public accountants, enrolled agents, and attorneys).

e Publication 5157-A, Affordable Care Act — Taxpayer Scenarios, is included in the
Publication 4480, VITA/TCE Link and Learn Taxes Training Kit.

e Legislative Extenders that were made permanent are merged into the
appropriate lessons in the Publication 4491, VITA/TCE Training Guide.

We have made additional changes to our policies and procedures for the 2017 Filing
Season that are highlighted in the Fact Sheet immediately following this letter.

| look forward to suggestions for improving your experience, as well as that of the
taxpayers you serve. Please email your feedback to partner@irs.gov.
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Welcome to the 2017 Filing Season, and thank you again for all you do for the
VITA/TCE programs.

Sincerely,

@M

Frank Nolden
Director, Stakeholder Partnerships,
Education and Communication



FACT SHEET for SPEC Partners & Employees
Quality & Oversight Updates for 2017 Filing Season

Key Messages

There is a new Circular
230 Federal Tax Law
Updates test for
attorneys, Certified
Public Accountants
(CPA) and Enrolled
Agents (EA).

Once volunteer data is
transferred to Form
13206 or partner-created
listing with the same
information and received
by the Territory Office,
partners do not need to
retain Forms 13615.

QSR # 2 and QSR #3
are now combined into
one QSR.

New QSR #3 requires
Photo ID and TIN
verification at VITA/TCE
sites.

Truncated SSN's are
now required on Form
14446, Virtual VITA/TCE
Site Module Taxpayer
Consent.

Site must remain marked
as “Active” in SPECTRM
if open for one or more
days throughout the
fiscal year.

Civil Rights posters are
now available in several
languages to better
inform taxpayers who
are Limited English
Proficiency (LEP).

y’

9/1/2016

This fact sheet provides updates to prepare employees, partners, site coordinators and
volunteers for filing season 2017. Share this document during site coordinators
training.

Background: Stakeholder Partnerships, Education & Communication (SPEC)
continues to encourage consistent site operations and effective
communications to improve quality and oversight in the Volunteer Income Tax
Assistance and Tax Counseling for the Elderly (VITA/TCE) Programs. The
following updates are effective for the 2017 Filing Season.

Updates to Quality Site Requirements (QSR)
QSR #1 — Certification

New: There is a new “Circular 230 Federal Tax Law Update” test for
volunteers governed by the rules and regulations under Treasury Department
Circular No. 230. This new certification exam will test knowledge of new tax
law provisions and updates. Only Attorneys, Certified Public Accountants
(CPA) and Enrolled Agents (EA) may certify using this new test. However,
they may choose to certify using the traditional certification path (i.e.
Advance, Military, etc.). This IRS tax law-certification is a minimum
requirement for this specific group of volunteers and some partners may have
different certification expectations. Partners may require all volunteers to use
the traditional certification path.

Why: This is a National Taxpayer Advocate recommendation. After reviewing
and evaluating the current certification process, SPEC agreed to provide this
new annual certification option. Many of these individuals are tax
professionals with annual Continuing Education (CE) requirements.

QSR #2 — Intake/Interview & Quality Review Process:
Update: QSR #2 (Intake/Interview Process) and QSR #3 (Quality Review
Process), are now combined as QSR #2, Intake/Interview & Quality Review
Process.

Why: To gain consistency in rating Quality Site Requirements by connecting
the inter-relationship between Intake/Interview and Quality Review
processes.

QSR #3 — Confirming Photo Identification & Tax Identification Numbers
(TIN):
Update: The new QSR#3 requires volunteers to confirm:
e Photo identification for primary and secondary taxpayers; and

e Social Security Numbers (SSN) or Individual Taxpayer Identification
Numbers (ITIN) for everyone listed on the tax return.

At a minimum, volunteers will validate taxpayers’ identities and identification
numbers prior to preparing the tax return and before the return is
electronically transmitted or before a copy of the return is given to the
taxpayer. Updated exceptions for taxpayers known to the site are listed in
Publications 4299, Privacy, Confidentiality and Civil Rights — A Public Trust.

Why: To deter the filing of rejects and identity theft returns at our VITA/TCE
sites.
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QSR #7 — Civil Rights Requirements:

Update: The English/Spanish Publication 4053 —Your Civil Rights are Protected and the AARP
Tax-Aide D-143 Civil Rights Posters are required to be posted at every site. We now have this
same product in Chinese, Korean, Russian, Spanish, and/or Vietnamese. Sites serving these
Limited English Proficient (LEP) taxpayers should secure these posters from IRS.gov.
Requirements to post these foreign products can be determined based on local demographics
indicating LEP taxpayers that may be served at the site. The Site Coordinator and SPEC
Partner should make this determination during the planning stages. The primary goal is to
provide this critical civil rights information to all taxpayers served in our VITA/TCE sites. The
number of posters are based on the type of taxpayers served at the site.

Why: To inform all taxpayers about their civil rights in various languages.

Other Changes and Reminders:

Change: Partners are no longer required to maintain Form 13615, Volunteer Standards of
Conduct Agreement, once the volunteer and partner have:

e Signed the completed agreement;

e Accurately transferred all required data to the current Form 13206, SPEC
Volunteer Assistance Report, or partner created listing (containing the same
information); and

e Forwarded the Form 13206 or partner created listing, to the SPEC Territory Office.

Partners can choose to give Forms 13615 back to their volunteers. However, if volunteers are
requesting CE credits, the form must be completed and forwarded to the SPEC Territory Office
as described in the CE credits requirements.

Why: No longer having to maintain this form reduces the burden for partners with large
numbers of volunteers.

Change: Form 14446, Virtual VITA/TCE Site Module Taxpayer Consent no longer requires the
full SSN. For security reasons, Form 14446 requires only the last four digits of the taxpayer’s
SSN.

Why: In an effort to protect the taxpayer against ID Theft IRS requires all agencies to remove
taxpayers’ full SSNs from IRS forms unless necessary. Partners and volunteers are required to
protect the taxpayers’ data by following this same practice.

Reminder: During Field Site Visits and QSS Return Reviews, we will continue to allow a
“Tolerance Amount Level” when determining the accuracy of a tax return as long as the tax
law is applied correctly, all income is listed on the correct Form 1040 line and the error does
not cause a change:

e More than $50 to “Total Income” or “AGI”,

¢ More than $14 to “Total Tax”, “Federal Income Tax Withheld” or “Amount You
Owe”

e Any of the credits shown on the return.

Why: This is the current IRS policy for determining if a corrected return requires a new signed
Form 8879, IRS e-file Signature Authorization.

Reminder: The Protecting Americans from Tax Hikes Act of 2015 (PATH Act) contained many
tax law provisions that affect the VITA/TCE programs. Some of these were previously existing
provisions known as extenders.

o Those that are permanently extended by the PATH Act have been added to their
respective lessons in Publication 4491, VITA/TCE Training Guide.
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o Those that are temporarily extended through 2016 continue to be included in
the Legislative Extenders lesson in Publication 4491.

¢ All (permanently/ temporarily) extenders have been added to the appropriate
tabs in Publication 4012, VITA/TCE Volunteer Resource Guide.

¢ An overview of the permanently and temporarily extended provisions and other new
provisions that are part of the PATH Act legislation are included in the Important
Changes for 2016 section in Publication 4491 and the “What’s New” Tab in
Publication 4012.

Why: To ensure all volunteers have access to tax law changes that affect the VITA/TCE programs.

Reminder: The SPEC Director must approve all policy changes that alter the current QSR,
software agreements, e-file requirement and security policies.

Why: To keep quality standards, security requirements or other license agreements from being in
jeopardy in an effort to increase return preparation.

SPEC Employees Only: Sites must remain marked as “Active” in the SPEC Total Relationship
Management (SPECTRM) Database if it is open one or more days during the year. Only SPEC
Headquarters (HQ) will mark all sites as “Inactive” at the appropriate time.

Why: This was a Treasury Inspector General Tax Administration (TIGTA) finding. If a territory
prematurely marks a site as inactive (closed for service), this gives the appearance the site (with
return production) was never marked as active (open for service). TIGTA also identified sites not
added to the SOl list to be selected as a QSS site and return review. HQ will change all active
VITA/TCE sites in SPECTRM from active to inactive in November/December.



How to Use This Guide

This publication is designed to assist you in preparing an accurate paper or software-prepared return
using TaxSlayer®.*

The decision trees and interview tips are from your training materials and Publication 17, Your
Federal Income Tax Guide (For Individuals). Use these tools during the dialogue with the taxpayer—
“ask the right questions; get the right answers.” Note: Publication 17 can be linked and researched
electronically via WWW.IRS.gov.

Also available via WWW.IRS.gov is the Interactive Tax Assistant (ITA), which is an excellent tool to
guide you through answers to tax law questions.

*TaxSlayer® is a copyrighted software program owned by Rhodes Computer Services. The screen
shots in this publication should not be extracted, copied, or distributed without written approval of the
IRS.

Note:

1. TaxSlayer® screen shots in this guide may not be updated for current tax law. Generally, the
screens depicted mirror the last year’s version. However, there are some instances where there
are embedded references to earlier tax years.

2. Not all forms are authorized for all volunteer programs. Forms intended specifically for the
Military VITA Program will be annotated as such. Volunteers should only provide tax assistance
based on their level of certification—basic, advanced, military, international, or Health Savings
Accounts.

SPEC allows volunteers to use the IRS provided software to prepare and electronically file their
own tax return and the returns of family and friends. Unlike VITA/TCE returns, these returns have no
income or tax law limitations.

Caution: At the time of printing the resolution for some of the graphic images lost clarity. We are
aware that volunteers may have difficulty reviewing this publication. We encourage volunteers to refer
to the software when possible. Every effort will be made to correct this issue in future editions. We
appreciate your understanding.


www.irs.gov
www.irs.gov

Scope of Service

Volunteers are trained to assist in the filing of Form 1040 and certain schedules and forms. To be covered under the
Volunteer Protection Act, volunteers must stay within the scope of the VIT. E programs and prepare returns for
which they achieved certification. This chart covers limitations or expansion of scope of service for each certification
level. The check mark indicates within scope for that level of certification. The light gray areas indicate tax law topics
not covered under that certification level. Form 1040 line items omitted from this chart are out of scope. Within each
line item, there are specific elements that are out of scope for the VITA/TCE programs as indicated in the training.
This list is not all-inclusive.

VITA/TCE Hot Line Assistor's column has been added below. For more information see Publication 5220, VITA/TCE
Volunteer Site Scope & Referral Chart.

Form 1040
Line #

Filing Status

1
2
3
4
5

Exemptions
6a-d
Income

7

8a-b

9a-b

15a-b
16a-b
17
17
19
20a-b

21

Note 1
Note 2

Note 3

Note 4
Note 5
Note 5A
Note 6

Can Hotline Assistors
Address these Tax Law

Topics with VITA/TCE
Description Information Reporting Document Basic Advanced Volunteer?*
See Note 1 See Note 1
Single v v Yes
Married filing jointly v Yes
Married filing separately v v Yes
Head of household v v Yes
Qualifying widow(er) v v Yes
Exemptions v v Yes
See Note 2 See Note 2
Wages, salaries, tips, etc. W-2 v v Yes
Taxable interest, tax-exempt interest 1099-INT v v Yes
Ordinary dividends, qualified dividends 1099-DIV 4 v Yes
Taxable refunds, etc. 1099-G v v Yes
Alimony received v v Yes
Business income or (loss) 1099-MISC, Box 7 v' See Note 3 No
Capital gain or (loss) 1099-B v' See Note 4 No
IRA distributions, taxable amount 1099-R v'See Note 5 v Yes
Pensions and annuities, taxable amount 1099-R, RRB 1099-R v'See Note 5 v See Note 5A Yes
Rental real estate (Military certification only) 1099-MISC, Box 1 No
Royalties 1099-MISC, Box 2 & Sch K-1 v'See Note 6 No
Unemployment compensation 1099-G 4 v Yes
Social Security benefits, taxable amount SSA-1099, RRB-1099 v v Yes
Other income - varies 1099-MISC, Box 3 v'See Note 7 v'See Note 7 (COI\D(eiz No)

Limitation: Foreign Student certification only for taxpayers with F, J, M & Q visas

Limitation: Military certification only — Combat Zone, Incentive Pay, Re-Enlistment, Education
Repayment, Recruitment Bonus

Limitation: Advanced Certification only- Unreported Tips
Limitation: International certification only — Foreign Pay

Limitation: Schedule C — Follow the Schedule C-EZ guidelines, except up to $25,000 of expenses are
allowed and more than one Schedule C can be prepared if the taxpayers have more than one business

Limitation: Wash sales shown on Form 1099-B or brokerage statements only
Limitation: If taxable amount has been determined

Limitation: When taxable amount cannot be determined.

Limitation: Only royalty income on Form 1099-MISC, Box 2 and Sch K-1

* If the VITA/TCE Hotline is unable to answer questions related to the tax law topic and you have performed your due diligence in seeking the answer, do not prepare
the return. Please refer the taxpayer to a professional return preparer.




Form 1040
Line #

Description Information Reporting Document Basic Advanced

Adjusted Gross Income

23

24

25

26
27
30
31a-b
32
33
34

Educator expenses v 4

Certain business expenses of reservists
(Military certification only)

Health savings account deduction 5498-SA, 1099-SA, W-2
(HSA certification only) (Box 12, Code W)

v'See Note 7 v'See Note 7
Moving expenses (Military certification only)

Deductible part of self-employment tax

Penalty on early withdrawal of savings 1099-INT
Alimony paid, recipient's SSN

IRA deduction

Student loan interest deduction 1098-E

AR NN

Tuition and fees

Tax and Credits

39a

39
40
40
42-44
46

48

49
50
51
52
53
54
Other Taxes
57

58

59

60b
61

Note 7

Note 8

Note 9
Note 10

Check if: blind/born <1/2/1952
Total boxes checked

AN
A

If your spouse itemizes on a separate return
Standard deduction

ltemized deductions

NN

Exemptions, Taxable income, Tax

IR ENE NN

Excess APTC repayment 1095-A
Foreign tax credit 1099-INT or 1099-DIV v'See Note 8 v'See Note 8

Credit for child and dependent care expenses W-2 and/or Provider Statement v v
Education credits 1098-T 4
Retirement savings contributions credit W-2, Box 12 v
Child tax credit v
Residential energy credit

Credit for the elderly or the disabled v

AN N NN

Self-employment tax v

Unreported social security and Medicare tax from
Form 4137 only

Additional tax on IRAs, other qualified retirement

plans, etc 1099-R v'See Note 10 | v See Note 10

First time homebuyer credit repayment

Health care: individual responsibility v

Can Hotline Assistors
Address these Tax Law
Topics with VITA/TCE
Volunteer?*

Yes

No

No

Yes (Job related only)
Yes
Yes
Yes
Yes
Yes

Yes

Yes

Yes
Yes
Yes
Yes

Yes
No

Yes
Yes
Yes
Yes
No

Yes

Yes

No

Yes

Yes

Yes

e Limitation: HSA certification only (requires Basic certification or higher) — HSA Distributions /

Contributions

e Limitation: COD for credit cards and home foreclosures (requires Advanced certification)

* Limitation: International certification only — Foreign earned income exclusion

e Limitation: International certification only if Form 1116 needed

e Limitation: Nonbusiness energy property credit is in scope (page 2 of Form 5695)
* Basic certification: automatic calculation only

* Advanced certification or higher: to remove addition to tax

* If the VITA/TCE Hotline is unable to answer questions related to the tax law topic and you have performed your due diligence in seeking the answer, do not prepare
the return. Please refer the taxpayer to a professional return preparer.
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Form 1040
Line #

Payments

64
65

66a
66b

67

68

69

70

71
Refund
75
76a-d
77
Amount You
78

Description

Federal income tax withheld from

2016 estimated tax payments and amount applied

from 2015
Earned income credit (EIC)

Nontaxable combat pay election (Military
certification only)

Additional child tax credit

American opportunity credit

Net premium tax credit

Amount paid with request for extension

Excess social security and tier 1 RRTA

Amount overpaid

Bank account information

Amount you want applied to 2017 estimated tax
Owe

Amount you owe

Third Party Designee

Identity Protection PIN section

Information Reporting Document

W-2 and 1099

W-2, Box 12, Code Q

1098-T
1095-A

SSA-1099, RRB-1099

Advanced

NUENENENEN

Can Hotline Assistors
Address these Tax Law
Topics with VITA/TCE
Volunteer?*

No
Yes
Yes

No

Yes
Yes
Yes
No

Yes

No
No
No

No
No
No

* If the VITA/TCE Hotline is unable to answer questions related to the tax law topic and you have performed your due diligence in seeking the answer, do not prepare
the return. Please refer the taxpayer to a professional return preparer.
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VITA/TCE Quality Site Requirements
All taxpayers using the services offered through the Volunteer Income Tax
Assistance (VITA) and Tax Counseling for the Elderly (TCE) Programs
should be confident they are receiving accurate tax return preparation and
quality service. The purpose of the ten Quality Site Requirements (QSR)
is to ensure quality and accurate tax return preparation and consistent site
operations. The QSR are required to be communicated to all volunteers
and partners to ensure IRS and partner mutual objectives are met.
The 10 requirements are listed below.

1. Certification

2. Intake/Interview & Quality Review Process
3. Photo ID and Taxpayer ID Numbers

4. Reference Materials

5. Volunteer Agreement

6. Timely Filing
7
8
9
0

Update!

o

. Civil Rights
. Site ldentification Number (SIDN)
. Electronic Filing Identification Number (EFIN)

12

Update! >1

. Security

For additional information refer to Publication 5166, VITA/TCE Quality
Site Requirements or Publication 1084, Site Coordinator Handbook.



https://www.irs.gov/pub/irs-pdf/p5166.pdf
https://www.irs.gov/pub/irs-pdf/p5166.pdf
https://www.irs.gov/pub/irs-pdf/p1084.pdf
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Important Changes for 2016

=

Due Date of Return

The due date for filing a 2016 return is Tuesday, April 18, 2017. This is because April 15, 2017 is a Saturday and
Emancipation Day is observed in Washington DC on Monday, April 17, 2017.

Standard Deduction Increases

The standard deduction for taxpayers who don’t itemize deductions on Schedule A (Form 1040) has increased. The
standard deduction amounts for 2016 are:

e $12,600 — Married Filing Jointly or Qualifying Widow(er) (no change)
¢ $9,300 — Head of Household (increase of $50)
¢ $6,300 — Single or Married Filing Separately (no change)

Taxpayers who are 65 and Older or are Blind

For 2016, the additional standard deduction for taxpayers who are 65 and older or blind is:
e $1,550 — Single or Head of Household (no change)

e $1,250 for married taxpayers or Qualifying Widow(er) (no change)

Personal Exemption Amount
The amount a taxpayer can deduct for each exemption increased to $4,050 for 2016 (increase of $50).

Retirement Savings Contribution Credit Income Limits Increased

In order to claim this credit, the taxpayer’s modified adjusted gross income (MAGI) must not be more than $30,750
for Single, Married Filing Separately, or Qualifying Widower (increase of $250). MAGI must not be more than $46,125
(increase of $350) for Head of Household, and $61,500 (increase of $500) for Married Filing Jointly.

Earned Income Credit (EIC)

Amount of Credit Increased

For 2016, the maximum credit is:

¢ $6,269 with three or more children
e $5,572 with two children

e $3,373 with one child

e $506 with no children

Earned Income Amount Increased

To be eligible for a full or partial credit, the taxpayer must have earned income of at least $1 but less than:
e $47,955 ($53,505 if Married Filing Jointly) with three or more qualifying children

e $44,684 ($50,198 if Married Filing Jointly) with two qualifying children

e $39,296 ($44,846 if Married Filing Jointly) with one qualifying child

e $14,880 ($20,430 if Married Filing Jointly) with no qualifying child

NEW-1



Investment Income
Taxpayers whose investment income is more than $3,400 can’t claim the EIC.

Standard Mileage Rate

For 2016, the following rates are in effect:

e 54 cents per mile for business miles driven

e 19 cents per mile driven for medical or moving purposes

* 14 cents per mile driven in service of charitable organizations (no change)

Education Benefits

American opportunity credit for 2016 is gradually reduced (phased out) if taxpayers’ MAGI is between $80,000 and
$90,000 ($160,000 and $180,000 if Married Filing Jointly). Taxpayers can’t claim a credit if their MAGI is $90,000 or more
($180,000 or more if Married Filing Jointly). There is no change.

Lifetime learning credit for 2016 is gradually reduced (phased out) if taxpayers’ MAGI is between $55,000 and $65,000
($111,000 and $131,000 if Married Filing Jointly). Taxpayers can’t claim a credit if their MAGI is $65,000 or more
($131,000 or more if Married Filing Jointly).

Student loan interest deduction begins to phase out for taxpayers with MAGI in excess of $65,000 ($130,000 for joint
returns) and is completely phased out for taxpayers with MAGI of $80,000 or more ($160,000 or more for joint returns).
There is no change.

Eligible Long-Term Care Premium Limits Increased

For 2016, the maximum amount of qualified long-term care premiums includible as medical expenses has increased.
Qualified long-term care premiums up to the amounts shown below can be included as medical expenses on Schedule A
(Form 1040) Itemized Deductions.

$390: age 40 or under

$730: age 41 to 50 The limit on premiums is for
$1,460: age 51 to 60 each person.

$3,900: age 61 to 70

$4,870: age 71 and over

Foreign Earned Income and Housing Exclusions

For 2016, the maximum foreign earned income exclusion will be $101,300, up from $100,800 for 2015. The foreign
housing exclusion is $44.28 per day or $16,208 for the year.

Link & Learn Taxes — Optional Courses

Health Savings Account (HSA) Deduction

The annual contribution limits on deductions for HSAs for individuals with self-only coverage is $3,350 (no change) and
$6,750 for family coverage (increase of $100). There is an additional contribution amount for taxpayers who are age 55 or
older.
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Deduction Amount and Modified AGI Limit for Traditional IRA Contributions Increased

For 2016, the maximum IRA deduction will remain at $5,500 ($6,500 if age 50 or older). For taxpayers who are covered by
a retirement plan at work, the deduction for contributions to a traditional IRA is reduced (phased out) if the modified AGl is:

¢ More than $98,000 but less than $118,000 for a married couple filing a joint return or a qualifying widow(er) if both
spouses are covered by a retirement plan,

e More than $61,000 but less than $71,000 for a single individual or head of household, or
¢ Less than $10,000 for a married individual filing a separate return

For an IRA contributor who isn’t covered by a workplace retirement plan and is married to someone who is covered, the
deduction is phased out if the couple’s income is between $184,000 and $194,000.

New IRA self-certification procedure

Revenue Procedure 2016-47 explains a self-certification procedure designed to help recipients of retirement plan
distributions who inadvertently miss the 60-day time limit for properly rolling these amounts into another retirement plan
or individual retirement arrangement (IRA). Eligible taxpayers can qualify for a waiver of the 60-day time limit and avoid
possible taxes and penalties on early distributions, if they meet certain circumstances. Taxpayers who missed the time
limit will now ordinarily qualify for a waiver if one or more of 11 circumstances, listed in the revenue procedure, apply:

An error was committed by the financial institution making the distribution or receiving the contribution.

The distribution was in the form of a check and the check was misplaced and never cashed.

The distribution was deposited into and remained in an account that | mistakenly thought was a retirement plan or
IRA.

My principal residence was severely damaged.

One of my family members died.

| or one of my family members was seriously ill.

| was incarcerated.

Restrictions were imposed by a foreign country.

A postal error occurred.

The distribution was made on account of an IRS levy and the proceeds of the levy have been returned to me.

The party making the distribution delayed providing information that the receiving plan or IRA required to complete
the rollover despite my reasonable efforts to obtain the information.

For more information, visit the “Can You Move Retirement Plan Assets?” section in Publication 590-A or the Rollovers of
Retirement Plan and IRA Distributions page on IRS.gov.

=

Affordable Care Act
Exercises to illustrate scenarios involving the Affordable Care Act (ACA) are contained in Publication 5157-A.

The flat dollar amounts used in calculating the shared responsibility payment increased for 2016. See the ACA lesson for
details.

Payments in Cash

Cash is a new in-person payment option for individuals to pay taxes owed. This service is provided through retail partners
with a maximum of $1,000 per day per transaction. To make a cash payment, taxpayers must first be registered online at
www.officialpayments.com/fed. This cash option is only available at participating 7-Eleven locations in 34 states.

NEW-3


https://www.irs.gov/pub/irs-drop/rp-16-47.pdf
https://www.irs.gov/publications/p590a/ch01.html
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https://www.irs.gov/retirement-plans/plan-participant-employee/rollovers-of-retirement-plan-and-ira-distributions
https://www.irs.gov/retirement-plans/plan-participant-employee/rollovers-of-retirement-plan-and-ira-distributions
http://www.irs.gov

New Legislation
The Protecting Americans from Tax Hikes Act of 2015 (PATH Act) made the following tax provisions permanent:

e Adjustments for up to $250 for educator classroom expenses. This provision was modified to include certain expenses
related to professional development courses the taxpayer takes related to the curriculum they teach or to their
students. The deduction amount will be indexed for inflation for future years.

e Qualified Charitable Distribution (QCD)

e State and local general sales tax deduction

The PATH Act extended the following provisions through 2016:

e Exclusion from gross income of qualified principal residence indebtedness

* Mortgage insurance premiums deductible as qualified residence interest

* Deduction for qualified tuition & fees

» Credit for nonbusiness energy property (residential energy credit)

Other provisions of the PATH Act include:

* American opportunity tax credit made permanent, replacing the Hope credit.
* Reduced earned income threshold for additional child tax credit made permanent at $3,000.
* Earned income tax credit made permanent for 3 or more qualifying children.

* Refundable Credits Refund date — no credit or refund for an overpayment for a taxable year shall be made to a
taxpayer before the 15th day of the second month (February 15) following the close of the taxable year if the taxpayer
claimed the EITC or additional child tax credit (ACTC) on the tax return. The IRS will hold the entire refund. Under the
new law, the IRS cannot release the part of the refund that is not associated with the EITC and ACTC. This provision
does not meet TAS hardship criteria and no refunds with EITC/ACTC will be released prior to Feb 15.

e Taxpayers can no longer make retroactive claims of the EITC after issuance of a social security number. A
taxpayer must have an SSN by the due date of the return (including extensions) in order to claim the EITC. Likewise,
any qualifying child claimed for the EITC must have an SSN by the due date of the return (including extensions).

e Taxpayers claiming the American opportunity credit must now have an SSN or an ITIN by the due date of the tax return
(including extensions). Further, the student claimed for the credit must have an SSN, an ITIN, or an Adoption Taxpayer
Identification Number (ATIN) by the due date (including extensions). Taxpayers can’t make retroactive claims for
the credit for a period that the taxpayer and student didn’t have a required identification number.

* Taxpayers claiming the child tax credit must now have an SSN or an ITIN by the due date of the tax return (including
extensions). Further, the child claimed for the credit must have an SSN, an ITIN, or an ATIN by the due date (including
extensions). Taxpayers can’t make retroactive claims for the credit for a period that the taxpayer didn’t have a
required identification number.

e Employer Identification number required for taxpayers claiming the American opportunity tax credit.

e Under the PATH Act, any ITIN that isn’t used on a federal tax return for three consecutive tax years, either as the ITIN
of an individual who files the return or as the ITIN of a dependent included on a return, will expire on December 31
of the third consecutive tax year of nonuse. For example, an individual applied for and received an ITIN in 2015 that
is used in 2015 on the individual’s 2014 federal income tax return. If the individual doesn't file or isn’t claimed as a
dependent on a tax return in 2016, 2017, and 2018, the ITIN will expire on December 31, 2018. This rule applies to all
ITINs regardless of when the ITIN was issued.

* ITINs issued prior to January 1, 2013 that have been used on a tax return in the last three consecutive years are set
to expire based on a multi-year schedule. Under the PATH Act, this schedule is based on the date that an ITIN was
issued. However, many ITIN holders may not know when their ITIN was issued and previously had no reason to keep a
record of the date an ITIN was issued. To simplify the renewal process and allow for the effective administration of the
program, the IRS will administer the renewal of ITINs on a schedule that is different from the schedule in the PATH Act.
The IRS will renew ITINs based upon the fourth and fifth digits (middle digits) in the ITIN. ITINs that contain the middle
digits of 78 or 79 will no longer be in effect beginning January 1, 2017. The expiration and renewal schedules for ITINs
with middle digits other than 78 or 79 will be announced in future guidance. See Notice 2016-48 for more information.

* |ITINs will be renewed using the original issuance date, and taxpayer will be allowed to claim CTC and AOTC credits for
any gap years that returns were not filed.
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Adds credit disallowance period for child tax credits or American opportunity tax credits improperly claimed. Requires
taxpayers to demonstrate eligibility after the CTC or AOTC is disallowed using deficiency procedures (existing
requirement for EITC).

20% penalty on erroneous claims on refundable portion of credits.

Higher education information reporting only include qualified tuition & related expenses actually paid. Applies to
expenses paid after December 31, 2015. Following the enactment of PATH, numerous eligible educational institutions
informed the IRS that implementation of the law change will require computer software reprogramming and other
changes that can’t be implemented in time to meet the applicable filing and furnishing due dates for Form 1098-T

for calendar year 2016. In light of this, the IRS will not impose penalties with respect to 2016 Forms 1098-T solely
because the eligible educational institution reports the aggregate amount billed for qualified tuition and related
expenses for the 2016 calendar year. Thus, eligible educational institutions will continue to have the option of reporting
either the amount of payments of qualified tuition and related expenses received or the amount of qualified tuition and
related expenses billed for the 2016 calendar year without being subject to penalties.

Expands definition of qualified higher education expenses for 529 plans to include computer equipment and
technology.

ABLE accounts to be established in any state.

Tax Relief available for the wrongfully incarcerated; some must amend by Dec. 2016. Taxpayers who were
wrongfully incarcerated can now take advantage of the new retroactive exclusion from civil damages, restitution, or
other monetary awards received in connection with their incarceration. The retroactive exclusion is only available
through December 19, 2016 for tax years 2012 and earlier that would otherwise be barred in most cases. Eligible
taxpayers must file Form 1040X for each year these payments were reported and write “Incarceration Exclusion PATH
Act” at the top.

In general, taxpayers can amend their tax returns for tax years 2013 and after by filing Form 1040X within three years
after the date they file their original return. Going forward, there are no reporting requirements for receipt of an award
qualifying for the wrongful-incarceration exclusion. This means for the year an award is received, recipients need not
report the award on their Form 1040 tax return or submit any documentation to the IRS.

Details on who qualifies and how to file are contained in frequently asked questions posted on irs.gov:

https://www.irs.gov/individuals/wrongful-incarceration-fags
4 . N

Congress may enact addi-
tional legislation that will affect
taxpayers after this publication
goes to print. Any changes
will be reflected in Publication
4491-X, VITA/TCE Training
Supplement, available in mid-
January on www.irs.gov.

\_ J
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Notes
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AFFORDABLE CARE ACT (ACA)

Health Insurance Introduction

This is easier than the doctor’s office. As part of the Affordable Care Act, we are required to verify insurance coverage for members of
your household. We have made this easy for you with a series of questions.

Contact our support team if you need assistance. We are here to make it painless.
Select this box if anyone in

the tax household had MEC -
at any time during the year.
(See page ACA-4) AN

Health Insurance Questionnaire

Did you or your family have health insurance at any time in 20157 ® Yes Mo

Below are some examples of healthcare plans that may be purchased or qualify as a purchased plan under the Affordable
Care Act.

» A private plan purchased from a health insurance company
An employer-sponsored health insurance plan or insurance through your work, spouse’s work or parent’s work
A university or college where you are enrclled

Your parent’s health insurance plan if you're under age 26

A State Medicaid program

State high-risk pools for plan or policy years

The Children's Hezlth Insurance Program (CHIF) in your state
Medicare

Veteran's Administration (VA), CHAMPVA, or Tricare

A former employer's retirement program

A union you belong to

The Peace Corps

COBRA

Refugee Medical Assistance (RWA)

The Monappropriated Fund Health Benefit Program

$HNHNNNHHN0%4%

A “Yes” answer will prompt another question about health insurance purchased through the Marketplace:

Health Insurance Questionnaire

Did you purchase health insurance via HealthCare.gov or a State Marketplace? Yes Mo

ACA-1



Verify Your Household Members

If there are additional household members that are listed as a dependent, click the "Dependents” button
below. If you have additional family members that are neither a spouse nor a dependent, click "Add a
New Member."

First Mame Last Mame 55N Date of Birth
Sample Return 555-50-XXXX 1/1/1965

Months Insured — Select Yes if everyone in the tax household was insured for all 12 months. If No, select
the number of months each individual had coverage.

\

Months Insured

Was your entire household insured for all 12 months of 20157 Yes I Mo

Please enter the number of months insured for each Nousehold member.

Name Months Insured

Sample Return 1 r
- Please Select -

ik

11
10

0

L= TN S R O N S = s ]
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Then indicate which months the individual had coverage:

Specify Insured Months (Sample Return)

Please specify the months that Sample Return had minimum essential coverage

January February March

Apri Mlay June

Juhy August September
Ochober Mowember December

ACA-3



Types of Minimum Essential Coverage

Minimum essential coverage means health care coverage under any of the following programs. It does not, however,
include coverage consisting solely of excepted benefits. Excepted benefits include stand-alone vision and dental plans
(except pediatric dental coverage), workers’ compensation coverage, and coverage limited to a specified disease or
illness.

Employer-sponsored coverage:

® Group health insurance coverage for employees under—
® A governmental plan, such as the Federal Employees Health Benefit program
® A plan or coverage offered in the small or large group market within a state
® A grandfathered health plan offered in a group market

® A self-insured health plan for employees

® COBRA coverage

® Retiree coverage

® Coverage under an expatriate health plan for employees

Individual health coverage:
® Health insurance you purchase directly from an insurance company
® Health insurance you purchase through the Marketplace
® Health insurance provided through a student health plan
® Catastrophic plans
® Coverage under an expatriate health plan for non-employees such as students and missionaries

Coverage under government-sponsored programs:
® Medicare Part A coverage
® Medicare Advantage plans
® Most Medicaid coverage*
® Children's Health Insurance Program (CHIP) coverage
® Most types of TRICARE coverage
® Comprehensive health care programs offered by the Department of Veterans Affairs
® Health coverage provided to Peace Corps volunteers
® Department of Defense Nonappropriated Fund Health Benefits Program
® Refugee Medical Assistance
® Coverage through a Basic Health Program (BHP) standard health plan

Other coverage:
® Certain foreign coverage
® Certain coverage for business owners
¢ Coverage recognized by HHS as minimum essential coverage.™*

*Medicaid programs that provide limited benefits generally don't qualify as minimum essential coverage; however, HHS will provide a hardship exemption to individuals
with certain types of limited-benefit Medicaid coverage.

**Plans recognized as minimum essential coverage are listed at: www.cms.gov/CCIIO/Programs-and-Initiatives/Health-Insurance-Market-Reforms/minimum-essential-
coverage.html, scroll down and click on the link for the list of approved plans.

No proof of coverage is needed. Oral statement from the taxpayer is acceptable, unless
normal due diligence leads you to believe the taxpayer’s statement is incorrect.
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Exemptions: Overview

Exemptions: Where do | start?

Does anyone in the tax household already have an exemption in hand from the Marketplace?
Marketplace exemptions require an application. If a person applied for an exemption through the
Marketplace (or if they were granted an exemption because they were denied Medicaid coverage in a
state that did not expand Medicaid), they should have received an Exemption Certificate Number (ECN)
from the Marketplace. It is a 6 or 7 digit alphanumeric code.

Is household or gross income under the filing threshold?
If yes, everyone on the tax return is exempt from the coverage requirement, and there is no need to
consider additional exemptions. Line 7 on Form 8965 is used to claim an income-based exemption. See

page ACA-8 for more information about this exemption.

If the tax household does not qualify for an exemption under Step 2, does any individual qualify
for an exemption that can be claimed directly on the tax return?
If yes, the exemption code is entered on Form 8965, Part Ill.

For any uninsured individual that does not qualify under Step 2 or 3, does any individual in the
tax household qualify for an exemption from the Marketplace?

If yes, direct the person to the Marketplace for additional help. Enter “pending” as shown on the
following page if the Marketplace has not processed the application for exemption before the return is
filed. A tax return with a “pending” exemption can still be e-filed. The IRS may follow up with a taxpayer
directly on a pending submission if the Marketplace does not approve the exemption.

Entering Exemptions in TaxSlayer

If any individual in the household qualifies for an exemption, either through the Marketplace or
claimed on the tax return, select Yes: \

Do you qualify for Health Care Exemptions?

Did you receive an exemption certificate from a marketplace, or qualify for exemptions @ Yes Mo
due to circumstances?

Click here to determine if you can claim an affordability exemption.
Click here to determine if you can claim a health coverage exemption.

If the household or gross income is under the filing threshold (as described in Step 2, above), check this
box. If not, select Continue.

Coverage Exemptions

Does this apply to your household?

> Are you claiming & hardship exemption because your gross income is below the filing

threshold?

ACA-5




For all other exemptions, indicate the individual, the type of exemption (and Marketplace-issued certificate number, if
applicable) and the months of eligibility:

Health Insurance/Exemption

Mame of Individus Sample Return

Do you heve a marketplace-issued certificate for this exemption? Ho

Exemption Type -- Please Select - i
-- Please Select —

Indicate full year or specify menths far which you quelify to take the sxemption. Coverage is unaffordable

Full Year SITHEDICTERES . o
Citizens living abroad and certain nencitizens
Memiber of health care sharing ministry
Member of Federally-recognized Indian tribe
Incarceration
il May Jumd] Appregate self-only coverage considered unaffordable
Gap in coverage at the beginning of 2015
Gap in CHIP coverage

January Februsry Mar

July Augu Sept]
i e “*| Resident of a state that did not expand Medicaid
o Limited benefit Medicaid and TRICARE programs that are not minimum essential coverage|
ctober Havember Decd " ST
Employer coverage with non-calendar plan year in 2014

Enter “Pending” if the Marketplace has not processed the application for exemption before the return is filed:

Health Insurance/Exemption
Narme of Individual Sample Return v
Do you have a marketplace-issued certificate for this exemption? ® Yes Mo
Exemption Certificate Mumber Pending
Indicate full year or specify months for which you qualify to take the exemption.

Full Year

January February March

Agril May June

July August September

October MNowvember December
=3 D
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Types of Coverage Exemptions

This chart shows all of the coverage exemptions available for 2016, including information about where the coverage
exemptions can be obtained and the code for the coverage exemption that is to be used on Form 8965 when you claim the
exemption. If your coverage exemption was granted by the Marketplace, you will need to enter the Exemption Certificate

Number (ECN) provided by the Marketplace (see the instructions for Part ).

Claimed

minimum essential coverage for one or more months of the year by meeting a spend-down, but not in other
months because the spenddown had not been met.

. Granted b Code for
Coverage Exemption Marketplacye f,’;ttl‘;’,‘: Exemption
Income below the filing threshold — Your gross income or your household income was less than your v No Code
applicable minimum threshold for filing a tax return. See Part Il
Coverage considered unaffordable — The minimum amount you would have paid for premiums is more than v A
8.13% of your household income.
Short coverage gap — You went without coverage for less than 3 consecutive months during the year. v B
Citizens living abroad and certain noncitizens — You were:
e AU.S. citizen or resident who was physically present in a foreign country or countries for at least 330 full
days during any period of 12 consecutive months;
e AU.S. citizen who was a bona fide resident of a foreign country or countries for an uninterrupted period
that includes an entire tax year;
e Abona fide resident of a U.S. territory;
e Aresident alien who was a citizen or national of a foreign country with which the U.S. has an income
tax treaty with a nondiscrimination clause, and you were a bona fide resident of a foreign country for an v (03
uninterrupted period that includes an entire tax year;
e Not lawfully present in the U.S and not a U.S. citizen or U.S. national. For more information about who is
treated as lawfully present in the U.S. for purposes of this coverage exemption, visit www.HealthCare.gov; or
e Anonresident alien, including (1) a dual-status alien in the first year of U.S. residency and (2) a
nonresident alien or dual-status nonresident alien who elects to file a joint return with a U.S. spouse. This
exemption doesn’t apply if you are a nonresident alien for 2016, but met certain presence requirements and
elected to be treated as a resident alien. For more information see Pub. 519.
Members of a health care sharing ministry — You were a member of a health care sharing ministry. v D
Members of Indian tribes — You were either a member of a Federally-recognized Indian tribe, including an
Alaska Native Claims Settlement Act (ANCSA) Corporation Shareholder (regional or village), or you were * v E
otherwise eligible for services through an Indian health care provider or the Indian Health Service.
Incarceration — You were in a jail, prison, or similar penal institution or correctional facility after the disposition v F
of charges.
Aggregate self-only coverage considered unaffordable — Two or more family members’ aggregate cost
of self-only employer-sponsored coverage was more than 8.13% of household income, as was the cost of any v G
available employer-sponsored coverage for the entire family.
Resident of a state that did not expand Medicaid — Your household income was below 138% of the federal
poverty line for your family size and at any time in 2016 you resided in a state that didn’t participate in the v G
Medicaid expansion under the Affordable Care Act.
Member of tax household born, adopted, or died — During 2016 a child was added to your tax household
by birth or adoption, or a member of your tax household died during the year and you can’t check the full-year v H
coverage checkbox on your tax return.
Members of certain religious sects — You are a member of a recognized religious sect. v '\éeedPE(r:t'\ll
ee Pa
Determined ineligible for Medicaid in a state that didn’t expand Medicaid coverage — You were Need ECN
determined ineligible for Medicaid solely because the state in which you resided didn’t participate in Medicaid v SZZ Part |
expansion under the Affordable Care Act.
General hardship — You experienced a hardship that prevented you from obtaining coverage under a qualified v Need ECN
health plan. See Part |
Coverage considered unaffordable based on projected income — You didn’t have access to coverage that 7 Need ECN
is considered affordable based on your projected household income. See Part |
Unable to renew existing coverage — You were notified that your health insurance policy was not renewable Need ECN
and you considered the other plans available to be unaffordable. This exemption is available only until October v S%% Part |
16, 2016.
Certain Medicaid programs that are not minimum essential coverage —You were (1) enrolled in Medicaid
coverage provided to a pregnant woman that is not recognized as minimum essential coverage; (2) enrolled in
Medicaid coverage provided to a medically needy individual (also known as Spend-down Medicaid or Share-of- 7 Need ECN
Cost Medicaid) that is not recognized as minimum essential coverage; or (3) enrolled in Medicaid, and received See Part |

Hardship Exemptions Granted by the Marketplace

1. Homelessness 10. Failure of another party to comply with a medical support order for a

2. Eviction in the last 6 months or facing eviction or foreclosure dependent child who is determined ineligible for Medicaid or CHIP

3. Utility shut-off notice 11. Through an appeals process, determined eligible for a Marketplace QHP,
4. Domestic violence PTC, or CSR but was not enrolled

5. Recent death of a close family member 12. Determined ineligible for Medicaid because the state did not expand

6. Disaster that resulted in significant property damage coverage

7. Bankruptcy in the last 6 months 13. Individual health insurance plan was cancelled and you believe

8. Significant debt from medical expense in the last 24 months Marketplace plans are considered unaffordable

9. High expense caring for ill, disabled or aging relative 14. Other hardship in obtaining coverage

* The Marketplace is not granting this exemption beginning in 2016, but lifetime ECNs granted in 2014 or 2015 are still valid.
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Exemptions: Form 8965, Part Il

Household Exemptions for Income Below Filing Threshold

Exemption Type Details

Household income below filing Household income is the sum of the modified adjusted gross income (MAGI)
threshold (Form 8965, Line 7) from the tax return and the MAGI of all dependents required to file a tax return.
Use the Filing Requirements for Children and Other Dependents chart (in this
tab) to determine whether the dependent is required to file his or her own tax
return.

— | AdjustedGross |,| Tax-Exempt || Excluded Foreign
Income (AGI) Interest Income

) N *International certification
[ Form 1040, Line 37 ] [ Form 1040, Line 8b ] 0
Form 25535,
Form 2555-£7

Gross income below filing threshold Gross Income means all income received in the form of money, goods,
(Form 8965, Line 7) property, and services that is not exempt from tax, see definition of gross
income on page A-1.

* Do not include income of any dependents

If either exemption applies, stop.
There is no need to consider other exemptions for individual members of the household.

2016 Federal Tax Filing Requirement Thresholds

Must file a return if

Filing Status Age* gross income** exceeds
Single Under 65 $10,350
65 or older $11,900
Head of Household Under 65 $13,350
65 or older $14,900
Married Filing Jointly*** Under 65 (both spouses) $20,700

65 or older (one spouse) $21,950
65 or older (both spouses) $23,200

Married Filing Separately Any age $4,050
Qualifying Widow(er) with Under 65 $16,650
Dependent Children 65 or older $17,900

*If you were born on January 1, 1952, you are considered to be age 65 at the end of 2016. (If your spouse died in 2016 or
if you are preparing a return for someone who died in 2016, see Pub. 501.)

** Gross income means all income you received in the form of money, goods, property, and services that isn’t exempt from
tax, including any income from sources outside the United States. It also includes gain from the sale of your main home,
even if you can exclude part or all of it. Include only the taxable part of social security benefits (Form 1040, line 20b; Form
1040A, line 14b). Also include gains, but not losses, reported on Form 8949 or Schedule D. Gross income from a business
means, for example, the amount on Schedule C, line 7, or Schedule F, line 9. But, in figuring gross income, do not reduce
your income by any losses, including any loss on Schedule C, line 7, or Schedule F, line 9.

***If you did not live with your spouse at the end of 2016 (or on the date your spouse died) and your gross income was at
least $4,050, you must file a return regardless of your age.
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2016 Federal Tax Filing Requirement Thresholds —
Dependents

If your parent (or someone else) can claim you as a dependent, use this chart to see if you must file a return.

In this chart, unearned income includes taxable interest, ordinary dividends, and capital gain distributions. It also includes
unemployment compensation, taxable social security benefits, pensions, annuities, and distributions of unearned income

from a trust. Earned income includes salaries, wages, tips, professional fees, and taxable scholarship and fellowship
grants. Gross income is the total of your unearned and earned income.

Single dependents. Were you either age 65 or older or blind?

1 No. You must file a return if any of the following apply.
1. Your unearned income was over $1,050.
2. Your earned income was over $6,300.
3. Your gross income was more than the larger of —
a. $1,050, or
b. Your earned income (up to $5,950) plus $350.

1 Yes. You must file a return if any of the following apply.
1. Your unearned income was over $2,600 ($4,150 if 65 or older and blind).
2. Your earned income was over $7,850 ($9,400 if 65 or older and blind).
3. Your gross income was more than the larger of —
a. $2,600 ($4,150 if 65 or older and blind) or
b. Your earned income (up to $5,950) plus $1,900 ($3,450 if 65 or older and blind).

Married dependents. Were you either age 65 or older or blind?

[1 No. You must file a return if any of the following apply.
1. Your unearned income was over $1,050.
2. Your earned income was over $6,300.
3. Your gross income was at least $5 and your spouse files a separate return and itemizes deductions.
4. Your gross income was more than the larger of —
a. $1050, or

b. Your earned income (up to $5,950) plus $350.

[1 Yes. You must file a return if any of the following apply.
. Your unearned income was over $2,300 ($3,550 if 65 or older and blind).
. Your earned income was over $7,550 ($8,800 if 65 or older and blind).

. Your gross income was at least $5 and your spouse files a separate return and itemizes deductions.
. Your gross income was more than the larger of —

a. $2,300 ($3,550 if 65 or older and blind), or
b. Your earned income (up to $5,950) plus $1,600 ($2,850 if 65 or older and blind).

A OWON =

Note: For children under age 18 and certain older children, unearned income over $2,100 is taxed at the parent’s rate if
the parent’s rate is higher than the child’s. For this purpose, “unearned income” includes all taxable income other than
earned income, such as taxable interest, ordinary dividends, capital gains, rents, royalties, etc. It also includes taxable
social security benefits, pension and annuity income, taxable scholarship and fellowship grants not reported on Form W-2,
unemployment compensation, alimony, and income received as the beneficiary of a trust. If the child’s unearned income is
more than $2,100, Form 8615 must be used to figure the child’s tax. Form 8615 is out of scope.
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Exemptions: Form 8965, Part llI

Insurance is Unaffordable, Code A or G

Coverage is unaffordable if it costs more than 8.13% of household income. For example, Susan’s household
income is $20,000. Her share of the cost of her employer’s offer of self-only coverage is $3,000. Susan is eligible for the
affordability exemption.

STEP 1: Determine what type of affordability exemption each uninsured person in the household might be eligible for.
There are three options offered on the ACA Affordability Worksheet. STOP at the first one that applies to each uninsured
household member.

Offer of coverage through an employer: Offer of coverage through an employer: NO offer of coverage through an
employer:
As an employee )| As a family member ) Look at marketplace
of an employee coverage affordability
(Next page)
Use the lowest-cost plan that Use the lowest-cost plan that covers all Use the lowest-cost bronze plan available
cuvers unly the empluoyee uninsured members (after accounting for subsidies)

l | l
On the Do You Qualify for Health Care

Get the plan cost(s) from the taxpayer. Figure out the cost of the employee or the Exemptions page within the Health Insurance

employee’s family for the entire year (“annualized premium”). menu, select CLICK HERE to determine if
Enter annualized premium on the table for each month it applies.** you can claim an affordability exemption.

COBRA is not considered an offer of employer sponsored coverage if the individual did not enroll in the coverage. If the
individual enrolled in the COBRA coverage, s/he has MEC for that month and does not need an exemption.

**If you or another member of your tax household has an offer of employer sponsored coverage for only part of the year,
see Form 8965 Instructions for the Annualized Premium Worksheet.

STEP 2: Use this worksheet to determine whether coverage for each individual in your tax household is
unaffordable.

(A) Affordability Threshold T| P :
Enter 8.13% of your househeld income (see Household income). For this purpose, increase household
income by the amount of any premium that is paid through a salary reduction arangement and excluded Th e MAG | Of any depende nt
from gross income. . .
that is claimed and has a tax
(B) Required Contribution Amount R : [
For each member of your tax household, enter in the columns provided the annual premium for the first option below that applies to that person. If fl I I ng req uirement is InCI Uded
the monthly premium is the same for the whole year, enter the annual premium in the space for each month. If the premiums cover only part of the i i
year, use the Annualized Premium Worksheet to determine what the annualized premium would be for each month. Once you have figured the in househOId Income.
annualized premium, enter it in the space for each month.
Options (use the first that applies to each member of your tax household, including you, for each month):
1. The lowest cost self-only policy offered to each member of your tax household by his or her
employer.
2. The lowest cost family policy* offered by your employer or your spouse's employer (if you are filing a
joint return).
3. The amount from the Marketplace Coverage Affordability Worksheet.
For each individual, coverage is unaffordable and the individual is exempt for any month in which (B), the Required Contribution Amount, is more
than (A), the Affordability Threshold.
Members of your
tax household
(enter one name
per column):
e :
Annualized premium for:
January |
February What is an annualized premium?
March .
P Example:
May Wilma’s employer offered both employee and family coverage:
June ¢ The employee-only premiums cost $150/month
July (Annualized premium: $150 x 12 = $1,800)
August .
September ¢ The employee + spouse premium cost $400/month
Octaber (Annualized premium $400 x 12 = $4,800)
November I
December |
*The policy must cover everyone in your tax household:
* For whom a personal exemption deduction is claimed on your tax return,
® Who isn't eligible for employer coverage, and
* Who doesn't qualify for another coverage exemption.

ACA-10



This worksheet is used only if there is no offer of employee coverage

Marketplace Coverage Affordability Worksheet

TIP

marketplace affordability exemption does not apply)

If the lowest cost bronze plan (LCBP) costs less than 8.13% of income (above), there is an affordable offer
of coverage. No Code A exemption is available. (The Marketplace presented affordable coverage and the

LCBP: Go to the taxpayer’'s Marketplace, such as www.healthcare.gov.

NOTE: The look up tool asks about tobacco use. Tobacco use is the use of
a tobacco product 4 or more times per week within no longer than the past
6 months by legal users of tobacco products (generally those 18 and older).

The LCBP quote will be for all individuals on the return that
did not have an offer of employer coverage and who did not
qualify for another exemption. That means that the LCBP
would include, for example, the taxpayer and spouse who
are on Medicare or Medicaid.

Do not complete this worksheet unless you were instructed to do so in the Affordability Worksheet.
CAUTION

Y

Enter the monthly premium for the lowest cost bronze plan that covers everyone in your tax household for whom a personal
exemption deduction is claimed, who isn't eligible for employer coverage, and who doesn't qualify for another coverage
exemption for the month. To find the lowest cost bronze plan go to www.HealthCare.gov/tax-tool or the Marketplace for
your area. If you are married and file a separate return, enter the monthly premium here and on line 12. Don’t complete
MBS -1, L e e e e e e e e e e e e

A

2. Enter your household income (see Household inCome) . ... .. ... ... ... .. .uuuunsiueuunnnenennns

3. Enter the total of all nontaxable social security benefits received by you, your spouse, and each claimed dependent who
must file @ tax retUrn® . . . . . e e e e

4. AdAIINES 2 and B . . . . .. e e e e e e e e e

5L Enter the federal poverty line for the number of individuals in your tax household less any dependents not claimed. See
the instructions for FOrm 8962, liNe 4 . . . . .. ... ... s

6. Divide line 4 by line 5. If the result (without rounding) is less than 1.0 or more than 4.0, skip lines 7 through 10 and enter
0L o 1 T

7. Multiply line 6 by 100 and round to the nearest whole number. Enter the applicable figure for the result from the table in
the instructions for FOrm 8962, N 7 . . . . . . . . o it e e e e e e e e e e e e e e e e e e e e

8. Multiply iN€ 4 Dy INE 7 . . . oottt et e e e e e e e e e e e e e

9. Divide N B DY 12.0 . . . .ttt et e e e e e e e e e e e e e e

10. Enter the monthly premium for the second lowest cost silver plan premium that covers everyone in your tax household
for whom a personal exemption deduction is claimed, who isn't eligible for minimum essential coverage (other than
coverage in the individual market), and who doesn't qualify for another coverage exemption for the month. To find the
second lowest cost silver plan go to www.HealthCare.gov/tax-tool or the Marketplace foryourarea . ............

11.  Subtract line 9 from line 10 . If Zero or 1ess, eNter -0-. . . . . . . ittt e e e e e e ettt e et e e s

12.  Subtract line 11 from line 1. If zero or less, enter -0-. This is the individual’s required contribution for the month . . . . .

13. Is the individual eligible for this coverage for every month oftheyear? ... ............ ... . ... ... ........

D Yes. Multiply line 12 by 12.0. This is the annualized premium. Enter this amount in the space for every month on
the Affordability:-Worksheet: . .. ... L L

D No. Multiply line 12 by 12.0. This is the annualized premium. Enter this amount in the space on the Aff
Worksheet for each month the individual was eligible for the coverage beingtested. .. ........_~T.........

*If the individual filed Form 1040, figure the nontaxable social security benefits received by
20b from Form 1040, line 20a. If the individual filed Form 1040A, figure the nontaxabl
subtracting Form 1040A, line 14b from Form 1040A, line 14a. If the individual fil
SSA-1099 or Form RRB-1099 showing the social security benefits receive

that individual, all of which were nontaxable.

individual by subtracting Form 1040, line
cial security benefits received by that individual by
orm 1040EZ, he or she should have received a Form

For this line on this
worksheet, use tax
household MAGI for
Form 8962 purposes
(adjusted gross
income + tax exempt
interest + excluded
foreign earned
income). Include
MAGI of any claimed
dependents with a
filing requirement.

Enter the appropriate amount on the
Affordability Worksheet as directed. This

If the annualized premium costs more
than 8.13% of income, Code A applies. from line 1).

Second lowest cost silver plan (SLCSP): Go to the
Marketplace at:
https://www.healthcare.gov/tax-tool/

Do not include individuals in your tax household that are

workgheett V\;w cofr;\pgriltlr.le ;nnuzlllz:d TIP: Note that more than one eligible for other employer sponsored or government
premium 1o the atiordability thresnold. marII:er:pIatce Co‘frage 3ffgr$ab'“ty sponsored MEC, or who are otherwise exempt.
; - worksheet may be needed i
g;h;/a”?fja“zed premium C?S‘Si'essl.tha” circumstances changed during That means that the SLCSP cost would NOT INCLUDE,
-197 otincome, No exemption applies. the year. for example, the taxpayer and spouse who are enrolled

in or eligible for Medicare or Medicaid. (This is different
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Federal Poverty Lines

For purposes of the premium tax credit, eligibility for a certain year is based on the most recently published set of poverty
lines. As a result, the tax credit for 2016 will be based on the 2015 federal poverty lines.

2015 Poverty Lines for the 48 Contiguous States and the District of Columbia

For families/households with more than 8 persons, add $4,160 for each additional person (100% Poverty Line)

Persons in family/household ' 100% Poverty Line

138% Poverty Line

400% Poverty Line

1 $11,770 $16,243 $47,080
2 $15,930 $21,983 $63,720
3 $20,090 $27,724 $80,360
4 $24,250 $33,465 $97,000
5 $28,410 $39,206 $113,640
6 $32,570 $44,947 $130,280
7 $36,730 $50,687 $146,920
8 $40,890 $56,428 $163,560

2015 Poverty Lines for Alaska

For families/households with more than 8 persons, add $5,200 for each additional person (100% Poverty Line)

Persons in family/household ' 100% Poverty Line

138% Poverty Line

400% Poverty Line

1 $14,720 $20,314 $58,880

2 $19,920 $27,490 $79,680

3 $25,120 $34,666 $100,480
4 $30,320 $41,842 $121,280
5 $35,520 $49,018 $142,080
6 $40,720 $56,194 $162,880
7 $45,920 $63,370 $183,680
8 $51,120 $70,546 $204,480

2015 Poverty Lines for Hawaii

For families/households with more than 8 persons, add $4,780 for each additional person (100% Poverty Line).

Persons in family/household ' 100% Poverty Line

138% Poverty Line

400% Poverty Line

1 $13,550 $18,699 $54,200
2 $18,330 $25,295 $73,320
3 $23,110 $31,892 $92,440
4 $27,890 $38,488 $111,560
5 $32,670 $45,085 $130,680
6 $37,450 $51,681 $149,800
7 $42,230 $58,277 $168,920
8 $47,010 $64,874 $188,040

ACA-12
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Shared Responsibility Payment

How is the Payment Calculated?

* For the year, based on the greater of the calculated:
A. percentage of income or
B. flat dollar amount
e Limited to maximum of 3X per household ($2,085 for 2016)
e Cannot exceed the national average premium for bronze level health plans
* Prorated for months without coverage/exemption

Greater of

| E—

2014 2015 2016 After 2016

Percentage 1% of household 2% of household 2.5% of household  2.5% of household
income income above the  income above the income above the income above the
(annual) filing threshold filing threshold filing threshold filing threshold

Flat dollar $95 per adult $325 per adult $695 per adult $695 per adult
amount 50% for individuals  50% for individuals 50% for individuals  plus an increase
(annual) under 18 under 18 under 18 based on cost of

living
50% for individuals
under 18
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Premium Tax Credit: Form 1095-A Overview

A person who purchased insurance through the Marketplace will receive Form 1095-A. Anyone who received the benefit
of advance payments of the premium tax credit (APTC) must complete Form 8962. You cannot prepare the return for

taxpayers who received the benefit of APTC without Form(s) 1095-A.

Carefully examine Form 1095-A to make sure it reflects the taxpayer’s account of coverage. Look for critical errors that
will affect the PTC calculation, such as errors in enroliment premiums, SLCSP premiums, or APTC. The taxpayer should
seek a corrected 1095-A if enrollment related information is incorrect.

This includes:
e Policy issuer's name (Part I)
e Policy start or end date (Part |, Part Il)
* Premium cost (Part lll, Column A)
e APTC received (Part Ill, Column C)

Marketplace call center: 1-800-318-2596

(TTY: 1-855-889-4325) For states not using
Healthcare.gov, look up state Marketplace

at Healthcare.gov

To obtain an original or corrected Form 1095-A the taxpayer can log into his or her online account, or call the

Marketplace call center.

o 1095=A

Health Insurance Marketplace

Deparmment of the Traasury
Intmal Fibris Senice

Is at www.lrs.gov/form 10858,

* Information about Form 1098-A and its separate instructions

Form 1095-A

OB Mo, 1545-2252

2016

_Jvom

[] commecTen

Statement

IEE Recipient Information

1 Manaipiacs idantfier 2 Markgtplace-aasigned pollcy number

3 Pokcy IBSUBrS Nams

4 Reciglent's name

B Ragiplant's S50 B Hacipiant's dasa of birth

T Racipiant's spau=a’s nama

8 Razipiont's spousa's SSN O Reripiont's snousa’s data of Bitth

10 Podicy elart date 19 Palicy Surmminaticor tate

12 Stroot addraes finchulig apartment ra.|

13 Gity ar foen 14 State or province

18 Gounlry and ZIF or fareign postal code

IE! !! Covered Individuals

A Y LN NN hmwh_‘\ P N o e i = WPV e WP S, ST RN

20 |

=
[ERAl] Coverage Information

Month

. Manthly enralimest premiven=gl B. Mantly second lowest cost silver €. Manthly advance payment of
plan (SLCEP) pramium

premium tax credit

21 January 4

e ColumnaA | ColumnB | Column C
| | |

23 March

24 April

25 Mag

JWW-WW

You may need to look up the SLCSP premium if:

e Itis incorrect, perhaps because a change in family size was not

reported.

e It is missing. This happens when someone paid the full premium

because he or she did not request advance payment of the premium

tax credit. Marketplaces routinely leave this space blank.

e There are multiple Forms 1095-A wit

h conflicting information or the

taxpayer otherwise thinks it's incorrect.

See healthcare.gov/tax-tool or your state’s tax tool.

ACA-14
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Column A - Monthly Premium: These
are the total monthly enrollment premiums
for the policy in which the individuals

are covered. This is the full premium,
including the amount paid by APTC
but it includes only the premiums for
essential health benefits. The amount
does not include the cost of certain
“extra” benefits such as adult dental
coverage.

Column B - Monthly SLCSP premium:
If this column is blank and the individuals
enrolled in a plan through a Federally-
facilitated Marketplace, go to www.
Healthcare.gov and use the tax tool to find
the SLCSP premium to enter in Column
B. If the individuals enrolled through

a State-based Marketplace, go to the
state’s website to determine the SLCSP
premium. In some cases, the state will
send a table with the information. If the
State-based Marketplace does not have a
look-up tool to find the SLCSP premium,
call the Marketplace to obtain a correct
SLCSP premium. The SLCSP premium

is the premium for the second lowest

cost silver-level plan that covers all the
members of the coverage family.

Column C - Advance payment of PTC

TIP: A person may be entitled to PTC even if no
APTC was paid for the coverage. Do not assume
someone is ineligible for PTC just because
Columns B and C of Form 1095-A are blank. If an
individual meets all the eligibility rules in the Form
8962 instructions but only the enrollment premium
amounts in Column A appear on Form 1095-A
and Columns B and C are blank, look up the
person’s SLCSP premiums and enter them on the
Advanced Premium Tax Credit (1095-A) screen in
the Premium Amount of SLCSP section.



https://www.healthcare.gov/
https://www.healthcare.gov/
https://www.healthcare.gov/tax-tool/

For taxpayers who purchased insurance through the Marketplace, complete the screen below using their Form

1095-A

Advanced Premium Tax Credit (1095-A)

Did you receive a 1095-A statement or any Premium Tax Credits te assist you in paying for 8 Yes Mo
vour health care for 20157

Do all Forms 1095-A include coverage for January through December, with no changes in Yes (@) Mo
monthly amounts?

Please enter your monthly Advance Premium Tax Credit information

Monthly Premium Amount (Form Meonthly Premium Ameount of SLCSP Monthly Advance Payment of PTC

Month 1095-A, Part Ill, Colurmn A) (Form 1005-A, Part IIl, Calumn B)  (Form 1005-A, Part lIl, Column C)
January s s s
February s s s
March s N s
April s s s
Ve s s s
June s s ¢
. s s s
August s s s
September s N s
October s s s
November s s s
December s s s

Caution: Enter dependent’s MAGI
only if the dependent has a tax filing
requirement. Do not enter the MAGI
of taxpayer or spouse as it is already
included.

Dependents' Modified AGI (if filing requirement)

Enter the AGI for your dependents from Form 1040, line 38; Form 10404, line 22; Form [ $
1040EZ, line 4; and Form 1040MR, line 37

Enter any tax-exempt interest for your dependents from Form 1040, line 8b; Form 10404, line §
Bb; Form 1040EZ, the amount written to the left of the line 2 entry space; and Form 1040NR,

line 9b
Enter any amounts for your dependents from Form 2555, lines 45 and 50, and Form 2555-EZ, $
line 18
Enter for each of your dependents the difference, if any, between Form 1040, lines 208 and 5

20b; and Form 10404, lines 14a and 14b
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Premium Tax Credit

Advanced Premium Tax Credit (1095-A) Check here if taxpayer is Married Filing
Did you receive a 1095-A statement or any Premium Tax Credits to assist you in paying for your health care Separate|y but cannot file a joint return because

giom* of spousal abuse or abandonment in the last

es < . .

b < year. See Form 8962 Instructions for details.
lo

If a taxpayer is Married Filing Separately and is
[] Check here if you are filing a separate return ONLY because you are a victim of domestic abuse or spousal not e||g|b|e for re”ef’ he/she must repay APTC,
sbandenment subject to the repayment limitation.

Do all Forms 1095-A include coverage for January through December, with no changes in monthly amounts?

@® Yes
O No

If Form 1095-A shows the same monthly
amounts for all 12 months, select “Yes” and
L___| enter the annual amounts below.

Please enter your annual Advance Premium Tax Credit information

Otherwise, select “No” and enter monthly

Premium Ameunt {(Form 1095-A, line 33A) $

amounts.
Annual Premium Amount of SLCSP (Form 1085-A, line 33B) $
Annual Advance Payment of PTC (Form 1095-A, line 33C) ‘ 5‘ |

Enter dependents’ AGI ONLY (not taxpayer or spouse) IF
dependents’ gross income is above the filing threshold.
See page ACA-9 for dependents’ filing threshold chart.

TaxSlayer will use the proper elements to
% calculate household income for premium tax

N

credit purposes.

Dependents' Modified AGI (if filing requirement) /

Enter the AGI for your dependents from Form 1040, line 38; Form 10404, line 22; | 5
Form 1040EZ, line 4; and Form 1040NR, line 37

Enter any tax-exempt interest for your dependents from Form 1040, line 8b; Form $
10404, line 8b; Form 1040EZ, the amount written to the left of the line 2 entry space;
and Form 1040NR, line 9b

The net premium tax credit a taxpayer can
claim (the excess of the taxpayer’s premium tax

A\

Enter any amounts for your dependents from Form 2555, lines 45 and 50. and Form $ . .

2555-E7, line 18 credit over APTC) will appear on Form 1040,
line 69. This amount will increase taxpayer’s

Enter for each of your dependents the difference, if any, between Form 1040, lines 20a $ refund or reduce the balance dUe

and 20b; and Form 10404, lines 14a and 14b

The amount of excess APTC (amount by

« Cartintia which APTC exceeds the taxpayer’s premium
tax credit) that needs to be repaid, if any, will
appear on Form 1040, line 46.

N
m
t

If the following situations apply, a shared policy allocation may be required and the return is out of scope:

* The 1095-A lists a covered person who is not on this tax return or,

e A person on the tax return was enrolled in another taxpayer’s Marketplace coverage. (The person is listed on someone
else’s Form 1095-A)

If the following situation applies, an Alternative Calculation for Year of Marriage may be elected. If the taxpayer elects this

option, the return is out of scope.

e Taxpayers got married during the year and are filing a joint return, and taxpayers were both unmarried as of December
31,2015 or 2016

* A member of the taxpayers’ tax family was enrolled in a qualified health plan for which APTC was paid for months prior
to the first full month of marriage, and

e Taxpayers have excess APTC that must be repaid
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Premium Tax Credit — Special Situations

See Instructions for Form 8962 and Publication 974, Premium
Tax Credit, for additional information.

Multiple Forms 1095-A

Some taxpayers will have multiple Forms 1095-A. This will happen if the taxpayer:

e Changed Marketplace plans during the year

* Updated their application with new information that resulted in a new enroliment
* Had family members enrolled in different Marketplace plans

* Had more than 5 family members in the same plan

Entering Multiple Forms 1095-A on One Form 8962 - Make sure everyone on the Forms 1095-A is also on the tax

return. If not, this may be a Shared Policy Allocation.

Column A: Add the premiums together.

EXIl Coverage information

Column B: If everyone is in the

Meanih

'k Rtarithby sreclimerd

same state and enrolled in the same

i IEI. Monthiy second lowest cosi mher I €. Morknly advance paymiend of I

policy, the SLCSP premium should

Column Al

Column B |

Column C I—

be the same on all Forms 1095-A for # Sy
a given month. Enter that amount. If B
the enrollees are in different states, e
add the SLCSP premiums. When in 2 may
doubt, look it up in the Tax Tool for your 6 s

Marketplace.

27 July

Column C (entered in Column F of
Form 8962): Add the amounts together.

The taxpayer stopped paying premiums
What you’ll see: Numbers in Columns B and C but no

premium in Column A (-0-) for a month on Form 1095-A,
Part 1l

What to do:

* The taxpayer can only claim a PTC for a month of
enrollment if the premium for the month is paid by the
tax return due date (without extensions). If the APTC is
high and covers most of the premium, can the taxpayer
make the (late) premium payment? It may be more
cost-effective to pay the premium than to repay the
APTC. When the premium is paid, ask for a corrected
Form 1095-A.

* If the premium payment has not and will not be made,

enter the SLCSP and APTC and leave Column A blank.

Note: There should never be consecutive months like
this. If so, there is an error on Form 1095-A.

Manth

A,

Sample Form 1095-A: PART Il
LELA] Coverage Information

Nt pramiums | B,

4 loneast Cost sibar
plan [ELCSF) pramium

. Menthly advance paymsnt of
fromim ta crodi

21 Jawsary

25 May

2 _une

2 Fobnory $301 $288 $87
20 b $301 $288 $87
2 st $301 $288 $87

=)= $288 $87

27 duly

= August

29 September

30 October

31 Newarmioer

Even if the taxpayer isn’t eligible for PTC, he or she is still considered to have coverage for the month, despite nonpayment

of premium.
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Premium Tax Credit (continued)

Handling Large APTC Repayments

Many tax preparers are seeing clients with large repayments of APTC that they must repay on Form 8962, Line 29.

Form 8962: Part Il
Part Il Repayment of Excess Advance Payment of the Premium Tax Credit
27 Excess advance payment of PTC. If line 25 is greater than line 24, subtract line 24 from line 25. Enter the difference here 27
28 Repayment limitation (see instructions) . . . . . . . . . . . . . . . . L L. ... 28

29 Excess advance premium tax credit repayment. Enter the smaller of line 27 or line 28 here and on Form 1040, line
46; Form 1040A, line 29; or Form 1040NR, lined44 . . . . . . . . . . . . . . . . . . . 29

To minimize repayment, consider the following strategies:

Make sure Form 1095-A is correct and complete.

¢ Ask the taxpayer to contact the Marketplace if the form doesn’t reflect premiums that were paid or if there are other
errors.
¢ See tips and tricks for complex cases when a taxpayer may be eligible for PTC for a particular month

Consider income adjustments to reduce household income.

e |If the taxpayer is eligible to claim an IRA deduction, remember that taxpayers can contribute to an IRA until the tax
filing deadline.

¢ |If someone on the taxpayer’s return has tuition expenses, consider the Tuition and Fees deduction instead of an
education credit

Consider married filing separately.
e The taxpayer may be ineligible for the PTC, but filing separately may cap repayment at a lower level based on income.

Important! If the taxpayer is currently enrolled in
Marketplace coverage and has a 2016 repayment,
the taxpayer should contact the Marketplace

now to adjust their 2017 APTC to avoid similar
repayments for the 2017 tax year!

Repayment Caps for APTC

Income (as % of federal poverty line)

Taxpayers Filing as SINGLE

Taxpayers Using Other Filing Statuses

Under 200% $300 $600
200% —299% $750 $1,500
300% — 399% $1,275 $2,550

400% and above

No cap (full repayment)

No cap (full repayment)
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Allocation of Policy Amounts

Caution: If this situation applies, the return is out of scope.

Table 3. Allocation of Policy Amounts—Line 9

Follow Steps 1-3 below to determine which allocation rule to use in Part [V—Allocation of Policy Amounts, later, to allocate the policy amounts for each qualified

health plan identified in the instructions to line 9. For each policy, if your answer directs you to Part IV, skip directly to the section of the Part IV instructions identified.
You do not need to complete the remaining steps below.

STEP 1
If

* You divorced or legally separated from a spouse in 2016; and

¢ For one or more months of marriage, the policy covered at least one individual in your tax family AND at least one individual in your former spouse's tax family.

Then allocate using the rules in Allocation Situation 1. Taxpayers divorced or legally separated in 2016 in Part I[V—Allocation of Policy Amounts.
Otherwise, continue to Step 2.

STEP 2
If

e You were married at the end of 2016 but are filing a separate return from your spouse; and
¢ The policy covered at least one individual in your tax family AND at least one individual in your spouse's tax family*...

Then allocate using the rules in Allocation Situation 2. Taxpayers married at year end but filing separate returns in Part IV—Allocation of Policy Amounts.
Otherwise, continue to Step 3.

*Also follow these instructions if you meet the rules in Exception 1—Certain married persons living apart or Exception 2—Victim of domestic abuse or spousal abandonment under
Married taxpayers; earlier, and a policy covered at least one individual in your tax family AND at least one individual.in your spouse's tax family.

STEP 3
If

e No APTC was paid for the policy...
Then allocate using the rules in Allocation Situation 3. No APTC in Part I[V—Allocation of Policy Amounts.

Otherwise, allocate using the rules in Allocation Situation 4. Other situations where a policy is shared between two tax families in Part [V—Allocation of Policy
Amounts.
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Alternative Calculation for Year of
Marriage Eligibility

Table 4. Alternative Calculation for Year of Marriage Eligibility

Answer questions 1-5 below to determine whether you may be eligible to elect the alternative calculation for year of marriage.

1

Were you and your spouse each unmarried on January 1, 2016?
(I Yes. Continue to the next question in this table.

[ No. You are not eligible to elect the alternative calculation. Do not complete Part V. If you did not complete Part IV, check the “No” box on line 9 and
continue to line 10. If you completed Part IV, check the “No” box on line 10, skip line 11, and continue to Lines 12 through 23—Monthly Calculation, later.

Were you married on December 31, 20167
[ Yes. Continue to the next question in this table.

[J No. You are not eligible to elect the alternative calculation. Do not complete Part V. If you did not complete Part IV, check the “No” box on line 9 and
continue to line 10. If you completed Part IV, check the “No” box on line 10, skip line 11, and continue to Lines 12 through 23—Monthly Calculation, later.

Are you filing a joint return with your spouse for 2016?
(I Yes. Continue to the next question in this table.

[ I No. You are not eligible to elect the alternative calculation. Do not complete Part V. If you did not complete Part IV, check the “No” box on line 9 and
continue to line 10. If you completed Part IV, check the “No” box on line 10, skip line 11, and continue to Lines 12 through 23—Monthly Calculation, later.

Was anyone in your tax family enrolled in a qualified health plan before your first full month of marriage? (For example, if you got married on July 15, your first
full month of marriage was August.)
[ Yes. Continue to the next question in this table.

[J No. You are not eligible to elect the alternative calculation. Do not complete Part V. If you did not complete Part IV, check the “No” box on line 9 and
continue to line 10. If you completed Part IV, check the “No” box on line 10, skip line 11, and continue to Lines 12 through 23—Monthly Calculation, later.

Was APTC paid for anyone in your tax family during 2016?

(I Yes. You are eligible to elect the alternative calculation for year of marriage if excess APTC was paid during 2016.

¢ [f you entered 400 or less on Form 8962, line 5, continue to Worksheet 3 next to determine whether excess APTC was paid during 2016.

¢ |f you entered 401 on Form 8962, line 5, excess APTC was paid, and you are eligible for the alternative calculation. Do not complete Worksheet 3. Instead,
see Alternative Calculation for Year of Marriage in Pub. 974 to determine if electing the alternative calculation reduces your repayment amount.

[ No. You are not eligible to elect the alternative calculation. Do not complete Part V. If you did not complete Part IV, check the “No” box on line 9 and
continue to line 10. If you completed Part IV, check the “No” box on line 10, skip line 11, and continue to Lines 12 through 23—Monthly Calculation, later.

Caution: Taxpayers may choose to file MFJ or MFS without the alternative calculation, which
remains in scope. If the taxpayer is eligible for and elects this alternative calculation, the return is
out of scope.
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Table 2. Applicable Figure

If the amount on line 5 is less than 133, your applicable figure is 0.0203. If the amount on line 5 is between 300 through
400, your applicable figure is 0.0966.
; ENTER on ENTER on IF Form ENTER on ENTER on
IF Form 8962,line 5 £ gog2, ||IFFOm8962, ko rigoeo, || 8962,line5 Formaoez, ||IFOM8962, o a0eo,
S.. line7... g3 18 e line7... is... line7... line 518 s line7...
less than 133 0.0203 175 0.0524 218 0.0705 261 0.0851
133 0.0305 176 0.0529 219 0.0708 262 0.0854
134 0.0311 177 0.0533 220 0.0712 263 0.0856
135 0.0317 178 0.0538 221 0.0715 264 0.0859
136 0.0323 179 0.0543 222 0.0719 265 0.0862
137 0.0329 180 0.0547 223 0.0722 266 0.0865
138 0.0335 181 0.0552 224 0.0726 267 0.0868
139 0.0341 182 0.0557 225 0.0730 268 0.0871
140 0.0347 183 0.0561 226 0.0733 269 0.0874
141 0.0353 184 0.0566 227 0.0737 270 0.0877
142 0.0359 185 0.0571 228 0.0740 271 0.0880
143 0.0365 186 0.0575 229 0.0744 272 0.0883
144 0.0371 187 0.0580 230 0.0747 273 0.0886
145 0.0377 188 0.0585 231 0.0751 274 0.0889
146 0.0383 189 0.0590 232 0.0754 275 0.0892
147 0.0389 190 0.0594 233 0.0758 276 0.0895
148 0.0395 191 0.0599 234 0.0761 277 0.0898
149 0.0401 192 0.0604 235 0.0765 278 0.0901
150 0.0407 193 0.0608 236 0.0768 279 0.0904
151 0.0412 194 0.0613 237 0.0772 280 0.0907
152 0.0416 195 0.0618 238 0.0776 281 0.0910
153 0.0421 196 0.0622 239 0.0779 282 0.0913
154 0.0426 197 0.0627 240 0.0783 283 0.0916
155 0.0430 198 0.0632 241 0.0786 284 0.0919
156 0.0435 199 0.0636 242 0.0790 285 0.0922
157 0.0440 200 0.0641 243 0.0793 286 0.0925
158 0.0444 201 0.0645 244 0.0797 287 0.0928
159 0.0449 202 0.0648 245 0.0800 288 0.0930
160 0.0454 203 0.0652 246 0.0804 289 0.0933
161 0.0458 204 0.0655 247 0.0807 290 0.0936
162 0.0463 205 0.0659 248 0.0811 291 0.0939
163 0.0468 206 0.0662 249 0.0814 292 0.0942
164 0.0473 207 0.0666 250 0.0818 293 0.0945
165 0.0477 208 0.0669 251 0.0821 294 0.0948
166 0.0482 209 0.0673 252 0.0824 295 0.0951
167 0.0487 210 0.0676 253 0.0827 296 0.0954
168 0.0491 211 0.0680 254 0.0830 297 0.0957
169 0.0496 212 0.0683 255 0.0833 298 0.0960
170 0.0501 213 0.0687 256 0.0836 299 0.0963
171 0.0505 214 0.0691 257 0.0839 300 thru 400 0.0966
172 0.0510 215 0.0694 258 0.0842
173 0.0515 216 0.0698 259 0.0845
174 0.0519 217 0.0701 260 0.0848

12/2016
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Chart A — For Most People Who Must File

If you CAN be claimed as a dependent by another taxpayer, you must file as a dependent whether you are being

claimed or not. See Chart B for filing requirements.

THEN file a return
if your gross
AND at the end of 2016 you income was at
If your filing status is... were...* least...**
Single under 65 $10,350
65 or older $11,900
Married filing jointly™** under 65 (both spouses) $20,700
65 or older (one spouse) $21,950
65 or older (both spouses) $23,200
Married filing separately
(see the instructions for line 3) any age $ 4,050
Head of household
(see the instructions for line 4) under 65 $13,350
65 or older $14,900
Qualifying wid_ow(er) with under 65 $16,650
dependent child
(see the instructions for line 5) 65 or older $17,900

*%k

If you were born on January 1, 1952 you are considered to be age 65 at the end of 2016. (If your spouse died in
2016 or if you are preparing a return for someone who died in 2016, see Pub. 501)
Gross income means all income you received in the form of money, goods, property, and services that isn’t

exempt from tax, including any income from sources outside the United States or from the sale of your main

home (even if you can exclude part or all of it).

e Do notinclude any social security benefits unless
(a) you are married filing a separate return and you lived with your spouse at any time in 2016 or
(b) one-half of your social security benefits plus your other gross income and any tax-exempt interest is
more than $25,000 ($32,000 if married filing jointly).
If (a) or (b) applies, see the instructions for lines 20a and 20b to figure the taxable part of social security
benefits you must include in gross income.

e Gross income includes gains, but not losses, reported on Form 8949 or Schedule D.

e  Gross income from a business means, for example, the amount on Schedule C, line 7, or Schedule F, line 9.
But, in figuring gross income, do not reduce your income by any losses, including any loss on Schedule C,

line 7, or Schedule F, line 9.

*kk

was at least $4,050, you must file a return regardless of your age.

If you did not live with your spouse at the end of 2016 (or on the date your spouse died) and your gross income

Individuals who do not have a filing requirement based on this chart should also check Chart C, Other Situations
When You Must File, and Chart D, Who Should File. Individuals with earned income but who do not have a filing
requirement may be eligible for the Earned Income Credit.

/
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Chart B — For Children and Other Dependents

If your parent (or someone else) can claim you as a dependent, use this chart to see if you must
file a return.

In this chart, unearned income includes taxable interest, ordinary dividends, and capital gain

distributions. It also includes unemployment compensation, taxable social security benefits, pensions, annuities,
and distributions of unearned income from a trust. Earned income includes salaries, wages, tips, professional
fees, and taxable scholarship and fellowship grants. Gross income is the total of your unearned and earned
income.

Single Dependents

Either 65 or over or blind You must file a return if any of the following apply.
1. Your unearned income was over $2,600 ($4,150 if 65 or older and blind).
2. Your earned income was over $7,850 ($9,400 if 65 or older and blind).
3. Your gross income was more than the larger of —

a. $2,600 ($4,150 if 65 or older and blind) or

b. Your earned income (up to $5,950) plus $1,900 ($3,450 if 65 or older

and blind).
Under 65 and not You must file a return if any of the following apply.
blind 1. Your unearned income was over $1,050.

2. Your earned income was over $6,300.

3. Your gross income was more than the larger of —
a. $1,050, or
b. Your earned income (up to $5,950) plus $350.

Married Dependents
Either age 65 or older or You must file a return if any of the following apply.

blind 1. Your unearned income was over $2,300 ($3,550 if 65 or older and blind).
2. Your earned income was over $7,550 ($8,800 if 65 or older and blind).
3. Your gross income was at least $5 and your spouse files a separate return
and itemizes deductions.
4. Your gross income was more than the larger of —

a. $2,300 ($3,550 if 65 or older and blind), or
b. Your earned income (up to $5,950) plus $1,600 ($2,850 if 65 or older
and blind).

Under age 65 and not blind You must file a return if any of the following apply.

1. Your unearned income was over $1,050.

2. Your earned income was over $6,300.

3. Your gross income was at least $5 and your spouse files a separate return
and itemizes deductions.

4. Your gross income was more than the larger of —

a. $1,050, or
b. Your earned income (up to $5,950) plus $350.

Tax for Certain Children who have Unearned Income (Kiddie Tax)

For children under age 18 and certain older children, unearned income over $2,100 is taxed at the parent’s
rate if the parent’s rate is higher than the child’s. For this purpose, “unearned income” includes all taxable
income other than earned income, such as taxable interest, ordinary dividends, capital gains, rents, royalties,
etc. It also includes taxable social security benefits, pension and annuity income, taxable scholarship and
fellowship grants not reported on Form W-2, unemployment compensation, alimony, and income received as
the beneficiary of a trust. If the child’s unearned income is more than $2,100, and the child is required to file a
tax return, Form 8615 must be used to figure the child’s tax. Form 8615 is out of scope.

. J
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Chart C - Other Situations When You Must
File

You must file a return if any of the conditions below apply for 2016.

1. You owe any special taxes, including any of the following.
a. Alternative minimum tax.
itself.
Schedule H by itself.

d. Social security and Medicare tax on tips you did not report to your employer or on wages you
received from an employer who did not withhold these taxes.

e. Recapture of first-time homebuyer credit. See the instructions for line 60b.

the instructions for line 62.
g. Recapture taxes. See the instructions for line 44 and line 62.

You had net earnings from self-employment of at least $400.

from employer social security and Medicare taxes.

1095-A showing the amount of the advance payments.

b. Additional tax on a qualified plan, including an individual retirement arrangement (IRA), or other tax-
favored account. But if you are filing a return only because you owe this tax, you can file Form 5329 by

c. Household employment taxes. But if you are filing a return only because you owe this tax, you can file

f.  Write-in taxes, including uncollected social security and Medicare or RRTA tax on tips you reported to
your employer or on group-term life insurance and additional taxes on health savings accounts. See

2. You (or your spouse, if filing jointly) received HSA, Archer MSA or Medicare Advantage MSA distributions.

. Advance payments of the premium tax credit were made for you, your spouse, or a dependent who en-
rolled in coverage through the Marketplace. You or whoever enrolled you should have received Form(s)

. You had wages of $108.28 or more from a church or qualified church-controlled organization that is exempt

Chart D — Who Should File

/
~

You had income tax withheld from your pay.

applied to this year’s taxes.

o s ow

mation.

mum Tax — Individuals, Estates, and Trusts. (Out of scope)

You qualify for a refundable American Opportunity Credit.

You receive a 1099-B and the gross proceeds plus other income exceeds the filing limits in Chart A.
You receive Form 1099-S, Proceeds From Real Estate Transactions.

You qualify for the federal tax on fuels (out of scope).

You are required to file a state return.

o0 2 © o N o

- O

K . You qualify for the Premium Tax Credit.

You made estimated tax payments for the year or had any of your overpayment for last year’s estimated tax
You qualify for the earned income credit. See Publication 596, Earned Income Credit (EIC), for more infor-

You qualify for the additional child tax credit. See Form 1040 Instructions for more information on this credit.
You qualify for the refundable credit for prior year minimum tax. See Form 8801, Credit for Prior Year Mini-

12/2016
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" Determination of Filing Status — Decision Tree )

Start Here
Were you married on the last YES
day of the year?’
\ NO Did you and your spouse
Did your spouse die during YES R MARRIED FILING JOINTLY NO live apart all of the Iait 6
the year? > OR MARRIED FILING < months of the year?>
SEPARATELY”
vy NO
Do all the following apply? * YES
* Your spouse died in 2014 or 2015 and v
you did not remarry before the end of YES NO
2016. Do all of the following apply?
¢ In the year of death, you were entitled to 4 * You file a separate return from
file a joint return with your spouse. your spouse.
¢ You paid more than 1/2 the cost of QUALIFYING WIDOW(ER) ¢ You paid more than 1/2 the
keeping up your home for the year.? cost of keeping up your home
* Your dependent child or stepchild lived for the year.?
in your home all year. (A foster child or e Your home is the main home
grandchild does not meet this test.)® for your child, stepchild or
* NO foster child for more than 1/2
the year.® A grandchild does
Do both of the following apply? NO= SINGLE not meet this test.
* You paid more than 1/2 the cost * You claim an exemption for the
of keeping up your home for the child.
year.?
* A “qualifying person,” as defined
on page B-3, lived with you in your
home for more than 1/2 the year.® YES

YES HEAD OF HOUSEHOLD &

A

\

Footnotes:

1. Answer “NO” to this question if, on the last day of the year, you were legally separated from your spouse under
a divorce or separate maintenance decree. Answer “NO” for individuals who have entered into a registered
domestic partnership, civil union, or other similar relationship that is not called a marriage under state (or foreign)
law. Answer YES if taxpayer is married regardless of where the spouse lives.

2. Include in the cost of upkeep expenses such as rent, mortgage interest, real estate taxes, insurance on the home,
repairs, utilities and food eaten in the home. See “Cost of Keeping Up a Home” worksheet on page B-4.

e Payments received under TANF or other public assistance programs used to pay the costs of keeping up the
home cannot be counted as money you paid. These payments must be included in the total cost of keeping
up the home to figure if you paid over 1/2 the cost.

e Amounts paid out of funds received from SSA in the child’s or qualifying person’s name, or funds received as
governmental assistance are considered to be paid by others, not by you.

3. See Publication 17, Filing Status, for rules applying to birth, death, or temporary absence during the year. There
are special rules for claiming your parent as a qualifying person for head of household. See Page B-3.

4. Unless the child’s other parent claims him or her under rules for children of divorced or separated parents or
parents who lived apart.

5. You are considered unmarried for head of household purposes if your spouse was a nonresident alien at any
time during the year and you do not choose to treat your nonresident spouse as a resident alien. However, your
spouse is not a qualifying person for head of household purposes. You must have another qualifying person (use
the table on page B-3) and meet the other tests to be eligible to file as a head of household.

6. Your spouse is considered to live in your home even if he or she is temporarily absent due to iliness, education,
business, vacation or military service.

7. If the taxpayer wants to file MFS, emphasize the advantages to Married Filing Jointly and the possibility of filing
Form 8379, Injured Spouse Claim & Allocation (if appropriate). See Pub 17, Filing Status, MFS Special Rules for
list of disadvantages. Respect a taxpayer’s decision to file MFS. If domiciled in a community property state see
Pub 555.

8. Generally, only one taxpayer in a home can claim Head of Household filing status. Just because each person has
their own children living in a home does not mean they have a separate “household” for this filing status purpose.

Qote: If one spouse dies and the other remarries in the same year, the deceased spouse files Married Filing Separately. /
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int?irF;/;ew Probe/Action: Ask the taxpayer:

step Were you married on December 31 of the tax year? (Answer yes if state If YES, go to Step 2.

o common law rules were met; or if your spouse died during the year and you If NO, go to Step 4.
didn’t remarry by the end of the year; answer no for individuals who have
entered into a registered domestic partnership, civil union, or other similar
relationship that isn’t called a marriage under state (or foreign) law.)

step Do you and your spouse wish to file a joint return? If YES, STOP.

9 Your filing status

is married filing

jointly.

If NO, go to Step 3.2
step Do all the following apply? If YES, STOP. You
9 * You file a separate return from your spouse are considered

* You paid more than half the cost of keeping up your home for the year! unmarried and your
* Your spouse didn’t live in your home during the last 6 months of the filing status is head
tax year ® of household.
¢ Your home was the main home of your child, stepchild, or foster child for more If NO. STOP
than half the year (a grandchild doesn’t meet this test) Your 1:iling status
* You claim an exemption for the child (unless the noncustodial parent claims the is married filing
child under rules for divorced or separated parents or parents who live apart) separatelys.
SR Did your spouse die in 2014 or 2015? If YES, go to Step 5.
0 If NO, go to Step 6.
step Do all the following apply? If YES, STOP.
6 * You were entitled to file a joint return with your spouse for the year your Your filing status is
spouse died qualifying widow(er)
¢ You didn’t remarry before the end of this tax year with dependent
¢ You have a child or stepchild for whom you can claim an exemption and child.
who lived with you all year, except for temporary absences. Don’t include a If NO, go to Step 6
grandchild or foster child. ’ '
* You paid more than half the cost of keeping up the home for the year!
step Do all the following apply? If YES, STOP. Your
6 * You paid more than half the cost of keeping up the home for the year’ filing status is head
* A “qualifying person,” as defined on page B-3, lived with you in your home for  of household.*
more than 1/2 the year* If NO. STOP. Your
filing status is single.
Footnotes

' Include in the cost of upkeep expenses such as rent, mortgage interest, real estate taxes, insurance on the home, repairs, utilities and food eaten
in the home. See “Cost of Keeping Up a Home” worksheet on page B-4
*Payments received under TANF or other public assistance programs used to pay the cost of keeping up the home can’t be counted as money
you paid. These payments must be included in the total cost of keeping up the home to figure if you paid over 1/2 the cost.
*Amounts paid out of funds received from SSA in the child’s or qualifying person’s name or funds received as government assistance are
considered to be paid by others, not by you.
2 You are considered unmarried for head of household purposes if your spouse was a nonresident alien at any time during the year and you don't
choose to treat your nonresident spouse as a resident alien. However, your spouse isn’t a qualifying person for head of household purposes. You
must have another qualifying person (use the table on page B-3) and meet the other tests to be eligible to file as a head of household.
Your spouse is considered to live in your home even if he or she is temporarily absent due to illness, education, business, vacation or military
service.
You can’t use head of household filing status based on any person who is your dependent only because he or she lived with you for the entire
year (for example, a companion or a friend).
5 If filing a MFS return in a Community Property state, allocate income and expense according to state law. May be treated as out of scope.

©
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Who Is a Qualifying Person Qualifying
You To File as Head of Household?'

DON'’T use this chart alone. Use as directed by the interview tips on B-2.

~

IF the person is your . ..

AND ..

THEN that personiis ...

qualifying child (such

as a son, daughter, or
grandchild who lived with
you more than half the
year and meets certain
other tests)?

he or she is single

a qualifying person, whether
or not you can claim an
exemption for the person.

he or she is married and you can claim an
exemption for him or her

a qualifying person.

he or she is married and you can’t claim an
exemption for him or her

not a qualifying person.®

qualifying relative* who is
your father or mother

you can claim an exemption for him or her®

a qualifying person.®

you can’t claim an exemption for him or her

not a qualifying person.

qualifying relative* other
than your father or
mother.

he or she lived with you more than half

the year, and you can claim an exemption
for him or her, and is one of the following:
son, daughter, stepchild, foster child,

or a descendant of any of them; your
brother, sister, half-brother, half-sister

or a son or daughter of any of them; an
ancestor or sibling of your father or mother;
or stepbrother, stepsister, stepfather,
stepmother, son-in-law, daughter-in-law,
father-in-law, mother-in-law, brother-in-law or
sister-in-law®

a qualifying person.

he or she didn’t live with you more than half
the year

not a qualifying person.

he or she isn’t related to you in one of the
ways listed above and is your qualifying
relative only because he or she lived with you
all year as a member of your household (for
example, a companion or a friend)

not a qualifying person.

you can’t claim an exemption for him or her

not a qualifying person.

the elderly.

\

T A person can’t qualify more than one taxpayer to use the head of household filing status for the year.

2 The term “qualifying child” is covered in the Exemptions/Dependency tab. Note: If you are a noncustodial parent,
the term “qualifying child” for head of household filing status doesn’t include a child who is your qualifying child for
exemption purposes only because of the rules described under Children of divorced or separated parents. If you
are the custodial parent and those rules apply, the child generally is your qualifying child for head of household
filing status even though the child isn’t a qualifying child for whom you can claim an exemption.

8 This person is a qualifying person if the only reason you can’t claim the exemption is that you can be claimed as a
dependent on someone else’s return.

*The term “qualifying relative” is covered in the Exemptions/Dependency tab.
5 If you can claim an exemption for a person only because of a multiple support agreement, that person isn’t a
qualifying person. See Multiple Support Agreement, in Pub 17.
5You are eligible to file as head of household even if your parent, whom you can claim as a dependent, doesn't live
with you. You must pay more than half the cost of keeping up a home that was the main home for the entire year for
your parent. This test is met if you pay more than half the cost of keeping your parent in a rest home or home for




Cost of Keeping Up a Home
Keep for Your Records
Amount
You Total
Paid Cost
Property Taxes $ $
Mortgage interest expenses $ $
Rent $ $
Utility charges $ $
Property insurance $ $
Food consumed
on the premises $ $
Other household expenses $ $
Totals $ $
Minus total amount you paid ( )
Amount others paid $

If the total amount you paid is more than the amount
others paid, you meet the requirement of paying more
than half the cost of keeping up the home

Note:

Costs you include. Include in the cost of keeping up a home
expenses such as rent, mortgage interest, real estate taxes,
insurance on the home, repairs, utilities, and food eaten in the home.

If you used payments you received under Temporary Assistance for
Needy Families (TANF) or other public assistance programs to pay
part of the cost of keeping up your home, you can’t count them as
money you paid. However, you must include them in the total cost of
keeping up your home to figure if you paid over half the cost.

Costs you don’t include. Don'’t include the cost of clothing,
education, medical treatment, vacations, life insurance, or
transportation. Also, don’t include the rental value of a home you own
or the value of your services or those of a member of your household.




/ Exemptions A

e  Exemptions reduce the taxpayer’s taxable income
e Exemption Amount: $4,050
* Two types:

1. Personal exemptions—one exemption for the taxpayer and, if married, one for his or
her spouse; unless either can be claimed as a dependent by another person.

2. Exemptions for dependents—one exemption for each qualifying child or qualifying
relative.

*  Apply the rules for exemptions for dependents using the worksheets in the Form 1040
instructions and the interview tips in this publication.

*  Taxpayers who can be claimed as a dependent on someone else’s return can’t claim any
exemptions for themselves or their own qualifying child or qualifying relative. This is true
even if the other person doesn’t claim the dependent’s exemption.

\_ /

Definitions:
Student: To qualify as a student, your child must be, during some part of each of any 5 calendar months of the year:

1. A full-time student at a school that has a regular teaching staff, course of study, and a regularly enrolled student
body at the school, or

2. A student taking a full-time, on-farm training course given by a school described in (1), or by a state, county, or
local government agency.

The 5 calendar months don’t have to be consecutive.
An on-the-job training course, correspondence school, or school offering courses only through the Internet doesn’t
count as a school for dependency exemption purposes.

Permanently and Totally Disabled: Your child is permanently and totally disabled if both of the following apply.

1. He or she can’t engage in any substantial gainful activity because of a physical or mental condition.
2. A doctor determines the condition has lasted or can be expected to last continually for at least a year or can lead
to death.

Custodial and Noncustodial Parent: The custodial parent is the parent with whom the child lived the greater number of
nights during the year. The other parent is the noncustodial parent. If the child lived with each parent for an equal number

of nights during the year, the custodial parent is the parent with the higher adjusted gross income.

Foster Child: A foster child is an individual who is placed with you by an authorized placement agency or by judgement,
decree, or other order of any court of competent jurisdiction.

C-1
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Personal Exemptions

December 31 of the tax year?

12/

int?iglsiew Probe/Action: Ask the taxpayer:
step Were you married during any part of the If YES, go to Step 2.
o tax year? (Answer YES if state common If NO, go to Step 7.
law rules were met.)
step Were you still married on If YES, go to Step 5.

If NO, go to Step 3. Note: Abandonment doesn’t
change marital status—answer YES if the taxpayer’s
responses to Steps 3 and 4 are NO.

Did you obtain a final decree of divorce or
separate maintenance by December 31 of
the tax year?

step

3/

If YES, you can’t claim a personal exemption for your
former spouse. Go to Step 7 to determine if you can
claim your own personal exemption.

If NO, go to Step 4.

alien spouse) have any gross income or
can anyone else claim your spouse as a
dependent??

6/

step  Did your spouse die during the tax If YES, go to Step 5.

0 year?’ If NO, go back through Steps 1-3 and clarify answers.
step  Are you filing a joint tax return? If YES, go to Step 7.

6 If NO, go to Step 6.

step  Did your spouse (including a nonresident  If YES to either, you can’t claim a personal exemption

for your spouse. Go to Step 7 to see about your own
personal exemption.

If NO to both, you can claim a personal exemption
for your spouse. Go to Step 7 to see about your own
personal exemption.

Can anyone claim you (or your spouse if
filing jointly) as a dependent on his or her
return? 3

step

N

If YES, you can’t claim a personal exemption for
yourself or your spouse.

If NO, you can claim a personal exemption for
yourself (and your spouse, if filing jointly).

/

" If his or her spouse died during the year, the taxpayer can
claim the spouse’s exemption if the taxpayer didn’t remarry
during the year. See Publication 17 for other considerations.

2 |f married filing separately, the taxpayer can take his or her
own exemption if no other taxpayer is entitled to claim him or her
as a dependent.

If married filing separately, the taxpayer can claim his or her
spouse’s exemption if the spouse had no gross income, isn’t

filing a return, and can’t be claimed as a dependent on another
person’s return.

You can claim an exemption for your nonresident alien spouse on
your separate return, provided your spouse has no gross income
for U.S. tax purposes, has a SSN or ITIN, and isn’t the dependent
of another U.S. taxpayer.

3 If married filing jointly (other than to claim a refund of income tax
withheld or estimated tax paid), the taxpayer can’t be a dependent
on another person’s return.



/ Overview of the Rules for Claiming an
Exemption for a Dependent

Caution: This table is only an overview of the rules. For details, see Publication 17.

* You can’t claim any dependents if you, or your spouse if filing jointly, could be claimed as a dependent by another
taxpayer.

* You can’t claim a married person who files a joint return as a dependent unless that joint return is only to claim a
refund of income tax withheld or estimated tax paid.

* You can’t claim a person as a dependent unless that person is a U.S. citizen, U.S. resident alien, U.S. national, or a
resident of Canada or Mexico."

* You can’t claim a person as a dependent unless that person is your qualifying child or qualifying relative.

Tests To Be a Qualifying Child Tests To Be a Qualifying Relative
1. The child must be your son, daughter, stepchild, 1. The person can’t be your qualifying child or the
foster child, brother, sister, half brother, half sister, qualifying child of any other taxpayer. A child isn’t
stepbrother, stepsister, or a descendant of any of them. the qualifying child of any other taxpayer if the child’s

parent (or any other person for whom the child is
defined as a qualifying child) isn’t required to file an
income tax return or files an income tax return only to
get a refund of income tax withheld.

2. The child must be: (a) under age 19 at the end of the 2. The person either (a) must be related to you in one

year and younger than you (or your spouse, if filing of the ways listed under Relatives who don’t have to
jointly), (b) under age 24 at the end of the year, a full- live with you (see Table 2, step 2), or (b) must live with
time student, and younger than you (or your spouse, if you all year as a member of your household? (and
filing jointly), or (c) any age if permanently and totally your relationship must not violate local law).
disabled.

3. The child must have lived with you for more than half of | 3. The person’s gross income for the year must be less
the year.? than $4,050.% Gross income means all income the

person received in the form of money, goods, property
and services, that isn’t exempt from tax. Don’t include
social security benefits unless the person is married
filing a separate return and lived with their spouse

at any time during the tax year or if 1/2 the social
security benefits plus their other gross income and
tax exempt interest is more than $25,000 ($32,000 if

MFJ).
4. The child must not have provided more than half of his | 4. You must provide more than half of the person’s total
or her own support for the year.® support for the year.®

5. The child isn’t filing a joint return for the year (unless
that joint return is filed only to claim a refund of income
tax withheld or estimated tax paid).

6. If the child meets the rules to be a qualifying child
of more than one person, you must be the person
entitled to claim the child as a qualifying child. See the
“Qualifying Child of More Than One Person” chart.

"There is an exception for certain adopted children.

2There are exceptions for temporary absences, children who were born or died during the year, children of divorced or
separated parents or parents who live apart, and kidnapped children.

SThere is an exception if the person is disabled and has income from a sheltered workshop.

“There are exceptions for multiple support agreements, children of divorced or separated parents or parents who live apart,
and kidnapped children.

5A worksheet for determining support is provided on page C-9. If a person receives social security benefits and uses them
toward his or her own support, those benefits are considered as provided by the person. Benefits provided by the state to a
needy person (welfare, food stamps, housing, SSI) are generally considered support provided by the state.

/




/ Qualifying Child of More Than One Person

If the child meets the conditions to be the qualifying child of more than one person, only one person can claim the child
as a qualifying child for all of the following tax benefits, unless the special rule for children of divorced or separated
parents applies.

e Dependency Exemption e Child Tax Credit
e Head of Household e Earned Income Credit
e Credit for Child and Dependent Care Expenses e Exclusion from income for Dependent Care Benefits

No other person can take any of the six tax benefits listed above unless he or she has a different qualifying
child. If you and any person can claim the child as a qualifying child, the following tiebreaker rules apply. See
the example below if no parent claims the child.

If only one of the persons is the child’s parent, the child is treated as the qualifying child of the parent.

If the parents file a joint return together and can claim the child as a qualifying child, the child is treated as the
qualifying child of the parents.

If the parents don’t file a joint return together but both parents claim the child as a qualifying child, the IRS will treat the
child as the qualifying child of the parent with whom the child lived for the longer period of time during the year. If the
child lived with each parent for the same amount of time, the IRS will treat the child as the qualifying child of the parent
who had the higher adjusted gross income (AGlI) for the year.

If no parent can claim the child as a qualifying child, the child is treated as the qualifying child of the person who had
the highest AGI for the year.

If a parent can claim the child as a qualifying child but no parent claims the child, the child is treated as the qualifying
child of the person who had the highest AGI for the year, but only if that person’s AGl is higher than the highest AGI of
any of the child’s parents who can claim the child. If the child’s parents file a joint return with each other, this rule can
be applied by dividing the parents’ combined AGI equally between the parents.

Example: Your daughter meets the conditions to be a qualifying child for both you and your mother. Under the
rules above, you are entitled to treat your daughter as a qualifying child for all of the six tax benefits listed above for
which you otherwise qualify. Your mother isn’t entitled to take any of the six tax benefits listed above unless she has
a different qualifying child. However, if your mother’s AGl is higher than yours, you can let your mother treat your
daughter as her qualifying child. If you do that, your daughter isn’t your qualifying child for any of the six benefits.

For more details and examples, see Pub. 17 and 501.

N J
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Table 1: Dependency Exemption

~

3/

year? (Answer “NO” if the person is filing a
joint return only to claim a refund of income tax
withheld or estimated tax paid.)

interview Begin with this table for both Qualifying Child and Qualifying Relative dependents.
tips Probe/Action: Ask the taxpayer:
step Can you or your spouse (if filing jointly) be If YES: If you can be claimed as a dependent by
o claimed as a dependent on someone else’s tax | another person, you may not claim anyone else as your
return this year? dependent.
If NO: Go to Step 2
step Was the person married as of December 31, If YES: Go to Step 3
@) 2016 If NO: Go to Step 4
step Is the person filing a joint return for this tax If YES: You can’t claim this person as a dependent.

If NO: Go to Step 4

step

4/

Was the person a U.S. citizen, U.S. resident alien,
U.S. national, or a resident of Canada or Mexico?
(Answer “YES” if you are a U.S. citizen or U.S.
national and you adopted a child who lived
with you as a member of your household all year.)

If YES: Go to Step 5
If NO: You can’t claim this person as a dependent.

step

15/

Was the person your son, daughter, stepchild,
eligible foster child, brother, sister, half
brother, half sister, stepbrother, stepsister,

or a descendant of any of them (i.e., your
grandchild, niece, or nephew)?

If YES: Go to Step 6
If NO: This person isn’'t your qualifying child. Go to Table
2: Dependency Exemption for Qualifying Relative

step

6/

Was the person:

-under age 19 at the end of the year and
younger than you (or your spouse, if filing
jointly) OR

-under age 24 at the end of the year, a full-
time student (see definition on page C-1) and
younger than you (or your spouse, if filing
jointly) OR

-any age if permanently and totally disabled' at
any time during the year?

If YES: Go to Step 7
If NO: This person isn’'t your qualifying child. Go to Table
2: Dependency Exemption for Qualifying Relative

step

7

Did the person live with you as a member
of your household, except for temporary
absences?, for more than half the year?
(Answer “YES” if the child was born or died

If YES: Go to Step 8 (Use Table 3 to see if the exemption
for children of divorced or separated parents or parents
who live apart applies.)

If NO: This person isn’'t your qualifying child. Go to Table

during the year.) 2: Dependency Exemption for Qualifying Relative
step Did the person provide more than half of his or | If YES: You can’t claim this person as a dependent
0 her own support® for the year? If NO: Go to Step 9
step Is the person a qualifying child of any other If YES: Go to the chart: Qualifying Child of More Than
9 person? One Person
K If NO: You can claim this person as a dependent /
Footnotes:

" A person is permanently and totally disabled if he or she can’t engage
in any substantial gainful activity because of a physical or mental
condition, AND a doctor determines the condition has lasted or can be
expected to last continuously for at least a year or can lead to death.

2 A child is considered to have lived with you during periods of time
when one of you, or both, are temporarily absent due to special
circumstances such as illness, education, business, vacation, military
service or detention in a juvenile facility. In most cases a child of
divorced or separated parents is the qualifying child of the custodial
parent. See Table 3: Children of Divorced or Separated Parents

or Parents Who Live Apart to see if an exception applies. There is
an exception for kidnapped children. See Publication 17, Personal
Exemptions and Dependents

3 A worksheet for determining support is included later in this section.
If a child receives social security benefits and uses them toward his
or her own support, those benefits are considered as provided by the
child. Benefits provided by the state to a needy person (welfare, food
stamps, housing, SSI) are generally considered support provided by
the state.
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Table 2: Dependency Exemption for
Qualifying Relative

interview  yoy must start with Table 1. (To claim a qualifying relative dependent, you must first meet the

~

qualifying child of any other taxpayer? A child
isn’t the qualifying child of any other taxpayer
if the child’s parent (or any other person for
whom the child is defined as a qualifying child)
isn’t required to file a U.S. income tax return or
files an income tax return only to get a refund
of income tax withheld.

1

tips Dependent Taxpayer, Joint Return and Citizen or Resident Tests in steps 1-4 of Table 1)
Probe/Action: Ask the taxpayer:
step s the person your qualifying child or the If YES, the person isn’t a qualifying relative. (See

Qualifying Child Interview Tips.)
If NO, go to Step 2.

step Was the person your son, daughter, stepchild,
foster child, or a descendant of any of them
(i.e., your grandchild)? OR

Was the person your brother, sister, half-
brother, half-sister, or a son or daughter of any
of them? OR

Was the person your father, mother, or an
ancestor or sibling of either of them? OR

Was the person your stepbrother, stepsister,
stepfather, stepmother, son-in-law, daughter-
in-law, father-in-law, mother-in-law, brother-in-
law, or sister-in-law?"

If NO, go to Step 3.

If YES, go to Step 4.

Note: The relatives listed in Step 2 are considered
“Relatives who don’t have to live with you”

step  Was the person any other person (other than
your spouse) who lived with you all year as a

member of your household??

If NO, you can’t claim this person as a dependent.

If YES, go to Step 4.

Note: There are exceptions for kidnapped children; a child
who was born or died during the year; certain temporary
absences—school, vacation, medical care, etc.

total support for the year?*

step Did the person have gross income of less If NO, you can’t claim this person as a dependent.
0 than $4,050 in 201672 If YES, go to Step 5.
step Did you provide more than half the person’s If YES, you can claim this person as your qualifying

relative dependent. (Use Table 3 to see if the exception for
children of divorced or separated parents or parents who
live apart applies.)

If NO, go to Step 6.

N

continued on next page

/

Footnotes:

' Any of these relationships that were established by marriage
aren’t ended by death or divorce.

2 A person doesn’t meet this test if at any time during the year the
relationship between you and that person violates local law.

3For purposes of this test, the gross income of an individual who
is permanently and totally disabled at any time during the year
doesn’t include income for services the individual performs at a
sheltered workshop.

Gross income means all income the person received in the form

of money, goods, property and services, that isn’t exempt from tax.

Don’t include social security benefits unless the person is married
filing a separate return and lived with their spouse at any time

C-6

during the tax year or if 1/2 the social security benefits plus their
other gross income and tax exempt interest is more than $25,000
($32,000 if MFJ).

4 A worksheet for determining support is included at the end of
this section.

See Table 3 for the exception to the support test for children of
divorced or separated parents or parents who live apart.

If a child receives social security benefits and uses them toward
his or her own support, those benefits are considered as provided
by the child. Benefits provided by the state to a needy person
(welfare, food stamps, housing, SSI), or for a foster child are
generally considered support provided by the state.
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Table 2: Dependency Exemption for
Qualifying Relative

~

interview )
tips Continued
Probe/Action: Ask the taxpayer:
step  Did another person provide more than half the If YES, you can’t claim an exemption for this person.
6 person’s total support? If NO, go to Step 7.
step  Did two or more people together provide more If YES, go to Step 8.
9 than half the person’s total support? If NO, you can’t claim this person as a dependent.
step  Did you provide more than 10% of the person’s | If YES, go to Step 9.
0 total support for the year? If NO, you can’t claim this person as a dependent.
step  Did the other person(s) providing more than If YES, you can claim this person as a dependent. You

O

10% of the person’s total support for the year
provide you with a signed statement agreeing
not to claim the exemption?

must file Form 2120 with your return.
If NO, you can’t claim this person as a dependent.
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Table 3: Children of Divorced or Separated )
Parents or Parents Who Live Apart

1

interview
tips (Use this table when directed from Table 1 or Table 2 to determine if the exception applies to the
qualifying child residency test or the qualifying relative support test)
Probe/Action: Ask the taxpayer:
step Did the child receive over half of his or her support from the parents If YES, go to Step 2.

who are:
Divorced OR
Legally separated under a decree of divorce or
separate maintenance OR
Separated under a written separation agreement OR
Lived apart at all times during the last 6 months of the year?

If NO, Table 3 doesn’t apply.

step  Was the child in the custody of one or both parents for more than half If YES, go to Step 3.
9 the year?! If NO, Table 3 doesn’t apply.
step Did the custodial parent (parent with whom the child lived for the greater If YES, the Table 3 exception

number of nights during the year) provide the taxpayer a signed written
declaration (Form 8332, a copy of Form 8332, or similar document)
releasing his or her claim to the exemption for the child?

applies.? Return to the
appropriate step in Table 1 or
Table 2.

If NO, go to Step 4.

step

N

Are either of the following statements true?
The taxpayer has a Post-1984 and Pre-2009 decree® or agreement
that is applicable for the current tax year and states all three of the
following?
1. The noncustodial parent can claim the child as a dependent without
regard to any condition, such as payment of support.
2. The other parent won’t claim the child as a dependent for the year.
3. The years for which the noncustodial parent can claim the child as a
dependent.
OR
The taxpayer has a Pre-1985 decree of divorce or separation
maintenance or written separation agreement between the parents
that provide that the noncustodial parent can claim the child as a
dependent, and the noncustodial parent provides at least $600 for
support of the child during the current tax year?

If YES, the Table 3 exception
applies. Return to the appropriate
step in Table 1 or Table 2.

If NO, Table 3 doesn’t apply.

/

Footnotes:

" If the child is emancipated under state law, either by reaching age of majority or other means, child is treated as not living with either
parent (see Pub 17).

2 Post-2008 decree or agreement. If the divorce decree or separation agreement went into effect after 2008, the noncustodial parent
can’t attach pages from the decree or agreement instead of Form 8332. The custodial parent must sign, and the noncustodial parent
must attach to his or her return, either Form 8332, or a copy of Form 8332 or a substantially similar statement the only purpose of which
is to release the custodial parent’s claim to a child.

3 Post-1984 and Pre-2009 divorce decrees or agreements:

The noncustodial parent must attach all of the following pages from the decree or agreement.

-Cover page (include the other parent’'s SSN on that page)
-The pages that include all the information identified in (1) through (3) above
-Signature page with the other parent’s signature and date of agreement.

Release of exemption revoked
A custodial parent who has revoked his or her previous release of a claim to exemption for a child must attach a copy of the revocation
to his or her return. For the revocation to be effective for current tax year, the custodial parent must have given (or made reasonable
efforts to give) written notice of the revocation to the noncustodial parent in the prior tax year or earlier. (See Form 8332 for more

details)

Other decrees or agreements that don’t meet step 4: Non-custodial parents must attach the Form 8332, or a copy of Form 8332 or
similar statement to their return.

C-8
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12.

13.
14.
15.
16.
17.
18.
19.

20.

21.

22,

23.

24,
25.
26.

Worksheet for Determining Support ﬂ\

Funds Belonging to the Person You Supported
Enter the total funds belonging to the person you supported, including income received (taxable
and nontaxable) and amounts borrowed during the year, plus the amount in savings and other

accounts at the beginningoftheyear . . .. .. ... ... . .. . 1.
Enter the amount on line 1 that was used for the person’s support ... ................... 2.
Enter the amount on line 1 that was used for otherpurposes . .. ......... ... ... ...... 3.
Enter the total amount in the person’s savings and other accounts at the end of the year . ... .. 4,
Add lines 2 through 4. (This amount should equal line 1.) . . . ... ... ... ... . . ... 5.

Expenses for Entire Household (where the person you supported lived)
Lodging (complete line 6a or 6b):

6a. Enterthetotal rentpaid . ... . ... . . . . . 6a.
6b. Enter the fair rental value of the home. If the person you supported owned the home,
also include thisamountinline 21. . . . .. .. .. e 6b.
Enter the total food eXpenses . . ... ... . 7.
Enter the total amount of utilities (heat, light, water, etc. not included in line 6aor6b) ... ... ... 8.
Enter the total amount of repairs (not included inline6aor6b) . ........................ 9.
. Enter the total of other expenses. Don't include expenses of maintaining the home, such as
mortgage interest, real estate taxes, andinsurance. . .......... .. ... .. 10.
. Add lines 6a through 10. These are the total household expenses . ..................... 11.
Enter total number of persons who lived in the household ... ........... ... ... ....... 12.

Expenses for the Person You Supported

Divide line 11 by line 12. This is the person’s share of the household expenses . . .. ......... 13.
Enter the person’s total clothing expenses .. ........ ... . . . . i 14.
Enter the person’s total education expenses . . . . ... ... i e 15.
Enter the person’s total medical and dental expenses not paid for or reimbursed by insurance . . 16.
Enter the person’s total travel and recreationexpenses . . ......... . ... . .. ... 17.
Enter the total of the person’s otherexpenses . . . . . ... ... .. . . i 18.
Add lines 13 through 18. This is the total cost of the person’s support fortheyear ... ........ 19.
Did the Person Provide More Than Half of His or Her Own Support?

Multiply line 19 by 50% (.50) . . . . ot 20.
Enter the amount from line 2, plus the amount from line 6b if the person you supported owned

the home. This is the amount the person provided for his or her own support. . . ............ 21.

Is line 21 more than line 207?

[ No. You meet the support test for this person to be your qualifying child. If this person also meets the other tests to be a
qualifying child, stop here; don't complete lines 23—26. Otherwise, go to line 23 and fill out the rest of the worksheet to
determine if this person is your qualifying relative.

[]Yes. You don't meet the support test for this person to be either your qualifying child or your qualifying relative. Stop
here.

Did You Provide More Than Half?
Enter the amount others provided for the person’s support. Include amounts provided by state,

local, and other welfare societies or agencies. Don't include any amounts included on line 1. . . 23.
Add lines 21 and 23 . . . .. . 24,
Subtract line 24 from line 19. This is the amount you provided for the person’s support. . . .. ... 25,

Is line 25 more than line 207
[ ]Yes. You meet the support test for this person to be your qualifying relative.

[] No. You don't meet the support test for this person to be your qualifying relative. You can't claim an exemption for
this person unless you can do so under a multiple support agreement, the support test for children of divorced or
separated parents, or the special rule for kidnapped children. See Multiple Support Agreement, Support Test for Children
of Divorced or Separated Parents or Parents Who Live Apart, or Kidnapped Child under Qualifying Relative.

/

Note: Taxpayers should keep a completed copy of this worksheet for their records.
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discussed and shown on the return, if required.

This list is a quick reference and volunteers should

Income Quick Reference Guide

this list alone. Some of the income items on this chart are out of scope for VITA/TCE. Refer taxpayers with out
of scope income to a professional tax preparer. Confirm that all income received by the taxpayer has been

~

refer to Publication 17 for more information. Don’t rely on

Table A — Examples of Taxable Income

income test for qualifying relative)

(Examples of income to consider when determining whether a return must be filed or if a person meets the gross

Wages, salaries, bonuses, commissions
Alimony

Annuities

Awards

Back pay

Breach of contract payment

Business income/Self-employment income
Cash income

Compensation for personal services
Debts forgiven'

Director’s fees

Disability benefits (employer-funded)
Discounts

Dividends

Employee awards

Employee bonuses

Estate and trust income

Farm income

Fees

Gains from sale of property or securities
Gambling winnings

Hobby income

Interest

Interest on life insurance dividends

IRA distributions

Jury duty fees

Military pay (not exempt from taxation)

Taxable scholarships and grants
Tips and gratuities
Tribal per capita payments

Military pension

Nonemployee compensation

Notary fees

Partnership, Estate and S-Corporation income
(Schedule K-1s, Taxpayer’s share)

Pensions

Prizes

Punitive damage award

Railroad retirement—Tier | (portion may be taxable)

Railroad retirement—Tier |

Recovery of prior year deduction? (medical,
property taxes, etc.)

Refunds of State and local income tax (if
reportable)?

Rents (gross rent)

Rewards

Royalties

Severance pay

Self-employment (gross income)

Social security benefits - portion may be taxable -
(See Income tab, Railroad Retirement, Civil Service,
and Social Security Benefits)

Supplemental unemployment benefits

Unemployment compensation

Table B — Examples of Nontaxable Income

(Examples of income items to exclude when determining whether a return must be filed)

Aid to Families with Dependent Children (AFDC)
Child support
Civil damages, restitution or other monetary award
paid to someone because that person was wrongfully
incarcerated
Damages for physical injury (other than punitive)
Death payments
Dividends on life insurance
Federal Employees’ Compensation Act payments
Federal income tax refunds
Gifts
Inheritance® or bequest
Insurance proceeds (Accident, Casualty, Health, Life)
Interest on tax-free securities
Interest on EE/l bonds redeemed for qualified

higher education expenses
Meals and lodging for the convenience of employer

Olympic and Paralympic Games medals and prizes*
Payments to the beneficiary of a
deceased employee
Relocation payments
Rebate/Patronage Dividends issued by co-ops for
personal use are not taxable.
Payments in lieu of worker's compensation
Rental allowance of clergyman
Sickness and injury payments
Social security benefits - portion may not be
taxable - (See Income tab, Railroad Retirement, Civil
Service, and Social Security Benefits)
Supplemental Security Income (SSI)
Temporary Assistance for Needy Families (TANF)
Veterans’ benefits
Welfare payments (including TANF) and food stamps
Worker's compensation and similar payments

/

Footnotes: 'If the taxpayer received a Form 1099-C, Cancellation of Debt,

in relation to their main home, it can be nontaxable

2If itemized in year paid and taxes were reduced because of deduction

3An inheritance isn’t reported on the income tax return, but a di
the same tax as the original owner would have had to pay.

“The exclusion does not apply to a taxpayer for any year in which the taxpayer’s AGl exceeds $1 million (or $500,000 for an

individual filing a MFS return). 12/20

stribution from an inherited pension or annuity is subject to

D-1
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Armed Forces Gross Income

Members of the Armed Forces receive many different types of pay and allowances. Some are included in gross income
while others are excluded from gross income. Table 1 lists included items that are subject to tax and must be reported on
your tax return. Table 2 lists excluded items that are not subject to tax, but may have to be shown on your tax return.

Table 1—Included ltems

These items are included in gross income, unless the pay is for service in a combat zone

Basic * Active duty

pay + Attendance at a designated
service school

Back wages

CONUS COLA

Drills

Reserve training

Training Duty

Special - Aviation career incentives
pay + Career sea

Diving duty

Foreign duty

(outside the 48

contiguous states

and the District of
Columbia)

Foreign language proficiency
Hardship duty

Special - Hostile fire or
pay imminent danger
(cont.) * Medical and dental officers
* Nuclear-qualified officers
+ Optometry
» Pharmacy
+ Special compensation for
assistance with activities
of daily living (SCAADL)
« Special duty assignment pay
* Veterinarian
+ Voluntary Separation
Incentive

Bonus + Career status

pay + Enlistment
«» Officer
+ Overseas extension
* Reenlistment

Other * Accrued leave

pay * High deployment per diem
+ Personal money

allowances paid to high

ranking officers

Student loan repayment

from programs such

as the Department of

Defense Educational Loan

Repayment Program when

year’s service (requirement)

isn’t attributable to a

combat zone

Incentive < Submarine
pay + Flight
+ Hazardous duty
+ High altitude/Low altitude
(HALO)

Table 2—Excluded Items

The exclusion for certain items applies whether the item is furnished in kind or is a reimbursement or allowance. There is no
exclusion for the personal use of a government-provided vehicle.

Combat » Compensation for active
zone pay service while in a combat
zone
» Note: Limited amount for
officers

Other pay - Defense counseling
Disability, including
payments received for
injuries incurred as a
direct result of a terrorist
or military action
Group-term life insurance
Professional education
ROTC educational and
subsistence allowances
State bonus pay for
service in a combat zone
Survivor and retirement
protection plan premiums
Uniform allowances
Uniforms furnished to
enlisted personnel

.

Death Burial services
allowances - Death gratuity payments
to eligible survivors
« Travel of dependents to
burial site

+ Certain educational
expenses for dependents
Emergencies

Evacuation to a place of
safety

Separation

Family
allowances

Living * BAH (Basic Allowance for
allowances Housing)

BAS (Basic Allowance for
Subsistence)

Housing and cost-of-living
allowances abroad paid by
the U.S. Government or by
a foreign government
OHA (Overseas Housing
Allowance)

Moving + Dislocation
allowances - Military base
realignment and closure
benefit (the exclusion

is limited as described
above)

Move-in housing

Move household and
personal items

Moving trailers or mobile
homes

Storage

Temporary lodging and
temporary lodging
expenses

Travel
allowances

» Annual round trip for
dependent students
Leave between
consecutive overseas
tours

* Reassignment in a
dependant

restricted status
Transportation for you
or your dependents
during ship overhaul or
inactivation

Per diem

In-kind » Dependent-care
military assistance program
benefits * Legal assistance
Medical/dental care
Commissary/exchange
discounts
Space-available travel
on government aircraft




TaxSlayer® Entries

The following are examples of items to consider in determining entries into TaxSlayer®:

Iltem
CSA 1099-R, Civil Service Annuity Paid

CSF 1099-R, Statement of Survivor Annuity
Paid

K-1, (Form 1065, 1120, 1041) Capital gains or
losses

K-1, (Form 1065, 1120, 1041) Dividend income
K-1, (Form 1065, 1120, 1041) Interest income
K-1, (Form 1065, 1120, 1041) Royalty income
K-1, (Form 1065, 1120, 1041) Tax exempt
income

RRB 1099 Railroad Retirement Benefits (Tier 1)
RRB 1099-R Railroad Retirement Benefits (Tier 2)
SSA-1099 Social Security Benefits

W-2 Wages & Salaries

W-2G Gambling Winnings

1098 Mortgage Interest Statement

1098-E Student Loan Interest

1098-T Tuition Statement

1099-B Proceeds from Broker and Barter Exchange

1099-DIV Dividends

1099-INT, Box 9, Private Activity Bond Interest

1099-G State Tax Refund
1099-G Unemployment Compensation
1099-INT Interest Income

1099-MISC Line 2 Royalties
1099-MISC Line 3 Other Income

16

16

13

9a

8a

17

8b

20

16

20

21

40

33

34/50

45

10

19

17
21

12/2016

1040 Line Navigation to Data Entry Screen

Click line 16b from 1040 View or Income>IRA/Pension
Distributions>Add or Edit a 1099-R

Click line 16b from 1040 View or Income>IRA/Pension
Distributions>Add or Edit a 1099-R

Click Income from Federal Section>Other Income>K-1
Earnings

Click Income from Federal Section>Other Income>K-1
Earnings

Click Income from Federal Section>Other Income>K-1
Earnings

Click Income from Federal Section>Other Income>K-1
Earnings

Click Income from Federal Section>Other Income>K-1
Earnings

Click line 20b from 1040 View or Income>IRA/Pension
Distributions>Social Security Benefits/RRB-1099

Click line 16b from 1040 View or Income>IRA/Pension
Distributions>RRB-1099-R

Click line 20b from 1040 View or Income>IRA/Pension
Distributions>Social Security Benefits/RRB-1099

Click line 7 from 1040 View or click Income from
Federal Section>Wages and Salaries

Click line 21 from 1040 View>Gambling Winnings
or click Income from Federal Section>Other
Income>Gambling Winnings

Click line 40 from 1040 View>Mortgage Interest and
Expenses>Mortgage Interest Reported on Form 1098

Click on line 33 from 1040 View or click Deductions
from Federal Section>Adjustments>Student Loan
Interest Deduction

Click on line 34 or 50 from 1040 View or click
Deductions>Credits Menu>Education Credits

Click line 13 from 1040 View or click Income from
Federal Section>Capital Gain and Losses>Capital Gain
and Loss Iltems

Click line 9a from 1040 View or click Income from
Federal Section>Interest and Dividends>Interest or
Dividend Income

Click Line 45 from 1040 View>Interest from specified
private activity bonds exempt from the regular tax or
click Other Taxes from Federal Section>Alternative
Minimum Taxes>Interest from specified private activity
bonds exempt from the regular tax

Click on line 10 from 1040 View or click Income from
Federal Section>State and Local refunds

Click on line 19 from 1040 View or click Income from
Federal Section>Unemployment Compensation

Click on line 8a from 1040 View or click Income from
Federal Section>Interest and Dividends>Interest or
Dividend Income

See Royalties, later in this section.

Click on line 21 from 1040 View>Other Income Not
Reported Elsewhere or click Income from Federal
Section>Form 1099-MISC

D-3



TaxSlayer® Entries (continued)

Item

1099-MISC Line 7 Non-employee Compensation

1099-R IRA Distributions

1099-R Pension Distributions

1099-R Retirement

Alaska Permanent Fund

Alimony Paid
Alimony Received

Business Income

Capital Gains Distributions

Cash Income for a Business

Cash Income for Other than a Business

Charitable Contributions

Child and Dependent Care Expenses

Child Tax Credit
Credit for the Elderly or Disabled

Dividend Income

Early Withdrawal Penalty

Education Expenses

Estimated Tax Payments for the tax year

D-4

1040 Line
12

15

16

16

21

31a
11

12

13

12

21

40

49

52
54

9a

30

34/50

65

12/2016

Navigation to Data Entry Screen

Click on line 12 from 1040 View or click Income from
Federal Section>Form1099-MISC

Click on line 15 from 1040 View>Add or Edit a 1099-
R or click Income from Federal Section>IRA/Pension
Distributions> Add or Edit a 1099-R

Click on line 16 from 1040 View>Add or Edit a 1099-
R or click Income from Federal Section>IRA/Pension
Distributions> Add or Edit a 1099-R

Click on line 16 from 1040 View>Add or Edit a 1099-
R or click Income from Federal Section>IRA/Pension
Distributions> Add or Edit a 1099-R

Click on line 21 on 1040 View>Other Inc. Not Reported
Elsewhere or click Income from Federal Section>Other
Income>Other Inc. Not Reported Elsewhere

Click on line 31 from 1040 View or click Deductions
from Federal Section>Adjustments>Alimony Paid

Click on line 11 from 1040 View or click Income from
Federal Section>Alimony Received

Click on line 12 from 1040 View>Fill Out Business
Information>Income or click Income from

Federal Section>Schedule C>Fill Out Business
Information>Income

Click on line 13 from 1040 View>Capital Gains

and Loss ltems or click Income from Federal
Section>Capital Gain and Losses>Capital Gains and
Loss ltems

Click on line 12 from 1040 View>Fill Out Business
Information>Income or click Income from

Federal Section>Schedule C>Fill Out Business
Information>Income

Click on line 21 from 1040 View>Other Inc. Not
Reported Elsewhere or click Income from Federal
Section>0ther Income>Other Inc. Not Reported
Elsewhere

Click on line 40 from 1040 View>Gifts to Charity
or click Deductions from Federal Section>ltemized
Deductions>Gifts to Charity

Click on line 49 from 1040 View>Fill in all three steps or
click Deductions from Federal Section>Credits>Child
Care Credit

Calculated Automatically

Click on line 54 from 1040 View>Credit for the Elderly
or Disabled or click on Deductions from Federal
Section>Credits Menu>Credit for the Elderly or
Disabled

Click on line 9a from 1040 View>Interest or Dividend
Income or click Income from Federal Section>Interest
and Dividends>Interest or Dividend Income

Click on line 30 from 1040 View or click Deductions
from Federal Section>Adjustments>Penalty on Early
Withdrawal of Savings or CD

Click on line 34 or 50 from 1040 View or click
Deductions under Federal Section>Credits
Menu>Education Credits

Click on line 65 from 1040 View or click Payments &
Estimates from Federal Section>Federal Estimated
Payments



TaxSlayer® Entries (continued)

Item 1040 Line Navigation to Data Entry Screen

First Time Home Buyer Credit (Repayment) 60b Click on line 60b from 1040 View or click Other
Taxes from Federal Section> First-time Homebuyer
Repayment

Foreign Tax Credit 48 Click on line 48 from 1040 View or click Deductions
from Federal Section>Credits>Foreign Tax Credit

Gambling Winnings 21 Click on line 21 from 1040 View>Gambling Winnings

or click Income from Federal Section>Other
Income>Gambling Winnings

Gambling Losses 40 Click on line 40 from 1040 View>Miscellaneous
Deductions or click Deductions from Federal
Section>Itemized Deductions>Miscellaneous

Deductions

Health Savings Account 25 Click on line 25 from 1040 View or click Deductions
from Federal Section>Adjustments>Health Savings
Account

Household Employee Income (no W-2) 7 Click on line 7 from 1040 View>Other Income>Other

Compensation>Household Employee Income or click
Income from Federal Section> Other Income>QOther
Compensation>Household Employee Income

Interest Income 8 Click on line 8 from 1040 View>Interest or Dividend
Income>Interest Income, Form 1099-INT or click
on Income from the Federal Section>Interest and
Dividends> Interest or Dividend Income>Interest
Income, Form 1099-INT

IRA Contributions 32 Click on line 32 from 1040 View or click on Deductions
from Federal Section>Adjustments>IRA Deduction
IRA Distributions 15 Click on line 15 from 1040 View>Add or Edit a 1099-

R or click Income from Federal Section>IRA/Pension
Distributions> Add or Edit a 1099-R

IRA Rollover 15 Click on line 15 from 1040 View>Add or Edit a 1099-
R or click Income from Federal Section>IRA/Pension
Distributions> Add or Edit a 1099-R

Jury Duty Pay 21 Click on line 21 from 1040 View>Other Inc. Not
Reported Elsewhere or click Income from Federal
Section>0ther Income>Other Inc. Not Reported

Elsewhere

Jury Duty Paid to the Employer 36 Click on Deductions from Federal Section>Other
Adjustments>Select Jury Duty Pay

Medical and Dental Expenses 40 Click on line 40 from 1040 View>Medical and Dental

Expenses or click on Deductions from Federal
Section>ltemized Deductions>Medical and Dental

Expenses
Medicaid Waiver Payments 7 & 21 See page D-45
Mileage for Charitable Travel 40 Click on line 40 from 1040 View>Gifts to Charity>Non-

Cash Gifts to Charity or click on Deductions from
Federal Section>ltemized Deductions>Gifts to
Charity>Non-Cash Gifts to Charity

Mileage for Medical Travel 40 Click on line 40 from 1040 View>Medical and Dental
Expenses or click on Deductions from Federal
Section>ltemized Deductions>Medical and Dental
Expenses

Mortgage Interest and Points Paid 40 Click on line 40 from 1040 View>Mortgage Interest
and Expenses>Mortgage Interest Reported on
Form 1098 or click on Deductions from Federal
Section>ltemized Deductions> Mortgage Interest and
Expenses>Mortgage Interest Reported on Form 1098

D-5
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TaxSlayer® Entries (continued)

Iltem
Other Income (prizes, jury duty, etc.)

Pension Distributions

Personal Property Taxes

Prizes and Awards

Real Estate Taxes

Refunds of State and Local Income Tax (if
reportable)
Retirement Savings Credit

Roth IRA Contributions

Royalties (Simple royalties with no associated
expenses)
Royalties from Services

Scholarships and Grants;

Self-employment Income

Social Security Benefits

Stock Sales (Gains and Losses)

Student Loan Interest

Tip Income (not reported to employer)

Tip Income (not reported to employer because
tips were less than $20 per month)

Traditional IRA Contributions

Tribal Per Capita Payments

Unemployment Compensation - Current Year

Wages & Salaries
D-6

1040 Line
21

16

40

21

40

10
51

51

17

12

12

20

13

33

58
32

21

19

12/2016

Navigation to Data Entry Screen

Click on line 21 on 1040 View>Other Inc. Not Reported
Elsewhere or click Income from Federal Section>Other
Income>Other Inc. Not Reported Elsewhere

Click on line 16 from 1040 View>Add or Edit a 1099-
R or click Income from Federal Section>IRA/Pension
Distributions> Add or Edit a 1099-R

Click on line 40 from 1040 View>Taxes You Paid or
click on Deductions from Federal Section>Itemized
Deductions> Taxes You Paid

Click on line 21 on 1040 View>Other Inc. Not Reported
Elsewhere or click Income from Federal Section>Other
Income>Other Inc. Not Reported Elsewhere

Click on line 40 from 1040 View>Mortgage Interest
and Expenses>Mortgage Interest Reported on

Form 1098 or click on Deductions from Federal
Section>ltemized Deductions> Mortgage Interest and
Expenses>Mortgage Interest Reported on Form 1098

Click on line 10 on 1040 View or click on Income from
Federal Section>State and Local Refunds

Click on line 51 on 1040 View or click on Deductions in
Federal Section>Credits>Retirement Savings Credit

Click on line 51 on 1040 View or click on Deductions
in Federal Section>Credits>Retirement Savings Credit
and enter Any Current Year Roth IRA Contributions

Click on line 17 from 1040 View or click on Income from
Federal Section>Rents and Royalties

Click on line 12 from 1040 View or click on Income from
Federal Section>Profit or Loss from a Business

Click on Line 21 from 1040 View>Other
Compensation>Scholarships and Grants or click
Income from the Federal section>Other Income>Other
compensation>Scholarships and Grants

Click on line 12 from 1040 View or click on Income from
Federal Section>Profit or Loss from a Business

Click on line 20 from 1040 View or click on Income from
Federal Section>IRA/Pension Distributions> Social
Security Benefits/RRB-1099

Click on line 13 from 1040 View>Capital Gains

and Loss ltems or click Income from Federal
Section>Capital Gain and Losses>Capital Gains and
Loss ltems

Click on line 33 from 1040 View or click on Deductions
from Federal Section>Adjustments>Student Loan
Interest Deduction

Enter on Form W-2 for that employer on the Unreported
Tips line

Click on line 58 from 1040 View or click on Other Taxes
from Federal Section>Tax on Unreported Tip Income

Click on line 32 from 1040 View or click on Deductions
from Federal Section>Adjustments>IRA Deduction

Click on line 21 on 2014 View>Other Inc. Not Reported
Elsewhere or click Income from Federal Section>Other
Income>Other Inc. Not Reported Elsewhere

Click on line 19 from 1040 View or click Income from
Federal Section>Unemployment Compensation

Click on line 7 from 1040 View or click on Income from
Federal Section>Wages and Salaries



How/Where to Enter Income

Let’s look at the money you earned

Money isn't everything, except on your tax return. Tell us about your W-2, interest and
dividends and retirement distributions. Follow our step-by-step guide to ensure accurate entry
of your income. Or, enter the information on your own if you are familiar with the forms.

-0OR-

I\

Enter Myself ‘
N

A

Select Guide Me to launch a
step-by-step series of questions
to help determine the various
types of income that should be
entered on the tax return.

If you don’t need to enter or
correct any income items, you
can skip this section.

If you prefer to enter items of income without the
help, select Enter Myself. This will take you to the
income entry screen which lists the various types
of income that should be reported on the tax
return. Instructions to follow on next page.

Note: Regardless of which path you choose, the tax form entry screens on the following pages are the same.



How/Where to Enter Income (continued)

To go directly to a specific form, enter
the form number or name here.

Select Quick File from this pull-down menu to
create a list of entry screens for this return

You can go directly to the Income section from
the tabs across the top of the screen.

Enter the Form Number..

y

Mr Taxpayer W

Income

Woages and Salaries (W-2)

State and Local Refunds (1099-G Box 2)

Interest and Dividends (1099-INT, 1099-DIV)

IRA/Pension Distrioutions (1099-R, 1099-S5A)

Unemployment Compensation (1099-G Box 1)

Form 1099-Misc

Profit or Loss From A Business (Schedule C}

Rents and Royalties (Schedule E)

Capital Gain and Losses (Schedule D}

Profit or Loss From Farming {Schedule F)

Alimony Received

Other Income

=}
=

N

/

EDIT

/

If the taxpayer received
a state refund in 2016
and itemized deductions
for 2015 that included

a deduction for state
income tax, click this
and complete the State
Refund worksheet.

To enter unemployment
compensation, click
Begin or click Line 19
from the 1040 view.

12/2016

To enter Taxable Schol-
arship, Prisoner Earned
Income, or Foreign
Compensation -- click
Other Income then
choose Other Compen-
sation




Form W-2 Instructions

If a Form W-2 can’t be obtained from the employer, check
the box to indicate this is a substitute W-2. TaxSlayer® will
generate a Form 4852, Substitute for W-2

W-2
S Indicate if W-2 is for Taxpayer or If the taxpayer
Mot needed for e-filing This iz = standard W-2 Spouse haS an ITIN, _yOU
S Verficaton Code i provided — will be prompted
RS Veerification Code If provided) 7| This is 2 substibute We2
to enter the
ITIN SSN:
. — ITIN or SSN as
mp?*je = n - - shown on the
Whase W2 is this? bEIN ..
M Tapayer ‘  original W-2.
Check here if foreign address ¢ Employer Name
Address {Number and Street)
oot I~ P ———— Compare this address to Form W-2 address. If the
Py T address on the W-2 is different, correct the W-2 address
iR T PR OB here to match the original Form W-2. This won’t change
st paul Zo Lk the tax return address.
S:,::i:nemm = City, Town, or Post Office
o Review box 2 and box 17 to ensure tax withheld was
entered and is correct
Note: Information entered above must match the IRS Master
File. P\EaseVetnf\d. * .
Wages The entries in boxes 3, 4, 5, 6 and 16 will auto-populate
P T ; g g s ; based on the Box 1 entry. If the figures don’t match
taxpayer’s Form W-2, correct the data so that it matches
253 P $ ox See Txiired ! the information on Form W-2.
& Medicars Wages 1 6 Medicare Tax $
78 T ;i B Hlecsted s ! If there is an entry in Box 10, Form 2441 must be
9 RESERVED 10 Dependent Care $ <1 | completed.
11 NonQual Plan $ Unreported Tips $
~
Be sure to complete Box 11 if there is an entry on the
original Form W-2. An entry here may indicate that the
taxpayer is receiving deferred compensation earned in a
Form W-2 ALERT! prior year.
IRS requires that information on electronically filed Form(s)

W-2 match the printed Form(s) W-2 exactly.

A taxpayer with multiple Forms W-2 could possibly have a
different address on several, if not all, of the Forms W-2.

Check them carefully; the change must be made on every
Form W-2 that is different from the current address

Be sure to enter every item from the taxpayer’s original W-2
— key what you see

CAUTION: If the taxpayer earned tips that weren’t reported
to the employer, enter in the Unreported Tips box. This will
add Form 4137 to the return.

If the taxpayer received tips that weren’t reported to the
employer because they were less than $20 a month, go to
other taxes, select Form 4137 and also enter the amount
there.
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Form W-2 Instructions (continued)

Be sure to check box 13 as indicated on
Forms W-2. This is important in calculating
the deductibility of IRA contributions.

14

Code Statutary Ermployes Code Amaount

IR

Retirement Plan

+ add another row Third Party Pay

State Information -

15 State Mame State EIN 16 5t Wages 1

- Please Select - 3

19 Local Tax Paid
5

18 Local Wages 20 Local Name

§

e
B

For Box 12 and 14, choose the code from
the drop-down menu and enter the dollar
amount. If there are more than 4 items in
box 12, enter those items that don’t impact
the return in box 14 such as code DD.

If choosing “Other” for Box 14, be sure
to use the information in other sections
of the return, if appropriate (i.e, pension
contribution impacting Saver’s Credit.)

If the Form W-2 shows withholding from
more than one state, click the “Add State”
button to add the additional information.

Form W-2 Reference Guide for Common Box 12 Codes

A Uncollected social security or RRTA tax on tips

B Uncollected Medicare tax on tips

D Elective deferrals to a section 401 (k) cash or deferred
arrangement

E Elective deferrals under a section 403 (b) salary
reduction agreement

G Elective deferrals and employer contributions
(including nonelective deferrals) to a section 457 (b)
deferred compensation plan

J Nontaxable sick pay

P Excludable moving expense reimbursements paid
directly to employee

Q Nontaxable combat pay

T Adoption benefits

W Employer contributions (including amounts the
employee contributes through a cafeteria plan) to your
health savings account

AA Designated Roth contributions under a section 401
(k) plan

BB Designated Roth contributions under a section 403
(b) plan

DD Cost of employer-sponsored health coverage

EE Designated Roth contributions under a governmental
section 457 (b) plan



State and Local Refund Worksheet

State Refund Worksheet

Bypass State Refund Worksheet

Enter an amount here to bypass worksheet and enter the full amount as taxable on form 1040: s y"

Section 1 - State and Local Refunds

State Tax Refunds (all refunds from 1098-G or similar statements):

Last year's (2014 Tax Return) Standard/ltemized Deductions found on line 40 Form 1040 or
line 24 Form 1040A. If you filed your 2014 return on form 1040EZ, please enter 0.

Last Year's (2014 Tax Return) Filing Status:

Last Year's (2014 Tax Return) Deductions for Over 65 or Blind:
Check here if the Taxpayer claimed the Over 65 deduction last year.

Check here if the Spouse claimed the Over 65 deduction last year
Check here if the Taxpayer claimed the Blind deduction last year.

Check here if the Spouse claimed the Blind deduction last year.

Section 2 - If the filing status on your 20714 Form 1040 was married filing separately and you were forced
to itemize because your spouse itemized in 2014, fill out this section ONLY.

State Tax Refunds (all refunds from 1098-G or similar statements):

Select one... v

V'

Note: If the taxpayer doesn’t
have a copy of the prior year
return, make the entire refund
taxable.

Section 1- Use this worksheet
to determine the portion of the
taxpayer’s prior year state refund
that is considered taxable in

the current year. Use a copy

of the taxpayer’s previous year
return to enter all amounts in the
spaces provided. The taxable
portion will be included on the
return as taxable income.

Section 2— For taxpayers who
filed a MFS tax return in the
previous year and were forced to
itemize deductions because their
spouse itemized deductions,
enter the amount from all current
year 1099-G statements. This
amount will be included on the
return as taxable income.




Interest and Dividend Income

If the aggregate value of foreign
financial accounts exceeds

s $10,000 at any time during the
Interest and Dividend Income year, the FInCEN Report 114 is

/ required and the return is out of

Interest or Dividend Income

Did you earn interest from a bank in a foreign country?

Exclusion of Interest from Series EE & | US Savings Bonds

/ scope.
~_

If U.S. Savings Bond interest is
™~ used to pay for higher education
expenses, return is out of scope.

1099 Description Schedule B

Choose the type of Interest or Dividend item you want to enter:

If Tax-Exempt interest is present
on the Form 1099-INT, enter
separately

Interest Income, Form 1099-INT

Tax Exempt Interest Income, Form 1099-INT, Box 8 or Form 1099-DIV, Box 10 <

Dividend Income, Form 1099-DIV, Box 1

Seller Financed Interest Income
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Interest and Dividend Income (continued)

Enter the name of payer. Don’t
use punctuation.

Annotating who received
interest is important for state tax

purposes.

Enter each Form 1099-INT
separately.

Interest Income

Type of transaction: Interest{lncome
y

Payer's Narme:
Taxpayer, Spouse, or Joint? Taxpayer ¥
Interest Income (Box 1) 5

Early Withdrawal Penalty (Box 2) $

Interest on U.5. Savings Bonds and Treasury obligations (Box 3) 5
{Note: Enter Taxable amount only)

Federal Tax Withheld (Box 4) $

Amount of Interest on U.S. Savings Bonds and Treasury Obligations that you want subtracted 5
from your state return

MNominee Interest 5
OID Adjustment 5
Accrued Interest 5
ABP Adjustment $
Accrued Market Discount 3

Taxable interest paid. This doesn’t
include interest shown in box 3.

This amount is carried as an
adjustment to Form 1040.

NN

Enter any taxable amount from box
3 on this line.

\

IMPORTANT—ENntries are
transferred directly when a state
return is added. If state tax law
treats the interest differently,
include the exempt interest
amount and select the state from
the drop down list.

Generally, interest on U.S.
government obligations (such as
savings bonds, treasury bonds/
bills/notes) is taxable on the federal
return but isn’t taxable on the state
return.

Accrued interest—Interest paid
to seller at time of purchase—out
of scope

Private activity bond interest (PAB) is entered in Other
Taxes>> Alternative Minimum Tax>>Interest from specified
private activity bonds exempt from the regular tax.

12/2016

Nominee interest—Interest
transferred to another person—out
of scope

OID adjustment — Don’t use this
for interest reported on Form 1099-
OID. This is only used when the
OID instrument was bought or sold
during the year. In that case, the
return is out of scope. OID interest
is treated the same as regular
interest.
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Tax-Exempt Interest

Enter the payer’s name. Select
whether the interest income
belongs to the taxpayer, the
spouse or if it is joint income.

Schedule B Other Interest

Type of transaction: Tax Exempt Interest, Box
Payer's Name:

Taxpayer, Spouse, or Joint? | Taxpayer v

Interest Income

To add/edit state taxable interest items, click here -

<<

Enter the amount of tax exempt
interest from Box 8 of Form 1099-
INT

<

If any of the tax exempt interest
isn’t exempt from state taxes,
select the Add/Edit button to add
a Taxable State Interest item.
Interest on out-of-state municipal
bonds isn’t taxable on the federal
return BUT IS generally taxable
on the state return.

Taxable State Interest ltem
State
Owner

Amount

- Please Select -

Taxpayer

$

Enter the required information
and select Continue To Next
Step.

D-14

Note: Interest on in-state municipal bonds
is generally NOT taxable on the federal and
state returns.




Enter your Dividend Income (Form 1099-DIV)

Type of transaction: Dividend IncDme/

Payer's Name

Enter each Form 1099-DIV
separately.

Enter the name of payer. Don’t
use punctuation.

Taxpayer, Spouse, or Joint? | Taxpayer ¥ | .

<
Ordinary Dividends (Box 1a) s
Qualified Dividends {amount of ordinary dividends that are considered qualified) (Box 1b) 5
Capital Gain to Schedule D (Box 2a) s
Unrecaptured Section 1250 Gain (Box 2b) 5
Section 1202 Gain (Box 2¢) s
Collectibles (28%) Gain (Box 2d) $
Nondividend Distributions (Box 3) s
Federal Income Tax Withheld (Box 4) 5
Foreign Tax Withheld (Box &} 1

Mominee Dividend 5 \

Amount of Interest on U.5. Savings Bonds and Treasury obligations that you want subtracted %
from your state return

Please select your state: | - Please Select - ¥

Select whether the dividend
income belongs to the taxpayer,
the spouse or if it is joint income.

Shows total capital gain
distributions from a regulated
investment company (mutual fund)
or real estate investment trust.
This entry flows to Schedule D.

Non-dividend distribution is a
return of basis, not taxed until all
cost is recovered. The taxpayer
must reduce their cost by these
distributions at the time of sale.
Once all costs are recovered,
report as capital gain.

An entry in Foreign tax paid (box
6) will flow to the foreign tax
credit line on Form 1040. See the
Nonrefundable Credits tab for
Foreign Tax Credit information.

Enter dividends from federal bond
funds which are fully taxable on
the federal return but tax exempt
on the state return.




Schedule B Other Interest

Type of transaction: Seller Financed Interest Income

Payer's Name

Taxpayer, Spouse, or Joint? Taxpayer v

Payer’s Social Security Number:

Address ([Number and Street)
Zip Code
City, Town, or Post Office

State

- Please Select - v

Interest Income

To add/edit state taxable interest items, click here -

Caution: Must have identification
number of payer to e-file the
return.
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IRA/Pension Distributions
(Form 1099-R, Form SSA-1099)

IRA/Pension Distributions

Add or Edit a 1099-R
RRB-1099-R
Social Security Benefits

MNontaxable Distributions

There are four items to choose from, and within each item you can make
entries for as many documents as needed.
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Form 1099-R

EIN must be entered
accurately, and is a common
cause for e-file reject.

If more than one taxpayer, choose who
the document belongs to.

/ /
Form 1099-R

w"| Check hers if this is a stafidard 1099-A.

Onfy the amount entered in box 2a will Me considered taxeble

Whose 1099-R is this?

Aecipient

1099-R Information

1 Gross Distribution
Mr Taxpayer N
Mrs Taxpayer
28 Tenable Amount

Payer Information 5

3 Capital gain lincluded in bax 2a}

§

Zip Code

4 Federalincome tax withheld
City. Town. or Fost Office
5
State 5 Employes contributions or insurance premiums
- Please Select- = s
it 3 6 riet unrealized appreciation in employer's
Recipient Information NN

Check hers if foreign address &

Address {Mumber and Street] 7 Distribution Codels]

Caution: Box 2a will automatically fill in
with the amount in Box 1. If a different
amount is shown on the document, enter
that amount directly.

The payer may calculate the tax-free
amount and show the correct taxable
amount in Box 2a. In that case, simply
enter the amounts shown on the 1099-R.
Don’t use the worksheet.

If the payer doesn’t calculate the taxable
amount, Box 2b will be marked, and Box
2a may be blank, zero or the same as
Box 1. In that case, use the Simplified
Method.

If Simplified Method is required, click
here for Worksheet.

Pays L
ayer's ID Do you need to figure your taxable smount using

the Simplified Method? Click here for the
sorkanmss /—

=me Worksheet
2b

Check here if foreign address Taxsble gmount not determined
Address [Mumber and Street] Tatel distrizutizn

Box 2b offers “Taxable amount not
determined” and “Total distribution”. Mark
exactly as shown on document.

If Box 4 has an entry, ensure that the tax
withheld is entered and is correct.

123 Main St <
Zip Code RA/SEP/Simple <€
90210

B Other (Hat callectzd)
City. Town, or Fost Office

Beverly Hills

9a Your percentage of total distribution
State
California - O Total =mpioyee contributions
5

Box 5 on the document may be current
year’s amount of employee contributions
or insurance premiums.

If Box 5 is the same as Box 1, none of
the distribution is taxable. If the payer
has calculated the taxable amount of
the pension in Box 2, generally the
difference between Boxes 1 and 2 will
appear in Box 5. If Box 5 is the amount
of health insurance premiums, (typically
only on a CSA 1099-R) you must
MANUALLY carry the amount to the
Schedule A, Itemized Deductions.

10 Amount aliocakle to IAR within 5 years (Mot
needed for e-filing)

Form CSA 1099-R—Civil Service Retirement Benefits—The Office of

Personnel Management issues Form CSA 1099-R for annuities paid or

Form CSF 1099-R for survivor annuities paid. The CSA-Form 1099-R box

numbers reflect the standard numbering on a Form 1099-R. If the taxable

amount isn’t calculated in box 2:

* The Simplified Method must be used.

e Enter box 9b on line 1 of the Simplified Method section, if applicable.

e Complete the other required entries of the Simplified Method section.

* Amounts in box 5 are for health insurance premiums paid by the annuitant
(and need to be manually entered on the Schedule A worksheet).

D-18 12/2016

Box 7 is a required entry — enter exactly
as shown on document. If IRA/SEP/
Simple is marked, check to enter exactly
as on document.

Box 9b shows the total employee
contributions and may be needed if
Box 2 has no entry — usually requires
Worksheet (see Box 2a)




Form 1099-R Simplified Method

If the taxpayer made after-tax contributions toward a pension, a portion of the annuity payment has already been taxed
and isn’t taxable now. Generally, if the starting date of the payments was prior to July 2, 1986, the Simplified Method
wouldn’t apply. If the taxpayer used the 3-year rule, the annuity is fully taxable. If he used the general rule, refer the

taxpayer to a professional tax preparer.

Since 1986, the employee’s total after tax contribution is distributed over a number of months that represents the average

life expectancy of someone who is this age (when they began receiving payments).

Simplified General Rule Worksheet

Gross distribution amount (from 1099-R): $5,000.00

Plan cost at annuity start date $

Starting date of annuity MMﬂ oD ZJ Yy ﬂ

Check here if this a Joint or Survivor Annuity
Death benefit exclusion s

Age of recipient at start date
*If joint or survivor annuity, add ages of recipients

Number of months paid in 2015

Amounts previously recovered s

/ 1099-R)

Enter the amount that could have been recovered tax free in prior
years even if not claimed. Look at last year’s tax return to find this
amount, or calculate the amount using the monthly tax free amount
computed by TaxSlayer for the 2016 tax year times the number of
months prior to 2016.*

Mr. Example
retired 2/2/2015 ¥

Color

Helpful Tools
P HEEEN

Quick File

Save & Log Out
|

*For annuitants who retired between July 2, 1986 and Dec. 31, 1986, enter zero.

12/2016

Taxpayer Name Income
" U
Add a new note

Your Office

Scanned Documents Simplifiedt Fgthod Note Name
| Mr. Example retived
| 2/2/2015 at age 51.

Si hablo Espanol?  esrecorered o T

la)

Enter the Plan cost
(shown in Box 9b of

Enter the age of the
taxpayer on the date the
pension started — this
may be different than the
taxpayer’s age at the end
of that year.

For a joint or survivor
annuity, add the ages of
both spouses on the start
date. For the beneficiary of
an employee who died, see
Publication 575, Pensions
and Annuities.

The taxable amount is
calculated and shown on
the original 1099-R.

If retired public safety
officer (PSO) has both
health insurance deduction
and simplified method,
complete the simplified
method first, then delete
the simplified method
worksheet and manually
subtract insurance
premiums (up to $3,000)
from calculated taxable
income in Box 2. Deduct
excess premiums on
Itemized Deductions
screen.

To save time for next
year’s preparer, enter a
Note with the taxpayer’s
annuity start date, age at
the start date, and amounts
previously recovered.
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Form 1099-R Rollovers

If any portion was rolled over, check to bring
up screen to enter the amount. Even if Box 7 is
Code G, this entry must be made.

Rollover or Disability

%' Check here if all/part of the distribution was rolled over, and enter the rollover amount.

Check here to report on Form 1040, Line 7 {Distribution code must be a "3")

Check if Code 3 is in box 7—and the taxpayer is
disabled and under the minimum retirement age
of the employer’s plan. This will put this disability
income on Line 7 of Form 1040, instead of Line
16. It will also be used in calculation of some
credits.

Rollovers
* A taxpayer should not receive a Form 1099-R for a trustee-to-trustee transfer from one IRA to another, but should
receive a Form 1099-R for a trustee-to-trustee direct rollover from an employer qualified plan to an IRA with code G.

* A rollover that involves a distribution of funds to the participant isn’t taxable if the funds are deposited into an IRA (or the
same IRA) or an employer plan within 60 days. Form 1099-R will have either a code 1 or code 7.

* A participant is allowed only one rollover from an IRA to another (or the same) IRA in any 12-month period, regardless
of the number of IRAs owned. However, you can continue to make unlimited trustee-to-trustee transfers between IRAs
because it is not considered a rollover.

* Sometimes a distribution includes both a regular distribution (generally taxable) and a rollover (generally non-taxable).
The Form 1099-R Rollover or Disability section is used to input the amount that won’t be taxed.

* If taxpayer inadvertently missed the 60-day rollover deadline for one of several reasons, he can submit a certification to
the trustee, and the amount can be considered a rollover on his tax return. See Revenue Procedure 2016-47 for details.

Note: The above applies to pre-tax accounts (e.g. traditional IRAs) and to post-tax accounts (e.g. Roth IRAs) within each
group. If rolling or converting from pre-tax to post-tax, the amount will generally be taxable.
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Form 1099-R Distributions

Form 1099-R IRA/Pension Distribution(s)

Taxpayer or Payer Federal Tax Taxable Amount  Gross
Spouse Withheld

Taxpayer Second Federal  $200 $900 $1,975 - -
Credit Union
- Add a Form 1099-R IRA/Pension Distribution(s)

\

\

When there is more than one IRA/Pension document, click on the Add button. When the last
document for that section has been entered, click Continue.
When entering Form 1099-RRB, don’t choose Form 1099-R
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Basis of distributed property. The basis of property distributed from a Roth IRA is its fair market value (FMV) on the
date of distribution, whether or not the distribution is a qualified distribution.

You don'’t include in your gross income qualified distributions or distributions that are a return of your regular contributions

Form 1099-R Roth IRA

from your Roth IRA(s).
Distributions from a Roth IRA are tax free and may be excluded from income if the following requirements are met:

«  The distribution is made after the 5-year period beginning with the first day of the first taxable year for which a
contribution was made to a Roth IRA set up for the taxpayer’s benefit, and

. The distribution is:

Made on or after age 59, or

Made because the taxpayer was disabled, or

Made to a beneficiary or to an estate, or

To pay certain qualified first-time homebuyer amounts (up to a $10,000 lifetime limit)

Figure 2-1. Is the Distribution From Your Roth IRA a Qualified Distribution?

Yes

Start Here

Has it been at least 5 years from the beginning of the year for
which you first set up and contributed to a Roth IRA?

No

Yes

Yes

Were you at least 592 years old at the time of the distribution?

No

Yes

Is the distribution being used to buy or rebuild a first home as
explained in Publication 590, First Home under Early Distribu-
tions in chapter 1?

iNo

Is the distribution due to your being disabled (defined Publica-
tion 590, under Early Distributions in chapter 1)?

No

Was the distribution made to your beneficiary or your estate
after your death?

No

Yes

A 4

The distribution from the Roth IRA is a qualified distribution. It
isn’t subject to tax or penalty. This distribution is in-scope.

The distribution from the Roth IRA isn’t

a qualified distribution. The portion of the
distribution allocable to earnings may be
subject to tax and it may be subject to the
10% additional tax. This return is out of
scope. Refer taxpayer to a professional
tax preparer.
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Form 1099-R Box 7 Distribution Codes

Box 7 Distribution Codes

Explanations

1 — Early distribution,
no known
exception.

e If this amount was rolled over within 60 days of the withdrawal and—if the distribution
was from an IRA--no prior rollover was made in the same 12-month period, enter the
amount rolled over in Line 1 of the Exclusion Worksheet below the 1099-R screen.
Trustee to trustee transfer isn’t considered a prior rollover. If more than one rollover
from an IRA in the 12-month period, return is out of scope.

e If this wasn’t rolled over, a 10% additional tax will be applied unless the taxpayer
qualifies for an exception. See page Tab H for a list of exceptions. If the taxpayer
qualifies for an exception, check the box on the 1099-R just below Box 7 that says,
“Click here to force Form 5329.” Go to Form 5329, enter the amount that qualifies for an
exception and select the reason for the exception from the dropdown list.

2 — Early distribution,
exception applies.

Code 2 applies if the taxpayer is under 59 V2 but the payer knows that an exception to
the additional tax applies. If the IRA/SEP/SIMPLE box ISN’T checked, no further action
needed. If the IRA/SEP/SIMPLE box IS checked, additional reporting may be required on
Form 8606, and the return is out of scope.

3 — Disability.

Code 3 is for a disability pension.

e If the taxpayer is under the minimum retirement age for the company he retired from,
then check the box on the 1099-R just below Box 9b that says, “Check here to report...
on Line 7. This will put this disability income on Line 7 of Form 1040 instead of Line 16.
It will also include the amount in earned income for calculation of the earned income
credit, the dependent care credit and the additional child tax credit.

* |f the taxpayer has reached the minimum retirement age, no further action is needed.

4 — Death.

Code 4 is for a survivor’s benefit or an inherited IRA. If it's a pension, the original retiree
has died, and the survivor is receiving his or her share of the pension. If the original
pensioner was using the Simplified Method, continue to use it for the survivor. If it's an
inherited IRA and the original owner had a basis, the survivor takes over that basis.

5 — Prohibited
transaction.

This code is out of scope.

6 — Tax-free Section
1035 exchange.

This code is out of scope.

7 — Normal
distribution.

Code 7 is for normal distributions. It may occur in several different situations:

e If the amounts in Box 1 and 2 are the same, and Box 2b isn’t checked, the pension is
fully taxable.

If the taxpayer makes a rollover from one IRA to another and holds the money less
than 60 days, enter the amount rolled over on the Exclusion Worksheet, line 1. This
will check the “rollover” box at Line 15 of Form 1040. Link out from there and enter a
description of the rollover.

If the Box 2b is checked and there is an amount in Box 9b, complete the Simplified
Method at the bottom of the 1099-R screen. Be sure to use the taxpayer’s age at the
time of retirement—not current age.

If there is an amount in Box 2 that is different than Box 1, no further action is needed.

If there is no amount (or zero) in Box 2, check to see if there is an amount in Box 5. If
this is the same amount as Box 1, the distribution is the taxpayer's own money coming
back. Enter the Box 5 amount on line 5 of the Exclusion Worksheet. None of the
distribution will be taxed.

If any portion of this distribution was sent directly from the trustee to a charity, enter the
amount on Line 2 of the Exclusion Worksheet. It won’t be included in gross income. No
charitable deduction may be taken for the donation.

8 — Excess
contributions

This code is out of scope.

9 — Cost of current life
insurance

This code is out of scope

A — May be eligible for
10-year tax option.

This code is out of scope.
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Form 1099-R Box 7 Distribution Codes (continued)

Box 7 Distribution Codes

Explanations

B — Designated Roth account
distribution

Code B is for a distribution from a designated Roth account. This code is in scope
only if taxable amount has been determined.

D — Annuity payments from
nonqualified annuities

Code D is used for a distribution from a private annuity in conjunction with the regular
code. The distribution is subject to the net investment income tax. If the taxpayer has
AGI over a threshold amount ($200,000 for a single taxpayer or HoH, $250,000 MFJ

or QW, $125,000 MFS), then this code means the return is out of scope. If the AGl is
less than the threshold amount the return is in scope and no further action is needed.

E — Distributions under
Employee Plans
Compliance Resolution
System (EPCRS).

This code is out of scope.

F — Charitable gift annuity.

Code F is used for the annuity payments from a charitable gift annuity. The difference
between the distribution in Box 1 and the capital gain shown in Box 3 will appear on
Line 15 of the 1040. Schedule D must be completed to report the capital gain.
Describe it as “From 1099-R”. The gain should be the amount in Box 3, and the gain
is long term.

G — Direct rollover of
distribution and direct
payment.

Code G is for a direct rollover from a qualified plan to an eligible retirement plan.
Change Box 2a to match the amount in 2a on the document. If there is an amount in
box 2, the direct rollover is fully or partially taxable.

H — Direct rollover of a
designated Roth account
distribution to a Roth IRA.

Code H is for a direct rollover of a distribution from a designated Roth account to a
Roth IRA. It won’t be taxed. No further action is needed.

J — Early distribution from a
Roth IRA.

This code is out of scope.

K — Distribution of IRA assets
not having a readily
available FMV

This code is out of scope.

L — Loans treated as deemed
distributions

Code L is for loans treated as deemed distributions. This code could possibly be
combined with codes 1, 4, or B. For more information on how it is treated see the
codes on this chart.

N — Recharacterized IRA
contribution.

This code is out of scope.

P — Excess contributions plus
earnings/excess deferrals

This code is out of scope.

Q — Qualified distribution
from a Roth IRA.

This distribution is not taxable. Be sure Box 2a matches the amount on the document.

R — Recharacterized IRA
contribution.

This code is out of scope.

S — Early distribution from a
SIMPLE IRA in the first 2
years, no known
exception.

A 25% additional tax will be applied unless the taxpayer qualifies for an exception.
See Tab H for a list of exceptions. If the taxpayer qualifies for an exception, go to
Form 5329. Enter the code for the exception and the amount that qualifies for it.

T — Roth IRA distribution,
exception applies.

This code is out of scope.

U — Dividends distributed
from an ESOP

This code is out of scope.

W — Charges or payments for
LTC contracts

This code is out of scope

D-24
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Form 1099-R Nontaxable Income

Qualified Charitable Distribution (QCD) may be used if the person was at least 70%2.
This makes that portion of the distribution non-taxable. The taxpayer doesn’t get a charitable
deduction of that amount, if itemizing.

1099-R Nontaxable Income

Nontaxable Distribution

If part or all of your 1099-R distribution(s) was for any of the following reasons, please check the appropriate box.
Important: The amount that you enter as the Taxable Amount in Box 2a for each 1099-R will be carried to your return as taxable
income. If any of the exclusions apply, do not include the excludable amount in Box 2a for the appropriate 1099-R. Only include in

Box 2a the amount that you want reported on your return as taxable income.

Exceptions:

Check here to mark this as a Qualified Charitable Distribution (QCD} on your return.

Check here to mark this as a qualified health savings account (HSA) funding distribution (HFD) on your return.

Check here if you are an eligible retired public safety officer, and part of your distribution was used to pay the

premiums for accident or health insurance, or to pay long-term care insurance.

Retired Public Safety Officer (PSO) may have up to $3,000 for health and/or long-term care
(LTC) insurance, if paid directly from the retirement plan. The remainder, if any, is entered on
Sch A, ltemized Deductions as insurance cost. The insurance can be for the taxpayer, spouse
and family. When Box 7 is Code 4, the PSO deduction may no longer be used.

Qualified Health Savings Account funding distribution from an IRA (related to a Form 1099-R )
if rolled over, is out of scope.
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Form RRB-1099-R Distributions

Railroad Retirement Benefits (RRB) are reported on two forms and
require two entry screens. Social Security Equivalent Benefits, Form
RRB 1099 Tier 1 (Blue Form) are entered on the Social Security
Benefits screen. Treat the benefits reported on this form just like the
information reported on Form SSA-1099. This screenshot shows the
entry screen for Form RRB 1099-R Tier 2 (Green Form).

RRB-1099-R

Payer Information

Payer's |ID

Check here if foreign address

Address {(Mumber and Street)

Zip Code

City, Town, or Past Office

State

- Please Select - =

Recipient Information
Recipient

Iir Taxpayer

Wrs Taxpayer

Check here if foreign address
Address {(Mumber and Street)
123 Main 5t
Zip Code
90210 -
City, Town, or Post Office
Beverly Hills

State

California .

RRB-1099-R Information

3 Total employes contributions

§
4 Contributory Amount Paid
Mot needed for e-filing

5 Vested Dual Benefit

Mot needed for e-filing

6 Supplemental Annuity

Mot needed for e-filing
7 Total Gross Paid

§

7a Taxable Amourt

$ ]

Do you need to figure your taxable amount using

Taxable amount may have
to be determined using
Simplified Method.

the Simplified Method? Click here for the
warkshest.
Workshest

8 Bepayments
Mot needed for e-filing

9 Federal income tax withheld
§

10 Rate of Tax

Mot needed for efiling

11 Country

Mat needed for e-filing

12 Medicare Premium Tetal:
MNat needed for efiling

Check here to report on Form 1040, Line 7
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Form SSA-1099 Distributions

Social Security 1099 SSA

Social Security Benefits

Taxpayer's Social Security Benefit (Generally Box 5 of Form SSA-1093)
Taxpayer's Federal Tax Withheld (Amount from Box 6 of Form SSA-1099)
Taxpayer's Medicare Premiums

Spouse's Social Security Benefit (Generally box 5 of Form SSA-1099)
Spouse's Federal Tax Withheld (Amount from Box & of Form SSA-1099)

Spouse's Medicare Premiums

Lump-Sum Payments: ‘ Begin Worksheet

A

[\

Enter amount from Box 5 of Form
SSA-1099 or enter from Form
RRB-1099 - Tier 1 (Blue form)
Social Security Equivalent Benefits
(SSEB)

Be sure to check for any tax
withheld. Often taxpayers choose
this option.

Enter the total of Medicare Parts A,
B, C, and D. Repeat for spouse.

If an amount is present in the description of Box 3
on Form SSA-1099, the taxpayer received benefits
attributable to a prior year. Consider using the
Lump-Sum worksheet to see if the taxable amount
of social security is reduced.

If Lump-Sum calculation is needed, click here.

Taxpayer will need to provide prior year tax returns.
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Form SSA-1099 Lump-Sum Distributions

Social Security Lump-Sum Payment
SSA Lump-Sum Payment

Year the lump sum payment was made for
Filing Status in Earlier Year

SSA Payments received in Earlier Year

Portion of this years SSA for Earlier year
Moedified Adjusted Gross Income for Earlier Year

Taxable Benefits Reported in Earlier Year

2014 X

- Please Select - v

- Please Select -

Single

Married Filing Joint

Married Filing Separate

Head of Household

Qualifying Widow(er) with Dependent Children

Enter relevant year, as shown on
Form SSA-1099.

If more than one year has prior
year payments use additional
Lump-Sum worksheet.

Dropdown is available for prior year
Filing Status

Social Security Lump-Sum Payment
SSA Lump-Sum Payment

Year the lump sum payment was made for
Filing Status in Earlier Year

SSA Payments received in Earlier Year

Portion of this years SSA for Earlier year
Modified Adjusted Gress Income for Earlier Year

Taxable Benefits Reported in Earlier Year

2014 »

- Please Select - i1

A

Choose proper answers for all
boxes. Leave the 3rd and/or 6th
box empty if not applicable. All
other boxes require entries.

The calculation won’t be correct
without the prior year AGI.

The software will determine total
taxable Social Security based on
these entries.

Add to AGI any tax-exempt interest
and any adjustments from Lines 33
to 35.

D-28
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Schedule C or C-EZ Self-Employment Income

Caution: Businesses with inventory, employees, contract labor, depreciation, business use of
the home, expenses over $25,000 or a net loss are out of scope.

Mr Taxpayer v Income

Enter the Form Number..

Income

Wages and Salaries (W-2)

State and Local Refunds {1099-G Box 2)
nterest and Dividends (1099-INT, 1098-DIv})
RA/Pension Distributions (1089-R, 1099-554)
Unemployment Compensation {1099-G Box 1)
Form 1099-Misc

Profit or Loss From A Business (Schedule C)
Rents and Royalties (Schedule E)

Capital Gain and Losses (Schedule D)

Profit or Loss From Farming (Schedule F)
Alimony Received

Other Income

EDIT

EDIT

AN

If any of the self-employment
income is reported on Form
1099-MISC, Miscellaneous
Income, select Form
1099-Misc. In most cases,
self-employment income
reported on a Form 1099-
MISC will be in Box 7,
Nonemployee compensation.

Select Profit or Loss From
A Business (Schedule C)
to enter self-employment
income that isn’t reported
on a Form 1099-MISC.

This would include income
reported on Form 1099-K,
Payment Card and Third
Party Network Transactions,
as well as all other cash

and any other income
received related to the
business activity. Also, enter
expenses related to the self-
employment income.

Form 1099-MISC. This income must still be reported.

Note: A taxpayer that received less than $600 in income from one payer may not receive a
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Schedule C or C-EZ Form 1099-MISC

On ajoint return, indicate

if the Form 1099-MISC
recipient is the Taxpayer or
the Spouse.

Note: There is usually no income tax withholding on a Form
1099-MISC. But always double check to make sure!

The Payer Information
relates to the entity that paid
the taxpayer and issued the
Form 1099-MISC. In most
cases, the Federal ID will be
an employer identification
number, not an SSN.

I

Self-employment income
generally appears in

box 7, Nonemployee
compensation. If there is
income reported in other
boxes and it was earned
by the business, it should
also be reported as other
business income on the
Schedule C or C-EZ.

Form 1099-MISC

Whose 1099-MISC is this?

[ Mr Taxpayer

Mrs Taxpayer

Payer Information

. Use Payer's SSN as ID

Payer's Federal ID

Payer's Name

Check here if foreign address

Address (Number and Street)

City, Town, or Post Office

State

- Please Select -

1099-MISC Infor
1 Rents
$

2 Royalties
$

3 Other income 4 Federal income tax withheld
$ $

5 Fishing boat proceeds 6 Medical and health care
$

payments Learn More

7 Nenemployee compensation

$

8 Substitute payments in lieu of
dividends or interest Learn
More

10 Crop insurance proceeds

$

9 Payer made direct sales of
55,000 or more of consumer
products to a buyer (recipient)

for resale Learn More Defer

11 Foreign tax paid Learn More

12 Foreign country or U.S.
possession Learn More

13 Excess golden parachute
payments Learn More
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Form 1099-MISC (continued)

Form 1099-MISC

Whose 1099-MISC is this? 1099-MISC Information
Some income that isn’t self- Mr Taxpayer 1 Rents 2 Royalties
employment, such as prizes and R $ s

. . |
aWardS', 1S reporteq Ir:] bOX 3’ . 3 Other income 4 Federal income tax withheld
Other income. This income is :

. Payer Information $ H
reported on Form 1040, line 21.

Use Payer's SSN as ID 5 Fishing boat proceeds 6 Medical and health care

$ payments Learn More

Payer's Federal ID

7 Monemployee compensation 8 Substitute payments in lieu of

Payer's Name s dividends or interest Learn

Mare

Check here if foreign address
9 Payer made direct sales of 10 Crop insurance proceeds
$5,000 or more of consumer

products to a buyer (recipient)

Address (Number and Street)

for resale Learn More Defer

Sometime income reported
in box 7, Nonemployee
compensation is related to a

hobby — an activity that isn’t ]
engaged in for profit. Activities
not for profit are out of scope. State

- Please Select -

11 Foreign tax paid Learn More

City, Town, or Post Office

12 Foreign country or U.S. 13 Excess golden parachute
possession Learn More payments Learn More
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Complete Basic Information
About your Business and
Questions About the Operation
of Your Business for every
Schedule C.

Schedule C Menu

Select Income to enter any
income for the business that was
not reported on Form 1099- MISC,
such as income from a Form
1099-K.

Most business expenses are
entered in the General Expenses
section.

Select Other expenses to enter
any expenses not listed under
General Expenses

Schedule C

S~ Basic Information About Your Business

RN
7

Questions About the Operation of Your Business
Income
Cost of Goods Sold
General Expenses
Car And Truck Expenses
Depreciation
Other Expenses
e
Expenses for Business Use of Your Home

Restart Schedule C Guide

EDIT

D-32

criteria.

Tip: Select Schedule C-EZ from the menu if the taxpayer meets the Sch C-EZ

Self-employed taxpayers who accepted payment cards for payments or who
received payments through a third party network may receive Form 1099-K

reporting those transactions.
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Schedule C or C-EZ - Questions about your

To be in scope, the accounting
method must be Cash and there
can be no inventory, no cost of
goods sold, no employees, no
business use of the home, and
no depreciation (completing Form
4562).

In most cases, the taxpayers

do materially participate in the
business. This means that the
taxpayer ran the business and did
the work.

Business

»

If the taxpayer has a business loss
carried over from another tax year
or is required to file a Form 1099,
the tax return is out of scope.

P

Accounting Method: ® Cash

 )

Accrual

Other

Methed used to value closing inventory: ® Cost

Lower of cost or market

Not Applicable

Check here if there were any changes in determining inventory.

&' Check here if you "materially participated” in the operation of this business during the tax year

This box must be checked to allow a net loss on your return

Check here if this is the first Sch. C filed by you for this business

Prior year unallowed loss (ONLY enter an amount if current year's activity is a net profit) $

Check here if you made any payments in 2015 that would require you to file Form(s) 1099

[ If you checked the box above, check here if you did or you will file all required Forms 1099

Check here for Qualified Joint Venture. {Ownership between Taxpayer and Spouse must be 50/50. If you are filing
Business Use of Home deductions or using the Clergy Worksheet, you will need to file separate Schedule C forms,

one for each spouse)

Check here to Prorate Expenses for Minister/Clergy.
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Schedule C or C-EZ General Expenses

The following expenses are out of scope:

Contract Labor, Depletion, Employee benefit program, Health Insurance, Mortgage interest, Pension and
profit sharing, and Wages.

Schedule C - Expenses

Advertising 5 Pension and profit sharing 5
Contract Labor 5 Rent or lease of equipment [
Commission and fees 5 Rent or lease of property 5
Depletion 5 Repairs and maintenance 5
Employee benefit programs s Supplies $
Health Insurance 5 Taxes and licenses s

{will carry automatically to worksheet)

Travel 5
Insurance §

{other than health)
Meals and entertainment (50%) Enter 100% 5

Mortgage interest § of the expenses.
) Meals and entertainment (80%) Enter 100% 5
Other interest §
of the expenses.
Legal and professional services 5 Utilities 5
Office expense 5 ages 5

(less employment credits)

To be deductible, a business expense must be both ordinary and necessary. An ordinary expense is one that is common
and accepted in your industry. A necessary expense is one that is helpful and appropriate for your trade or business. An
expense does not have to be indispensable to be considered necessary.

Note: Car and truck expenses aren’t entered on this page. Those expenses are entered on a separate page.
Note: Rentals or leases of equipment for more than 30 days are out of scope.

Caution: Expenses that aren’t deductible include Bribes and Kickback; charitable contributions; demolition expenses or
losses; and dues to business, social, athletic, luncheon, sporting, airline, and hotel clubs.
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Schedule C or C-EZ Car and Truck Expenses

Using actual expense
deductions, such as gas,
repairs, and depreciation, is

out of scope.

Schedule C Car and Truck Expenses

Enter a brief description of
the vehicle; for example, 2008
Ford.

Car and Truck Expenses

Please Note: Actual car or truck expenses must be entered in the depreciation menu for this business.

Description of Vehicle

Date you placed your vehicle in service for business purposes: MM v DD T | YYYY X

Of the total number of miles you drove your vehicle during the tax year, enter the number of miles you used your vehicle for each of
the following.

Business miles: Miles related
to the business activity that
aren’t commuting miles.

¥

Business miles

Commuting

Other

Check if you have (or your spouse has) another vehicle available for personal use.

Commuting miles: Miles
driven each day from home to
the first business location and
driven from the last business
location back home.

Check if your vehicle was available for personal use during off-duty hours.

Check if you have evidence to support your deduction.

Other: Miles driven for
personal purposes.

If yes, check if the evidence is written.

Note: The total of Business, Commuting
and Other miles should add up to the total
miles on the vehicle for the year.

Caution: Refer to Tab F, Deductible Transportation Expenses, for help determining
deductible business mileage and non-deductible commuting mileage. For additional
information and examples, see Publication 463, Travel, Entertainment, Gift, and Car
Expenses.

Note: The car and truck expense deduction will automatically be calculated using the
standard mileage rate, based on the number of business miles entered. The rate is 54 cents
per mile for tax year 2016. In addition, the taxpayer can deduct the cost of parking and tolls.

Note: If you are self-employed and use your car in your business, you can deduct the busi-
ness part of state and local personal property taxes on motor vehicles on Schedule C or
C-EZ. Enter this on the Taxes line on the Schedule C Expenses screen.

Note: If you are an employee, you cannot deduct any interest paid on a car loan. This ap-
plies even if you use the car 100% for business as an employee.

However, if you are self-employed and use your car in your business, you can deduct that
part of the interest expense that represents your business use of the car. You cannot deduct
the part of the interest expense that represents your personal use of the car. Enter the de-
ductible amount on the Other Interest line on the Schedule C Expenses screen.

12/2016
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Schedule D Capital Gains

Enter all capital transactions here.

The software will carry the transactions to
the appropriate Form 8949. The totals for

each Form 8949 will automatically carry to
the correct line of Sch D.

Schedule D Capital Gains

Capital Gains and Loss ltems

Additional Capital Gains Distributions
Other Capital Gains Data

Sale of Main Home Worksheet

@
| eeon |
-
e |
v conie

P4

Other Capital Gains Data

Adjust Section 1250 Amounts 7 If the taxpayer has a Short Term or
Long Term capital loss carryover from
Adjust 28% Gain . .
J G the prior year, enter on the appropriate
Short Term Leoss Carryover from 2014{enter as a positive number) $ 47 [ines'
Long Term Loss Carryover from 2014 (enter as a positive number) $ &

D-36



Entering Capital Gains and Losses

—
Date Acquired - select if Applicable -
* Alternate Option: If Date Acquired s not known, leave the date Various - Short Term

Various - Long Term
blank and select an option here Inherited - Long Term

If you check the box for Alternate Option for Date Acquired or Date
Sold, a pick list will appear. Choose the correct option for the
transaction.

Worthiess - Short Term
Worthless - Long Term
Bankrupt - Short Term
Barkrupt - Leng Term

D Sokd

* Altarnate Opson:

Form 1099-B box 1b.

Capital Gains Transaction

Description of Property

» Date Acquired:

select an option here

Date Sold:
> * Alternate Option:

Check here if a short sale.

Form 1099-B box 1c /

Form 1099-B box 1d

* Alternate Option: If Date Acquired is not known, leave the date blank and

MM v (DD T YYYY oT

{1 | S s ) A

Form 1099-B box 1e or
provided by taxpayer.

If basis can’t be
determined, use zero.

Iy~ Sales Price §
* Alternate Option: If Sale Price is Expired, leave the sales price blank and select
an option here
- Please Select - F1099 shows Code A or D

Form 1099-B, Box 1e Showss Cost Basis F1099 shows Code B or E
Zelin (R A VG EIGE O RIS  F1099 shows Code C or F
Did not receive Form 1099-B

Choose the cost basis type that applies to the transaction.

A

Select cost basis type - Please Select - v
Cost 1

* Alternate Option: If Cost is Expired, leave the cost blank and select an option

here
Enter any necessary adjustments o Gain or Loss $ -
MOTE: If this entry is to be shown as a loss, please enter a negative sign before the number.
If you entered an adjustment amount above, please select the adjustment explanation - Select if Applicable - *
Is this a Collectible Exchange? Check if "YES'

A

If an adjustment to basis or net capital gain is required, enter the
adjustment and pick the reason from the drop down list. For most

If you have no more Click “Save & Enter
transactions to enter, click Another” if you have
“Continue” (this will also save more capital gain
your entry.) transactions to enter.

transactions, no adjustment to gain or loss is needed. You may
need to enter an adjustment if the basis provided is incorrect, or
another situation applies that requires a change to the basis, or if
the taxpayer is able to exclude some or all of the capital gain. The
pick list of reasons is shown below.

- Select if Applicable -
Exclude Some/All of the Gain from the Sale of Your Main Home

TIP: If summarizing transactions, enter zero for the
adjustment amount and select “Reporting Multiple
Transactions on a Single Row.”

12/2016

Form 1099-B with Basis in Box 3 is Incorrect & Correct Basis is Lower or Higher

Form 1099-B & Type of Gain/Loss Indicated in Box 8 is Incorrect

Nondeductible Loss from a Wash Sale

Exclude gain from Dist of Columbia Enterprise Zone or Qualified Community Assets
Rollover of Gain from QSB, Empowerment Zone Assets, sold publicly traded securities
Nominee Capital Gain Distributions

Other Adjustments

Exclude Part of the Gain from the Sale of QSB Stock

Nondeductible loss other than a Wash Sale
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Entering Capital Gains/Losses (continued)

Exception to Entering Each Transaction on a Separate Row

When a taxpayer’s Form 1099-B includes so many transactions that it isn’t practical to enter each one into TaxSlayer®,
use the following procedure.
1. Divide the transactions into four categories:
e Short term transactions with basis reported to the IRS - categorized as “Box A
* Short term transactions with basis not reported to the IRS - categorized as “Box B”
e Long term transactions with basis reported to the IRS - categorized as “Box D”
¢ L ong term transactions with basis not reported to the IRS - categorized as “Box E”
2. Enter the total of each category on the capital gain entry screen.
3. If any of the transactions requires an adjustment to the reported basis, select the reason from the drop down box that
includes that transaction.
4. |If there are transactions with basis not reported to the IRS, the broker’s list of transactions must be submitted as an
attachment to the tax return. Submit the document using either of the following two methods.
e Hardcopy: Make a photocopy and attach it to Form 8453 to be mailed to Austin.
* Electronic: Scan the pages and save as a pdf. Attach the pdf to the electronic return prior to creating the e-file.

Brokers’ Statements

Look for all the following items. (You may or may not find them all.)
1. 1099-INT. (Summary-NOT detail)

2. 1099-DIV. (Summary-NOT detail)

3. 1099-B (Summary and Detail) and “Cost basis” or “Transaction detail” for sale of stock: Input as a capital gain and
losses.

4. “Management” or “Investment fees”: Input on Schedule A Line 23.

5. If there are dividends from mutual funds, look for an insert or chart that says what percentage came from federal
government interest: Enter on the dividend input screen and select your state (check your state rules).

6. The chart should also show what percent came from municipal bonds from each state: Input exempt interest from
states other than yours by selecting tax exempt interest income and making the state adjustment (check your state
rules).

7. Foreign taxes paid: Enter Foreign taxes paid on the dividend input screen only if all foreign taxes relate to passive
income and the total on all tax statements (1099 etc) is less than $300 ($600 MFJ); otherwise, in scope only if
certified in International.

8. If the taxpayer has margin interest and is itemizing deductions, the return is out of scope.

Capital Gain/Loss

Description Date Acquired Date Sold Price Cost

10 shares LongE  1/6/2009 2M15/2015 5200 $500
10 shares longF ~ 1/11/2008 1/10/2015 $150 5250

10 shares LTD Various - Long 9/2/2015 51,000 $500
Term

50 ShortA Various - Short 2/27/2015 $600 $500
Term

50 ShortB 7/7/2014 41242015 5200 5300

50 ShortC 2/5/2015 8/11/2015 51,000 $600

- Add a Capital Gains Transaction

D-38 Note: Net losses greater than $3000 ($1500 if MFS) will carry forward to future tax years.
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Adjustments to Basis in TaxSlayer-TY2016

Enter Capital Gain/Loss Transactions in TaxSlayer

For most transactions, you do not need to adjust the basis. You may need to adjust the basis if you received a Form
1099-B or 1099-S (or substitute statement) that is incorrect, if you are excluding or postponing a capital gain, if you have a
disallowed loss, or in certain other situations. Details are in the table below.

In Scope

THEN select from the

Adjustment Code

column...

IF... THEN... dropdown list thatl\:lgllnflggzgr on
You received a Form 1099-B If the basis was not reported to the | Form 1099-B with
(or substitute statement) and IRS, report the correct basis and | Basis in Box 3 is
the basis shown in box 3 is make no adjustment. If the basis | Incorrect & Correct B
incorrect. .. was reported to the IRS... Basis is Lower or
Higher
You received a Form 1099-B or | Enter the proceeds as reported in | Form 1099-B with
1099-S (or substitute statement) | Box 1d. Enter as an adjustment Basis in Box 3 is
and there are selling expenses | using a minus sign for any selling | Incorrect & Correct £
that are not reflected on the form | expenses that you paid (and that | Basis is Lower or
or schedule... are not reflected on the form or Higher
statement you received).
You sold or exchanged your Report the sale or exchange as Exclude Some/All of
main home at a gain, must you would if were not taking the the Gain from the Sale
report the sale or exchange and | exclusion. Then enter the amount | ©f Your Main Home H
can exclude some or all of the of excluded (nontaxable) gain as a
gain... negative number.
You have a nondeductible loss | Report the sale or exchange Nondeductible loss
other than a loss indicated by and enter the amount of the other than a Wash Sale
code W... nondeductible loss as an L
adjustment. See Nondeductible
Losses in the Instructions for
Schedule D.
You report multiple transactions | Enter -0- as the adjustment amount | Reporting Multiple
on a single row as described unless an adjustment is required Transactions on a
in Exception to Reporting each | because of another code. Single Row M
Transaction on a Separate
Row...
You received a Form 1099-B (or | Enter transaction with correct Form 1099-B and Type
substitute statement) and the term (long or short). Enter -0- as | of Gain/Loss indicated
type of gain or loss (short term | the adjustment amount unless an | in Box 2 is incorrect T
or long term) shown in box 1cis | adjustment is required because of
incorrect)... another code.
You have a nondeductible loss Report the sale or exchange
from a wash sale ... and enter the amount of the Nondeductible loss W
nondeductible loss as an from a Wash Sale
adjustment.
You have an adjustment Report the appropriate Other adjustment
not explained earlier in this adjustment amount. 0]

12/2016
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Adjustments to Basis in TaxSlayer-TY2016

(continued)

OUT OF SCOPE
Adjustment Code

IF...
You received a Form 1099-B or 1099-S (or substitute statement) as a nominee for the N
actual owner of the property.
You sold or exchanged qualified small business stock and can exclude part of the gain. Q
You can exclude all or part of your gain under the rules explained in the Schedule D X
instructions for DC Zone assets or qualified community assets.
You are electing to postpone all or part of your gain under the rules explained in the
Schedule D instructions for any rollover of gain (for example, rollover of gain from QSB R
stock or publicly traded securities).
You had a loss from the sale, exchange, or worthlessness of small business (section
1244) stock and the total loss is more than the maximum amount that can be treated as S
an ordinary loss.
You disposed of collectibles (see the Schedule D instructions). C

D-40
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Capital Gains or Losses Sale of Main Home

Report the sale or exchange of your main home as a Capital Gain or Loss if:
* You can’t exclude all of your gain from income, or
* You received a Form 1099-S for the sale or exchange.

Generally, if you meet the following two tests, you can exclude up to $250,000 of gain. If both you and your spouse meet
these tests and you file a joint return, you can exclude up to $500,000 of gain (but only one spouse needs to meet the
ownership requirement in Test 1).

e Test 1. During the 5-year period ending on the date you sold or exchanged your home, you owned it for 2 years or
more (the ownership requirement) and lived in it as your main home for 2 years or more (the use requirement). *Military
members may be able to suspend the 5-year period while serving on qualified official extended duty.

e Test 2. You haven’t excluded gain on the sale or exchange of another main home during the 2-year period ending on
the date of the sale or exchange of your home.

If you have a gain that can’t be excluded, it is taxable.

Death of spouse. If you sell your home after your spouse dies (within 2 years after
your spouse dies), and you have not remarried as of the sale date, you can count
any time when your spouse owned the home as time you owned it, and any time
when the home was your spouse’s residence as time when it was your residence.

If you are required to report the sale AND Sale of Home
IT RESULTS IN A GAIN: Basic Info about the Sale

e Enter the purchase date, sale date, Daterof purchasz [ <]
purchase price, and sales price in

DD x| YYYY v

the Sale of Home Worksheet (you Fureneseprice ’
will enter improvement and other [ Date of sale MM v DD v yryy v
adjustments to basis on the next
screen) Sale-price $
° Enter the number Of days the dWe”/ng Allowable Depreciation related to the business use or rental of the home $
was Used as the main home (Separate Depreciation taken after 05/06/1997 H
entry for spouse) \

e Enter the number of days the taxpayer Info about your home

owned the home (separate entry fO\

How many days in the last 5 years was the home your main home?

spouse)
. lf the taxpayer I’eceived the 2008 FII‘ [ How many days in the last 5 years did you own your home?
Time Homebuyel’s Credit, CheCk the How many days in the last 5 years was the home your spouse's main home?
box — Form 5405 will be required to
determine hOW mUCh Of the Credit \ How many days in the last 5 years did your spouse own your home?

must be repaid
Check here if you received the First-time Homebuyers Credit AND you received the credit in 2008 OR you did NOT
° If the USe test and OWﬂefShlp tQStS meet the minimum ownership requirements to exclude repayment of the credit.

were met and the taxpayer is eligible S
for the Maximum Exclusion, check the
box (reduced maximum exclusion is

out of scope —refer to a professional) - -

e Click continue —

Check here if you qualify for the Maximum Exclusion or the Reduced Maximum Exclusion.
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Capital Gains or Losses Sale of Main Home
(continued)

Adjustments

Fees you may have paid when you bought your home
Legal fees

Surveys

Title Insurance

Fees that the seller owed that you agreed to pay

Other fees

General Adjustments

Selling expenses

Cost of additions and improvements that you made to your home

Tax assessments that you paid for sidewalks, streets, and other local improvements
Other increases to your basis

Decreases to your basis

If no 1099-S was received, and any gain can
be excluded, you don’t have to report the Sale
of Main Home

If the sale must be reported and results in a
gain, it will be listed on the appropriate F8949
(basis type C or F.) The gain will be included
with the other capital gains and losses on
Schedule D

Enter the fees from the purchase of the home
that weren't included in the purchase price
already entered

Enter the selling expenses, cost of
improvements and other increases or
decreases to the basis of the home

This will calculate the adjusted basis of the
home, which will be shown on Form 8949

The information will carry to Form 8949 and
Schedule D.

If you've checked the box to exclude the entire
gain, Form 8949 will show the adjustment as a
negative number in the amount of the net gain,
with adjustment code H and basis type F and
no net gain/loss.

If the sale resulted in a gain but wasn't eligible
for the exclusion, it will be reported on the
appropriate Form 8949 as a gain.

Adjustment, if any, to gain or loss.

(e) If you enter an amount in column (g), h)
b (0) (d) Cost or other basis. enter a code in column (f). Gain or (loss).
Descrinti (a)f " Dat b 4| Datesoldor Proceeds See the Note below| See the separate instructions. [ sybtract column ()
E escrl|p. |1oonoo hpr)c(:\;(:; (%/ I\j N adcquwe disposed of (sales price) and see Column (e) from column (d) and
(Example: sh- o) Mo., day, yr.) (Mo., day, yr.) | (see instructions) in the separate ) (9) combine the result
instructions  |Code(s) from Amount of with column (g)
instructions adjustment
10 SHARES LONGF 01/11/2008 | 01/10/2015 150 250 -100
MAIN HOME 03/03/2010 | 12/12/2015 195000 123800 H -71200
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Capital Gains or Losses Sale of Main Home
(continued)

Description of Property

Date Acquired
* Alternate Option: If Date Acquired is not known, leave the date blank and

select an option here

Date Sold
* Alternate Option:

Check here if a short sale
Sales Price

* Alternate Option: If Sale Price is Expired, leave the sales price blank and select

an option here

Select cost basis type
Cost

* Alternate Option: If Cost is Expired, leave the cost blank and select an option

here

Enter any necessary adjustments to Gain or Loss

NOTE: If this entry is to be shown as a loss, please enter a negative sign before the number

If you entered an adjustment amount above, please select the adjustment explanation

Main Home
2 3 v | 2010
B T 4 v || 2015
$ 190000

Did not receive Form 1099

$203800

$13800

Nondeductible loss other th

v

If the sale is a loss but must be reported because Form 1099-S was received:

Loss on the sale of a main home can’t be deducted;
TO REPORT THE SALE, YOU MUST ENTER THE
SALE AS A CAPITAL GAIN OR LOSS ITEM:
e You can use the Sale of Main Home worksheet
to assist you in determining the basis, but the
information will NOT carry to Form 8949
e Add a new Capital Gain or Loss Item
e Enter the dates, sales price and basis amount
e The basis type will be “Did not receive Form 1099-

Bn

e Enter an adjustment in the amount of the loss as a

positive number

e Select the adjustment reason as “nondeductible
loss other than a wash sale” which will show as

adjustment code L

Is this a Collectible Exchange? Check if 'YES'
Adjustment, if any, to gain or loss.
) If you enter an amount in column (g), (h)
@) ®) () (d) Cost or other basis. enter a code in column (f). Gain or (loss).
Desoribtior, of bropert Date acaquired | D2te sold or Proceeds See the Note below| See the separate instructions. | sybtract column (g)
{Exam I; 100 shp X\F()Z (%/o) Mo d:‘ r) disposed of (sales price) and see Column (e) from column (d) and
pie: ’ ’ - CaY yr. (Mo., day, yr.) | (see instructions) in the separate (f) 9) combine the result
instructions  [Code(s) from Amount of with column (g)
instructions adjustment
10 SHARES LONGF 01/11/2008 | 01/10/2015 150 250 -100
MAIN HOME 02/03/2010 | 09/04/2015 190000 203800 L 13800
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Other Income

Detailed information for each income type found on subsequent pages.

Use Other Inc. Not Reported Elsewhere to enter

amounts from:

e Form 1099-MISC Box 3 (Other Income), or Box 7
(hobby income) or Box 8 (Substitute payments in
lieu of dividends or interest.)

e Jury Duty Pay

e Alaska Permanent Fund Dividend

e Gambling winnings not reported on a Form W-2
(use the description “Gambling Winnings”)

e QOther income not entered elsewhere on the return

Gambling winnings are reported to the
taxpayer on Form W-2G and are fully

taxable and must be reported as income
on the tax return. Gambling Losses up to
the amount of winnings reported may be Less Commeon Income
deducted as a Miscellaneous deduction,
not subject to the 2% limit on Schedule A. \ Gtherine;Tiet Reported Hiscwhere

Gambling Winnings (W-2G)

Use the Other Compensation menu to

report scholarships and grants, taxable Other Compensation
fringe benefits, household employee
inCOme, priSOner earned inCOme and ’ Payments from Qualified Education Programs (Form 1099-Q)

foreign compensation.

Cancellation of Debt (1099-C, Form 982)

Taxable distributions from Coverdell

Education SaVingS ACCOUFItS (ESAS), /Ins[alment Sale Income (Form 6252)
Qualified Tuition Programs (QTPs) or
Achieving a Better Life Experience (ABLE)
accounts are out of scope.

Sale of Business Property (Form 4797)

K-1 Earnings

Cance//ation Of Debt from a Credit Card Gains and Losses From Section 1256 (Form 6781)
or Primary Mortgage Forgiveness are :

in SCOpe fOI’ preparers Wlth advance Foreign Earned Income Exclusion (Form 2555)
certifications. A

EDIT

The K-1 Earnings menu allows you to enter
all items of income, deductions, etc. that
were reported to your client on Form K-1
from either a partnership (Form 1065),
S-Corporation (Form 1120S) , or trust

(Form 1041). Enter the amounts from the In scope ONLY for those with International
K-1 in the spaces provided exactly as they Certification: United States Citizens and
appear on your client’s paper K-1. resident aliens who live and work abroad

may be able to exclude all or part of

their foreign salary or wages from their
income when filing their U.S. federal tax
return. They may also qualify to exclude
compensation for their personal services or
certain foreign housing costs.
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Entering Other Compensation in TaxSlayer®

Scholarships and grants used to pay

for tuition, fees and course-related
expenses are NOT taxable. Use this link
to report only amounts that were used
for non-qualifying expenses. “SCH” will
appear on the dotted line next to line

7 on Form 1040. Taxable scholarship is
considered “unearned” income.

Enter wages received as a household
employee for which the taxpayer did

not receive a Form W-2 because the
employer paid less than $1,900 in 2016.
“HSH” will appear on the dotted line next
to line 7 on Form 1040.

Enter the amount received for work
while an inmate in a penal institution.
For purposes of the Earned Income
Credit, this isn’t considered “earned”
income. This includes amounts received
for work performed while in a work
release program or while in a halfway
house. “PRI” will appear on the dotted
line next to line 7 on Form 1040. This_
entry is made in addition to entering the
Form W-2 from the penal institution.

Other Compensation

Scholarships and Grants

Fringe Benefits

Household Employee Income
Prisoner Earned Income

/

Foreign Earned Compensation

/

/3

Enter Household Employee Income
Owner

® Mr Taxpayer

etc.) paid by a foreign employer for work

country.

Enter foreign earned income (wages, salaries,

performed while the taxpayer lived in a foreign

Mrs Taxpayer

Amount Paid

4

|

spouse.

When entering compensation on a joint return, be careful to
indicate whether the income belonged to the taxpayer or the

Entering Medicaid Waiver Payments

Scenario A:

If income is reported on Form W-2 (and payer will not
change), enter the Form W-2 as provided. Then, go to
line 21>0ther income not reported elsewhere>enter
Notice 2014-7 in the description field and the amount

as a negative number. Then, go to Other Income>Other
Compensation and enter the income as Medicaid Waiver
wages. This will remove the income from EIC and other

Scenario B:

If income is reported on

a Form 1099-MISC, go to
line 21>0ther income not
reported elsewhere>enter
Notice 2014-7 in the
description field and $0 in
the amount field.

credit calculations as necessary. (Note: At the time this
publication was finalized, this line was not available in
the Practice Lab. To prepare a return with this scenario in
the Practice Lab, enter the amount as Prisoner Earned

Income, which will have the same effect.)

12/2016

Scenario C:

If income is reported on a
Form 1099-MISC and you are
in the business of providing
home care services, enter
the full amount of payments
under Gross Receipts in
the Schedule C Income
section. In Other Expenses,
enter Notice 2014-7 as the
description and the amount
as a positive number.
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/‘*"”— Publication 4731
| ' Screening Sheet for Nonbusiness Credit Card Debt @
= Cancellation RS

~

ufl (B

If the taxpayer is in bankruptcy, the tax return is out of scope for the VITA/TCE Programs.

Instructions: Use this Screening Sheet for taxpayers with Form 1099-C resulting from cancellation of nonbusiness
credit card debt and to assist in identifying taxpayers with cancellation of credit card debt issues.

Credit Card Debt

step

(1)

Did the taxpayer receive Form 1099-C, Cancellation of Debt, or other documenta- YES — Go to Step 2
tion (if less than $600) from a creditor and is the information shown on the form or NO — Go to Step 6
document correct?

Note: The creditor is not required to issue a Form 1099-C if the canceled debt is
under $600. However, the taxpayer may be required to report the canceled debt as
income regardless of the amount.

step  \Was the credit card debt related to a business? YES - Go to Step 6
NO — Go to Step 3
step  Does box 3 of Form 1099-C show any interest or was box 6 checked to indicate YES — Go to Step 6
PG EE NO — Go to Step 4
Note: If the bankruptcy box is not checked but the taxpayer has subsequently filed
bankruptcy, answer “yes.”
step  Was the taxpayer insolvent immediately before the cancellation of debt? YES — Go to Step 6

Use the Insolvency Determination Worksheet in Publication 4012 and interview the =~ NO — Go to Step 5
taxpayer to determine if the taxpayer was insolvent immediately before the cancel-
lation of debt.

step

The cancellation of nonbusiness indebtedness or cancellation of debt (the amount in box 2 of Form 1099-C
or an amount less than $600 provided in other documentation) must be reported as ordinary income on Form
1040, line 21 (Other Income). No additional supporting forms or schedules are required for reporting income
from canceled credit card debt.

step

This tax issue is outside the scope of the volunteer programs. The taxpayer may qualify to exclude all or
some of the discharged debt. However, the rules involved are complex.

Refer the taxpayer to:

* www.irs.gov for the most up-to-date information.

» The Taxpayer Advocate Service (TAS): 1-877-777-4778, TTY/TDD 1-800-829-4059. TAS may help if the
problem cannot be resolved through normal IRS channels.

» A professional tax preparer.

Publication 4731 (Rev. 10-2015) Catalog Number 52643X Department of the Treasury Internal Revenue Service www.irs.gov
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é &A@ Insolvency Determination Worksheet
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IRS

Assets (FMV)

Liabilities

Homes $ Mortgages

Cars Home equity loans
Recreational vehicles, etc. Vehicle loans

Bank accounts Personal signature loans
IRAs, 401Ks, etc. Credit card debts

Jewelry Past-due mortgage interest, real
Furniture estate taxes, utilities, and child
Clothes care costs

Misc. Student loans

Olrer e B Other liabilities

Total Assets: $ Total Liabilities:

(Negative amount equals insolvency)
(Positive amount equals solvency)

Total Assets minus Total Liabilities = $

2
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Entering Cancellation of Credit Card Debt in

Generally, if a debt for which a
taxpayer is personally liable is
canceled or forgiven, the taxpayer
must include the canceled amount in
income.

Caution: Be sure to ask if the
taxpayer was insolvent or in
bankruptcy — these situations makes
the return out of scope.

Cancellation of Credit Card Debt and
Forgiveness of Qualified Principal
Residence Indebtedness is within
the scope of the volunteer program.

If the taxpayer has another type of
debt forgiven, or may have been
insolvent at the time of the debt
forgiveness, the taxpayer should be
referred to a professional.

TaxSlayer®

Cancellation of Debts

Cancellation of Debt (Form 1099-C)

Exclusions (Form 982}

Form 1099-C

Taxpayer or Spouse?

Mr Taxpayer

Mrs Taxpayer
Creditor's name

Creditor's federal identification number

Amount of debt cancelled

Enter the information from the Form
1099-C.

Be sure to indicate whether the
cancelled debt was for the taxpayer
or the spouse.

If the Form 1099-C was for mortgage
forgiven on the taxpayer’s main
home, see the next section on
Discharge of Qualified Principal
Residence Indebtedness, on the next

page.
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Discharge of Qualified Principal Residence
Indebtedness

Use the job aid on on the following page to determine if the debt forgiveness on the main home is
within scope.

Taxpayers may exclude from income certain debt forgiven or canceled on their principal residence.
This exclusion is applicable to the discharge of “qualified principal residence indebtedness.” If the
canceled debt qualifies for exclusion from gross income, the debtor may be required to reduce tax
attributes (certain credits, losses, and basis of assets) by the amount excluded.

If a property was taken by the lender (foreclosure) or given up by the borrower (abandonment), the
lender usually sends the taxpayer Form 1099-A, Acquisition or Abandonment of Secured Property.
Form 1099-A will have information needed to determine the gain or loss due to the foreclosure or
abandonment.

If the debt is canceled, the taxpayer will receive Form 1099-C, Cancellation of Debt. If foreclosure/
abandonment and debt cancellation occur in the same calendar year, the lender may issue only
Form 1099-C, including the information that would be reported on Form 1099-A.

Volunteers may assist taxpayers who meet the following requirements:

The home was never used in a business or as rental property

+ The debt was not canceled because the taxpayer filed bankruptcy

+ The taxpayer isn’t in bankruptcy when he/she comes to the site for assistance

« Form 1099-C doesn’t include an amount for interest

+ The debt must be a mortgage used only to buy, build, or substantially improve the taxpayer’s
primary residence, i.e., this money was not used to pay off credit cards, medical/dental
expenses, vacations, etc.

+ The mortgage was secured by the taxpayer’s primary residence

« The mortgage was not more than $2 million ($1 million if Married Filing Separately)

TaxSlayer® Hint: To exclude debt forgiven on principal residence, go to Other Income, Cancellation
of Debt then Exclusions (Form 982).

Note 1: Form 1099-C, Box 3 (Interest if included in Box 2, Amount of Debt Canceled) and Box 16
out-of-scope.

Note 2: If a bankruptcy, out-of-scope.

Note 3: If personally liable for the debt, sales price is the lesser of balance of principal outstanding
(Form 1099-A, box 2) or fair market (Form 1099-A, box 4); if not personally liable on the debt, sales
price is the balance or principal outstanding.
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Publication 4731-A

Cancellation of Debt

Screening Sheet for Foreclosures/Abandonments and

If the taxpayer is in bankruptcy, the tax return is out of scope for the VITA/TCE Programs.

~

A

IRS

N
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Instructions: Use this Screening Sheet to assist taxpayers with Form(s) 1099-A and/or 1099-C with cancellation of
debt issues.

» Use Part | for taxpayers with Form 1099-A for a foreclosure or abandonment of their principal residence.

» Use Part Il for taxpayers with Form 1099-C, and/or Forms 1099-A and 1099-C resulting from cancellation of debt on
a home mortgage loan.

» Use Publication 4731 for taxpayers with Form 1099-C resulting from cancellation of credit card debt.

Part | - Home Mortgage Loan

Did the taxpayer receive Form 1099-A, Acquisition or
Abandonment of Secured Property, from their home mortgage
lender?

YES - Go to Step 2

NO - Advise the taxpayer to get the docu-
mentation from the home mortgage lender.

Did the taxpayer ever use the home in a trade or business or
as rental property?

YES — Go to Step 6
NO - Go to Step 3

step

Is box 5 of Form 1099-A checked indicating a recourse loan in
which the taxpayer is personally liable?

YES — The sales price is the lesser of box
2 (Balance of principal outstanding) or box
4 (Fair Market Value of Property) on Form
1099-A.

NO — The sales price is the amount in box 2
(Balance of principal outstanding) on Form
1099-A. The taxpayer is not personally liable
(non-recourse loan).

Ask the taxpayer for the cost or basis of the home.

Refer to Publication 523, Selling your Home, for further infor-
mation, if needed.

Report the sale of the personal residence on Form 8949 and
Schedule D.

If the disposition of the property results in a:

Gain — The taxpayer may qualify for the Section 121 exclusion
($250,000 or $500,000 if Married Filing Jointly) for a gain on
the sale of a principal residence, if all requirements are met.
Loss — The taxpayer cannot claim a loss on the sale or dispo-
sition of a principal residence.

Refer to Publication 4012 (Tab D), “Entering Forgiveness of

Qualified Principal Residence Indebtedness” for further
information.

step

These tax issues are outside the scope of the volunteer
program.

Refer the taxpayer to:

» www.irs.gov for the most up-to-date information.

» The Taxpayer Advocate Service (TAS): 1-877-777-4778,
TTY/TDD 1-800-829-4059. TAS may help if the problem
cannot be resolved through normal IRS channels.

» A professional tax preparer.

Additional Resources:

* Publication 523, Selling your Home

¢ Publication 525, Taxable and Nontaxable
Income

* Publication 4681, Canceled Debts,
Foreclosures, Repossessions, and
Abandonments

/

Publication 4731-A (12-2016) Catalog Number 67470W Department of the Treasury Internal Revenue Service www.irs.gov
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K Publication 4731-A
é ". Screening Sheet for Foreclosures/Abandonments and
wy— Cancellation of Debt
udfl (M

If the taxpayer is in bankruptcy, the tax return is out of scope for the VITA/TCE Programs.

A

IRS

~

Instructions: Use this Screening Sheet to assist taxpayers with Form(s) 1099-A and/or 1099-C with cancellation of
debt issues.
» Use Part | for taxpayers with Form 1099-A for a foreclosure or abandonment of their principal residence.

» Use Part Il for taxpayers with Form 1099-C, and/or Forms 1099-A and 1099-C resulting from cancellation of debt on
a home mortgage loan.

» Use Publication 4731 for taxpayers with Form 1099-C resulting from cancellation of credit card debt.

Part Il - Home Mortgage Loan

step

1)

Did the taxpayer receive Form 1099-C, Cancellation of Debt, from their home
mortgage lender and is the information shown on the form correct?

Note: Answer “yes” if the taxpayer has received a Form 1099-A and Form
1099-C.

YES — Go to Step 2
NO - Go to Step 6

Did the taxpayer ever use the home in a trade or business or as rental
property?

YES — Go to Step 6
NO — Go to Step 3

[0] (0]
kel ke]

Does box 3 of Form 1099-C show any interest or does box 6 show code A
indicating bankruptcy?

Note: If box 6 is not marked with code A but the taxpayer has subsequently
filed bankruptcy, answer “yes.”

YES — Go to Step 6
NO - Go to Step 4

N

step  Ask the following questions to determine if the discharged debt is “qualified a. YES - Go to Step 4b
principal residence indebtedness:” NO - Go to Step 6
a. Was the mortgage taken out to buy, build, or substantially improve the
taxpayer’s principal residence? (Note: A principal residence is generally the b. YES — Go to Step 4c
home where the taxpayer lives most of the time. A taxpayer can have only NO — Go to Step 6
one principal residence at any one time.)
b. Was the mortgage secured by the taxpayer’s principal residence? c. YES — Go to Step 6
c. Was any part of the mortgage used to pay off credit cards, purchase a car, NO - Go to Step 4d
pay for tuition, pay for a vacation, pay medical/dental expenses, or used
for any other purpose other than to buy, build, or substantially improve the d. YES — Go to Step 6
principal residence? NO — Go to Step 5
d. Was the mortgage amount more than $2 million ($1 million if Married Filing
Separately)?
step  The discharged debt is “qualified principal residence indebtedness.”
The Mortgage Forgiveness Debt Relief Act of 2007 allows for the exclusion of discharged qualified principal
residence indebtedness canceled in 2007, 2008, and 2009; the Emergency Economic Stabilization Act of 2008
extended the exclusion for tax years 2010 through 2012; the American Taxpayer Relief Act of 2012 extended the
exclusion to 12/31/2013; and, the Tax Increase Prevention Act of 2014 extended the exclusion to 12/31/2014. The
Protecting Americans from Tax Hikes Act of 2015 (PATH Act) extended the exclusion through 2016.
The volunteer should complete the applicable lines on Form 982, and file it with the taxpayer’s return. If the
residence was disposed of, the taxpayer also may be required to report the disposition (sale) on Form 8949 and
Schedule D.
step  These tax issues are outside the scope of the volunteer Additional Resources:

program. The taxpayer may qualify to exclude all or some of the . pypilication 523, Selling your Home

discharged debt. However, the rules involved in the mortgage
debt relief exclusions are complex.

Refer the taxpayer to: Repossessions, and Abandonments
* www.irs.gov for the most up-to-date information. « Publication 4705, Overview of Mortgage Debt
» The Taxpayer Advocate Service (TAS): 1-877-777-4778, Forgiveness

TTY/TDD 1-800-829-4059. TAS may help if the problem + Form 982, Reduction of Tax Attributes Due to

cannot be resolved through normal IRS channels.

* Publication 525, Taxable and Nontaxable Income
* Publication 4681, Canceled Debts, Foreclosures,

Discharge of Indebtedness (and Section 1082

» A professional tax preparer. Basis Adjustment) and Instructions

/

Publication 4731-A (12-2016) Catalog Number 67470W Department of the Treasury Internal Revenue Service www.irs.gov
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Entering Forgiveness of Qualified Principal
Residence Indebtedness

Reduction of Tax Attributes

Part I; General Information

Part Il: Reduction of Tax Attributes

Enter amount excluded from gross incone:

Bavy passive activity kass adit canyom %
Ay Toreign tas oot £arryo %

Part Ill: Consent of Corporation to Adjustment of Basis of its Property Under Section 1082(a)(2]

Aot dncdludied undi tiani 1081141 o gi 5
Tax yaar baginning MM | DD - YYYY L
MM | DD - YYYY L

Statw of incorparation - Plaase Sel=ot -
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Use the job aid on the preceding pages to determine if
the debt forgiveness on the main home is within scope.

Form 982, Reduction of Tax Attributes Due to
Discharge of Indebtedness, must be filed with the
taxpayer’s return to report the excluded amount of
discharged indebtedness and the reduction of certain
tax attributes:

e Indicate whether the Form 1099-C was issued to
the taxpayer or spouse

e Check the box for Discharge of qualified principal
residence indebtedness

e Enter the amount of primary mortgage debt
cancelled (Form 1099-C Box 2)

e Ifthe taxpayer had a portion of the mortgage debt
cancelled but kept the home (loan modification or
mortgage workout),

e Enter the amount of debt cancelled in Part
I, Reduction of Tax Attributes, on the line for
“Applied to reduce the basis of your principal
residence.” [there doesn’t currently seem to be a
line corresponding to line 10b of Form 982, but
an entry made on this line appears on line 10 of
Form 982 when the return is printed.]

e Ifthe taxpayer disposed of the home due to
foreclosure or Abandonment, and the lender
cancelled the remaining mortgage debt:

e No entry is made in Part Il, Reduction of Tax
Attributes

e Report the gain or loss from Form 1099-A in the
Sch D/Capital Gains section

e The basis is the taxpayer’s adjusted basis in the
home

e The sale price (amount realized) is based
on whether the taxpayer is personally liable
(recourse loan) or not personally liable
(nonrecourse loan) for the debt:

e [f the taxpayer is personally liable, the sale
price is the lesser of the balance of the
principal mortgage debt outstanding or the
fair market value

e [fthe taxpayer isn’t personally liable, then
the sale price is the full amount of the
outstanding debt, as reflected on Form 1099-
A

e For both recourse and nonrecourse loans,
add any proceeds the taxpayer received from
the foreclosure sale to the amount realized.

e [f the taxpayer ends up with a gain on the sale,
some or all of the gain can be excluded under
the rules for sale of main home, if the taxpayer
qualifies

e A loss on the main home can’t be deducted




Entering K-1 Information in TaxSlayer®

Schedule K-1
Schedule K-1 {Form 1065)

A
The taxpayer’s Schedule K-1 Schedule K-1 {11205) -
may come from a Form 1065 ”
(partnership), Form 1120S (S-corp) ™ schedule k-1 (1041) -
or Form 1041 (estate.) Be careful to
choose the nght form. Schedule E (Page 2) Question

This situation would be out of scope.

Schedule E (Page 2) Question

Check here if you are reporting losses not allowed in prior years due to the at-risk or basis limitations, passive

losses not reported on Form 8582, or unreimbursed partnership expenses
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Entering K-1 Information in TaxSlayer® (continued)

Income from K-1 requires the Advanced certification level.
Enter all items as indicated on the taxpayer’s K-1.

Be sure to indicate whether the income is attributable to
taxpayer or spouse.

Most in-scope K-1s will be from a Passive Entity, and the
taxpayer’s investment will be at risk. Be sure to check
these boxes if applicable —TaxSlayer® may give you a
warning if the At-Risk box is left blank.

\L,

Form 1120S K-1
Part Il - Information About the Shareholder

S-Corporation belongs to.
Mr Taxpayer
Mrs Taxpayer

Part | - Information About the S-Corporation

S-Corporatien’s Name

S-Corporation’s EIN Number
Check here if forsign address

Address (Nurmber and Strest)
Zip Code

City, Tewn. or Post Office
State

- Please Select - i

Check the box if.

This &-1 is from a Passive Entity.

\

All Investment is At-Rizk

Entire Interest in Investment has been disposed,

PTP Prior Year Unallowed Loss

There is an amount on line 2 of the K-1 and this is a NonPassive Entity and you Msaterially Participate.

There is an amount on line 2 of the K-1 and you Actively Participate,

Income reported on Schedule K-1 that is within the scope
of the VITA/TCE programs includes:

e Interest income (flows to 1040, line 8a)

e Dividend income (1040, line 9a)

e Qualified Dividends income (1040, line 9b)

e Net short-term capital gains and losses (Schedule D,
line 5)

e Net long-term capital gains and losses (Schedule D,
line 12)

e Tax-exempt interest income (Form 1040, line 8b)

e Royalty income (Schedule E)

If the K-1 includes any deductions, expenses, credits, or
other items not listed above, the return is out of scope

D-54

Form 1120S K-1

Actively Managed Passive Loss Carryover
Disposition Gain/Loss
Other Passive Loss Carryover

Carry Gain/Loss to

1 Ordinary Business Income {Loss) $
2 Net Rental Real Estate Income (Loss) $
3 Other Net Rental Income (Loss) $
4 Interest Income $
Ba Ordinary Dividends $
5b Qualified Dividends $
6 Royalties $

Part Il - Shareholder's Share of Current Year Income, Deductions, Credits etc.

k
$
$
Form 4797 v
7 Net Short-Term Capital Gain {Loss) $
8a Net Long-Term Capital Gain (Loss) $
8b Collectibles (28%) Gain (Loss) $
8c Unrecaptured section 1250 Gain $
9 Net Section 1231 Gain (Loss) $

Check if the Section 1231 Gain(Loss) is Passive

11 Section 179 Deduction $




Entering Rental Income in TaxSlayer®

Volunteers must certify at Military level to prepare Schedule E for rental income.

Schedule E Required Information

Check here if you made any payments in 2016 that would require you to file Form(s) 1099.

\

If the taxpayer made any payments
that would require them to file Form
1099, the return is out of scope.

Schedule E Rent and Royalty Information

Type --Select-- r

Description
Address
Check here if foreign address

Address (Number and Street)

Enter the required information about
the rental property in this section.

Zip Code

City, Town, or Post Office

State

- Please Select - r
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Entering Rental Income in TaxSlayer® (continued)

Check here if taxpayer had any
days of personal use, and enter
the number of days here.

AN

Enter the total rental

¥

Percent of ownership

Check if persanal use

Rental payments received

Refunds, Returns and Allowances

Enter the number of days the property was rented at fair rental value

Enter the number of days the property was used for personal purposes

Check here if you are you a member of a Qualified Joint Venture

payments received for the

Enter number of days
rented at fair rental value.

» / tax year.

¥

Check here if the taxpayer actively participated.

Check if you actively participated <€

Check here if you are a real estate professional or sold or disposed of the property this year

(This will allow ALL losses)

A rental loss will not appear on Form 1040,
unless the taxpayer actively participated.

\

Use Schedule E to report rental income only
when taxpayer is not in the business of renting
property. If in the business, return is out of scope.
Refer taxpayers who are in the business of
renting properties to a professional tax preparer.

Click here to edit the physical address, type of
property, and to report the number of fair rental

Schedule E Rentals and Royalties

Currently Editing: House

Rent and Royalty Basic Information

and personal use days.

Depreciation

Clicking here will complete Form
4562. If Form 4562 is required,
the tax return is out of scope.

Click here to enter

> - _—"| rental expenses.

Expenses

Car and Truck Expenses

Click here to enter
—"| vehicle expenses.

D-56
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Entering Rental Income in TaxSlayer® (continued)

Advertising

Travel

Cleaning

Commission

Insurance

Legal Fees

Management Fees

Mortgage Interest

Other Interest

Repairs

Supplies

Taxes

Utilities

Schedule E Rental/Royalty Expense

Additional Expenses
Prior Unallowed Loss

Amount to Adjust Depreciation Expense or Depletion

Enter taxpayer-provided
depreciation amount here
as a positive number.

Caution: If the rental property has both personal and rental use days, you must manually compute
the percentage to use on the rental expenses. For example if the house is rented half the year and
you paid $4,000 for Mortgage Interest, you have to manually input $2,000 on the Mortgage Interest

line.

12/2016
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Entering Foreign Earned Income Exclusion
Information in TaxSlayer® (International
Certification only)

Form 2555 General Information
Form belongs to:

I Taxpayer

Mrs Taxpayer

Your Foreign Address

Address (Mumber and Street)

City. Town, or Post Office

Foreign State or Province Foreign Country

- Please Select -

Foreign Postsl Code

Occupation

Ermployer's Mame

Employer's US Address

Addrezs (Mumber and Straet]

Zip Code

City, Town, or Post Office

State

- Please Select -

D-58

U.S. citizens and U.S. resident aliens are
required to report worldwide income on a
U.S. tax return.

However, certain taxpayers can exclude
income earned while living in foreign
countries.

To claim the foreign earned income

exclusion, taxpayers must:

¢ Demonstrate that their tax home is in a
foreign country

* Meet either the bona fide residence test
or the physical presence test

e Have income that qualifies as foreign
earned income (reported on Form 1040,
line 7 as taxable wages or on line 12 as
self-employment income.)

The foreign earned income exclusion doesn’t
apply to wages and salaries of U.S. military
members and civilian employees of the U.S.
government.

If the taxpayer qualifies to exclude foreign
earned income, the excludable amount will
be reported as a negative amount on Form
1040, line 21.

For 2016, the maximum exclusion is
$100,800.

You can’t exclude or deduct more than the
taxpayer’s foreign earned income for the
year.



Entering Foreign Earned Income Exclusion
Information in TaxSlayer® (International
Certification only) (continued)

Employer's Foreign Address

Address [Mumber and Street]
Post Office

Fareign State =r Frovines 3 Ery
- Please Select -

Employer is:
A Fareign Enfity

4 U5, Campany

Foreign Affiliste of U.5. Company
Other

eck here if you have filed Form 2566 since 1982

Year you last filed & 2555 - Please Select -
hars if you h k ancalled) sithar of the suclusiz:

Fevocation Type - Please Select -

Few - Please Select -

of - Please Select -

Check here if you maintained & separate foreign residence because of adverse living conditions at yaur tax hame.

Tax home #1

Date Established:

Tax home #2
Descrip

M oo Y
D Establishi

Enter information for the taxpayer’s tax

home. The tax home is the taxpayer’s reqular
or principal place of business, employment, or
post of duty, regardless of where the taxpayer
maintains a family residence. A taxpayer may
have more than one tax home during the year.
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Entering Foreign Earned Income Exclusion
Information in TaxSlayer® (International
Certification only) (continued)

Form 2555 Qualifying Test
Taxpayer qualifies under:

Physical Presence Test

Bona Fide Residence Test

To meet the period of stay requirement,
the taxpayer must be either:

e A U.S. citizen or U.S. resident
alien from a tax treaty country
who is a bona fide resident of a
foreign country (or countries) for an
uninterrupted period that includes an
entire tax year, or

e A U.S. citizen or U.S. resident alien
who is physically present in a
foreign country or countries for at
least 330 full days during any period
of 12 consecutive months

Form 2555 Physical Presence Test

Physical Presence Test Based on 12-Month Period
From

Ending

Your Principal Country of Employment During 2015
Check here if there is no travel to report during the period

Country One

Name of Country Including U.S.
Date Arrived

Date Left

Days in Country
Days in US.

Income Earned

<

AN\

MM Y DD Y| YYYY

<

MM Y| DD Y| YYYY

Total Days: 0

<

- Please Select -

- Please Select - v

MM v DD | YYYY v

MM v DD v| YYYY v

Total Days: 0

EREAN

The 12-month period on which the
physical presence test is based must
include 365 days, part of which must be
in 2015. The dates may begin or end in a
calendar year other than 2015

To figure 330 full days, add all separate
periods you were present in a foreign
country during the 12-month period

If the taxpayer left the principal country of
residence during the tax year, enter the
information requested for each additional
country he or she visited.

Days in the United States are entered in
a separate field.

If no money was earned in the country to
which the taxpayer travelled, enter $0.

If more than one additional country was
visited, click Add Country.

Click “Clear” if the taxpayer did not visit
any other countries during their time
abroad.
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Entering Foreign Earned Income Exclusion
Information in TaxSlayer® (International
Certification only) (continued)

Bona Fide Residence Test

To meet the bona fide residence test, taxpayers
must show that they have set up permanent
quarters in a foreign country for an entire,

Form 2555 Bona Fide Residence Test uninterrupted tax year. Simply going to another
country to work for a year or more isn’t enough to
meet the bona fide residence test. A taxpayer must
establish a residence in the foreign country.

Date Bona Fide Residence

EBegan MM -||DD -

3 3

Ended MM - (| DD -

Check here if residency end date exceeds 12/31/2016

Kind of Living Cuarters in Foreign Country

Purchased House

If the taxpayer was present in the United States

or its possessions during the tax year, enter the

information for each trip.

e To add another trip, click Add New

e [f the taxpayer did not visit the US or its
possessions during the year, click CLEAR to
remove this item

List any contractusl terms or conditions relating to the length of employment sbroad Don’t include income earned Wh”e ,'n the United
States in the amount of foreign earned income to be
< foreign country excluded (next page.)

heck hers if your Visa limited the length of your stay or employment in & fereign country

Check here if you maintained & home in the U.S. while abroad

f the home was a rental enter the occupant information here

Occupant Hemes

Cccupant Relationship MNone

A brief trip to the U.S. will not prevent the taxpayer
from being a bona fide resident, as long as the
intention to return to the foreign country is clear.
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Entering Foreign Earned Income Exclusion
Information in TaxSlayer® (International
Certification only) (continued)

Form 2555 Foreign Earned Income

Income Information

s this i only ecluding ncomi. You musl stil
or within the Diher Incoene Mol Reported

Moncash income {market value of property or facilities furnished by employer)
Horna |Lod '] %

¥

E]

Ty o Faclities $

Allowances, reimbursements, or expenses paid on your behalf

Other Information

Enter the income the taxpayer earned during the
2016 tax year for services performed in a foreign
country. This income should already have been
entered on the tax return as wages, foreign
compensation, or self-employment income.
Amounts paid by the United States or its
agencies to its employees don'’t qualify for the
exclusion.
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Entering Foreign Earned Income Exclusion
Information in TaxSlayer® (International
Certification only) (continued)

Enter the number of days in your qualifying period that fall within your 2016 tax year. Your
qualifying period is the period during which you meet the tax home test and either the
bona fide residence or the physical presence test.

Form 2555 Housing/Foreign Income Exclusion

Number of days in your qualifying period that fall within your 2015 tax year

Check here if you are claiming the Housing Exclusion or Deduction

Enter the total amount of those deductions (such as the deduction for moving expenses,
the deductible part of self-employment tax, and the expenses claimed on Schedule C
or C-EZ (Form 1040)) that are not allowed because they are allocable to the excluded
income.

D-63



Notes

D-64



Adjustments to Income

Adjustments

Medical Savings Account {Form 8853)

Educator Expenses

Expenses for Reservists, Performing Artists, and Qualifying Government Employees

Health Savings Account (Form B889)

hoving Expenses (Form 3903)

Contributions to SEP, Simple, and Qualified Plans

Self-Employed Health Insurance

Penalty on Early VWithdrawal of Savings or CD

Alimaony Paid

IRA Deduction

Mondeductible IRAs (Form BE06)

Student Loan Interest Deduction

Health Savings
Account — select to
open Form 8889.
(HSA Certification
required)

Must be Certified for
Military. Check the
box near the top of
the form to indicate
an Armed Forces
PCS move.

Flows over from
input of Form 1099-
INT in Interest
Income.

If the taxpayer paid
alimony to more than
one person, add a
second payee after
entering the first.

Tuition and Fees Deduction

Student Loan
Interest paid is
entered here

Domestic Preduction (Form 8903)

Other Adjustments

j L

See Education
Benefits Tab
for additional
information.

Note: Military reservists who must travel more than 100 miles away from home and stay overnight to attend a
drill or reserve meeting may be able to deduct their travel expenses as an adjustment to income rather than as a

miscellaneous itemized deduction.
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(Educator Expenses

Don'’t rely on this table alone. Refer to Publication 17 for more details.

Question

Answer

What is the maximum benefit?

$250 (If the taxpayer and spouse are both eligible educators, they can
deduct up to $500, but neither can deduct more than their own expenses up
to $250). Taxpayers may be able to deduct expenses that are more than the
limit as a miscellaneous deduction on Schedule A.

Who can claim the expense?

Eligible Educators — an eligible educator is a kindergarten through grade
12 teacher, instructor, counselor, principal, or aide who worked in a school
for at least 900 hours during a school year.

What are qualifying expenses?

Qualifying expenses include ordinary and necessary expenses paid in
connection with books, supplies, equipment (including computer equipment,
software, and services), and other materials used in the classroom.
Additionally, professional development expenses.

What are non qualifying expenses?

Expenses for home schooling or non athletic supplies for courses in health
or physical education.

What other issues apply?

N

Taxpayer must reduce qualified expenses by

e Excludable U.S series EE and | savings bond interest from Form 8815

* Non taxable qualified tuition program earnings or distributions

* Non taxable distribution of earnings from a Coverdell education savings
account

e Any reimbursements received for expenses that weren’t reported on the
Form W-2 /

Note: Professional development expenses include courses related to the curriculum in which the educator provides

instruction.

E-2
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Health Savings Accounts (HSA)

How will you know if the taxpayer has an HSA issue?

¢ The Intake/Interview sheet has the Yes or Unsure HSA box checked.
e The taxpayer’s (or spouse’s) Form W-2 has a box 12 entry of code W for employer contributions. [Caution —
Contributions to an employee’s account through a Section 125 (cafeteria) plan are treated as employer

contributions and aren’t deductible.]

¢ The taxpayer (or spouse) has a Form 1099-SA with an X in box 5 showing distributions from an HSA.
e The taxpayer (or spouse) may receive Form 5498-SA for their HSA contributions. If taxpayers don’t have this
form they can provide the information regarding HSA contributions based on their records

Form 8889 - Health Savings Account

Form belongs to

Coverage under high deductible health plan

HSA Contributions

HSA Contributions you made for 2016
* INCLUDE contributions m
* DO NOT INCLUI

amounts that were

from Jan 1 to Apr 15 of thi t were for 2016.

contributions, contributions thre

cafeteria plan, or

er into your HSAIs)

Number of months during this tax year that you were an eligible individual
Amount you and your employer contributed to your Archer MSAs for 2016 from Form 8853,

lines 3 and 4. If you and your spouse had family coverage under an HDHP at any time during
the tax year, also include any amount contributed to your spouse's Archer MSA

Employer Contributions made to your HSA for 2016

We will automatically pull your employer contributions from your W-2. DO NOT enter amounts

from your W-2.

Qualified HSA Funding Distributions

HSA Distributions
Total distributions received during 2016 from all HSAs.
{Usually shown in Box 1 of Forml(s) 1099-SA)

Distributions used for qualified medical expenses

If you do not enter an amount here your entire distribution will be considered taxable.

Distributions you received in 2016 that you rolled over into another HSA. Also include any

excess contributions fand the eamings on those excess contributions) included above that were
wiithdrawn by the due date of your return

age 65

Check here if you meet any of the exceptions to the 20% tax

—

HSA Adjustments

Limitation - Adjust amount of limitation from worksheet

Note: This amount will adjust 3 calculated amount

Adjust your share of high-deductible heslth plan. If you and your spouse had separate HSAs
AND had family coverage under an HDHP, see Page 4 of the In ns for the amount to
enter.

Note: This amount will adjust a calculated amount.

If you were age 55 or older at the end of the tax year, married, AND you or your spouse had
family coverage under an HDHP at any time during the year, enter your Additional Contribution
Amount.

Note: This amount will adjust s calculatad amount

]

$

$

- Please Select -

$

s

Exceptions - The additional 20% tax does not apply to distributions made after the account beneficiary dies, becomes disabled, or turpis

Select the appropriate (HDHP) coverage for the
taxpayer: self-only or family. This determines the
maximum HSA contribution limits.

Employee contributions are entered here.
Contributions by relatives or friends are considered
to be made by the taxpayer. Don’t include employer
contributions on this line.

The account holder needs to tell you how much was
put in the HSA, because they might not have
received the Form 5498-SA by the time they’re
preparing their tax return.

Enter number of months you had a Health Savings
Account, a high deductible policy and no other
major medical policy (including Medicare) and
could not be claimed as a dependent.

Enter HSA distributions here. Ask the taxpayer for
Form 1099-SA, with the HSA box checked. If not an
HSA distribution, refer the taxpayer to a professional
tax preparer.

Enter amount spent on qualifying medical expenses
not reimbursed by insurance.

\

Age 55 or older, look up “catch

If the taxpayer meets one of exceptions to the 20% additional tax, check this box. The
exceptions are that the account beneficiary dies, becomes disabled, or turns age 65

up” contribution limits in Form
8889 Instructions.

Form 8889 will calculate the amount of excess contributions, if any. Caution: If the
excess isn’t withdrawn by the due date of the return then the return is out-of-scope.

Qualified medical expenses are expenses that generally would qualify for the medical and dental expenses deduction.
Examples include unreimbursed expenses for doctors, dentists, and hospitals.

Only these Insurance premiums can be included: a) long-term care insurance based on premium limits shown in What’s New
tab, b) health care continuation coverage such as coverage under COBRA, c) health care coverage while receiving
unemployment compensation, and d) Medicare and other health care coverage if the taxpayer was 65 or older (other
than premiums for a Medicare supplemental policy, such as Medigap)

A medicine or drug will be a qualified medical expense only if the medicine or drug: a) requires a prescription, b) is available
without a prescription (an over-the-counter medicine or drug) and the taxpayer gets a prescription for it, or c) is insulin.

12/2016
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Publication 4885

idﬁ-:

with HSA issues.

Screening Sheet for Health Savings Accounts (HSA)

NOTE: Only volunteers with Health Savings Account Certification may assist taxpayers

m\
IRS

Instructions: This Screening Sheet will help you identify HSA issues that are within the scope of the VITA/TCE program. Use
the Determine HSA Eligibility section to determine if taxpayer is eligible for an HSA; use Part | for contributions/deduction; use

Part Il for distributions. References: Publication 969, Form 8889 and Instructions

Determine HSA Eligibility (To set up an HSA or make contributions to an HSA)

TO QUALIFY: An individual must meet ALL the following requirements:

» Be covered under a high deductible health plan (HDHP) on the first day of any month of the year.
* Have no other health coverage except for allowable “other health coverage.” (Publication 969, “Other health coverage”)
* Not be claimed as a dependent on someone else’s tax return. (Publication 969, “Qualifying for an HSA”)

* Not be covered by Medicare (but the individual can be HSA eligible for the months before being covered by Medicare)

NOTE: If the taxpayer doesn’t qualify, but contributions have been made to an HSA, the taxpayer should be referred to a

professional tax preparer.

PART | - HSA Contributions and Deduction

step  If eligible, were contributions made to an HSA?
YES — Complete Form 8889, Part, I,
lines 1 and 2. Go to Step 2.
NO - STOP.

step  Was the taxpayer enrolled in the same HDHP coverage for the entire year? YES - Complete Form 8889, Part |,

(Answer Yes, if last-month rule applies, and see Form 8889 Instructions)

Caution: If line 2 is more than line 13, the taxpayer must withdraw the excess
contribution to avoid an additional tax. If the excess is not timely withdrawn, refer the
taxpayer to a professional tax preparer. (Refer to Form 8889 Instructions, line 13).

lines 3-13.

FOR YES AND NO: Lines 4 and 10
are out of scope.

NO — Refer to Form 8889
Instructions for additional information
on completing line 3.

PART Il - HSA Distributions

step  Did the taxpayer receive distributions from the HSA trustee (whether or not YES - Complete Form 8889 Part I,
Form 1099-SA received)? Line 14a, 14b, if applicable, and 14c.
Go to Step 2.
NO — STOP, do not complete Part Il.
step  Did the taxpayer use all or part of the distribution to pay or get reimbursed for YES — Enter the amount on line 15

12/

qualified medical expenses during the year that were incurred after the HSA
was established and were for qualified persons?

and complete line 16. Go to Step 3.

NO — Enter zero on line 15 and
complete line 16. Go to Step 3.

step

©

If any part of the distribution is taxable, was the distribution made after the
taxpayer died, became disabled or turned 65?

-

Publication 4885 (Rev. 10-2016) Catalog Number 55732V Department of the Treasury Internal Revenue Service www.irs.gov
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YES — Check box on line 17a and
complete 17b.

NO — Taxpayer will be subject to an
additional 20% tax.
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Alimony Requirements
(Instruments Executed After 1984)

~

Payments ARE alimony if all of the following are true:

Payments are required by a divorce or separation
instrument.

Payer and recipient spouse don'’t file a joint return with
each other.

Payment is in cash (including checks or money orders).

Payment isn’t designated in the instrument as not
alimony.

Spouses legally separated under a decree of divorce
or separate maintenance aren’t members of the same
household.

Payments aren’t required after death of the recipient
spouse.

Payment isn’t treated as child support.

Payments AREN’T alimony if any of the following are true:

Payments aren’t required by a divorce or separation
instrument.

Payer and recipient spouse file a joint return with each other.

Payment is:

¢ Not in cash,

¢ A noncash property settlement,

* Spouse’s part of community income, or
* To keep up the payer’s property.

Payment is designated in the instrument as not alimony.

Spouses legally separated under a decree of divorce or
separate maintenance are members of the same household.

Payments are required after death of the recipient spouse.

Payment is treated as child support.

These payments are deductible by the payer and
chudible in income by the recipient.

These payments are neither deductible by the payer nor
includible in income by the recipient.

/

IRA Deduction

Note: Taxpayer’'s age must be 70%2 or younger to contribute to a traditional IRA; if married filing
separately, couldn’t have lived together any time during the year. Contributions can be made until the
filing deadline (generally April 15) of the year following the tax year.

Note: compensation for purposes of an IRA contribution includes alimony received.

TaxSlayer® Hint: If the taxpayer made a traditional IRA contribution, select Adjustments from the
Deductions menu, then select IRA deduction, shown below. Don’t enter a Roth IRA contribution
on this screen. Enter it in the Credits section. If eligible, the software will calculate a Retirement
Savings Contributions Credit. Be sure to enter any applicable retirement plan distributions. See the
Nonrefundable Credits tab for more information on this credit.

IRA Deduction

Enter amount of IRA Contribution made by Taxpayer
(Generally this is from a Traditional IRA):

on the navigation bar above after continuing through this page.)

excess contribution amount for the current year.

Taxpayer Retirement Plan

Taxpayer has a retirement plan.

Taxpayer DOES NOT have a retirement plan

(This deduction may be limited. To see the deductible amount, go to the "Summary” tab located

If you entered over 55,500 (56,500 if age 50 or older), visit Form 5329, Part |l to report any

s

If the total of traditional and Roth IRA contributions
exceed the allowable limit, the taxpayer must
withdraw the excess before the filing deadline or a
penalty will apply and the return will be out of scope.

E-5
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Student Loan Interest Deduction at a Glance

Caution: This table is only an overview of the rules. For details, see Publication 17.

Feature

Description

Maximum benefit

You can reduce your income subject to tax by up to $2,500.

Loan qualifications

Your student loan: Taxpayer must be legally liable for the loan.
e must have been taken out solely to pay education expenses, and
e can’t be from a related person or made under a qualified employer plan.

Student qualifications

The student must be:

* you, your spouse, or a person who was your dependent when you took out
the loan, or would’ve been your dependent except you were a dependent, or
had gross income over the exemption amount, or filed MFJ.

* enrolled at least half-time in a program leading to a degree, certificate or
other recognized educational credential.

Time limit on deduction

You can deduct interest paid during the remaining period of your
student loan.

Phaseout

The amount of your deduction depends on your income level.

/

If student loan interest is paid by someone who isn’t legally liable for it, the payment is treated
as received by the person who'’s legally liable, and the person legally liable is allowed to take the

adjustment.
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Exhibit 1 — Standard Deduction for Most People*

This table provides the standard deduction amounts for tax year 2016.

R . Your standard
If the taxpayer’s filing status is... deduction is ...
Single or married filing separate return $6,300
Married filing joint return or qualifying widow(er) with
dependent child $12,600
Head of household $9,300

*Don’t use this chart if the taxpayer was born before January 2, 1952, or is blind, or if someone else
can claim an exemption for the taxpayer (or their spouse if married filing jointly).

N J

o ~
Persons Not Eligible for the Standard

Deduction

Your standard deduction is zero and you should itemize any deductions you have if:

* Your filing status is married filing separately, and your spouse itemizes deductions on his or
her return,

* You are filing a tax return for a short tax year because of a change in your annual accounting
period, or

* You are a nonresident or dual-status alien during the year. You are considered a dual-status
alien if you were both a nonresident and resident alien during the year.

If you are a nonresident alien who is married to a U.S. citizen or resident alien at the end of the
year, you can choose to be treated as a U.S. resident. (See Publication 519, U.S. Tax Guide for
Aliens.) If you make this choice, you can take the standard deduction.

If an exemption for you can be claimed on another person’s return (such as your parents’ return),
Kyour standard deduction may be limited. )
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Standard Deduction Chart for People Born
Before January 2, 1952, or Who are Blind

Standard Deduction Worksheet for Dependents

Use this worksheet only if someone else can claim you
(or your spouse if filing jointly) as a dependent.

Check the correct number of boxes below. Then go to the chart.

You: Born before
January 2, 1952 O Blind O

Your spouse, if Born before
claiming January 2, 1952 O Blind O
spouse’s exemption:

Check the correct number of boxes below. Then go to the worksheet.

You: Born before
January 2, 1952 O Blind O

Your spouse, if Born before
claiming January 2, 1952 O Blind O
spouse’s exemption:

Total number of boxes checked ] Total number of boxes checked =]
. IFyour AND THEN 1. Enter your earned income (defined below). If none,
filing status is... the number in your
. enter -0-. 1.
box above is... standard
deduction
is... 2. Additional amount. 2. $350
Single 1 $7,850
5 9,400 3. Addlines 1 and 2. 3.
Married filing jointl 1 13,850 . )
ing v $ 4. Minimum standard deduction. 4. $1,050
or Qualifying — 9,97
< - 2 15,100
widow(er) with
dependent child 3 16,350 5. Enter the larger of line 3 or line 4. 5.
4 17,600
— 6. Enter the amount shown below for your filing
Married filing separately 1 $7,550 status.
2 8,800 0  Single or Married filing separately—
3 10,050 $6,300 6.
4 11,300 O Married filing jointly—$12,600
Head of household 1 $10,850 [0 Head of household—$9,300
2 12,400

*If someone else can claim you (or your spouse if filing jointly) as a dependent,
use standard deduction worksheet for dependents.

F-2

7. Standard deduction.

a. Enter the smaller of line 5 or line 6. If born
after January 1, 1952, and not blind, stop here.
This is your standard deduction. Otherwise, go
on to line 7b. 7a.

b. If born before January 2, 1952, or blind,
multiply $1,550 ($1,250 if married) by the
number in the box above. 7b.

c. Add lines 7a and 7b. This is your standard
deduction for 2016 7c.

Earned income includes wages, salaries, tips, professional fees,

and other compensation received for personal services you performed.
It also includes any amount received as a scholarship that you must
include in your income.




/
Interview Tips — Itemized Deductions

These interview tips will assist you in determining whether a taxpayer’s itemized deductions are
more than their standard deduction amount. It may be more advantageous for a taxpayer to
itemize their deductions if the amount is larger than the allowable standard deduction amount.

interview
tips

~

step

1

Do you have expenses in the following categories: medical
and dental expenses, taxes you paid, home mortgage
interest you paid, gifts to charity, job expenses, and certain
miscellaneous deductions?

Note: Casualty and theft losses and some miscellaneous
deductions are beyond the scope of VITA/TCE.

If YES, go to Step 2.

If NO, generally speaking, you
should take the standard deduction
if eligible. For further explanation
see exceptions in Publication 17,
Standard Deduction chapter.

step

12/

Were the medical and dental expenses paid by an employer
under a pre-tax plan (not included in box 1 of the customer’s
Form W-2) or were the expenses reimbursed by an
insurance company?

If YES, you can’t deduct reimbursed
expenses. Go to Step 4.

If NO, you can claim these
expenses. Go to Step 3.

step

13/

Were the medical and dental expenses more than 10% of
your adjusted gross income (7.5% If one spouse is 65 or
older)?

Note: You can include medical and dental bills you paid for:

B Yourself and your spouse
I All dependents you claim on your return

Il Your child whom you don’t claim as a dependent because
of the rules for children of divorced or separated parents

B Any person you could have claimed as a dependent on
your return except that person received $4,050 or more
of gross income or filed a joint return

I Any person you could have claimed as a dependent
except that you, or your spouse if filing jointly, can be
claimed as a dependent on someone else’s 2016 return

If YES, you can claim qualified
expenses. Go to Step 4.

If NO, you can’t deduct these
expenses. Go to Step 4.

step

Were the following taxes you paid imposed on you: state,
local or foreign income taxes, real or personal property
taxes?

If YES, go to Step 5.

If NO, you can’t claim this expense
as a deduction because you weren’t
obligated to pay the taxes. Go to
Step 6.

step

Did you pay these taxes during this tax year?

If YES, you can claim these
expenses and go to Step 6.

If NO, you can’t deduct taxes for
this year that were paid in another
year. Go to Step 6.

step

Are you legally liable for a home mortgage loan?

If YES, go to Step 7.

If NO, you can’t take an interest
expense for a mortgage for which
you aren’t legally liable. Go to Step
12.

/

F-3



-~

neriew INtErview Tips — ltemized Deductions (continued)

~

tips

step  Was the mortgage a secured debt on a main If YES, go to Step 8.

e or second home? If NO, you can’t take an interest expense. Go to Step 12.

step  Did you pay the mortgage interest in this If YES, go to Step 9.

9 tax year? If NO, you can’t take the mortgage interest deduction. Go to
Step 12.

step  Did you take out the mortgage on or before If YES, your mortgage interest is fully deductible. Go to Step

(9]

October 13, 19877

10.

If NO, follow the flowchart, Is My Home Mortgage Interest
Fully Deductible in Publication 17 to determine what is
deductible. Go to Step 12.

step

10

Did you pay premiums in 2016 for qualified
mortgage insurance for a home acquisition
debt that was issued afer 2006

If YES, you can take a deduction for qualified mortgage
insurance as home mortgage interest with AGI limitations.
If NO, you can’t take a deduction for qualified mortgage
insurance as home mortgage interest. Go to Step 12

step

®

Did you pay points to obtain a home mortgage
(on a main home or second home or home
improvement loan or to refinance your home)?

If YES, follow the Are My Points Fully Deductible This Year
flowchart in Publication 17 and then go to Step 12.
If NO, go to Step 12.

See note
step  Did you make a cash contribution to a If YES, you must have a written record from
@ qualified organization? that particular organization, and then go to Step 13.
If NO, go to Step 13..
step Did you make a noncash donation to a If YES, advise the taxpayer that generally he or she must

13

qualified organization?
Note: Generally the value of a donation is the
lesser of your cost or fair market value.

have a written receipt from that particular organization. Go to
Step 14.
If NO, Go to Step 15.

step

14

Is the total of all noncash donations $500
or less?

Note: If more than $500, refer taxpayer to a
professional tax preparer.

If YES, see Publication 17 for more details.
If NO, this is beyond the scope of VITA/TCE. Refer taxpayer
to a professional tax preparer.

N

step

&

Do you have any employee, job hunting or
investment expenses?

If YES, report the expenses on Schedule A, Job Expenses
and Certain Miscellaneous Deductions.

If NO, your employee and investment expenses aren’t
deductible.

/
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Note: If you refinanced in an earlier year, and weren’t eligible to take all the points in that year, you can
add in this year’s portion of those prior year points.



Schedule A - ltemized Deductions

Itemized Deductions

Use Standard or ltemized Deduction

Medical and Dental Expenses

Taxes You Paid

Moaortgage Interest and Expenses

/

™
I

Schedule A Nondeductible Items

Select to enter state and local taxes paid during the tax year in addition to income tax withheld.

If itemizing deductions,
select itemized
deductions. If MFS and
spouse itemizes, taxpayer
must also itemize.
Standard deduction can’t
be used. It doesn’t matter
which spouse files first.
Select to force itemized
deduction.

Select to enter medical
expenses.

Medical: cosmetic surgery; funeral/ burial; nonprescription drugs (except insulin) or prescribed drugs which were
purchased over the counter; weight loss program not prescribed; diet food.

Taxes: fees/licenses (drivers, marriage, dog); assessments for improvements that increase property value;
assessments for services to the property (sewer, trash collection, etc.).

Contributions: political; country club/fraternal lodge; raffle, bingo, or lottery tickets; tuition; value of time/services;

gifts to lobby groups; civic leagues, social clubs; labor unions.

Miscellaneous: commuting; home repair; rent; loss from sale of home; personal legal expenses; lost/misplaced

cash or property; fines/penalties.



Schedule A - Itemized Deductions (continued)

Schedule A - Medical Deductions

Medical and dental insurance s
Note: We automatically pull over the following ;

# Medicare premiums paid on your 109955A (Social Security).
# Self employed health insurance you have already entered.
# Do not include medical/dental premiums deducted fram your pay through a cafeteria plan (pre-taxed)

Amount paid to doctors/dentists $
Prescriptions $
X-Rays, lab work, etc $
MNursing help (not for healthy baby or housework) s
Hospital care {including meals and lodging) $
Alcohol/Drug rehabilitation [
Medical aids (hearing aids, crutches, wheelchairs, etc) $

Medical mileage driven (in miles)

Description Amount
Other medical expenses
$
Add/Edit Qualified Long-Term Care Premiums o
¢ { Add Premiums }

Note: For 2016, medical and
dental floor percentage is
10% if under 65 and 7.5% if
65 or older.

Some senior residences have
an amount in the monthly cost
which is a medical expense.

Schedule A - Taxes You Paid

* State and Local Tax amounts are automatically pulled from W-2, 1099, W-2G, and Estimates
PLEASE DO NOT include any of these amounts in any of the boxes below or your calculations will NOT be correct.

Schedule A - Taxes You Paid

* State and Local Tax amounts are automatically pulled from W-2, 1099, W-2G, and Estimates.
PLEASE DO NOT include any of these amounts in any of the boxes below or your calculations will NOT be correct.

Taxes Paid

Additional State and Local Income Tax $
(DO NOT INCLUDE AMQUNTS FROM W-2, 1099, W-2G or Estimates )

State and Local Sales Tax Paid Begin Sales Tax Worksheet ]

Prior Year 4th Quarter State Estimates paid after 12/31/2014 5
Real Estate Taxes (Non-Business Property) 5
Real Estate Taxes entered here will overwrite any real estate taxes paid already entered.

Personal Property (ex: Car Registration) 5
Enter in your Ad Valorem tax, exclude amount paid for actual car tags.

Amount

$

Description
Other Taxes

d

yrd

™

Click here to calculate
sales tax. Be sure to base
sales tax on total income -
taxable and non taxable.

Enter real estate taxes that
are reported on Form 1098
with the mortgage interest
on the mortgage interest
screen.

Enter vehicle license
registration fee if based
on value under Personal
Property taxes.

A
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If taxpayers purchased or sold home
in tax year, they may not be able

to deduct all Real Estate Taxes.
Subtract any property tax refund
received at closing. (see Publication
17, Real Estate Taxes for more
information).




Schedule A - Itemized Deductions (continued)

Schedule A Interest

Mortgage Interest Reported on Form 1098

Mortgage Interest Not Reported on Form 1098

FPoints Mot Reported on Form 1098

Primary Mortgage Insurance (PMI) Deduction

Mortgage Interest Reported on 1098

Real Estate Taxes (Non-Business Property)

Real Estate Taxes (Non-Business Property)

faglEdtinterest feported _
-

Select for mortgage interest
reported on Form 1098.

Enter amount from Form
1098, box 1 (and box 2, if
applicable).

Points from refinancing must
be spread over the life of

the mortgage unless used to
remodel (see Publication 17,
Points). Enter loan origination
fee from closing statement as
Points not reported on Form
1098 if not included as points
on Form 1098

If there are multiple
mortgages, make additional
Schedule A Interest entries.

Gifts to Charity

Unreimbursed Employee Business Expense

Job-Related Travel Expenses (Form 2106)

Miscellaneous Deductions

Less Commaon Deductions

Click here for cash or non-
cash donations

Click here to enter Form

2106 or Form 2106-EZ. On
the entry screen for Form
2106, there is a box to check
near the top for a reservist,
performing artist, or qualifying
government employee.
(Military Certification required)

Hint: Job-related education
expenses not used elsewhere
can be entered here. For
other unreimbursed employee
expenses see Pub 17.
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Schedule A - Itemized Deductions (continued)

Charity Cash Contributions

o To group all cash contributions as one single entry, select the "Override” button below.

Charity Name ‘ |

Description

Amount Donated

Date of Donation

Set the total contributions without itemizing.

DD v || YYYY v

Note: Enter amounts
given by cash or
check under Cash
Gifts to Charity. The
30% & 50% refer to
the percentage of
your AGI that can be
deducted this year.
See Publication 17
for definitions. Enter
the value of noncash
items donated under
Non-Cash Gifts to
Charity. Be careful to
list them separately.
If noncash
contributions are
greater than $500
Form 8283 must be
completed and this
form is out-of-scope.

Schedule A - Miscellaneous Deductions

Schedule A - Miscellaneous Deductions
Amortizable premium on taxable bonds

Federal estate tax on income in respect to a decedent

Gambling losses to the extent of gambling winnings

Impairment-related work expenses

Repayment under claim of right (if greater than $3000)
If your repayment was less than $3000, click Add/Edit below and enter it as an additional
Miscellaneous Deduction.

Unrecovered investment in pension
Tax Return Preparation
Safe Deposit Box Rental

Investment Fees and Expenses

Add/Edit Miscellaneous Deductions that are not listed above:

Add Additional ‘

Gambling losses
up to the amount
of winnings are
deducted here.
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Travel Expenses

This chart summarizes expenses you can deduct when you travel away from your home for
business purposes. (See publication 17 for definition of tax home)

Note: If you are an employee, travel expenses are deductible on Schedule A, Job Expenses and
Certain Miscellaneous Deductions subject to the 2% of AGI Limit. If you are self employed, travel
expenses are deductible as business expenses on Schedule C.

IF you have
expenses for...

THEN you can deduct the cost of...

transportation

travel by airplane, train, bus, or car between your home and your business destination. If you
were provided with a ticket or you are riding free as a result of a frequent traveler or similar
program, your cost is zero. If you travel by ship, see Luxury Water Travel and Cruise Ships
(under Conventions) for additional rules and limits.

taxi, commuter
bus, and airport

fares for these and other types of transportation that take you between:
e The airport or station and your hotel, and

N

limousine * The hotel and the work location of your customers or clients, your business meeting place,
or your temporary work location.

baggage and sending baggage and sample or display material between your regular and temporary work

shipping locations.

car operating and maintaining your car when traveling away from home on business. You can
deduct actual expenses or the standard mileage rate, as well as business-related tolls
and parking. If you rent a car while away from home on business, you can deduct only the
business-use portion of the expenses. Important note: The actual
expense method is out of scope for the VITA/TCE program. If the taxpayer is using actual
expenses for car expenses, refer the taxpayer to a professional tax preparer.

lodging and your lodging and meals if your business trip is overnight or long

meals enough that you need to stop for sleep or rest to properly perform your duties. Meals include
the actual cost or standard deduction for meals and incidental expenses (M&IE). See Meals in
Publication 17, Car Expenses and Other Employee Business Expenses for additional
rules and limits.

cleaning dry cleaning and laundry.

telephone business calls while on your business trip. This includes business communication by fax
machine or other communication devices.

tips tips you pay for any expenses in this chart.

other other similar ordinary and necessary expenses related to your business travel. These

expenses might include transportation to or from a business meal, public stenographer’s fees,

computer rental fees, and operating and maintaining a house trailer. /
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Deductible Entertainment Expenses
When Are Entertainment Expenses Deducted?

~

General rule

You can deduct ordinary and necessary expenses to entertain a client, customer, or
employee if the expenses meet the directly-related test or the associated test. If you
deduct travel, entertainment, gift, or transportation expenses, you must be able to prove
(substantiate) certain elements of the expense.

Definitions

e Entertainment includes any activity generally considered to provide entertainment,
amusement, or recreation, and includes meals provided to a customer or client.

e An ordinary expense is one that is common and accepted in your trade or business.

e A necessary expense is one that is helpful and appropriate.

Tests to be met

Directly-related test

e Entertainment took place in a clear business setting, or

e Main purpose of entertainment was the active conduct of business, and
You did engage in business with the person during the entertainment period, and
You had more than a general expectation of getting income or some other specific
business benefit.

Associated test
e Entertainment is associated with your trade or business, and
e Entertainment directly before or after a substantial business discussion.

Other rules

* You can’t deduct the cost of your meal as an entertainment expense if you are claiming
the meal as a travel expense.

* You can’t deduct expenses that are lavish or extravagant under the circumstances.

* You generally can deduct only 50% of your unreimbursed entertainment expenses (see

50% Limit).




/

50% Limit

Table 3. Does the 50% Limit Apply to Your Expenses?

There are exceptions to these rules. See Publication 463 for additional guidance.

All employees and self-employed persons can use this chart.

Start Here

Were your meal and entertainment expenses reimbursed?
(Count only reimbursements your employer didn't
include in box 1 of your Form W-2. If self-employed,
count only reimbursements from clients or customers that No
aren't included on Form 1099-MISC, Miscellaneous
Income.)

Yes

If an employee, did you adequately account

to your employer under an accountable plan?
If self-employed, did you provide the payer No
with adequate records? (See chapter 6.)

Yes

No

N

Did your expenses exceed the reimbursement?

Yes

\ 4

For the amount reimbursed...

Your meal and entertainment
expenses AREN'T subject to
the 50% limit. However, since
the reimbursement wasn't
treated as wages or as other
taxable income, you can't
deduct the expenses.

!

For the excess amount...

Your meal and
entertainment expenses
ARE subiject to
the 50% limit.”

/

*50% limit for most taxpayers; 80% for those subject to Department of Transportation hours of service.
See Publication 463 for more information.
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Deductible Transportation Expenses

Most employees and self-employed persons can use this chart.
(Don’t use this chart if your home is your principal place of business.)

Temporary
work location

deductible

Never deductible

Regular or
main job

Always
deductible

Second job

Home: The place where you reside. Transportation expenses between your home and
your main or regular place of work are personal commuting expenses.

Regular or main job: Your principal place of business. If you have more than one job,
you must determine which one is your regular or main job. Consider the time you
spend at each, the activity you have at each, and the income you earn at each.

Temporary work location: A place where your work assignment is realistically
expected to last (and does in fact last) one year or less. Unless you have a regular
place of business, you can only deduct your transportation expenses to a temporary
work location outside your metropolitan area.

Second job: If you regularly work at two or more places in one day, whether or not
for the same employer, you can deduct your transportation expenses of getting from
one workplace to another. If you don't go directly from your first job to your second
job, you can only deduct the transportation expenses of going directly from your first
job to your second job. You can't deduct your transportation expenses between
your home and a second job on a day off from your main job.

F-12
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Recordkeeping

How to Prove Certain Business Expenses

If you have
expenses for ...

THEN you must keep records that show details of the following elements . ..

Amount

Time

Place or
Description

Business Purpose
Business Relationship

Travel

Cost of each
separate expense
for travel, lodging,
and meals. Incidental
expenses may be

Dates you left
and returned
for each trip
and number of
days spent on

Destination or area
of your travel (name
of city, town, or other
designation).

Purpose: Business purpose for the
expense or the business benefit
gained or expected to be gained.

Relationship: N/A

totaled in reasonable | business.
categories such as
taxis, fees and tips,
clc

Entertainment | Cost of each Date of Name and address Purpose: Business purpose for the
separate expense. entertainment. | or location of place of | expense or the business benefit
Incidental expenses | (Also see entertainment. Type gained or expected to be gained.
such as taxis, Business of entertainment if not | For entertainment, the nature of the
telephones, etc., may | Purpose.) otherwise apparent. business discussion or activity. If the

be totaled on a daily
basis.

(Also see Business
Purpose.)

Gifts

Cost of the gift.

Date of the gift.

Description of the gift.

entertainment was directly before
or after a business discussion: the
date, place, nature, and duration of
the business discussion, and the
identities of the persons who took
part in both the business discussion
and the entertainment activity.

Relationship: Occupations or other
information (such as names, titles,
or other designations) about the
recipients that shows their business
relationship to you.

For entertainment, you must also
prove that you or your employee was
present if the entertainment was a
business meal.

Transportation

Cost of each
separate expense.
For car expenses,
the cost of the

car and any
improvements, the
date you started
using it for business,
the mileage for each
business use, and
the total miles for the
year.

Date of the
expense. For
car expenses,
the date of the
use of the car.

Your business
destination.

Purpose: Business purpose for the
expense.

Relationship: N/A




Notes
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Nonrefundable Credits

Credits Select for Form 1116, Foreign

Tax Credit
Foreign Tax Credit (Form 11186) -
L— Select for Form 2441, page

Child Care Credit (Form 2441} - ] I1.tSee" Ch_ll'{q TalxtCredit Tip &
nterview Tips, later

Education Credits (Form 1088-T) - <—_ __ Select for Form 8863. See
Education Benefits tab.

Retirement Savings Credit (Form 8880) - \

™ Select for Form 8880.
Remember to complete Form

Residential Energy Credit (Form 5695)

A 8880 if taxpayer received any
Adoption Credit (Form 2839 - \ distributions from retirement
plans
DC First-Time Homebuyer Credit (Form 8859) Select for Form 5695

Mortgage Interest Credit (Form 8396)

Select for EIC worksheets.

/ .
Ezrned Income Credit [Form 5362) - < See Earned Income Credit
tab.

Credit for the Elderly or Disabled (Schedule R) - -~
—— Select for Schedule R

Alternative Motor Wehicle Credit (Hybrid Cars, Form 8910)

Qualified Electric Mator Vehicle Credit (Form 8936)

Small Employer Health Insurance Premiums (Form 8941]

Credit for Federal Tax Paid on Fuels (Form 4136)

Credit for Increasing Research Activities from Pass-through Entities (Form 6763)

Hint: Remember, the nonrefundable credits can't exceed the taxpayer’s federal income tax.

Form 8863
Open Form 8863 Education Credits. Select the student’s name, SSN, and the type of credit. Enter the qualified
expenses in the appropriate section of Form 8863. For complete education credit information refer to Tab J-
Education Benefits.

Schedule R

If taxpayer qualifies for the credit for the elderly or the disabled, open Schedule R. Refer to the Elderly or Disabled
Decision Tree on the last page of this tab.
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Form 1116 — Foreign Tax Credit

Credits

Foreign Tax Credit Form 1116 Begin

Child Care Credit Form 2441 Begin

Education Credits Form 1098-T

]

Form 1116 - Foreign Tax Credit

In order to receive a credit for any foreign taxes paid you must answer Yes to all of the following questions:

« |5 all of your gross foreign source income from interest and dividends?

« Was all of that interest and dividend income reported to you on From 1092-INT, Form 1099-DIV, or Schedule K-17
« [f you had dividend income from shares of stock, did you hold those shares for at least 16 days?

» |s the total of your foreign taxes less than or equal to $300

« Were all of your taxes:

A Legally owed and not eligible for a refund; AND
B. Paid to countries that are recognized by the United States; AND
C. Paid to countries that do not support terrorism?

Foreign tax credit not over $300 s|
© MNote: Only enter an amount if you answered Yes to all the questions above.

If you paid more than $300 dollars in foreign taxes, you must fill out Form 1116 Foreign Tax Credit.

« GotoForm 1116

FOR INTERNATIONAL CERTIFICATION ONLY:

If the taxpayer doesn't meet the requirements for the Simplified Limitation Election,
complete Form 1116 as follows:

G-2

P Select Foreign Tax Credit

ONLY the Simplified Limitation
Election for the foreign tax
credit is in scope for Advanced
certification. To be eligible for

- this election, qualified foreign

taxes must be $300 ($600

if MFJ) or less, all foreign
source income is passive
category (such as interest

and dividends) and taxpayer
meets the other requirements
as explained in the Form

1116 Instructions. Enter the
amount of foreign taxes paid as
indicated on the Form 1099-
INT or 1099-DIV. No other entry
is required.



Form 1116 — Foreign Tax Credit (continued)

Foreign tax credit

Passive income

General limited income
Section 901(j) income
Income resourced by treaty

Lump-sum distributions

Begin

Begin

Begin

Begin

Begin

+ Continue

Form 1116 - Foreign Tax Credit

Country of residence *

Carryback or Carryover
Reduction in Foreign Taxes
Adjustments

Reduction of credit for international boycott operations

Credit is claimed for taxes paid or accrued
(O Paid <

- Please Select -

$

00 0:

In scope for VITA/TCE with
International Certification.
Select the appropriate
category. If taxpayer has
income in more than one
category or from more
than one country, another
can be added later.

<«

<—— Qut of scope.

Select country of
residence.

<

Indicate whether the foreign tax
was actually paid during the tax
year (“paid”) or if the tax was
billed in one year but paid in

() Accrued

« Continue

another (“accrued”). A taxpayer
using the cash basis can
choose to use either the cash
or accrual method to determine
the foreign tax credit. However,
if the accrual method is chosen,
the taxpayer must continue to
use the accrual method for the
foreign tax credit on all future
returns.



Form 1116 — Foreign Tax Credit (continued)

Form 1116 - Foreign Tax Credit

Foreign Country or U 5. passession *
a ry p

Gross income from sources within the country of the specified type (Do nat include
incame excluded by Form 2555, Forgian Earned Income)

Expenses Directhy Allocable to Income
Other Deductions

(Gross income from sources within the country of the specified type (Including any
income exluded by Farm 2555, Foreign Earned Income)

Home mortgage interest
(Other interest expense
osses from foreign sources

Date paid ar accrued *

(ErEr—] <

§ \
; =

H

§

MM [v] DD ]| vy [V

Enter the date the tax
was paid or accrued.

Foreign taxes paid or accrued in foreign currency

Tax Withheld on Dividends (in Forgign Currency)

Taw Withheld on Rents/Rovalties (in Foreign Currency)

Taw Withheld on Imterest (in Foreign Currency)

Other Foreign Taxes (in Foreign Currency)

Foreign taxes paid or accrued in U.S. dollars

Dividends

Rents and royalties Enter the taxes paid

(in U.S. dollars) in the

Interest appropriate category.

Other taxes

G-4

Select the country that
imposed the tax.

Enter the gross INCOME
of this category type in
both places (not the tax).

If your gross foreign
source income (including
income excluded on Form
2555 or Form 2555-EZ7)
does not exceed $5,000,
you can allocate all of your
interest expense to U.S.
source income. Otherwise,
deductible home mortgage
interest (including points
and qualified mortgage
insurance premiums) is
apportioned using a gross
income method.

Click on the itemized
amounts boxes to enter
taxes paid in foreign
currency in the appropriate
category.

Generally, you must enter
the amount of foreign
taxes, in both the foreign
currency denomination(s)
and as converted into
U.S. dollars, that relate to
the category of income
checked (Passive or
General limited income).



/ Child and Dependent Care Credit Expenses\

Probe/Action: To determine if a taxpayer qualifies for the Credit for Child and Dependent Care Expenses,
ask the taxpayer for information from the decision tree on the next page.

Who is a qualifying person?

* A qualifying child who was under the age of 13 when the expenses were incurred
and for whom a dependency exemption can be claimed, see caution 1 below.

* Any person who was incapable of self-care whom the taxpayer can claim as a
dependent or could've claimed as a dependent except that the person had gross
income of more than $4,050 or filed a joint return or that the taxpayer or spouse,
if married filing jointly, could be claimed as a dependent on someone else’s 2016
return.

* A spouse who was physically or mentally incapable of self-care.
* The qualifying person must live with the taxpayer more than 1/2 the year.

e Incapable of self-care - Can't dress, clean, or feed themselves because of physical
or mental problems. Also persons who must have constant attention to prevent
them from injuring themselves or others.

See Publication 17, Child and Dependent Care Credit for special rules regarding
divorced or separated parents or parents who live apart.
Qualified work-related expenses

* Expenses must be paid for the care of the qualifying person to allow the taxpayer
and spouse, if married, to work or look for work.

* The care includes the costs of services for the qualifying person’s well-being and
protection.

* Expenses to attend kindergarten or a higher grade aren't an expense for care.
* Expenses for summer day-camp are qualifying, but those for overnight camp aren't.

N J

*Refer to the tables on page C-3 for the rules governing who may be claimed as a dependent.

Caution: Only the custodial parent may claim the child and dependent care credit even if the child’s
exemption is being claimed by the non-custodial parent under the rules for divorced &
separated parents.

Caution: If Dependent Care Benefits are listed in Box 10 of a W2, then the taxpayer MUST complete
Form 2441. If Form 2441 isn't completed, the Box 10 amount is entered on Line 7 of the
1040 as taxable income.

Note: If the qualifying child turned 13 during the tax year, the qualifying expenses include amounts
incurred for the child while under age 13 when the care was provided.

G-5



8 Credit for Child & Dependent Care Expenses —

Decision Tree
Can You Claim the Child and Dependent Care Credit

Start Here

Was the care for one or more qualifying persons? L>

See prior page for definition.
¢ Yes

Did you1 have earned income during the year? Refer to the Earned No >
Income Table in the Earned Income Credit tab.

¢ Yes

Did you pay the expenses to allow you1 to work or look for work? No >
See prior page for qualifying expenses.

¢ Yes

Were your payments made to someone you or your spouse could Yes >
claim as a dependent?
¢ No

Were your payments made to your spouse or to the parent of your VoS
child who is your qualifying person? Answer No if your qualifying —P
child is a disabled person over age 13.

I

Were your payments made to your child who was under the age of | Yes N
19 at the end of the year?

¢ No
No

Are you single? > \ 4

Are you filing a joint return?

Yes
Yes ¢ No
No

Do you meet the requirements >
to be considered unmarried?

¢ Yes

Do you know the care provider’s name, v
address, and identifying number?

¢ No
No

v Did you make a reasonable effort to get this >
information? (See Due diligence.)

¢ Yes

Did you have only one qualifying person and Yes

—P» exclude or deduct at least $3,000 of dependent —————P»|

care benefits?
y 1o v

You CAN claim the child and dependent You CAN'T claim the child
care credit. Fill out Form 2441 and dependent care credit.?

Yes

' This also applies to your spouse. However, your spouse is treated as having earned income for any month that he
or she is a full-time student, or physically or mentally not able to care for himself or herself. (Your spouse also must
live with you for more than half the year.)

2 If you had expenses that met the requirements for 2015, except that you didn't pay them until 2016, you may be

k able to claim those expenses in 2016.

~
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Form 2441 — Credit for Child and Dependent Care

Expenses

F2441 - Child Care Credit - Page 1

The 2441 covers expenses paid for child care. The amount paid to the provider(s) of the child care

o must equal the total expenses of the dependents and any qualified person not listed on the return
as a dependent. If the totals do not balance out to a difference of 50, then there is a risk of
rejection of the return.

Total Expenses $0.00
Total Amount Paid To Providers - $0.00
Difference - 50.00

= Step 1 - Child Care Providers

Child Care Providers

Enter the required information about the chi
dependents and qualified persons,
- Dependents.

Te provider you paid to care for your
you have entered all providers, continue to Step 2

Provider ID Number Amount

- Add a Child Care Provider

-«

+ Step 2 - Dependents =

+ Step 3 - Qualifying Persons

Additions to Income for Taxpayer for this credit

NOTE: I the taxpayer was a full-time student or disabled, enter any additional income.

Figuring the amount to enter:
Step 1: Figure out how many menths you were a student (or disabled) and did not work. Do not include any month in which bath you
and your spouse (if applicable) were both students.

Step 2: If you have just one gualifying child that you paid expenses for, multiply the number of months you figured in Step 1 by $250. If
you have mare than one qualifying child, multiply the number of months by $500. The result is what you should report as Additional
Income for Taxpayer.

Additional Income for Taxpayer for purposes of this credit $

Additions to Income for Spouse for this credit

NOTE: If the spouse was a full-time student or disabled, enter any additional income

Figuring the amount to enter:
Step 1: Figure out how many menths your spouse was a student {or disabled) and did not werk. Be sure to include any month in which
both you and your spouse were students.

Step 2: If you have just one qualifying child that yeu paid expenses for, multiply the number of months you figured in Step 1 by $250. If
you have more than one qualifying child, multiply the number of months by $500. The result is what you should report as Additional

Income for Spouse. /
$

Additional Income for Spouse for purposes of this credit
(If you are married filing separately and are eligible to file the 2441, please enter the taxpayers
income)

Benefits (Do not enter an amount from your W-2)

Employer-paid Dependent Care Benefits s -
Forfeited Employer-paid Benefits $
Benefits Received from Sole Proprietership or Partnership $

/

Add a Child Care Provider.

Hint: The tax return can't be filed electronically
without a valid Employer Identification Number or
Social Security Number for the Daycare Provider.

Next, enter the total amount of qualified expenses
paid for each dependent. Select edit next to the
appropriate dependent.

Note: Foreign earned income and housing
exclusion, and Medicaid Waiver payments are
subtracted from the wages listed on Line 7 when
figuring the credit. Subtract any amount earned
while incarcerated or on work release.

Form 2441 Page 2:

If the taxpayer or spouse is a full-time student or
disabled enter $250 per month ($500 per month

if more than one qualifying person was cared for
during the year).

If the person also worked during the month, use the
higher of $250 (or $500) or his or her actual earned
income for that month.

Caution: Only Enter dependent care benefits not
reported on a W-2




(" Retirement Savings Contributions Credit — )
Decision Tree

To determine if a taxpayer qualifies for the Credit for Qualified Retirement Savings
Contributions, review the return information and ask the taxpayer the following:

Did you make a voluntary contribution or
deferral to an IRA or other qualified plan
for 20167 NO

YES

Is AGI $30,750 or less ($46,125 if head of
household, $61,500 if married filing jointly)?

NO
- \ Not qualified

for credit
Were you born before January 2, 19997

NOTEg
YES ¢
Can you be claimed as a dependent on
someone else’s tax return? > YES
NO Y
|Were you a full-time student? during 20167 |

> YES
NO

Y

Y

Y

Qualified for credit

' Plans that qualify are listed in the Other Credits chapter of Publication 17. Answer yes if the taxpayer will make a qualifying IRA contribution for tax
year 2016 by April 18, 2017.

2 See Publication 17 for definition of full-time student.

Important Reminders for Retirement Savings Contributions Credit

e Be sure to look at the taxpayer’s Form(s) W-2. An entry in box 12 or an “X” in the Retirement box is an
indicator that the taxpayer may be eligible for this credit. A full description of all codes used in box 12
can be found in Instructions for Forms W-2 and W-3.

* An entry in box 14 on the W-2 may also indicate a contribution to a state retirement system. Caution:
If these are treated as employer contributions they aren't eligible for the credit. See Form W-2
Instructions.

* When using tax software, remember to key in all entries as they appear on the Form W-2.

* A contribution to a traditional or Roth IRA (including a myRA) qualifies for this credit, but may not
appear on any taxpayer document. Remember to review the expenses section on page 2 of the Intake
and Interview Sheet and ask taxpayers if they made any IRA contributions.

» Some distributions reduce the eligible contributions for this credit. In addition to distributions for the
current year as shown on Forms 1099-R, be sure to ask about distributions in the prior two years and
up to the due date of the return.

* See the next page for a list of distributions that don't reduce the eligible contributions for this credit.

e Complete Form 8880 to claim this credit.

N J
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Retirement Savings Contributions Credit (continued)

Open the Retirement Savings Contributions Credits screen if the taxpayer meets eligibility criteria and any of
the following are true:

1. The taxpayer(s) make a traditional IRA or a ROTH IRA contribution before the filing deadline.
2. The taxpayer or spouse’s Form W-2 includes box 12 entries of D, E, F, G, H, S, AA, BB, or box 14
amounts are marked as “Qualifies for Form 8880.”

Verify total contribution amounts with the taxpayer.

Note: Certain distributions received after
. . - . 2013 and before the due date (includin
Retirement Savings Contributions Credits ) ( 9
extensions) of your 2016 tax return from
TAXPAYER any of the following types of plans must be
_ entered on Form 8880:
Enter Any Qualifying Retirement Distributions in 2015, 2014, or 2013 | $| |
e Traditional or Roth IRAs (including
Enter Any Other Taxable Distributions in 2015 or 2014 5 myRAS)
Enter Any Current Year Roth IRA Contributions s ° 401 (k)! 403(b)’ goVernmental 4571 501 (C)
(18)(D), SEP, or SIMPLE plans
et Deferels from 2 - * Qualified retirement plans (including the
Enter any Elective Deferrals to a 401(k) or other Qualified Plan not reported on a W-2 5 federa| Thr|ft Savings Plan)_
Distributions from the 3 prior years and
SPOUSE current year normal distributions must be
N ] ) o entered manually on this form.
Enter Any Qualifying Retirement Distributions in 2015, 2014, or 2013 s
Enter Any Other Taxable Distributions in 2015 or 2014 $
Enter Any Current Year Roth IRA Contributions s
Elective Deferrals from W-2(s) 50.00
Enter any Elective Deferrals to a 401(k} or other Qualified Plan not reported on a W-2 s

Don't include any:

e Military pensions

* Distributions not taxable as the result of a rollover or a trustee-to-trustee transfer

e Distributions from your IRA (other than a Roth IRA) rolled over or converted to your Roth IRA

e Loans from a qualified employer plan treated as a distribution

e Distributions of excess contributions or deferrals (and income allocable to such contributions or deferrals)

» Distributions of contributions made during a tax year and returned (with any income allocable to such
contributions) on or before the due date (including extensions) for that tax year

e Distributions of dividends paid on stock held by an employee stock ownership plan under section 404(k)

» Distributions that are taxable as the result of an in-plan rollover to your designated Roth account

e Distributions from an inherited IRA by a nonspousal beneficiary



. h
Child Tax Credit

This is a credit intended to reduce the tax. This part of the credit isn't refundable. The credit is up to $1,000
per qualifying child.

Qualifying child:
1. Under age 17 at the end of the tax year.
2. A U.S.citizen or U.S. national* or resident alien of the United States. See the ITIN Returns tab.
3. Claimed as your dependent.**
4. Your:
a. son or daughter, adopted child, stepchild, eligible foster child, or a descendant of any of them

b. brother, sister, half brother, half sister, stepbrother, stepsister, or a descendant of any of them (for
example, your niece or nephew)

5. Didn't provide over half of his or her own support.

6. Lived with the taxpayer for more than half of the tax year. (See Interview Tips for Child Tax Credit for
Exception to Time Lived with You section if the child didn't live with the taxpayer for more than half the
year.)

* National is an individual who, although not a U.S. citizen, owes his or her allegiance to the United States. U.S. nationals include

American Samoans and Northern Mariana Islanders who chose to become U.S. nationals instead of U.S. citizens.
(Refer to the tables on page C-3 for the rules governing who may be claimed as a dependent. /

Caution: If the taxpayer is able to claim the dependent under the rules for divorced and separated parents, he or she is
the only parent entitled to claim the child tax credit or additional child tax credit.

‘v~ Additional Child Tax Credit — General A
Eligibility

The child tax credit is generally a nonrefundable credit; however, certain taxpayers may
be entitled to a refundable additional child tax credit.

. Taxpayers with more than $3,000 of taxable earned income may be eligible for the additional child tax
credit if they have at least one qualifying child.

J Taxpayers with three or more children may also be eligible for additional child tax
credit regardless of their income.

Schedule 8812 is used to calculate the allowable additional child tax credit.

See Tab C, Exemptions/Dependency, and the worksheet in the instruction booklet for additional information
(including definitions and special rules relating to an adopted child, foster child, or qualifying child of more

Kthan one person). /

Note: No credit or refund for an overpayment for a taxable year shall be made to a taxpayer before the 15th day of
the second month following the close of the taxable year (generally February 15th) if the taxpayer claimed the EITC or
additional child tax credit on the tax return.

Note: Taxpayers claiming the Child Tax Credit must now have a valid identification number by the due date of the tax
return (including extensions). Taxpayers may not file an amended return to retroactively claim the additional child tax credit
for a qualifying child if a valid TIN for the child is issued after the due date of the tax return.

Note: You must claim the child as a dependent on your return to qualify for the Child Tax Credit

Note: If you claim the foreign earned income exclusion, the housing exclusion, or the housing deduction on Form 2555 or
Form 2555-EZ, you can't claim the additional child tax credit.
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interview
tips

Child Tax Credit

(Remember to apply the steps for each child.)
Probe/Action: Ask the taxpayer:

step

Is this child your son, daughter, adopted child, stepchild, foster
child, brother, sister, half brother, half sister, stepbrother,
stepsister, or a descendant of any of them (for example, your

grandchild, niece, or nephew)? A descendant is of any generation.

If YES, go to Step 2.

If NO, you can't claim the child

tax credit for this child. STOP if the taxpayer has
no other children.

(0]

=
®

o

Is this child under age 17 at the end of the tax year?

If YES, go to Step 3.

If NO, you can't claim the child

tax credit for this child. STOP if the taxpayer has
no other children.

United States?

Note: A national is an individual who, although not a U.S. citizen,
owes his or her allegiance to the United States. U.S. nationals
include American Samoans and Northern Mariana Islanders who
chose to become U.S. nationals instead of U.S. citizens. See ITIN
Return tab for definition of Resident Alien.

step Did the child provide over half of his or her own support for the tax  If NO, go to Step 4.
year? If YES, you can't claim the child
tax credit for this child. STOP if the taxpayer has
no other children.
step Did the child live with you for more than half of the tax year? If the  If YES, go to Step 5.
child didn't live with you for the required time, see the following If NO, you can't claim the child
notes below the chart: tax credit for this child. STOP if the taxpayer has
o Exception to Time Lived with You no other children.
o Kidnapped Child
o Children of Divorced or Separated Parents or Parents who
live apart.
step Is this child a U.S. citizen, U.S. national, or resident alien of the If YES, go to Step 6.

If NO, you can't claim the child
tax credit for this child. STOP if the taxpayer has
no other children.

Questions: Who Must Use Publication 972?

7

° Adoption Credit, a residential energy credit, Form 5695, Part
II; Mortgage Interest credit, Form 8396; District of Columbia
first-time homebuyer credit, Form 8859.

step Are you excluding income from Puerto Rico or are you filing If NO, go to Step 7.

@ Form 2555, Form 2555-EZ (relating to foreign earned income), If YES, you must use Publication
or Form 4563, Exclusion of Income for Bona Fide Residents of 972 to figure the credit.
American Samoa?

step Are you claiming any of the following credits? If NO, use the Child Tax Credit

Worksheet to figure the credit.
If YES, you must use Publication
972 to figure the credit.

Exception to Time Lived with You
A child is considered to have lived with you for all of the current tax year

Children of Divorced or Separated Parents
A child will be treated as being the qualifying child of his or her

if the child was born or died in 2016 and your home was this child’s home
for the entire time he or she was alive. Temporary absences for special
circumstances, such as for school, vacation, medical care, military
service, or detention in a juvenile facility, count as time lived at home.

Kidnapped Child

A kidnapped child is considered to have lived with you for all of the

current tax year if:

o In the year the kidnapping occurred, the kidnapped child is
presumed by law enforcement to have been taken by someone who
isn't a family member, and

J The kidnapped child lived with the taxpayer for more than half of
the portion of the year prior to the kidnapping.

Modified Adjusted Gross Income Limits

. Married filling jointly - $110,000

o Single, head of household, or qualifying widow(er) - $75,000
o Married filling separately - $55,000

N

noncustodial parent if all of the following apply:

The parents were divorced or legally separated or lived apart at all
times during the last 6 months of the current tax year.

The child received over half of his or her support for the current tax
year from the parents.

The child was in the custody of one or both of the parents for more
than half of the current tax year.

A decree of divorce or separate maintenance or written separation
agreement that applies to the current tax year provides that (a) the
noncustodial parent can claim the child as a dependent, or (b) the
custodial parent will sign a written declaration that he or she won't
claim the child as a dependent for the current tax year.

The custodial parent signs Form 8332 or similar statement that

he or she won't claim the child as a dependent in the current tax
year. If the divorce decree or separation agreement went into effect
before 2009, the non custodial parent may be able to attach certain
pages of the decree or agreement instead of Form 8332.

/

Note: current tax year reference applies to tax year 2016.
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Residential Energy Credits

Part | of Form 5695- Residential Energy Efficient Property Credit, is available for taxpayers who pur-
chased qualified residential alternative energy equipment, such as solar hot water heaters, geothermal
heat pumps and wind turbines. This part of the form is out of scope. Taxpayers that have these ex-
penses should be referred to a professional tax preparer.

Part Il, Form 5695 - Key points about the Nonbusiness Energy Property Credit:

o A total combined credit limit of $500 ($200 limit for windows) for all tax years after 2005.

o The maximum credit for residential energy property costs is $50 for any advanced main air
circulating fan; $150 for any qualified natural gas, propane, or oil furnace, or hot water boiler;
and $300 for any item of energy-efficient building property.

° The credit applies to:

e Qualified energy efficiency improvements such as adding insulation, energy-efficient
exterior windows and doors, and qualifying metal or asphalt roofs (doesn't include
labor costs for onsite preparation, assembly or installation)

e Qualified residential energy property improvements such as energy-efficient heating
and air conditioning systems. For a complete list of items see Form 5695. (includes
labor costs for onsite preparation, assembly, or original installation)

. The improvements must be made to the taxpayer’s main home located in the United States
(must be existing home).
o Qualifying improvements must be placed into service by the taxpayer during the tax year.

o Expenditures which are made from subsidized energy financing can't be used to figure the
credit.

° The credit is taken on Part Il, Form 5695. See Form 5695 and Instructions for more information.

Note: Not all ENERGY STAR products qualify for a tax credit. Beginning in 2016, exterior doors, exterior
windows, and skylights will only be eligible for the nonbusiness energy property credit if they meet or exceed
the specific requirements of the version 6.0 Energy Star program. For detailed information about qualifying
improvements, visit the U.S. Department of Energy’s EnergyStar Web site https://www.energystar.gov/

Manufacturers must certify that their products meet new standards and they must provide a written
statement to the taxpayer such as with the product packaging or in a printable format on the
manufacturer's Web site. Taxpayers should keep a copy of the manufacturer’s certification statement
and receipts with their other important tax records.

N J
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Decision Tree

(Credit for the Elderly or the Disabled —

Use the following chart to determine if the taxpayer is eligible for the Credit for the Elderly or the Disabled:

~

Figure A. Are You a Qualified Individual?

Were you married at the end of the tax year?

<«—— Start here

No

A Y

Are you a U.S. citizen or resident alien?’

Yes

Y

Were you 65 or older at the end of
the tax year?

Yes

No

A

Are you retired on permanent and
total disability?

Yes

Y

Did you reach mandatory retirement
age before this year??

Did you live with your spouse Yes
at any time during the year? [<
Answer “No” if you qualify to
be considered unmarried and
file as Head of Household. No
Yes Yes
Are you filing a joint No -
return with your spouse?
\
You aren't a qualified [
individual and can't
take the credit for the No
elderly or the disabled.
A
Yes
No

No
L

to this question.

Figure B. Income Limits

Did you receive taxable disability
benefits this year?

!

You are a qualified
individual and may be
able to take the credit
for the elderly or the
disabled unless your
income exceeds the
limits in Figure B.

A

Yes

' If you were a nonresident alien at any time during the tax year and were married to a U.S. citizen or resident alien at the end of the tax year,
see U.S. Citizen or Resident Alien under Qualified Individual. If you and your spouse choose to treat you as a U.S. resident alien, answer “yes”

2 Mandatory retirement age is the age set by your employer at which you would have been required to retire, had you not become disabled.

IF you are . ..

THEN you generally can't take the credit if...

Your adjusted gross income (AGI)*
is...

OR the total of your nontaxable social

security and other nontaxable pension
annuities or disability income is equal

to or more than . ..

single, head of household,
or qualifying widow(er) with
dependent child

$17,500

$5,000

married filing a joint return and
both spouses qualify in Figure A

$25,000

$7,500

married filing a joint return
and only one spouse qualifies in
Figure A

$20,000

$5,000

married filing a separate return
and you lived apart from your
spouse for all of 2016

$12,500

$3,750

the questions.

* AGl is the amount on Form 1040A, line 22, or Form 1040, line 38.
Tax Software Hint: Be sure to include the taxpayer’s total social security benefits, regardless of the taxability, to ensure the

correct calculation of the credit. If the taxpayer appears to qualify for the credit, click on line 54 from 1040 View>Credit for the
Elderly or Disabled or click on Deductions from Federal Section>Credits Menu>Credit for the Elderly or Disabled and answer




Notes
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Other Taxes and Payments

Hint: TaxSlayer provides all the forms and schedules you need in order to figure and report these taxes, and

in most cases, performs the calculations.

57  Self-employment tax. Attach Schedule SE e e 57

Other 58  Unreported social security and Medicare tax from Form: a [_] 4137 b [] 8919 58
Taxes 59  Additional tax on IRAs, other qualified retirement plans, etc. Attach Form 5329 if required 59
60a Household employment taxes from Schedule H 60a
b  First-time homebuyer credit repayment. Attach Form 5405 if reqwred 60b

61 Health care: individual responsibility (see instructions) ~ Full-year coverage [_| 61

62 Taxesfrom: a [ JForm8959 b [ ]Form8960 ¢ [ | Instructions; enter code(s) 62

Add lines 56 through 62. This is your total » 63

For those with HSA cetrtification only. Additional
taxes for HSA distributions not used for qualified
medical expenses may be applicable unless age
65, disabled, or deceased See Form 8889. All
other taxes on this line are out-of-scope.

Form 5329

5 3 29 Additional Taxes on Qualified Plans OMB No. 1545-0074
Form (Including IRAs) and Other Tax-Favored Accounts 2015
Department of the Treasury » Attach to Form 1040 or Form 1040NR. Attachment
Internal Revenue Service (99) » Information about Form 5329 and its separate instructions is at www.irs. 329, quence No. 29

Name of individual subject to additional tax. If married filing jointly, see instructions. Your social security number

Home address (number and street), or P.O. box if mail is not delivered to your home Apt. no.

If You Are Filing This the spaces below (see instructions).
Form by Itself and Not
With Your Tax Return

If this is an amended
return, check here » O
Foreign country name Foreign province/state/county Foreign postal code

Fill in Your Address Only } Gity, town or post office, state, and ZIP code. If you have a foreign address, also complete

If you only owe the additional 10% tax on early distributions, you may be able to report this tax directly on Form 1040, line 59, or

Form 1040NR, line 57, without filing Form 5329. See the instructions for Form 1040, line 59, or for Form 1040NR, line 57.

Additional Tax on Early Distributions. Complete this part if you took a taxable distribution before you reached age 59%2
from a qualified retirement plan (including an IRA) or modified endowment contract (unless you are reporting this tax directly on
Form 1040 or Form 1040NR—see above). You may also have to complete this part to indicate that you qualify for an exception
the additional tax on early distributions or for certain Roth IRA distributions (see instructions).

1 Early distributions included in income. For Roth IRA distributions, see instructions . . . . 1 /'

2  Early distributions included on line 1 that are not subject to the additional tax (see mstructlons) /
Enter the appropriate exception number from the instructions: e 2

3  Amount subject to additional tax. Subtract line 2 from line1 . . . . 3

4 Additional tax. Enter 10% (.10) of line 3. Include this amount on Form 1040, line 59 or Form 1040NR Ilne 57 4

Caution: If any part of the amount on line 3 was a distribution from a SIMPLE IRA, you may have
to include 25% of that amount on line 4 instead of 10% (see instructions).
Il Additional Tax on Certain Distributions From Education Accounts and ABLE Accounts. Complete this part if
you included an amount in income, on Form 1040 or Form 1040NR, line 21, from a Coverdell education savings account
(ESA), a qualified tuition program (QTP), or an ABLE account.
5  Distributions included in income from a Coverdell ESA, a QTP, or an ABLE account
6 Distributions included on line 5 that are not subject to the additional tax (see instructions)
7
8

~|o| o

Amount subject to additional tax. Subtract line 6 from line5 . .

itil tax. Enter 10% (.10) of line 7. Include this amount on Form 1040, Ime 59 or Form 1040NR Ilne 57 8

m Additional Tax on Excess Contributions to Traditional IRAs. Complete this part if you contributed more to your
traditional IRAs for 2015 than is allowable or you had an amount on line 17 of your 2014 Form 5329.

9  Enter your excess contributions from line 16 of your 2014 Form 5329 (see instructions). If zero, go to line 15 9

10 If your traditional IRA contributions for 2015 are less than your

maximum allowable contribution, see instructions. Otherwise, enter -0- 10
11 2015 traditional IRA distributions included in income (see instructions) . 11
12 2015 distributions of prior year excess contributions (see instructions) . 12
13 Addlines 10, 11,and12 . . . . N I
14  Prior year excess contributions. Subtract Ilne 13 from hne 9 If zero or Iess enter 0- e B C)
15  Excess contributions for 2015 (see instructions) . . . . . . . . . . . . . . . . . |15
16  Total excess contributions. Add lines 14and 15 . . . . 16

17 Additional tax. Enter 6% (.06) of the smaller of line 16 or the value of your traditional IRAs on December 31, 2015
including 2015 contributions made in 2016). Include this amount on Form 1040, line 59, or Form 1040NR, line 57 . 17
m Additional Tax on Excess Contributions to Roth IRAs. Complete this part if you contributed more to your Roth
IRAs for 2015 than is allowable or you had an amount on line 25 of your 2014 Form 5329.

18  Enter your excess contributions from line 24 of your 2014 Form 5329 (see instructions). If zero, go to line 23 18
19  If your Roth IRA contributions for 2015 are less than your maximum

allowable contribution, see instructions. Otherwise, enter -0- . . . . 19
20 2015 distributions from your Roth IRAs (see instructions) . . . . . |20
21 Addlines19and20 . . . . N |
22 Prior year excess contributions. Subtract Ime 21 from hne 18 If zero or Iess enter 0- ... | 22
23  Excess contributions for 2015 (see instructions) . . . . . . . . . . . . . . . . . |23
24  Total excess contributions. Add lines22and23 . . . . 24

25  Additional tax. Enter 6% (.06) of the smaller of line 24 or the value of your Roth IRAs on December 31 2015
(including 2015 contributions made in 2016). Include this amount on Form 1040, line 59, or Form 1040NR, line 57 25
For Privacy Act and Paperwork Reduction Act Notice, see your tax return instructions. Cat. No. 13329Q Form 5329 (2015)

When using TaxSlayer® enter the amount
not subject to additional tax. Select the
appropriate exception from the drop down
menu.

Self Employment Tax —

Entered automatically from Schedule SE.
TaxSlayer® calculates the amount using the
entries from Schedule C.

Unreported Social Security and Medicare
Tax —

Comes from Form 4137 Tip income not
reported on Form W-2.

Additional Tax on IRA’s and Other
Qualified Plans —

A 10% penalty is calculated on Form 5329
for early withdrawal before age 59-1/2. If an
exception applies, enter the code and the
amount on line 2 of Form 5329. See codes
on next page.

Household Employment Taxes — (out-of-
scope)

Repayment of First-Time Homebuyer
Credit Form 5405 -

2008 homebuyers who received the First
Time Homebuyer Credit ($7,500 loan)
started repayments in 2010 and must enter
the repayment on page 2 of Form 1040,
Other Taxes section or complete Form 5405,
Part Il if required. (See 5405 instructions for
when it is required.)
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Other Taxes and payments (continued)

Exception codes and explanations for early distributions from IRA or retirement plans:
(Do not rely on this list alone. See Publication 590-B, Distributions from Individual Retirement
Arrangements (IRAs), for rules and details pertaining to each exception.)

No | Exception

o1 Qualified retirement plan distributions (doesn’t apply to IRAs) if you separated from service in or after the year
you reach age 55 (age 50 for qualified public safety employees).

02 Distributions made as part of a series of substantially equal periodic payments (made at least annually) for your
life (or life expectancy) or the joint lives (or joint life expectancies) of you and your designated beneficiary (if
from an employer plan, payments must begin after separation from service).

03 Distributions due to total and permanent disability.

04 Distributions due to death (doesn’t apply to modified endowment contracts).

05 Qualified retirement plan distributions up to (1) the amount you paid for unreimbursed medical expenses during
the year minus (2) 10% (7.5% if TP or Spouse is 65 or older) of your adjusted gross income for the year.

06 Qualified retirement plan distributions made to an alternate payee under a qualified domestic relations order
(doesn’t apply to IRAS).

07 IRA distributions made to unemployed individuals for health insurance premiums.
08 IRA distributions made for higher education expenses.
09 IRA distributions made for purchase of a first home, up to $10,000.

10 Distributions due to an IRS levy on the qualified retirement plan.

11 Qualified distributions to reservists while serving on active duty for at least 180 days.

12 Other (see Other, below). Also, enter this code if more than one exception applies. *

*Other: Distributions incorrectly indicated as early distributions by code 1, J, or S'in
box 7 of Form 1099-R. Include on line 2 the amount you received when you were
age 59 1/2 or older. See Form 5329 Instructions for additional exceptions.

For additional exceptions that apply to annuities, see Pub. 575.

Payments 64 Federal income tax withheld from Forms W-2 and 1099 . . 64
65 2015 estimated tax payments and amount applied from 2014 return | 65

”g;# ?:Ve 8 66a Earnedincomecredit(EIC) . . . . . . . . . . |e6a

ghi.d,yaﬁich b Nontaxable combat pay election | 66b

Schedule EIC. | 67  Additional child tax credit. Attach Schedule 8812 . . . . . | 67
68  American opportunity credit from Form 8863, line8 . . . 68
69 Net premium tax credit. Attach Form8962 . . . . . . 69
70  Amount paid with request for extensiontofile . . . . . | 70
71 Excess social security and tier 1 RRTA tax withheld . . . . | 71
72 Credit for federal tax on fuels. Attach Form 4136 . . . . | 72
73 Creditsfrom Form: a [ ] 2439 b [] Reserved c [ ] 8885 d [] 73
74  Add lines 64, 65, 66a, and 67 through 73. These are your total payments . . . . . P> | 74
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Payments and Estimates

Federal Income Tax Withheld — Amount Paid with Extension Request Directly enter
Entered automatically from the entries made on Forms any payment made. When preparing a Prior year return,
W-2, 1099, SSA 1099, etc. For Form 1099 withholding remember to ask if payments have been made.

not listed elsewhere, go to Other Federal Withholdings from

Excess Social Security —
the Payments & Estimates menu. y

Calculated automatically if there are multiple W-2s for an

2016 Estimated Tax Payments - individual and the combined wages exceed the maximum
Open Federal Estimated Payments for 2016 and enter: subject to Social Security for the year.
¢ Any refund amount from last year that was credited Credits from Form —

toward estimated taxes for the current year. 2439, 4136, 8801, 8885, 8689 (out-of-scope)

e Enter payment dates shown on taxpayer’s checks.
e Enter actual amount paid in each quarter.

73 Creditsfrom Form: a [ ]2439 b [] Reseed c [ ]8885 d [ ] [ 73 ] |
74 Add lines 64, 65, 66a, and 67 through 73. These are your total payments . . . . . » 74

Refund 75  Ifline 74 is more than line 63, subtract line 63 from line 74. This is the amount you overpaid 75

Amount Overpaid — Amount to be Applied to 2017 Estimated Tax —
Calculated automatically. From the Payments & Estimates screen select Apply
Overpayment to Next Year’s Taxes and enter the amount
of overpayment to apply to 2017.

Amount to be Refunded -
Calculated automatically.

76a Amount of line 75 you want refunded to you. If Form 8888 is attached, check here . » |:| 76a
Direct deposit? ® b Routing number > ¢ Type: :|:| Checking |:| Savings
'Se(te " » d Account number
nstructions. 77  Amount of line 75 you want applied to your 2016 estimated tax » | 77 | |

Estimated Tax Penalty —
Out of Scope

12/2016 H-3
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Earned Income Table

Earned Income

Includes

Doesn’t include

Taxable wages,
salaries, and tips
Union strike
benefits

Taxable long-term
disability benefits
received prior to
minimum retirement
age

Net earnings from
self-employment
Gross income of a
statutory employee
Household
employee income
Nontaxable combat
pay election
Non-Employee
compensation

The rental value

of ahome or a
housing allowance
provided to a
minister as part of
the minister’s pay
(Out of Scope)

Interest and dividends

Social security and railroad retirement benefits

Welfare benefits

Workfare payments

Pensions and annuities (except if disability pension and taxpayer is under
minimum retirement age)

Veteran’s benefits (including VA rehabilitation payments)

Workers’ compensation benefits

Alimony

Child support

Nontaxable foster-care payments

Unemployment compensation

Taxable scholarship or fellowship grants that aren’t reported on Form W-2
Earnings for work performed while an inmate at a penal institution or on work
release*

Salary deferrals (for example, under a 401 (k) or 403(b) plan or the Federal Thrift
Savings Plan)

The value of meals or lodging provided by an employer for the convenience of the
employer

Disability Insurance payments

Excludable dependent care benefits (line 24 of Form 2441)

Salary reductions such as under a cafeteria plan

Excludable employer-provided educational assistance benefits (may be shown in
box 13 of Form W-2)

Anything else of value received from someone for services performed, if it isn’t
currently taxable, which include Medicaid waiver payments that have been
excluded from income.

/

Common EIC Filing Errors

N

Claiming a child who doesn’t meet the residency and relationship requirements

Married taxpayers incorrectly filing as a single or head of household

Incorrectly reporting income, particularly income and expenses from self employment

Incorrect social security numbers

/

*Note: This particular income is entered both as normal income and again as other income>>other
compensation>>prisoner income. It is not counted as earned income for EITC, ACTC or CDCC.
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‘=] Summary of EIC Eligibility Requirements

Part A Part B Part C
Rules for Everyone Rules If You Have Rules If You Don’t
a Qualifying Child Have a Qualifying Child
Taxpayers & qualifying children Child must meet the relationship, Must be at least age 25 but under
must all have SSN that is valid age, residency test and joint age 65 as of December 31.*
for employment. (See note below return tests. If child is married, see
regarding new requirement.) additional rules in Publication 17.
Filing status can’t be married Qualifying child can’t be used by Can’t be the dependent of another
filing separately. more than one person to claim the person.
EIC.
Must be a U.S. citizen or resident The taxpayer can’t be a qualifying Must have lived in the United
alien all year. child of another person. States more than half the year.
Can't file Form 2555 or Can’t be a qualifying child of
Form 2555-EZ (relating to foreign another person.
earned income).
Investment income must be $3,400
or less.
Can’t be a qualifying child of
another person.
Part D
Earned Income and AGI Limitations
You must have earned income to qualify for this credit.
Your earned income and AGI must be less than:
W $47,955 ($53,505 for married filing jointly) if you
have three or more qualifying children,
W $44,648 ($50,198 for married filing jointly) if you
have two qualifying children,
W $39,296 ($44,846 for married filing jointly) if you
have one qualifying child, or
W $14,880 ($20,430 for married filing jointly) if you
\ don’t have a qualifying child.

U\

/ Disallowance of the Earned Income Credit

Form 8862, Information to Claim Earned Income Credit After Disallowance, must be completed for any
taxpayer whose EIC claim was denied or reduced for any reason other than a math or clerical error. If
the taxpayer’s EIC was denied or reduced as a result of a math or other clerical error, Form 8862 isn’t
required.

If the IRS determined a taxpayer claimed the EIC due to reckless or intentional disregard of the EIC

rules the taxpayer can’t claim the EIC for 2 tax years. If the error was due to fraud, then the taxpayer
Kcan’t claim the EIC for 10 tax years. See Publication 596, Earned Income Credit, for specific guidance. /

*Taxpayers turning 25 on January 1st are considered to be 25 as of December 31st. Taxpayers reaching the
age of 65 on January 1st are still considered 64 as of December 31st.

Note: Taxpayers meeting the above age criteria should file a paper return to avoid a potential rejected
electronic filed return.

Caution: New law passed requiring taxpayers to have a valid SSN by the due date of the return (including
extension) in order to claim EITC. Taxpayers can'’t file amended returns to claim the credit for a year that the
taxpayer didn’t originally have a valid social security number.
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interview
tips

-
EIC General Eligibility Rules

Probe/Action: Ask the taxpayer:

step

Calculate the taxpayer’s earned income and adjusted gross
income (AGI) for the tax year. Are both less than:

e $47,955 ($53,505 married filing jointly) with three or
more qualifying children;

» $44,648 ($50,198 married filing jointly) with two
qualifying children;

* $39,296 ($44,846 married filing jointly) with one
qualifying child; or

e $14,880 ($20,430 married filing jointly) with no
qualifying children?

If YES, go to Step 2.
If NO, STOP. You can’t claim the EIC.

step

Do you (and your spouse, if filing jointly) have a social secu-
rity number (SSN) that allows you to work?*

Note: Answer “no” if the taxpayer’s social security card has
a “NOT VALID FOR EMPLOYMENT” imprint, and if the card-
holder obtained the SSN to get a federally funded benefit,
such as Medicaid.

If YES, go to Step 3.
If NO, STOP. You can’t claim the EIC.

step

13/

Is your filing status married filing separately?

If YES, STOP. You can'’t claim the EIC.
If NO, go to Step 4.

step

4/

Are you (or your spouse, if married) a nonresident alien?
Note: Answer “no” if the taxpayer is married filing jointly, and
one spouse is a citizen or resident alien and the other

is a nonresident alien.

If YES and you are either unmarried
or married but not filing a joint return,
STOP. You can’t claim the EIC.

If NO, go to Step 5.

6/

step  Are you (or your spouse, if filing jointly) filing Form 2555 or If YES, STOP. You can’t claim the EIC.
6 Form 2555-EZ (Foreign Earned Income) to exclude income  If NO, go to Step 6.

earned in a foreign country?
step Is your investment income (interest, tax exempt interest, If YES, STOP. You can'’t claim the EIC.

dividends & capital gains) more than $3,400?

If NO, go to Step 7.

step

(7]
N

Are you (or your spouse, if filing jointly) the qualifying child
of another taxpayer?

If YES, STOP. You can'’t claim the EIC.
If NO, go to the interview tips for
EIC—With a Qualifying Child or
EIC—Without a Qualifying Child.

/

*Note: If your Social Security card says VALID FOR WORK ONLY WITH DHS AUTHORIZATION, you
can use your Social Security number to claim EITC if you otherwise qualify.



p
EIC with a Qualifying Child

1

intflrview Probe/Action: Ask the taxpayer:
ips
step Does your qualifying child have an SSN that allows If YES, go to Step 2.

him or her to work?

Note: Answer NO if the child’s social security card
says “NOT VALID FOR EMPLOYMENT” and his or
her SSN was only obtained to get a federally funded
benefit.

If NO, STOP. You can’t claim the EIC on the basis
of this qualifying child.

step

12/

Is the child your son, daughter, stepchild, adopted
child, or eligible foster child, brother, sister, half
brother, half sister, stepbrother, stepsister, or a
descendant of any of them?

If YES, go to Step 3.

If NO, STOP. This child isn’t your qualifying child.
Go to interview tips for EIC without a Qualifying
Child.

step

13/

Was the child any of the following at the end of the

tax year:

e Under age 19 and younger than the taxpayer (or
spouse, if filing jointly)

* Under age 24 and a full-time student and younger

than the taxpayer (or spouse, if filing jointly), or
* Any age and permanently and totally disabled?

If YES, go to Step 4.

If NO, STOP. This child isn’'t your qualifying child.
Go to interview tips for EIC without a Qualifying
Child.

step

Did the child file a joint return for the year?’
Note: Answer NO if the child and his or her spouse
filed a joint return only as a claim for a refund.

If NO, go to Step 5.

If YES, STOP. This child isn’t your qualifying child
(failed the joint return test). Go to interview tips
for EIC without a Qualifying Child.

step

Did the child live with you in the United States for
more than half (183 days for 2016) of the tax year?

Note: Active duty military personnel stationed outside

the United States are considered to live
in the United States for this purpose.

If YES, go to Step 6.

If NO, STOP. This child isn’t your qualifying child.
Go to interview tips for EIC without a Qualifying
Child.

step

Is the child a qualifying child of another person?
Note: There may be a case when a qualifying child
can’t be claimed by anyone. Example: The only
parent that the child lives with doesn’t work nor files

a tax return and another adult can’t meet the general

eligibility rules. In this example no one qualifies to
claim this child as a qualifying child
for EIC.

If YES, explain to the taxpayer what happens
when more than one person claims the EIC using
the same child (Qualifying Child of More than
One Person rule). If the taxpayer chooses to
claim the credit with this child, compute the EIC
using the appropriate EIC worksheets.

If no, compute the EIC using the appropriate EIC
worksheet.

N

" If your child was married at the end of the year, he or she doesn’t meet the joint return test unless you can claim the child’s
exemption or you can’t claim the child’s exemption because you gave that right to the child’s other parent.

/
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4 . e .
EIC Without a Qualifying Child

interview Probe/Action: Ask the taxpayer:
tips
step  Can you (or your spouse, if filing jointly) be claimed as a If NO, go to Step 2.
o dependent by another person? If YES, STOP. You can't claim the EIC.
step  Were you (or your spouse, if filing jointly) at least 25 but If NO, STOP. You can’t claim the EIC.

9 under age 65 on December 31 of the tax year? Taxpayers If YES, go to Step 3.
born on January 1st are considered to be of age as of
December 31st. Taxpayers reaching the age of 65 on
January 1st are still considered 64 as of December 31st.

step  Did you (and your spouse, if filing jointly) live in the If NO, STOP. You can’t claim the EIC.
e United States for more than half (at least 183" days) of If YES, compute EIC using the appropriate
the tax year? EIC worksheet.
K ' More than 183 days in a leap year. /

Note: If you can’t claim the EIC because your qualifying child is treated under the tiebreaker rules as the
qualifying child of another person for 2016, you may be able to take the EIC using a different qualifying child,
but you can’t take the EIC using the rules for people who don’t have a qualifying child.

/ Qualifying Child of More than One Person A

If the child meets the conditions to be the qualifying child of more than one person, only one person can
claim the child. The following rules apply if multiple taxpayers claim the same qualifying child.

* If only one of the persons is the child’s parent, the child is treated as the qualifying child of the
parent.

* If the parents don't file a joint return together but both parents claim the child as a qualifying
child, the IRS will treat the child as the qualifying child of the parent with whom the child lived
for the longer period of time in 2016. If the child lived with each parent for the same amount
of time, the IRS will treat the child as the qualifying child of the parent who had the higher
adjusted gross income (AGl) for 2016.

* If no parent can claim the child as a qualifying child, the child is treated as the qualifying child
of the person who had the highest AGI for 2016.

e If a parent can claim the child as a qualifying child but no parent does so claim the child, the
child is treated as the qualifying child of the person who had the highest AGI for 2016, but
only if that person’s AGl is higher than the highest AGI of any of the child’s parents who can
claim the child.

N J

Note: Taxpayers have the option to choose which taxpayer will claim the child. The tiebreaker
rules apply when the child is claimed by multiple taxpayers.




Schedule EIC — Checksheet

Answer “Yes.”
A “No” answer will eliminate
EIC from the return.

EIC Checklist

Qualifying Information

Was the taxpayer a nonresident alien for any part of the year? Yes No
Is the taxpayer (or spouse) a qualifying child of another person? Yes No
Did you complete form 8867 and/or perform the due diligence required based on current ®) Yes No

information provided by the taxpayer or reasonably obtained by you?

Did you ask this taxpayer any additional questions that are necessary to meet your knowledge
requirement?

Does Not Apply

Did you comply with the EIC due diligence knowledge requirements? ®) Yes No

To comply with the EIC knowledge requirement, you must not know or have reason to know that

0 any information used to determine the taxpayer’s eligibility for, and the amount of, the EIC is
incorrect. You must not ignore the implications of information furnished to or known by you, and
you must make reasonable inguiries if the information furnished appears to be incorrect,
inconsistent, or incomplete. At the time you make these inquiries, you must document in your files
the inquiries you made and the taxpayer's responses.

Records

Did you keep the records found below? Yes (@) No

—Form 8867 (or your own form or files).

0 —The EIC worksheet(s) or your own worksheet(s).
—Record of how, when, and from whom the information used to prepare the form and worksheet
(s) was obtained.

Qualifying Child #1 - Denis Montana XXX-00-XXXX

Is this child currently, or intended to be, a qualifying child on any other individual's tax return? Yes No

Documents used to determine Residency

School records or statement

Landlord or property management statement
Health care provider statement

Medical records

Child care provider records

Placement agency statement

Social service records or statement

Place of worship statement

Indian tribal official statement

Employer Statement

Other

Did not rely on any documents, but made notes in file

+ | Did not rely on any documents

NOTE: Quality Site Requirement 2 — Intake/Interview & Quality Review Process, states:

Answer “Does Not Apply”

Answer “Yes.” Generally,
as an IRS tax law-
certified volunteer, you
can rely in good faith

on information from

a taxpayer without
requiring documentation
as verification. However,
part of due diligence
requires asking a
taxpayer to clarify
information that may
appear to be inconsistent
or incomplete. When
reviewing information for
its accuracy, you need
to ask yourself if the
information is unusual or
questionable.

Select “No.” Selecting No
will not prohibit the return
from being electronically
filed. The Form 8867 is
not included in the forms
that have to be E-filed.

Select “Did not rely on
any documents”

All IRS tax law-certified volunteers are required to exercise due diligence. This means, as a volunteer, you are required to do your part
when preparing or quality reviewing a tax return to ensure the information on the tax return is correct and complete. Doing your part
includes: confirming a taxpayer’s (and spouse, if applicable) identity and providing top-quality service by helping them understand and
meet their tax responsibilities.
Generally, as an IRS tax law-certified volunteer, you can rely in good faith on information from a taxpayer without requiring documenta-
tion as verification. However, part of due diligence requires asking a taxpayer to clarify information that may appear to be inconsistent or
incomplete. When reviewing information for its accuracy, you need to ask yourself if the information is unusual or questionable.

I-6
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(" Tax Treatment of Scholarship and Fellowship Payments )
A scholarship or fellowship is tax free (excludable from gross income) only if:
* You are a candidate for a degree at an eligible educational institution. You are a candidate for a
degree if you attend a primary or secondary school or are pursuing a degree at a college or university,
or attend an educational institution that offers a program of training to prepare students for gainful
employment in a recognized occupation and is authorized under federal or state law to provide such a
program and is accredited by a nationally recognized accreditation agency.
A scholarship or fellowship is tax free only to the extent:
* It doesn’t exceed your qualified education expenses;
e [tisn’t designated or earmarked for other purposes (such as room and board), and doesn’t require (by
its terms) that it can’'t be used for qualified education expenses; and
* It doesn’t represent payment for teaching, research, or other services required as a condition for
receiving the scholarship. (But for exceptions, see Payment for services in Publication 970).
KUse Worksheet 1-1 to figure the amount of a scholarship or fellowship you can exclude from gross income. /

4 Education Expenses )
The following are qualified education expenses for the purposes of tax-free scholarships and
fellowships:

* Tuition and fees required to enroll at or attend an eligible educational institution

* Course-related expenses, such as fees, books, supplies, and equipment that are required for the
courses at the eligible educational institution. These items must be required of all students in your
course of instruction.

Qualified education expenses don’t include the cost of:

* Room and board e Travel
e Research e Clerical help
* Equipment and other expenses not required for enrollment in or attendance at an eligible
\ educational institution /

Worksheet 1-1. Taxable Scholarship and Fellowship Income

1. Enter the total amount of any scholarship or fellowship for the tax year. .... 1.

* If you are a degree candidate at an eligible educational institution, go to line 2.
* If you aren’t a degree candidate at an eligible educational institution, stop here.
The entire amount is taxable.

2 Enter the amount from line 1 that was for teaching, research, or any other services 2.
required as a condition for receiving the scholarship. (Don’t include amounts received
for these items under the National Health Service Corps Scholarship Program or the
Armed Forces Health Professions Scholarship and Financial Assistance Program.)

3. Subtract INe 2 from NE 1 ..ot eaees

4. Enter the amount from line 3 that your scholarship or fellowship required you to use
for other than qualified education EXPENSES ........coeveiieiciiiiiiieeee e

5.  Subtract iNe 4 from NG S. ..o

6. Enter the amount of your qualified education expenses (see Education Expenses 5.
= 01011/ S 6.
7. Enter the smaller of line 5 or line 6. This amount is the most you can exclude from
your gross income' (the tax-free part of the scholarship or fellowship) .......cccccceeen.e. 7.

8. SUbract INE 7 froOmM NE 5 ...t eeeaees

9. Taxable part. Add lines 2, 4, and 8. This amount is taxable to the person in whose
name the scholarship was received. .........c.ccci

" However, a scholarship or fellowship grant isn’t treated as tax free to the extent the student includes it in gross income (the student may or may not be required to file a
tax return) for the year the scholarship or fellowship grant is received and either:

- The scholarship or fellowship grant (or any part of it) must be applied (by its terms) to expenses (such as room and board) other than qualified education expenses.

- The scholarship or fellowship grant (or any part of it) may be applied (by its terms) to expenses (such as room and board) other than qualified education expenses.
You may be able to increase the combined value of an education credit and certain educational assistance if the student includes some

or all of the educational assistance in income in the year it is received. J-1
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/Tuition and Fees Deduction at a Glance

Don'’t rely on this table alone. Refer to Publication 17 complete details.

Question

Answer

What is the maximum benefit?

You can reduce your income subject to tax by up to $4,000.

Limit on modified adjusted gross income (MAGI)

$160,000 if married filing joint return; $80,000 if single, head of
household, or qualifying widow(er).

Where is the deduction taken?

As an adjustment to income on Form 1040.

For whom must the expenses be paid?

A student enrolled in an eligible educational institution who is
either;

. you

. your spouse, or

J your dependent for whom you claim an exemption

What tuition and fees are deductible?

Tuition and fees required for enrollment or attendance at an
eligible postsecondary educational institution, but not including
personal, living or family expenses, such as room and board.

What records does the taxpayer need?

N

Beginning in tax year 2016, the tuition and fees deduction won’t
be allowed unless the taxpayer possesses a valid information
return (Form 1098-T, Tuition Statement) from the educational

institution. j
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4 _ _ N
Education Credits

Probe/Action: To determine if a taxpayer qualifies for the Education Credit.

Comparison of Education Credits

American Opportunity Credit Lifetime Learning Credit
Up to $2,500 per eligible student Up to $2,000 credit per return

Available only for 4 tax years per eligible student | Available for all years of post secondary
(including any year(s) Hope Scholarship Credit education and for courses to acquire or improve

was claimed). (see note at bottom of page) job skills

Forty percent (.40) of the credit is refundable’ Non refundable credit

(Up to $1,000 even if no taxes are owed)

Student must be pursuing a program leading Student doesn’t need to be pursuing a degree
to a degree or other recognized education or other recognized education credential
credential

Student must be enrolled at least half time for at | Available for one or more courses
least one academic period beginning during the

year
No felony drug conviction on student’s record Felony drug conviction rule doesn’t apply
Credit is reduced if modified AGl is between Credit is reduced if modified AGl is between
$80,000 and $90,000 ($160,000 and $180,000 if | $55,000 and $65,000 ($111,000 and $131,000
married filing jointly) if married filing jointly)

Who Can Claim the Credit?

* Taxpayers who paid qualified educational expenses of higher education for an eligible student.

e Taxpayers who paid the education expenses for a student enrolled at or attending an eligible
educational institution. (to determine if eligible, see http://ope.ed.gov/accreditation)

e The eligible student is either the taxpayer, taxpayer’s spouse or a dependent for whom the taxpayer
claims an exemption on the tax return.

Note: Qualified education expenses paid by a dependent for which an exemption is claimed, or by a
third party for that dependent, are considered paid by the taxpayer. If a student isn’t claimed
as a dependent (even if eligible to be claimed), only the student can claim an education credit
no matter who paid the expenses. This doesn’t entitle the student to claim a personal
exemption on his/her tax return. Anyone paying the expenses (even directly to the institution)
are considered to have given a gift to the student who in turn is treated as having paid the
expenses.

" None of the credit is refundable if (1) the taxpayer claiming the credit is (a) under age 18 or (b) age 18 at the end of
the year, and their earned income was less than one-half of their own support or (c) a full time student over 18 and
under 24 and their earned income was less than one-half of their own support; and (2) the taxpayer has at least one
living parent, and; (3) the taxpayer doesn'’t file a joint return

Note: There are two 4-year tests for American Opportunity Credit. First, the credit can be taken only four tax years.
Second, the student must not have completed four years of academic credit before the beginning of this tax year. Follow
the examples in the Who is Eligible Student for the American Opportunity Credit section in Publication 970 for
additional information.

N J
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http://ope.ed.gov/accreditation

/ Education Credits (Continued) A

Probe/Action: To determine if a taxpayer qualifies for the Education Credit.

Who Can Claim a Dependent’s Expenses?

If the taxpayer... Then only...
Claims an exemption on the return for a The taxpayer can claim the credit based on that
dependent who is an eligible student dependent’s expenses. The dependent can’t claim
the credit.

Doesn’t claim the exemption on the tax return | The dependent can claim the credit. The taxpayer
can’t claim the credit based on the dependent’s
expenses.

Who Can’t Claim the Credit?

o Married filing separate filing status
o Anyone listed as a dependent on another person’s tax return
o Taxpayers whose modified AGl is more than the allowable income limits
. Taxpayer (or the spouse) was a nonresident alien for any part of the tax year unless one of
the exceptions listed in Pub. 519 applies
What Expenses Qualify?
J Expenses paid for an academic period starting in 2016 or the first 3 months of 2017
. Expenses not refunded when the student withdraws from class
J Expenses paid with the proceeds from a loan

What are Qualifying Expenses?

J The term “qualified tuition and related expenses” is expanded for the American
Opportunity credit (AOC) to include expenditures for course materials. For this purpose,
course materials are books, supplies, and equipment needed for a course of study
whether or not the materials are purchased from the educational institution as a condition
of enrollment or attendance.

What is Tax-Free Educational Assistance?
Tax-free parts of scholarships and fellowships
Pell grants (see chapter 1 of Publication 970)
Employer-provided educational assistance (see Publication 970)
Veterans’ educational assistance
Any other nontaxable payment (other than gifts or inheritances) received as educational
assistance

Note: Don’t reduce the qualified education expenses by any scholarship or fellowship reported
as income on the student’s tax return if the use of the scholarship isn’t restricted and
used to pay education expenses that aren’t qualified (such as room and board).

Note: New law enacted in 2015 requires a taxpayer claiming the American Opportunity Credit
to report the EIN of the educational institution of the student claimed on the return.

Note: Taxpayers claiming the AOC must have a valid identification number (SSN, ATIN, ITIN)
by the due date of the return (including extensions). Further, any student claimed must
also have a valid identification number by the due date of the return. Taxpayers can’t file
amended returns to claim the credit for any year that the taxpayer and/or student didn’t
originally have a valid number.

N J

J-6




Determining Qualified Education Expenses

Box 1 may include non-taxable scholarship and grant amounts. Be sure to subtract these before using an amount from this
box as qualifying expenses. Some students may choose to pay non-qualifying expenses with scholarship/Pell Grant funds,
making the scholarship/Pell Grant taxable. This is true even if the scholarship/grant was paid directly to the school. This
may increase the amount of qualifying expenses that can be used in calculating an education credit.

Box 2 Shows the total amount billed in 2016 for qualified tuition and related expenses less any reduction in charges made
in 2016 that relate to those billed in 2016.

FILER'S name, street address, city or town, state or province, country, ZIP or | 1 Payments recelved for OMB No. 1545-1574
forelgn postal code, and telephone number qualified tuition and related
expenses
: 2016 rutr
2 Amounts billed for Statement
qualified tuition and
related expenses
8 Form 1098-T
FILER'S federal identification no. STUDENT'S soclal security number | 3 If this box Is checked, your educational institution Cgpy B
2016
has changad its reporting method for 0] For Student
STUDENT'S name 4 Adjustments made for a 5 Scholarships or grants
prior year
$ $ This is important
Street address (ncluding apt. no.) 6 Adjustments to 7 Chackad If the amount in tax information
schalarships or grants box 1 or 2 Includes and is being
for a prior year amounts for an acadermic fumished to the
Gity or town, state or province, country, and ZIP or forelgn postal code period beginning January - Internal Revenue
2017 » i
$ March 20 N Service.
Service Provider/Acct. No. (see instr.) 8 Check If at least 9 Checked if a graduate 10 Ins. contract reimb./refund
half-time student ]| stweent . . . . [J|g
rorm 1098-T fkeep for vour records) www.Irs.gov/form1098t Department of the Treasury - Interal Revenue Service

Determine the amount paid by verifying the payment received from the student account statement with the
amount shown in Box 1 or 2 of Form 1098-T. Remember to include books, supplies, materials and equipment if
claiming the American Opportunity Credit. Also remember to include out of pocket payments made by the student or on
the student’s behalf. This includes student loans, payments, credit cards and taxable portions of scholarships/grants.

Adjusted Qualified Education Expenses Worksheet (Form 8863 instructions)

1. Total qualified education expenses paid for on behalf of the student in 2016 for the academic period . .................. 5,500

2. Less adjustments:

a. Tax-free educational assistance received in 2016 allocable to the academic period. ......... 3,000
b. Tax-free educational assistance received in 2017 (and before you file your 2016 tax return)
allocable to the academic period . ... ... i 0
c. Refunds of qualified education expenses paid in 2016 if the refund is received in 2016 or in 2017
before you file your 2016 tax return ... 0
3. Total adjustments (add lines 2a, 2b, @aNA 2C) . . . .. ...ttt e 3,000
4. Adjusted qualified education expenses. Subtract line 3 from line 1. If zero or less, enter-0- .. ............... ... ... .. 2,500

Example - Bill and Sue are eligible to claim the American Opportunity Credit for their daughter Sarah, who is in her first
year of college. They have a Form 1098-T with $10,000 in box 2 and a $3,000 Pell grant in box 5. During your interview
with Bill and Sue, you determine that $5,000 was paid in September 2016 for the fall semester; $3,000 was paid by Pell
Grant and $2,000 was paid by loan proceeds. Also, $5,000 was billed in December for the Spring 2017 semester, which
was paid in January 2017. They paid $500 for books in 2016. To calculate the eligible expenses for their credit, take the
$5,000 ($3,000 grant + $2,000 loan) paid in 2016 plus the $500 for books and enter on line 1 of the worksheet above.
The $3,000 will be entered on line 2a. The line 3 amount would be $3,000. Subtracting line 3 from line 1, you get qualified
education expenses of $2,500. In this same example, if the taxpayers opted to include all the income as wages, they
wouldn’t have any adjustments to subtract to determine their expenses.

Note: If the student doesn’t have a copy of their student account statement, ask them to go online thru their
College or University to get this information.
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Entering Education Benefits

Income Deductions Other Taxes Payments & Estimates Miscellaneous Forms

Deductions

Adjustments

Standard Deduction

ltemized Deductions

Credits Menu

Compare Deductions

Credits

Foreign Tax Credit (Form 1116)

Child Care Credit (Form 2441)

Education Credits (Form 1098-T)

Form 8863 - Educational Credit

Credit Type MName/SSN Qualifying Expenses

American Opportunity Dependent Taxpayer 1500.00 - -

Credit 411-00-XXXX

Lifetime Learning Mrs Taxpayer 400.00 - -
4711-00-XXXX

Tuition and Fees Mr Taxpayer 250.00 - -
4711-00-XXXX

Note: TaxSlayer® will allow you to compare the education benefits and determine the largest refund using each benefit.

J-8



Entering Education Benefits (continued)

Farm 8863 - Educational Credit

-
Inatitution 1

Augusta University

Haa thi Hope Scholeeskip Cradil or Armerican Opporbarity Credit sieady been o

£ 5000

b Tamparyar
AT100XXXX

—

If the taxpayer was under age 24 at the
end of the year and met the conditions
as outlined in the TIP on the next page,
they can’t take the refundable American
Opportunity credit.

See determining qualified expenses
page earlier in tab.

For lifetime learning credit-course
books, materials, supplies not included
unless paid directly to institution as
condition of enroliment.

e Only the taxpayer is eligible if he or she claims the student as a dependent. Only the student is eligible if he or she
isn’'t claimed as a dependent (even if he or she can be claimed) - no matter who pays.

¢ For the American Opportunity credit only, qualified tuition & related expenses include books, supplies & equipment
needed for the course, whether or not they were purchased from the institution as a condition of enroliment.
Computers, however, can only be included IF they are a requirement for enroliment or attendance.

Note: The following aren’t qualifying expenses for Education Credits: room and board, insurance, medical, transportation,
or personal expenses, even if the amount must be paid to the institution as a condition of enrollment or attendance. If the
educational expenses are associated with sports, games, hobbies, or other noncredit courses, see Publication 970 for

more information.



/ Student Under Age 24 Claiming o

American Opportunity Credit

1.We;'e you under 24 at the end of If no, stop here; you do qualify to claim part of the
20167 allowable American opportunity credit as a refundable
credit.

If yes, go to question 2.

2. Were you over 18 at the end of If yes, go to question 3.
20167? ’
If no, go to question 4.
3. Were you a full-time ’s,tudent If no, stop here; you do qualify to claim part of your
(defined later) for 20167 allowable American opportunity credit as a refundable

credit.

If yes, go to question 5.

4. Were you 18 at the end of 2016? If yes, go to question 5.

If no, go to question 6.

5. Was your earned income (defined | |t 1o stop here; you do qualify to claim part of your

later) less than one-half of your allowable American opportunity credit as a refundable
support for 2016? credit.

If yes, go to question 6.

6. Was either of your parents alive If no, stop here; you do qualify to claim part of your
at the end of 20167 allowable American opportunity credit as a refundable
credit.

If yes, go to question 7.

7. A“; you filing a joint return for If no, you don’t qualify to claim part of your allowable
20167 American opportunity credit as a refundable credit.

If yes, you do qualify to claim part of your allowable
American opportunity credit as a refundable credit.

Earned income. Earned income includes wages, salaries, professional fees, and other payments received for
personal services actually performed. Earned income includes the part of any scholarship or fellowship that
represents payment for teaching, research, or other services performed by the student that are required as a condition
for receiving the scholarship or fellowship. Earned income doesn’t include that part of the compensation for personal
services rendered to a corporation which represents a distribution of earnings or profits rather than a reasonable
allowance as compensation for the personal services actually rendered.

Full-time student. You were a full-time student for 2016 if during any part of any 5 calendar months during the year
you were enrolled as a full-time student at an eligible educational institution (defined earlier), or took a full-time, on-
farm training course given by such an institution or by a state, county, or local government agency.

N J
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Form 1040 Job Aid

¢1040

Department of the Treasury—Internal Revenue Service (99)

U.S. Individual Income Tax Return

2016

OMB No. 1545-0074 | IRS Use Only—Do not write or staple in this space.

For the year Jan. 1-Dec. 31, 2016, or other tax year beginning , 2016, ending ,20 See separate instructions. ’
Your first name and initial Last name Your social security number

If a joint return, spouse’s first name and initial Last name Spouse’s social security number
Home address (number and street). If you have a P.O. box, see instructions. Apt. no. Make sure the SSN(s) above

and on line 6¢ are correct.

City, town or post office, state, and ZIP code. If you have a foreign address, also complete spaces below (see instructions).

Presi ial Election C

Check here if you, or your spouse if filing

Foreign country name

Foreign province/state/county

Foreign postal code

jointly, want $3 to go to this fund. Checking
a box below will not change your tax or

refund. [] You []Spouse
Filing Status 1 D Single 4[] Head of household (with qualifying person). (See instructions.) If
2 D Married filing jointly (even if only one had income) the qualifying person is a child but not your dependent, enter this

Check only one 3 [ ] Married filing separately. Enter spouse’s SSN above child’s name here. »
box. and full name here. » 5[] Qualifying widow(er) with dependent child
Exemptions 6a [ Yourself. If someone can claim you as a dependent, do not check box 6a . } E:’ézsa‘:‘f&egléed

b [ Spouse . A N No.of children —

¢ Dependents: (2) Dependent's (3) Dependent’s (4) v if child under age 17 on 6¢ who:

(1) First name

La8hame social security number relationship to you (see instructions)

qualifying for child tax credit

* lived with you
« did not live with

you due to divorce

If more than four

or
(see instructions)

dependents, see
instructions and

Dependents on 6¢c
not entered above

check here »[]

I

Add numbers on

} Tab K
Tab B
> TabC

d Total number of exemptions claimed lines above »
Income 7  Wages, salaries, tips, etc. Attach Form(s) W-2 7
8a Taxable interest. Attach Schedule B if required L 8a
b Tax-exempt interest. Do not include on line 8a . ‘ 8b ‘ ‘
x‘;‘:"‘ef:’xl‘g 9a Ordinary dividends. Attach Schedule B if required . . . . . |oa
attach Farms b Qualified dividends Lon | |
W-2G and 10  Taxable refunds, credits, or of‘fsets of state and local income taxes 10
1099-R if tax 11 Alimony received . . 11
was withheld. 12  Business income or (loss). Attach Schedule C or C EZ . 12
. 13  Capital gain or (loss). Attach Schedule D if required. If not requlred check here > |:| 13 Tab D
It );ouxldznot 14  Other gains or (losses). Attach Form 4797 . P 14
g:e ?nstr_'ucy:tions. 15a IRA distributions . 15a b Taxable amount 15b
16a Pensions and annuities | 16a b Taxable amount 16b
17 Rental real estate, royalties, partnerships, S corporations, trusts, etc. Attach Schedule E 17
18 Farm income or (loss). Attach Schedule F . 18
19 Unemployment compensation e Ce e 19
20a Social security benefits | 20a l ‘ b Taxable amount 20b
21 Other income. List type and amount 21
22  Combine the amounts in the far right column for lines 7 through 21. This is your total income » 22
. 23  Educator expenses . . 23
AdIUSted 24  (Certain business expenses of reservists, performlng artists, and
Gross fee-basis government officials. Attach Form 2106 or 2106-EZ 24
Income 25 Health savings account deduction. Attach Form 8889 . | 25
26 Moving expenses. Attach Form 3903 . . . . .| 26
27 Deductible part of self-employment tax. Attach Schedule SE . | 27 Tab E:
28  Self-employed SEP, SIMPLE, and qualified plans . . | 28
29  Self-employed health insurance deduction . . . . | 29
30  Penalty on early withdrawal of savings. . . . . . | 30
31a Alimony paid b Recipient’s SSN » 31a
32 IRA deduction . . . 5 & o o a o o o 32
33  Student loan interest deduction. . . . . . . . | 33
34  Tuition and fees. Attach Form 8917. . . . 34 < Tab J
35 Domestic production activities deduction. Attach Form 8903 35
36  Add lines 23 through 35 . . .o . 36
37  Subtract line 36 from line 22. This is your adjusted grossincome . . . . . b 37

For Disclosure, Privacy Act, and Paperwork Reduction Act Notice, see separate instructions.

Cat. No. 11320B

Form 1040 (2016)




Form 1040 Job Aid-Page 2

Form 1040 (2016) Page 2
38  Amount from line 37 (adjusted gross income) . L 38 h
Tax and 39a Check | [] You were born before January 2, 1952, [ Blind. ] Total boxes
Credits if: O .Spo.use was born before January 2, 1952,  [] Blinq. checked > 39a
b If your spouse itemizes on a separate return or you were a dual-status alien, check here»  39b[ ]
Standard 40  Itemized deductions (from Schedule A) or your standard deduction (see left margin) 40
B;d_uctlon 41 Subtract line 40 from line 38 o o Gl
* People who | 42 Exemptions. If line 38 is $155,650 o less, multlply $4 050 by the number on line 6d. Otherwise, see instructions | 42
ggicgnal?ge 43  Taxable income. Subtract line 42 from line 41. If line 42 is more than line 41, enter -0- 43
%%ao %ra?]gge“ 44  Tax (see instructions). Check if any from: a [ | Form(s) 8814 b [ ]Form 4972 ¢ [] 44
claimedasa | 45  Alternative minimum tax (see instructions). Attach Form 6251 45
;’Sg SIEETE 46 Excess advance premium tax credit repayment. Attach Form 8962 . . e 46 <
instructions. | 47 Add lines 44, 45, and 46 . . . R v
¢ All others: L
Single or 48 Foreign tax credit. Attach Form 1116 if requwed 48 }
Married filing | 49  Credit for child and dependent care expenses. Attach Form 2441 49
Separately, 50  Education credits from Form 8863, line 19 50 < :
Married filing | 51 Retirement savings contributions credit. Attach Form 8880 51 h
ghn;my?,q 52  Child tax credit. Attach Schedule 8812, if required. 52
widow(er), 53  Residential energy credits. Attach Form 5695 . . . 53 »
Heayd of 54  Other credits from Form: a [ ] 3800 b [ ] 8801 ¢ [] 54
household, 55  Add lines 48 through 54. These are your total credits . N 55
: 56 Subtract line 55 from line 47. If line 55 is more than line 47, enter 0— . . . . . . P |56
57 Self-employment tax. Attach Schedule SE - . . .. . 57 <
Other 58 Unreported social security and Medicare tax from Form: a [ ] 4137 b [] 8919 58
Taxes 59  Additional tax on IRAs, other qualified retirement plans, etc. Attach Form 5329 if required 59
60a Household employment taxes from Schedule H P 60a
b  First-time homebuyer credit repayment. Attach Form 5405 if required 60b >
61 Health care: individual responsibility (see instructions) ~ Full-year coverage [] 61
62 Taxesfrom: a [ JForm8959 b [JForm8960 ¢ [] Instructions; enter code(s) 62
63  Add lines 56 through 62. This is your total tax . . T 63
Payments 64 Federal income tax withheld from Forms W-2 and 1099 64
65 2016 estimated tax payments and amount applied from 2015 return 65
W you have 8 e6a Earned income credit (EIC) 66a
qualifying
child, attach b Nontaxable combat pay election ‘ 66b I f
Schedule EIC. | 67  Additional child tax credit. Attach Schedule 8812 67 I
68  American opportunity credit from Form 8863, line 8 68 "\\
69 Net premium tax credit. Attach Form 8962 . 69 — —
70  Amount paid with request for extension to file 70 \
7 Excess social security and tier 1 RRTA tax withheld 7 \\
72 Credit for federal tax on fuels. Attach Form 4136 72
73 Credits from Form: a [_]2439 b [] Reseed ¢ [] 8885 d [ 73
74 Add lines 64, 65, 66a, and 67 through 73. These are your total payments . . . . . » 74
Refund 75 If line 74 is more than line 63, subtract line 63 from line 74. This is the amount you overpaid 75
76a Amount of line 75 you want refunded to you. If Form 8888 is attached, check here »[] 76a
Direct deposit? ® b Routing number EcT pe: [] Checklng [] Savmgs
See » d Account number P
instructions.
77 Amount of line 75 you want applied to your 2017 estimated tax > 77 I I
Amount 78 Amount you owe. Subtract line 74 from line 63. For details on how to pay, see instructions » | 78
You Owe 79  Estimated tax penalty (see instructions) ‘ 79 ‘ ‘
Third Party Do you want to allow another person to discuss this return with the IRS (see instructions)? E] Yes. Complete below. [] No
Designee E::q'g"e’e s EE-OH: ssrrsggsl( ||3c|i§;1t|f|0at|on> T T 17T
Sign Under penalties of perjury, | declare that | hav_e examined this return and accompa_nying schedule_s and stqtementsI and to the best of my knowledge and belief,
they are true, correct, and complete. Declaration of preparer (other than taxpayer) is based on all information of which preparer has any knowledge.
Here Your signature Date Your occupation Daytime phone number
Joint return? See
instructions.
Keep a copy for }Spouse’s signature. If a joint return, both must sign. Date Spouse’s occupation If the IRS sent you an Identity Protection
your records. me (esnetee:r\r?st) | | | | |
Paid Print/Type preparer’s name Preparer’s signature Date Check D # PTIN
Preparer self-employed
Use only Firm’s name » Firm’s EIN »
Firm’s address » Phone no.
Wwww.irs.gov/form1040 Form 1040 (2016)

Tab F

Tab ACA

Tab G
Tab J

Tab G

Tab H

Tab |

Tab G
Tab J

Tab ACA

Tab K


http://www.irs.gov/form1040

Form 13614-C Job Aid for Volunteers

Name as shown on
Social Security rec-
ords (see Tab K for
information hyphenat-
ed or double names).

View photo ID’s for
each taxpayer and
spouse (if filing a
joint return).

Taxpayer’s cur-
rent address .
(where to mail
refund and other
correspondence).

Use Tab C, to verify
taxpayer and
spouse’s
dependency status.

Refer to Tab P
if taxpayer is a
victim of identity
theft.

Refer to Pub 17, for
definition of Legally
Blind, Totally and

Permanently Disabled,
and Full Time Student.

If not a US citizen, use the
Determining Residency Sta-
tus decision tree in Tab L to
determine taxpayer/spouse
residency for tax purposes.

T T

You wil| need:
* Tau Information such as Forms W-2, 10934048, 10935,
* Swrial security cards or/TIN letters for §f persons on your tax refurn.

&) for you and your spouge.

* Picture ID {such as val

driver’s lice

* You are res

* Please compléte pages 1-3 of this fo
nsible for the informatidn on your return. Please

complete apd accurate information.
* If you hav¢ questions, please ask the IRS-certified volunteer pyeparer.

wide

[

To report unethical b

avior to the IRS, e

s are trained to provide high quality service .';'I/uphﬂld the highest ethical s
ail us at wivoltaxgpirs gov

dards.

Fart | - Your Personal lyformation #ff you are filing a joint return, entér your names in the fame order as last year's retum) \

1. Your first name M.L Last narr'j{ Telephone number ."l'E'J'DIJ a U 5. citizen?
O Yes O Ne
2. Your spouse’s first name M.L Lastn71'e / Telephone number \ s your spouse a U.5. citizen?
O ves O Mo
3. Mailing address / /pt# City \ State ZIF code
4_Your Date of Birth 5. Your job title . Last yegf, were you a. F¥-time student O Yes [O Mo
/ b. Total Igu:l permanently disabled [ Yes [ No ¢ Legally blind O ¥es O Mo
7. Your spouse’s Date of Birth | 8. Youwr spouse’s job title 9. Last fear, was your spouse: a. Full-ime student [0 Yes [ No
Z b Tolally and permanently disabled [] Yes [J Mo c Legally blind O Yes [J Mo
10. Can anyone claim you or your spouse on their tax retuf? [ Yes /tl No [ Unsure
11. Hawe you or your spouse a. Been a victim of identity theft? O Yes O Mo b. Adopted achild? [ Yes [ Mo

Part Il - Marital Status and Household Information

1. As of Decermber 34, 2018, were [
you: O
O

O

O

Unmamed {This includes registered domestic partnerships, civil unions, or other formal relationships under state law)
Married a. If Yes, Did you get married in 20167 0O Yes [J Mo
b. Did you live with your spouse during any part of the [ast six months of 20167 [ Yes [J Mo

Divorced

Date of final decree

Legally Separsted \Date of separate maintenance agreement

Wikdowed

rof spouse’s death

2 List the names below of:

= everyone who lived with you last year (other than youwr spouse)

If additional space is ne*ed check here [] and list gn page 3

yone you supported but did mot live with you last year To be {:umplerteclh? a Certified Volunteer arer
Name\(first, last) Do not enter your | Dtz of Birth  |RetaSonship |Mumber of U3 ub\ Zingle or  |Ful-time [Tomily and  |Is s Did this Did this Did the [
name §r spouse's name below fmmigiail fo you {for | months Citlzem  |of i s |Btudent |Fermanently |person a person pErson tapayeris) ayens]
T hved I f1ms Canada) ast year |Disabled qualtying provlde have l=s5 | provide mone more than
sor, your home K or Mexica veshal |resing) chikirelative |mare than \[than $4,050 |than 50% of the costal
daughter, st yea LN of any other |50% of his/ |of IRcome? | support Tor @iniksg a
\Darent, \ ¥ 'n:*\ p=rson? her cwn LI this person? fior this
none, efc) {yezina) support? [rsnamia) 7
) {1=1] cl [=1] ({3 ] ] \ 1] [yesno) Y! o)
Taxpayer musiinclude everyone who | Verify bi\th date for | Verbally confirm the| If not a US citizen, | If taxpayer’'s mari- | The Certified See Page 3 to

lived with the taxpayer and anyone
the taxpayer supported who lived
elsewhere.

each person includ-
ed on the tax return.
Note: Incorrect birth
dates may cause e-

Always confirm this information during
the interview process, especially if
the taxpayer did not list anyone.

file rejection.

number of months
each person listed
lived in the taxpay-
ers' home.

see Tab L, Deter-
mining Residency
Status decision

tree, to determine

tal status changed
in 2016 (Married
or Divorced),
verify how it may

Volunteer Pre-
parer will com-
plete these
questions for

verify if taxpayer
listed additional
names.

affect ACA and if
the return may be
“Out of Scope”.

Use page 4 to
record interview
notes.

each listed
person during
the Interview

residency for tax
purposes.

Important Reminder: Review all infor-
mation in Part II before determining Filing
Status and Dependency Exemptions.

Use Tabs B & C to make determinations.

Important Reminder: Do not refer taxpay-
ers to the Voltax e-mail address for IRS help
or refund information.

Refer to the back cover of Pub 4012 for
appropriate IRS referrals.
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Form 13614-C Job Aid for Volunteers Page 2

Important Reminder: During the interview, question taxpayers about any items marked
“Unsure” and mark them “Yes” or “No”. Modify any taxpayer answers to correctly
reflect all information obtained during the interview.

Certification indica-
tors (B, A, HSA, M)
should only be used
to assign returns to
preparers.

Final certification
level determina-
tions should be
made by using the
Scope of Service
Chart after a com-
pleting the
interview process.

ate b

ox for gach quesilen In aach section

Sure

Part Il - Income - Last Year, Did You {or Your Spouse) Receive

Not all of these
items are reported

| ——¥15. (B) Other income? (gambling, lottery, prizes, awards, jury duty, Sch K-1,

DDDDDDDRDDDDD

1. (B) Wages or Salary? (Form W-2) I yes. how many jobs did you have Last year? 4\

2. (&) Tip Income?

Enter all W-2 infor-
mation; see Tab D.

3. (B) Scholarships? (Forms W-2, 1093-T
4. {B) Interest'Dividends from: checking/savings accoD
| wi(B) Refund of stateflocal income taxes? (Form 1088-G)

&. (B) Alimeny income or separate maintenance payments?

nds, CDs, brokerage? (Forms

If yes, verify tips were
reported to employer. If
not, complete Form
4137 (Advanced).

7. {A) Seif-Employment income? (Form 1088-MISC, cash)
8 {A) Cashicheck payments fior any work performed not reported on W-2 or 10227
2. {A) Income (or loss) from the sale of Stocks, Bonds or Real Estate? (including e} (Forms 1088-5,1028-8)

See Tab D for infor-
mation about F1098T.

10. (B) Disability income? (such as payments from inswrance, or workers compensation) (Forms
11. (A) Payments from Pensions, Annuities, andior IRA? (Form 1088-R)

12. (B) Unemployment Compensation? (Form 1089G)

13. (B) Social Security or Ralroad Retirement Benefits? (Forms 55A-1008, RRB-1080)

Verify the return is with-
in the scope of VITA/
TCE Programs.

14. (M) Income (or loss) from Rental Property?

on F1040, Line 21.

Unsure

If yes, determine if taxa-
ble.

Part IV — Expenses — Last Year, Did You for Your Spouse) Pay

See Pub 17.

Verify eligibility for
Saver’s Credit.

|+

Include only quali-
fied unreimbursed
expenses (Sch A)
See Pub 17.

[
?/DDDDDEN{DS\:H:I

royalties, foreign income, etc.) Specify
. (B) Alimony or separate maintenance payments? i yes, do you have the recipient’s S5N?

Yes O Me
p 2. Confributions to a retirement account? IRA[A) 401K (B} Roth IRA

(B) College or post secondary educational expenses for yourself, spouse or dependents? (Form 10828-T)

See Tab E for definition
of alimony.

(B) Unreimbursed employee busness expenses? (such as uniforms or m eageN\

(B) Medical expenses? (including health inswrance premiums)
(B) Real estate taxes for your home or personal property taxes for your vehicle? (Form 1

See Tab J and compare
credits and adjustments.

(B) Home mortgage interest? (Form 1008)
(B) Charitable contributions? q——

(B) Child or dependent care expensas such as daycare?

.rv.tr-ﬂ.a-r-ﬂir-a

Advise taxpayer of rec-
ords requirements (Sch
A) see Pub 17.

Student Loan Inter- 10. {B) For supplies used as an eligible educater such as a acher's aide, counselor, etc.?
est adjustment 11. {A) Expensas related to self-employment income or any other income i
See Tab E. b2, (B) Student loan interest? (Form 1088-E)
re=T e |Unsure F'art W — Life Events — Last Year, Did You {or Your Spouse)
The taxpayer may O

. [H5A) Have a Health Savings Account? [Forms 5488-54, 1089-5A, W-2 with code W in box 12)
. {A) Have debt from a morigage or credit card cancelledforgiven by a commercial lender? (Forms 1089-C, A

If yes, ask taxpayer for

have a requirement O 2 provider’s TIN.
to repay their credit. O 3. (A) By, sell or have a foreclosure of your home? (Form 1088-A)
4. {B) Have Eamed Income Credit (EIC) disallowed in a prior year?  Hyes, for which tax year?

Ask taxpayer for a 5. {A) Purchase and install energy-efficient home items? (such as windows, fumace, insulation, ete) Check for tax benefits
copy of last year's m] £, {B) Live in an area that was affected by a natural disaster?  fyes where? o for declared disaster
;‘Ztggst‘a’ locate M () Receive the First Time Homebuyers Cradit in 20037 areas.
informatirgn. E. (B) Make estmated tax payments or apply last year's refund to this year's tax? I so how much?

] 8. (&) File a federal return last year containing a “capital loss camyover” on Form 1040 Schedule D7

Form 13614-C Job Aid for Volunteers Page 3

s T ———

Refer taxpayers

pisure

Part V1 - Health Care Coverage - Last year, did you, your spouse, or dependentis)

who have ques-
tions or need cover-
age to this web
site/phone number.

2.
3

1. (B) Hawe health care coverage?

o—

You must use the flow

(B) Receive one or more of these forms? (Check the box) [ Form 1085-8 [ Form 1085-C
{A) Have coverage through the Marketplace (Exchange)? [Provide Form 1085-4]

chart in Tab ACA for all
taxpayers.

3a. (A) If yes, were advance credit payments made to help you pay your health care premiggs?
OorTgd O 3b. (&) If yes, |s everyone listed on your Form 10285-A being claimed on this tax return?
O 4. (B Have an exemption granted by the Marketplace?
Vish or call 1-800-318-2396 for more information on health insurance options and assistance.

If advance payments of the premium tax credit were paid on your behalf to help pay your health insurance premiums, you should re

Taxpayer must provide
a copy of Form 1095-A
if they received insur-
ance through the mar-
ketplace.

Receiving advanced
payments creates an

35 income marital status or family size changes, to your Marketplace. Reporting changes will help to make sure you are getting the prop
Complete for [ments.
-L"’;pr:r?’;éiénadﬁer tod by a Certifled ger Praparer (Lise Publication 4012 and check M approprats boxies) Indieating Minkmum Essental Coverage (MEC) for everyone lstad {
answering questions |dependen, = MEC No MEC Part ear MEC Exemption (mark months Exemption Mo automatic filing
in the Certified Vol- e Part If) Entire ear (mark months with coverage) exempiions applies) AN Year requirement.
unteer Preparer JFMAMJJASOND|JFMAMJJASOND See Pub 17.
ﬁ:‘r’t“l‘l’)" (Page 1, JFMAMJJASOND|[JFMAMJJASOND
) JFMAMJJASOND|[JFMAMJJASOND
Dependent JFMAMJJASOND[JFMAMJJASOND
Dependent JFMAMJJASOND|[JFMAMJIJASOND
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Determining the Last Name of Taxpayer

A name control is a sequence of letters derived from a taxpayer’s last name that is used by IRS in processing the
tax return filed by the taxpayer. It is important that the combination of name control and taxpayer identification
number (TIN) provided on an electronically filed return match IRS’s record of name controls and TINSs.

In e-file, a taxpayer's TIN and name control must match the data in the IRS database. If they don’t match, the e-filed

return will reject and generate an Error Reject Code.

Individuals may create a mySocialSecurity account at htt
information shows up on Social Security Administration records.

Name Controls for Individual Tax Returns

1. Primary Name Control (SEQ 0050) of Form 1040/1040A/1040EZ must equal the first significant characters
of the primary taxpayer’s last name. No leading or embedded spaces are allowed. The first left-most position
must contain an alpha character. Omit punctuation marks, titles and suffixes within last name field.

Examples:

Individual Name Primary/Secondary Name Control

://secure.ssa.gov/RIL

iView.do to see how their

Individual Name on
SSN/ITIN Card(s)

Enter in TaxSlayer®

First Name Field

Last Name Field

IRS Database
Primary/Secondary
Name Control

John Brown John Brown BROW
Walter Di Angelo Walter Di Angelo DIAN
Ronald En, Sr. Ronald En EN
Thomas LeaSmith Thomas Lea-Smith LEA-
Joseph Corn & Mary Smith Joseph Corn CORN
Mary Smith SMIT
Roger O’Neil Roger O’Neil ONEI
Kenneth McCarty Kenneth McCarty MCCA
FNU Smith (First Name Unknown) | FNU Smith SMIT
Smith (No First Name) Smith SMIT
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https://secure.ssa.gov/RIL/SiView.do

2. Consider certain suffixes as part of the last name (i.e., Armah-Bey, Paz-Ayala, Allar-Sid). Particular attention
must be given to those names that incorporate a mother's maiden name as a suffix to the last name. For
example, traditional Hispanic last names include the taxpayer’s father's name followed by a space and the
taxpayer’s mother's maiden name. A married taxpayer’s last name remains the same and either simply adds on
the spouse’s father’s name (resulting in 3 names forming the last name) or deletes the mother's maiden name
and adds on the spouse’s father's name (sometimes the spouse’s father’'s name is preceded by “de”).

Examples:
Individual Name Primary Name Control
Individual Name on Enter in TaxSlayer® IRS Database Primary
SSN/ITIN Card FirstName Field LastName Field Name Control

Abdullah Allar-Sid Abdullah Allar-Sid ALLA
Jose Alvarado Nogales Jose Alvarado Nogales ALVA
Juan de la Rosa'Y Juan de la Rosa Y Obregon DELA
Obregon
Pedro PazAyala Pedro Paz-Ayala PAZ -
Donald Vander Neut Donald Vander Neut VAND
Otto Von Wodtke Otto Von Wodtke VONW
John Big Eagle John Big Eagle BIGE
Mary Her Many Horses Mary Her Many Horses HERM
Ted Smith Gonzalez Ted Gonzalez GONz
Maria Acevedo Smith Maria Smith SMIT
Robert Garcia Garza Robert Garza Hernandez GARZ
Hernandez

3. Below are examples of Indo-Chinese last names and the derivative Name Control. Some Indo-Chinese names
have only two characters. Indo-Chinese names often have a middle name of “Van” (male) or “Thi” (female).

Examples:
Individual Name Primary/Secondary Name Control
Individual Name on Enter in TaxSlayer® IRS Database
SSN/TIN Card FirstName Field LastName Field Primary/Secondary
Name Control
Binh To La Binh La LA
Kim Van Nguyen Kim Nguyen NGUY
Nhat Thi Pham Nhat Pham PHAM
Jin Zhang Qui & Yen Yin | JinZhang Qui QuUI
Chiu Yen Yin Chiu CHIU
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Preparing the Return

Filing Status  Personal Information Dependents

Basic Information

Filing Status
Persenal Information

Dependents / Qualifying Person

EDIT

EDIT

After collecting necessary information from Form 13614-C, Intake/Interview & Quality Review Sheet and properly applying
the tax law, you should choose your client’s filing status. If you are unsure of which filing status to select, select the Filing

Status Wizard button. The Filing Status Wizard will ask you a series of questions to help determine the correct filing status
for the taxpayer. Select the circle next to the correct filing status and click Continue.

Filing Status Personal Information Dependents

What's your filing status?

Single
Married Filing Joint

@ Married Filing Separate
Head of Household

Qualifying Widowler) with Dependent Children

Need help determining your filing status?

T e

B N

Use the “Filing Status
Wizard” or Tab B to
determine Filing Status

Use the “Filing Status
Wizard” or Tab B to
determine Filing Status

In this section you will input the Filing Status by using the customer’s response on the Form 13615-C and verbal
statement. You can also use the decision tree within Tab B.

Filing Status Personal Information Dependents

Married Separate

Check here if the Spouse lived with the Taxpayer at any time during the year:

CANNOT be claimed as a dependent on another person's return

Check here to claim the exemption for your spouse if he/she has NO Gross Income, is NOT filing a return, and

The second screen, under the Filing Status tab, is used to determine the spouse’s return status.

K-7



Preparing the Return (continued)

After filing status the next screen is an input screen that gathers the taxpayer’s personal information.

Personal Information Part 1

Filing Status Personal Information ependents

Personal Information Must input birth date.
Include spouse if joint

return. Use drop down
boxes to select Month,
Primary First Name Ml Last Name Suffix (Jr, Sr, etc.) Date and Year.

Taxpayer Information

\

- L

This section is important
for calculation of filing

_ . MA Y| DC Y| YYYY ¥ status, exemption,
standard deduction,
Presidential Election
Fund, and military
status.

Social Security Number Date of Birth

Occupation

Check here if the Taxpayer can be claimed as a dependent on someone else’s return.
This will generate a Date
of Death box, which
Check here if Taxpayer is blind. must be completed.
Once completed, click
‘Continue’ at the bottom
Check here if the Taxpayer wishes to contribute 53 to the Presidential Election Campaign Fund. of the page to proceed.

Check here if Taxpayer is a student.

Check here if Taxpayer is deceased. <«

Check here if the Taxpayer or Spouse served in a Combat Zone during the current tax year.

/ Verify spouse last name
with SS card. If different

Spouse Information from taxpayer, enter last
name here.
Spouse First Name Ml Last Name Suffix (Jr, 5r, etc.)
. v
Social Security Number Date of Birth

- - Mh v || DC v || YYYY ~

Enter spouse SSN. If the taxpayer is filing MFS and does
not know the SSN of the spouse, enter the spouse’s SSN
as 000-11-0000. You may leave the spouse’s DOB blank.
Without the spouse’s SSN, the return must be paper-filed.

The Personal Information tab is divided into Taxpayer Information, Spouse’s information, and Address and phone number.

Note: If the taxpayer or spouse is deceased, check the appropriate box from the list and enter the date of death when
prompted. When you print the return, the tax software prints the Deceased and the date of death next to the deceased
person’s name at the top of Form 1040 page 1, as required by the IRS.
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Preparing the Return (continued)

Personal Information Part 2

Check the Military and
— foreign address boxes if
Address and Phone Number they apply.
Check here if Stateside Military address.
Check here if foreign address
Address (Number and Street) Apartment . fi
| Enterzip code first. (See

note 1.)
Zip Code

City, Town, or Post Office

State Resident State Return /

| _— See Note 2.

= iz et - v e v Always ask for at least one
Daytime Telephone Number te/ephone number. The
P daytime phone will appear

{ ) - <

on the printed return. Enter
area code first.

Secondary Telephone Number

: ! - Click the “Filing Status”
button for assistance in
determining the customer’s

N\

Dependent/Qualifying Child Information:
Dependents or Qualifying Person(s) are
entered next. If the taxpayer is claiming
dependents or other qualifying persons

on their tax return, select the YES button
to begin filling in applicable information
pertaining to each dependent. To bypass
the dependent entry menu, select the NO
button.

Note 1: Once the ZIP code is entered TaxSlayer® will then auto-fill the city. Correct City name if needed.

Note 2: Resident State Return - This option will allow you to select the taxpayer state of residency. Once the state has
been selected, clicking on Continue will prompt the state questions. The program will create the state return based on the
state selected. If there isn’t a state return to complete, choose None from the list. The program will automatically transfer
all the necessary information into the state return for you.

Note 3: This option will allow you to select the taxpayer state of residency. Once the state has been selected, clicking on
Continue will prompt the state questions. The program will create the initial state return based on this selection. If there is
not a state return, chose “None” from the list. Any additional states to be attached will be selected within the State Return
section of the return.



Preparing the Return (continued)

To add multiple dependents, click the Add button on the following Dependent or Qualifying Child screen:

Dependent or Qualifying Child

First Name Last Mame Social Security Number

John Doe 400-00-XXXX - -
- Add a Dependent or Qualifying Child

Note: In order for the IRS to accept the tax return electronically, ensure that:

e The correct year of birth is entered
e  The dependent’s name is spelled correctly
e  The correct social security number is entered

If any of these three items are entered incorrectly, the IRS will reject the tax return for electronic filing
purposes.
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Preparing the Return (continued)

Dependent or Qualifying Child

Child Without an SSN or

ITIN
Filing Status Personal Information Dependents
e - . . Click the box under the
Dependent / Qualifying Child Information Child's name if they do not
First Name Middle Last Name have a SSN, ITIN or ATIN.
A statement will appear
e ot B [ asking, “This dependent

will be completing a Form
Wi v o] WA © W-7, Application for ITIN
and yes or no buttons. The
Check if the dependent does not have an SSN/ITIN/ATIN Form W-7 is located within
the “Federal Section” under

the “Miscellaneous Forms”
tab. If not applying for an

Social Security Number

Aelationship: ITIN, select “No” and enter
- Please Select - i the reason (such as the

Number of months this person lived in your home during 2015: death of the Chlld) that the
12 o child does not have a TIN.

(Note: If this dependent was born in 2015, you must select 12 months) .
If you are the noncustodial

I o
Please answer the following: parent, enter “divorce/

separation” for the number
Check if this person was a FULL-TIME student.

of months.
Check if this person was DISABLED.
Check if this qualifying child is NOT YOUR DEPENDENT.
Check if you wish NOT to claim this dependent for Earned Income Credit purposes. P If the dependent is not
Check if this dependent is married. el’glble fOf EIC, CheCK thlS

box. This will eliminate
forms and questionnaire
geared to determine EIC

* EIC is considered for every return until the program determines that it is not viable. If you know that the dependent is not
eligible for consideration, click the box beside “Check if you wish NOT to claim the dependent for Earned Income Credit
purposes”. Verify names, SSN, and dates of birth with social security card to prevent rejected returns. Children should be
listed from youngest to oldest.

Qualifying Child(ren) for Earned Income Credit (EIC):

TaxSlayer® calculates the amount of earned income credit if the client qualifies based on income and other requirements.
Reminder: Although age, relationship and residency requirements are the same for EIC as for dependency, support is
NOT an issue for EIC (it does not matter whether or not the child, parent, or another provides over half of the child’s
support.

Enter number of months each individual lived in the taxpayer's home or use “Lived in Mexico” if the dependent lived in
Mexico or “Lived in Canada” if the dependent lived in Canada — use the drop-down list. Enter 12 months if dependent was
born or died during the year or was temporarily absent (school, vacation, etc.).

Carefully read the selections under the “Please answer the following” list. Check all that apply.



Preparing the Return (continued)

Income

The Income portion of the Federal Section is used to enter all items of income on the tax return. You will be
given two options from the main income page.

Select Guide Me to launch a step-by-step series of questions to help determine the various types of income
that should be entered on the tax return. If you prefer to enter in items of income without the help, select Enter
Myself. This will take you to the income entry screen which lists the various types of income that should be
reported on the tax return. Select a Begin or an Edit button to enter/edit an item of income. See the Income
tab for more directions on entering specific types of income.

Deductions

The Deductions portion of the Federal Section is used to enter all deductions, adjustments or subtractions on
the tax return. You will be given two options from the main income page.

Let's see how we can cut your tax bill

Here's a reason to smile. You may be able to get tax deductions for education costs, child
care, charitable contributions and more. Follow our step-by-step guide to ensure accurate entry
of your tax deductions. Or, enter the information on your own if you are familiar with the
forms.

- -OR- Enter Myself

Select Guide Me to launch a step-by-step series of questions to help determine the various types of
deductions that should be entered on the tax return. If you prefer to enter deductions without assistance, select
Enter Myself. This will take you to the deductions entry screen which lists the various types of deductions

that should be reported on the tax return. Select a Begin or an Edit button to enter/edit a deduction. See the
Adjustments, Deductions, Nonrefundable Credits, Earned Income Credit, and Education Benefits tabs for
additional information and specific instructions on these topics.

K-12



Preparing the Return (continued)

Deductions

Adjustments
Standard Deduction
ltemized Deductions
Credits Menu

Compare Deductions

Other Taxes

The Other Taxes portion of the Federal Section is used to enter any other tax types for which the taxpayer may
be liable. Select the Begin button next to any other tax item to enter in data applicable to the taxpayer.

Payments & Estimates

The Payments & Estimates portion of the Federal Section is used to enter such items as payments, apply
overpayments to next year’s return and to print vouchers for next year’s estimated payments. Select the Begin
button next to any payment or estimate item to enter in data applicable to the taxpayer.

Miscellaneous Forms

The Miscellaneous Forms portion of the Federal Section is used to enter the following:

Injured Spouse Form - Form 8379

Claim a Refund Due to a Deceased Taxpayer - Form 1310
Application for Extension - Form 4868

Married Filing Separate Allocation

IRS Identity Protection PIN (IP PIN)

Installment Agreement (Form 9465)

State Section

If you chose a State of Residency from within the Personal Information screen, this part of the program will be
created based on all the necessary information entered into the return for you.

If you don’t have a state return, you can click Continue or use any of the navigation options on the left side of
your screen.

The following states don’t have state income tax returns that can be filed through the program:

Alaska, Florida, Nevada, New Hampshire, South Dakota, Tennessee, Texas, Washington and Wyoming.

The Add Another State Return(s) will help you to create any state return that you will be including in the tax
return. Choose a state from the drop down box located on the State Name page and select Continue.

You will be prompted to select the taxpayer’s state residency type. Most states have a separate resident, part
year resident and non-resident tax return. Select the Continue. You will be given two options from the state
return page.

Select Guide Me to launch a step-by-step State Return which will ask you a series of questions to help prepare
the state tax return. If you prefer to enter the state tax return without the help of the State Return, select Enter
Myself. This will take you to the State Return screen which lists the various sections of the state return.
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Pointers for Direct Deposit of Refunds

institution as proof of account, verify:

* Routing Transit Number (RTN). The RTN must
contain 9 digits and begin with 01 through 12
or 21 through 32.

e Depositor Account Number (DAN). The DAN
can be up to 17 characters. Include hyphens
but omit spaces and special symbols. Don’t

include the check number or the dollar amount

on canceled checks. On the sample check
below, the account number is 20202086.
2. Don’t use a deposit slip for proof of RTN as
this may not be the same RTN used for direct
deposit. For direct deposit into a savings account,
the taxpayer should obtain a statement from
the financial institution to verify the routing and
account number for direct deposit. For direct
deposit into a checking account, if the taxpayer
doesn’t have a cancelled check, the taxpayer
should also contact their financial institution.
3. Entering the incorrect RTN and/or DAN will result
in a 4—6 week delay of the refund, or it may go
into some else’s account. If the direct deposit is

voided, a paper check will automatically be mailed

to the address on the electronic tax form.

Caution: Financial institutions generally don’t
n allow a joint refund to be deposited into an
individual account. The IRS isn’t responsible if

CAUTION q o 5 - - . .
a financial institution refuses a direct deposit.

Using a check or documentation from the financial

4. Double-check the RTN of the financial institution if:

* You are unfamiliar with the financial institution.
(Some types of accounts that exist through
brokerage firms can’t accept direct deposits.)

e The RTNis for a credit union, which is payable
through another financial institution. The
taxpayer should contact his or her credit union
for the correct RTN.

5. Savings Bonds - Taxpayers can buy U.S. savings
bonds with their federal tax refund. Even if the
taxpayer doesn’t have a bank account or a
Treasury account they can elect this option.
Taxpayers can make bond purchases for
themselves, add beneficiaries or co-owners, and
make bond purchases for someone other than
themselves. Refer to Form 8888 or www.IRS.gov
for more details.

6. Remember the split refund option: If a taxpayer
chooses to direct deposit his or her refund into two
or three accounts, you will need to complete Form
8888, Allocation of Refund (Including Savings
Bond Purchases).

mmrn] @ccounts) only in the taxpayer’'s name.

Advise taxpayers their refund may
only be deposited directly into his/her own
account(s).

Caution: Direct deposit of a taxpayer’s
. refund is to be made to an account (or
C

Taxpayers federal and state refunds can’t
be deposited into VITA/TCE Volunteer or any

TONY MAPLE
JENNIFER MAPLE

Anyplace, GA 00000

PAY TO THE
ORDER OF | $

1234

123 Pear Lane 15-0001

associated partners’ personal or business
bank/debit card accounts.

Note: Don’t use deposit slip as proof

DOLLARS

Routing
number

(line 74b)

ANYPLACE BANK
Anyplace, GA 00000

For

Do not include
the check number.

of account because the routing
number may be different than on a
check.

I (250250025) (2020201 8y - 123Y4

Note: To combat fraud and identity theft, IRS permits a maximum of three refunds to be electronically

deposited into a single financial account.

The fourth and subsequent refunds automatically will convert to a paper refund check and be mailed to the

taxpayer.
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Split Refund Option

When the taxpayer elects to direct deposit his or her refund into two or three accounts or to purchase saving bonds, you

will need to answer questions in the e-file section.

Taxpayer Bank Account Information
Mote: This bank information MUST be accurate for your return to process correctly.
You may split your refund in up to 3 accounts and purchase up to 3 savings bonds. The total depaosits and savings bond purchases must equal your total refund of $3,271.00

Bank Accounts

Enter bank account information where you waould like your refund deposited

Bank Name Routing Number Account Mumber Deposit Amount

$0.00

$0.00

$0.00

Taxpayer Bank Account Information

Purchase Savings Bonds
You purchase up to 3 savings bonds with the remainder of your refund.

Bond amounts must be in $ 50 increments

Purchase A Bond

Amount to be used for bond purchase for yourself $0.00

Purchase another bond for yourself or somecne else
Bond Amount $0.00
Enter the owner's name (First then Last) for the bond registration

If you would like to add a co-owner or beneficiary, enter the name here (First then Last)

Is Beneficiary?




Balance Due Returns (amount owed on return)
Form 1040, 1040A, or 1040EZ Instructions for additional information)

General Information

Taxpayers don’t have to pay if balance due is less than $1.

Payment in full is due by the April filing due date, to avoid interest and penalties.

Taxpayer should file his or her return by the April filing due date, to avoid a failure-to-file
penalty.

There are separate penalties for filing late and paying late. The late filing penalty is higher.
Advise taxpayers to file the return on time, even if they can’t pay the full amount owed. They
should pay as much as they can with the return to reduce penalties and interest.

Payment Methods

1.

Electronic Funds Withdrawal

E-filing allows taxpayers to file their return early and schedule their payment for withdrawal from
their checking or savings account on a future date up to the April filing due date. See Form
ACH 1040/ES Direct Debit for Balance Due or Estimated Tax Payment later.

. IRS Direct Pay

IRS direct pay at irs.gov is a free one-time payment from your checking account to the IRS.
Use this secure service to pay your tax bill or make an estimated tax payment directly from
your checking or savings account at no cost to you. You'll receive instant confirmation that your
payment has been submitted. Just follow the easy steps below. Bank account information isn’t
retained in IRS systems after payments are made.

It takes just 5 easy steps to make a payment:

Step 1 Step 2 Step 3 Step 4 Step 5 PAY NOW
Provide Verify your Enter Your Review and | Print or

your tax identity payment electronically | record

information information sign the your online

transaction confirmation
number

3.

4,

Check or money order payments

¢ Don’t attach the payment to the return.

Refer to instructions on Form 1040V, Payment Voucher.
Submit the payment with a properly completed Form 1040V.
* No cash payments.

Credit card payments

* American Express, Discover, Mastercard, or Visa cards are accepted.
* A convenience fee will be charged by the service providers.

» Visit IRS.gov/E-pay or call service provider for details.

Official Payments Corporation Link2Gov Corporation WorldPay US, Inc.

1-888-UPAY-TAX™ (1-888-872-9829) | 1-888-PAY-1040™ (1-888-729-1040) | 844-872-9829 Payment 855-508-0160
1-877-754-4413 (Customer Service) | 1-888-658-5465 (Customer Service) | Live Operator Service 844-825-8729
www.officialpayments.com/fed www.PAY 1040.com
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Balance Due Returns (continued)

5. EFTPS (Electronic Federal Tax Payment System)
Taxpayers can use EFTPS to pay their federal taxes, but they must enroll first. EFTPS is a fast,
easy, convenient and secure service provided free by the Department of Treasury. For more
information or to enroll visit IRS.gov/E-pay or call EFTPS Customer Service at 1-800-316-6541
(for individual payments). TTY/TDD help is available by calling 1-800-733-4829.

Note: You must have a valid Social Security Number (SSN) to use this application. This
application can’t accommodate Individual Taxpayer Identification Numbers (ITINs).

6. PayNearMe
Through a partnership with OfficialPayments.com and the PayNearMe Company, taxpayers can
now make a cash payment without the need of a bank account or credit card at more than 7,000
7-Eleven stores nationwide. To find a location near you, visit the PayNearMe locations Web
page.
Visit the Payments Options Web page on IRS.gov for the most current information about tax
payments.

What if the taxpayer can’t pay?

e Can you pay in full within 120 days? If taxpayers can pay the full amount they owe within 120
days, go to irs.gov to establish your request to pay in full. By doing this, taxpayers can avoid
paying the fee to set up an installment agreement.

* Applying online for a payment agreement. If the taxpayer’s balance due isn’t more than
$50,000, the taxpayer can apply online for a payment agreement instead of filing Form 9465. To
do that, go to IRS.gov and enter “Online Payment Agreement” or “OPA” in the “Search” box.

* The taxpayer can request an extension of time to pay if paying the tax by the due date will be an
undue hardship. For details see Form 1127 (out of scope).

Offer in Compromise

If the taxpayer can’t pay through an installment agreement and/or by liquidating assets, they may be
eligible for an Offer in Compromise (offer). An offer is an agreement between the taxpayer and the
IRS that settles a tax debt for less than the full amount owed. The IRS may accept an offer if:

e The IRS agrees that the tax debt may not be accurate,
* The taxpayer has insufficient assets and income to pay the amount due in full, or

* The taxpayer has exceptional circumstances and paying the amount due would cause an
economic hardship or would be unjust.

The taxpayer can use the Offer in Compromise Pre-Qualifier tool located at irs.gov (key word “offer”)
to determine if an offer is a realistic option to resolve their balance due. The questionnaire format
assists in gathering the information needed and provides instant feedback as to eligibility. To apply for
an offer, the taxpayer must read and complete the forms located in the Offer in Compromise booklet,
Form 656-B. The Form 656-B, Offer in Compromise, may be found at www.irs.gov (key word “offer”).


http://www.irs.gov/E-pay
http://www.irs.gov
http://www.irs.gov
http://www.irs.gov
http://www.irs.gov
http://www.irs.gov

How can a taxpayer avoid a balance due in the future?
TIP: The more withholding allowances claimed, the less taxes withheld.

* If the taxpayer didn’t have enough withheld from his/her paycheck or pension income and there
is an amount owed on the current return:

* Advise the taxpayer to access the Withholding Calculator at IRS.gov.

* On the Form W-4/Form W-4P, the taxpayer can reduce the number of allowances or
request an additional amount to be withheld.

* Advise the taxpayer to submit a revised Form W-4 to the employer. For pension income
taxpayers should submit a revised Form W-4P to the pension payer. Form W-4V is used to
request withholding from Social Security or certain other federal government payments.

e [f the taxpayer had income that wasn’t subject to withholding (such as self-employment, interest
income, dividend income, or capital gain income):

e Explain estimated taxes to the taxpayer. In TaxSlayer®, add Form 1040-ES, Estimated
Tax for Individuals, and complete it. Discuss with taxpayer(s) whether to use the minimum
required amount or the total amount expected to be due.

* Advise the taxpayer to review Publication 505, Tax Withholding and Estimated Tax.

Forms or Publications can be obtained from irs.gov.

e |f the taxpayer is receiving advanced premium tax credits, they should notify the Marketplace
when they have any significant change to income, family size or a life event.

Note: This information only applies to federal balance due returns. For state information, consult the
applicable state.
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Form ACH 1040/ES
Estimated Payments for Next Year

Under Federal Section, the Preparer can access the “Payment and Estimates” tab in order to
complete the “Vouchers for Next Year’s Estimated Payments” (Form ACH 1040/ES) tab.

Mr Taxpayer % C C ction: es Payments & Estimates

Enter the Form Number...

Payments and Estimates

Federal Estimated Payments for 2015
State Estimated Payments EDIT
Other Federal Withholding

Other State Withholdings

Underpayment of Estimated Tax

Click this tab to access
Apply Overpayment to Next Year's Taxes EDIT /

Vouchers for Next Year's Estimated Payments

Amount Paid with Extension

|II\IIIIII

Under this section, the customer will indicate how much in estimated tax payment they will be
submitting by quarter for the next year’s tax return.

Enter the Form Number...

Estimated Payments for Next Year

First Quarter(April 15, 2016) $

Second Quarter(June 15, 2016) = ESfImafed TaX Payments
for next year

Third Quarter(September 15, 2016) s

Fourth Quarter(January 15, 2017) H
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Form ACH 1040/ES
Estimated Payments for Next Year (Continue)

After clicking “Continue”, a screen will appear showing a summary of the voucher proposed for the upcoming
filing season. Upon click “Continue” the request for vouchers will be saved and the vouchers will be generated
when the return is printed.

Set of Estimated Payment Vouchers for Next Year

First Quarter Second Quarter Third Quarter Fourth Quarter

$250.00 5250 00 $250 00 $250 00 -

Enter the Form Number...

NOTE: When the IRS due date for doing any act from filing a return, paying taxes, etc. — falls on Saturday and
Sunday, or a legal holiday, the due date is delayed until the next business day.

Estimated Tax Payments:
When e-filing a Form 1040 series return, up to four estimated payments can be scheduled for withdrawal on
the following dates:

April 15
June 15

September 15
January 15, of the following year*

* You don’t have to make the payment due January 15, if you file your current tax return by February 16, and
pay the entire balance due with your return.
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C PIN Guidelines )

The Practitioner PIN method is the preferred only electronic signature method for taxpayers using
TaxSlayer software. The ERO may enter the taxpayer’s PINs in the electronic return record before the
taxpayers sign Form 8879, but the taxpayers must sign and date the appropriate form before the ERO
originates the electronic submission of the return. The taxpayer must sign and date the Form 8879
after reviewing the return and ensuring the tax return information on the form matches the information
on the return.

Practitioner PIN Guidelines

What? The PIN can be any five numbers except all zeros. If filing a joint return, a PIN is needed for
the taxpayer and their spouse. The Practitioner PIN option requires the completion of Form 8879, IRS
e-file Signature Authorization, or Form 8878 if filing Form 4868 with electronic funds withdrawal. The
taxpayers may authorize the volunteer to enter their PIN on their behalf using Form 8879.

How to use the Practitioner PIN in TaxSlayer®
J 98765 is defaulted in Office Setup
. The information is pulled from Office Setup to Part Il of Form 8879
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C Form 8453, Transmittal for an IRS E-file Return )

Form 8453 will be used to transmit specific your transactions electronically on Form
supporting documents that can’t be e-filed. 8949. Form 8453 is to be mailed to the Austin
Those paper forms, schedules and supporting Submission Processing Center within three
documents include: business days.
e Form 2848, Power of Attorney and
Declaration of Representative (or POA that Mail Form 84583 to:
states the agent is granted authority to sign Internal Revenue Service
the return) Attn: Shipping and Receiving, 0254
e Form 8332, Release / Revocation of Release Receipt and Control Branch
of Claim to Exemption for Child by Custodial Austin, TX 73344-0254
Parent (or certain pages from a divorce
decree or separation agreement, that went TIP - Alternatively, a PDF of the
into effect after 1984 and before 2009) (see attachments can be attached to the
instructions) electronic return. In that case, no
* Form 8949, Sales and Other Dispositions Form 8453 is required. To do this,
of Capital Assets (or a statement with the scan the document to create the PDF.
same information), if you elect not to report
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(

Return Signature

A return isn’t considered valid unless it is signed.
Both spouses must sign if the return is filed jointly.
The return should be dated and the occupation
lines should be completed.

Child’s Return

If a child can’t sign his or her name, the parent,
guardian, or another legally responsible person
must sign the child’s name in the space provided
followed by the words “By (parent or guardian
signature), parent or guardian for minor child.”

Deceased Taxpayer

If a taxpayer died before filing the return, the
taxpayer’s spouse or personal representative
may have to file and sign a return for the person
who died. A personal representative can be

an executor, administrator, or anyone who is in
charge of the decedent’s property.

If the taxpayer didn’t have to file a return but
had tax withheld, a return must be filed to get a
refund.

Filing Returns of Deceased Taxpayers
If filing a paper return, write “Deceased,” the
decedent’s name, and the date of death across
the top of the tax return.

TaxSlayer® will automatically note on the top of
Form 1040 the decedent’s name and date of
death.

If the spouse died during the year and the

surviving spouse didn’t remarry, a joint return
can be filed. If the spouse died before signing
the return, the executor or administrator must

sign the return for the deceased spouse. If the
surviving spouse or anyone else hasn’t yet
been appointed as executor or administrator,
the surviving spouse can sign the return for the
deceased spouse and enter “Filing as surviving
spouse” in the area where the return is signed.

Form 2848, Power of Attorney and Declaration
of Representative is no longer valid because the
taxpayer is deceased and therefore, Form 56

or new Form 2848 signed by estate executor or
representative must be completed.

Filing Returns for Deceased
Taxpayers—Using TaxSlayer®

See Tab N for TaxSlayer detailed instructions.

Claiming a Refund for a Deceased
Person

If a surviving spouse is filing a joint return with
the decedent, file the tax return to claim the
refund. Court-appointed representatives should
file the return and attach a copy of the certificate
that shows their appointment. All other filers
requesting the decedent’s refund should file the
return and attach Form 1310.

Incapacitated Spouse

If one spouse is incapable of signing the joint
return and hasn’t given someone a POA to sign
on their behalf, the other (capable) spouse may
be able to sign on behalf of their incapacitated
spouse. A statement attached to the return may
be required. See Pub 501.
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( Power of Attorney )

Read Pub 17 on Power of Attorney & Signatures. For additional details, see Pub 947 and Form
2848 Instructions.

See Tab N for TaxSlayer® detailed instructions.

Attach a copy of the taxpayer’s original paper POA to a copy of Form 8453 for the site to send to
the IRS once the return is accepted. Alternatively, you may scan the POA to a PDF and attach the
PDF to the return prior to creating the e-file.

—

w

Even when the TP’s agent is using a POA different than Form 2848, follow the same process.
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C Distributing Copies of Returns )

Taxpayer

e Form 1040 with all forms/schedules
including signed Form 8879 and Form 8453,
if applicable

* Organize the taxpayer’s copy of the return
according to the attachment sequence
at the top right corner of each form. Any
supplemental schedules are put at the end.

Form 8332, if applicable

Original Power of Attorney, if applicable
State forms/schedules, as applicable
All other taxpayer documents including
Form(s) W-2 and Form(s) 1099

C Where to File Paper Returns )

When a paper return must be filed, advise the
taxpayer to sign and mail the federal return
to the applicable IRS address for the state
where the taxpayer lives. The taxpayer must
be given an exact copy of the paper return to
be filed. Additional copies of the schedules
and worksheets should also be provided, as
appropriate.

If applicable, State income tax returns should be
signed and mailed to the appropriate address for
that state.

Mailing addresses can be located in the Partner
Resource Tab and on www.IRS.gov. In the
search box, type “Where to file addresses”.

The addresses are also located in Form1040
instructions.
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TAX RETURN . .
QUALITY / The Quality Review Process

CHECK Every tax return must be Quality Reviewed prior to the taxpayer leaving the site.

Volunteer Preparer

1. Advise the taxpayer of the importance of this Quality Review Process and their role in the process.
2. Compile the taxpayer’s supporting documents and their intake and interview sheet.
3. Introduce the taxpayer to the quality reviewer and provide all items used to complete the return.

Quality Reviewer

1. Ask the taxpayer if all of their questions have been answered by the preparer.
2. Verify you have a copy of the tax return and all documents used to prepare the tax return.
(Form 13614-C, W-2’s, Form 1099’s, Social Security documents, identification, etc.)
3. Conduct the Quality Review by addressing all items listed in Section VIII (Page 3) of Form 13614-C.
» Taxpayer (and Spouse's) identity was verified with a photo ID.
* The volunteer return preparer/quality reviewer are certified to prepare/review this return and return
is within scope of the program.
* All questions in Parts I through VI have been answered.
» All unsure boxes were discussed with the taxpayer and correctly marked yes or no.
» The information on pages one through three was correctly addressed and transferred to the return.
» Names, SSNs, ITINs, and EINs, were verified and correctly transferred to the return.
» Filing status was verified and correct.
» Personal and Dependency Exemptions are entered correctly on the return.
* All Income (including income with or without source documents) checked "yes" in part Il was
correctly transferred to the tax return.
* Adjustments are correct.
« Standard, Additional or Itemized Deductions are correct.
* All credits are correctly reported.
* All Affordable Care Act information is reported correctly.
* Withholding shown on Forms W-2, 1099 and Estimated Tax Payments are correctly reported.
» Direct Deposit/Debit and checking/saving account numbers are correct.
» SIDN is correct on the return.

If there are errors:
* Discuss the error with the preparer and make sure you are both in agreement on the correction(s).
* Make correction(s) on Form 13614-C.

* Explain the error and correction with the taxpayer.
If there are no errors or after correcting errors:

* Ask taxpayer(s) if they have any questions.

* Advise taxpayer(s) that they are responsible for the information on the return.
(This can be done by having taxpayer(s) review the statement in Part II of Form 8879, IRS e-file
Signature Authorization)

* Obtain the appropriate taxpayer signatures and submit for e-filing.

* Place the copy of the taxpayer’s return and supporting documents in Publication 730, Important Tax
Records Envelope (VITA/TCE) or a Tax-Aide envelope, if available.

* Advise the taxpayer to bring completed tax return with worksheets (or the envelope and all its contents)
back next year.
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Electronic Filing of Returns with Valid ITIN

Returns can be electronically filed when the taxpayer has an Individual Taxpayer Identification
Number (ITIN) but has a Form W-2 with a Social Security Number (SSN) not belonging to that
taxpayer.

1. The taxpayer’s ITIN must be entered on the personal information screen in the space provided
for the taxpayer’s, or if applicable, spouse’s social security number.

2.  When completing the Form W-2 in TaxSlayer®, enter the SSN shown on the paper Form W-2.
The Internal Revenue Service requires the manual key entry of the Taxpayer Identification
Number (TIN) as it appears on Form W-2 received from the employer for all taxpayers with
ITINS who are reporting wages. The ITIN that was entered when the return was started won’t
auto-populate the TIN on Form W-2 for these ITIN filers.

\_ )

Note: ITIN taxpayers requesting to file Forms 1099-R with an incorrect Social Security Number must
file a paper return. These returns can’t be e-filed. There are no procedures in place to efile these
types of returns.



Creating a Temporary TIN when the Spouse and/or
Dependent(s) are Applying for an ITIN

TaxSlayer® will not generate temporary ITINs for the taxpayer, spouse and/or dependents on a return if Form W-7 is
needed. The ITIN application requires a federal tax return be associated with all Form W-7 applications (with some
exceptions as noted in the instructions for Form (W-7). Federal tax returns can’t be filed using electronic return preparation
software without a TIN (taxpayer identification number). If the taxpayer is working under an erroneous social security
number, that social security number should be used only on the W-2.

1. In the TIN field for all individuals needing to complete Form W-7, enter all digits as zeros “0”. A return requiring three
temporary TINs will be entered as follows:

The spouse’s 000-00-0000

The first dependent’s 000-00-0000

The second dependent’s 000-00-0000

2. Select each individual in TaxSlayer®. See Preparing the Return tab, determining the Last Name of Taxpayer. Fill in
name of each family member applying for an ITIN on a separate Form W-7 application. Make sure that names match
required documentation that clients will be submitting with their W-7 application(s).

3. Print the return package, and provide the return package to the taxpayer to mail with Forms W-7 to the address
shown on the Form W-7 instructions.

4. If the taxpayer has a family pack that includes multiple Forms W-7 with one return, or multiple returns with one Form
W-7, these forms should be staggered and stapled together to show the entire package as a family pack. This will
prevent separation of the forms/returns that could delay the processing time.

5. Have taxpayers mail Form W-7 application(s), all necessary documentation, and tax return or take to local IRS
office. Note: Not all local IRS offices are authorized to process Form W-7 applications. See the list of
supporting documentation in the Form W-7 Instructions.

6. If applicable, prepare a copy of the state with a copy of the Federal attached. If taxpayers will not owe state, suggest
they hold the state until they receive their official ITIN cards - may take 6-8 weeks - and record the ITINs on the tax
returns before mailing.

Start a return using all digits as zeros “0”.
Go to Miscellaneous Forms to find the W-7.

Note: ITINs will expire if not used within three years.

The following communication products provide information on changes being made to the Individual Taxpayer
Identification Number (ITIN) program this year. They are intended for use in raising awareness among taxpayers with a
need to file a federal tax return in 2017 but whose ITIN will expire at the end of 2016. The products, available in multiple
languages, are offered in electronic format for electronic distribution or for printing.

Publication 5259 (EN-SP), ITIN Fact Sheet

This publication is a guide to changes IRS is implementing resulting from the December 2015 PATH Act legislation
requiring expiration of certain ITINs. It also covers changes to the use of a passport as a stand-alone document for
dependent ITIN applications.

Publication 5256 (EN-SP), You May Need to Renew Your Expired ITIN

This publication provides taxpayers quick facts about which ITINs are expiring and how to get more information. It provides
three flyers per page and can be printed and cut/separated for use.

Publication 5257 (EN-SP), Renewing Your ITIN

This publication is a full page document detailing the facts about expiring ITINs and basic information about how to renew
them. There’s an electronic version with resource links and a printable version with instructions on how and where to find
more information.
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Amended Returns

Important: If the original return isn’t already in TaxSlayer®, you will need to create the return in
TaxSlayer® by using a copy of their original return. Amended returns can’t be electronically filed and
must be mailed to the IRS. Direct deposit/debit isn’t available for amended returns.

Caution: Protecting Americans from Tax Hikes (PATH) Act 2015 prevents taxpayers using newly
issued ID numbers to retroactively claim refundable tax credits in prior years. For example, someone
who filed a tax return under an ITIN and later got an SSN can’t file amended return(s) to claim EITC.

A. Pull original tax return amounts to Form 1040X Original column

1.
2.

©XONOOA

10.

11.

Open the original return in TaxSlayer®.

If the return was previously adjusted by the IRS, modify the original return to match the
changes the IRS made before opening Form 1040X.

To open Form 1040X, click 9. Miscellaneous Forms, then select 1. Amended Return
(1040X) at the top of the listed items. You can also double-click on Form 1040X under Form
Finder section located in lower left corner.

Click Ok to the message that says, “Make sure you have a printed original copy...”

Click on 1. Edit 1040X Menu.

Highlight the appropriate 20XX Amended Return being amended, then click Ok

Highlight 1. Original Column and click Ok.

Click Ok to the message that says, “If Any States also need to be amended...”

Next, the Edit Form 1040X screen shows amounts in Original column and zeros in Correct
column. Ensure the amounts in the Original column are correct.

There are two options to exit the screen.

a. Click on the line that starts with the number 0 (zero), or

b. Enter the number 0 (zero) in the Option box and press the enter key.

Exit next two screens, (Form 1040X Menu; Miscellaneous Forms Menu), which will take you
back to the Form 1040 screen (that is the original return).

B. Enter corrections and pull corrected return amounts to Form 1040X Corrected column

12.

13.
14.
15.
16.

Enter the correction(s) on the tax return by selecting the appropriate section on the left (e.g.
1. Personal Information, 2. Income Menu, 3. Income Menu, etc.).

Once correction(s) are entered, go back to the Form 1040 screen.

Go back to the 1040X by repeating steps 3, 4, 5, and 6 above.

IMPORTANT: Next, you will need to highlight 2. Corrected Column and click Ok.

Next, the Edit Form 1040X screen shows amounts in both Original and Correct columns.
Stay on this screen for next step.

C. Provide explanation of changes in Form 1040X

17.
18.
19.

Click on 1. Questions & Explanations.
Next, click on 9. Explanation and enter explanation of changes; click Ok when done.
Exit next two screens to return to the Form 1040 screen.

Caution: Please see the Amended Returns Guide posted on 12/6/2016
to the VITA/TCE Blog at https://vitablog.taxslayerpro.com
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Amended Returns (continued)

Print Return and assemble the Form 1040X package to be mailed

20.
21.
22.
23.
24.

25.

26.

At Form 1040 screen, click on 11. View Results; then click on 2. Print Return.

At Select Print Option screen, double-click 2. Two Copies Federal and State.

Answer Yes to message that asks, “Would you like to Print...”

Next screen allows you to select which printer to use from a drop-down menu.

From the printed pages, pick out Form 1040X and only those schedules and forms that
need to be attached as explained in 25 below.

Attachments to Form 1040X should include any new or corrected document(s). For
example, previously missing source documents (Forms W-2,1099s, 1095s, etc.), Form 1040
schedules and supporting forms that changed as a result of amending the return (e.qg.,
a recomputed Schedule EIC after adding a qualifying child). Don’t attach a copy of the
original tax return.

Have the taxpayer sign the amended return and provide them with the mailing address
given in the Where to File section of Form 1040X Instructions



Prior Year Returns

Who can prepare prior year returns?

Sites are encouraged to prepare prior year returns if they have the required technical resources
described below. Prior year returns may only be prepared and reviewed when the tax topics are
within scope for VITA/TCE and within the volunteers’ current level of training and certification. They
don’t need to be certified in the actual prior year. Determining the certification level of the return is
described below in Getting Started.

Getting started:

e TaxSlayer® only provides software for the 3 years prior to the current tax year.

* A currentyear Form 13614-C must be completed for each prior year and will be used to
determine the scope and certification level of each return

* Taxpayers with out-of-scope returns should be advised to seek assistance from a paid tax
preparer.

* Assign prior year returns to experienced volunteers if at all possible.

* Direct deposit or debit isn’t available for prior year returns. IRS will mail refund checks to the
address on the prior year return.

Beware: Taxpayers can’t retroactively claim some tax credits with newly issued ID nhumbers.
As of December 2015, taxpayers can no longer:

* File a prior year return claiming EITC on the basis of newly issued social security numbers
(SSNs) for themselves and/or qualifying dependent(s).

* File a prior year return claiming American Opportunity Tax Credit on the basis of newly issued
SSNs, Individual Taxpayer Identification Numbers (ITINs) or Adoption Taxpayer Identification
Numbers (ATINs) for themselves and/or qualifying student(s).

* File a prior year return claiming Additional Child Tax Credit on the basis of newly issued SSNs,
ITINs, or ATINs for themselves and/or qualifying child.

Technical resources:
The following tools are useful resources:
e Prior year return tax preparation software.
e TaxSlayer Pro® Online users can access the prior year software from the home page.
* Desktop sites will need to download and install the prior year software from the TaxSlayer
website. Sites will use their current EFIN and setup the software as usual. No registration
codes are needed with TaxSlayer®.

e Applicable Publications 17 and 4012 and volunteer quality alerts/volunteer tax alerts (available
on irs.gov)

e Forms 13614-C from prior years are helpful. Sites may keep hard copies or rely on electronic
copies.

e Taxpayer's Wage and Income Transcripts from their IRS records are extremely useful.

Note: For transcripts, taxpayers can go to irs.gov/individuals/Get-Transcript, register, and secure
transcripts online if they have email and can comply with enhanced verification. Taxpayers can
also request transcripts to be mailed to the address on file and takes 5 to 10 calendar days for
delivery. In addition, taxpayers can request a transcript via Form 4506-T, or by calling 1-800-908-
9946.

* Prior year publications and instructions to forms and schedules are available on www.irs.gov.
* Use the online tool Interactive Tax Assistance (ITA) for answers to many current and prior year
tax law questions. ITA is available on www.irs.gov.
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Prior Year Returns (continued)

Whether to e-file or mail prior year returns:

Only the two most current prior years can be e-filed. Older prior year returns must be mailed to the
appropriate IRS address from the list at Tab P, “Where Do You File” page. Also, refer to Tab K for
additional information regarding balance due returns and payment options.

Expired Tax Topics and Other Issues Applicable to Prior Years:
Refer to the Publication 17 for the applicable tax year and review the “What’s New” section.

What if a site cannot prepare a requested prior year return?

If possible, refer the taxpayer to other VITA/TCE sites that offer prior year return service. Otherwise,
advise the taxpayer to seek assistance from a paid tax preparer. (Note: Don’t refer taxpayers to their
local IRS Tax Assistance Center because they no longer prepare tax returns for individuals.)
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Filing for an Extension Using TaxSlayer®?

Form 4868 - Application for Extension

How To File Your Extension

1.

Enter your Information: Fill out all of the information in the “Required Extension Information”
section below. Click “Continue”.

E-File Your Extension: Start by selecting efile from the navigation bar. You will then be given the
option to file your return (Form 1040 and supporting schedules), or to file your extension (Form
4868). Complete the extension e-file process. You should get an acknowledgement regarding
your extension (whether the IRS accepted or rejected it) by email within the 24-48 hours of
filing.

Pay the Amount Paid with Extension: You will need to pay the amount due that you enter for
“Amount Paid with Extension”. You can do this in one of 3 ways

a. Pay by Electronic Withdrawal from your checking account: You can choose to pay your
“payment” amount as an electronic withdrawal from your checking account. Once you
enter the amount you would like to pay, check the box that appears to select this option.
You will then enter your banking information, the date you would like the transaction
to take place and re-enter the amount to pay for confirmation. When you submit your
extension, the withdrawal information will be sent.

b. Pay by Credit Card: You can use your credit card and pay by phone by contacting one of
the IRS approved service providers. See link below.

c. Mail in your payment with your Form 4868: The form will print with your draft tax return.
Mail the form with your payment by check or money order.

Required Extension Information

Tax Information

Tax Liability s
Tax Payments $

Amount Paid with Extension $
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Setting up TaxSlayer®Pro Online

To set up TaxSlayer® ProOnline as a Favorite in your web browser, use the following steps:

1. Open Internet Explorer, Mozilla Firefox, or Google Chrome.

2.  Type https://online.taxslayerpro.com in the address line. Current and prior year software can be accessed
upon logging in.

3. Click on the Favorites icon.
4. Click Add.
5. In Name, type the name you want the favorites to display.
Add a Favorite E
. Add a Favorite
M Add this webpage as a favorite. To access your favorites, visit the
Favarites Center.
Name: |
Create in: |§:Z Favorites v|| New folder |
| ad || cancel |
6. Click OK.

Logging on to Pro Online the first time

The user name isn’t case sensitive. To log on to TaxSlayer® ProOnline, enter your Username, Password, and
Security Code.

TaxSlayer Pro’

Professional Tax Preparation Software

Login Page

Username

Password

(case-sensitive)

Security Code

(case-sensitive)

Forgot Username
Forgot Password
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https://online.taxslayerpro.com

Pro Online Homepage

The Welcome Menu is the “Main Menu” of the program. It is the first screen the program takes you to every
time you log into your office account. From the Main Menu, you will find nine (9) Menu Options that contain
functions pertaining to the program. Each part of the program can be accessed by clicking on the gray Select
button.

Welcome to SUPPORT

Message Center G
Start New Tax Return | oselect |
Create a brand new tax return for a client
Client Search | select |
Edit returns you previously started
Review Returns # ‘ Select |
Returns that are currently waiting to be reviewe:
Configuration ‘ Select |
Setup the configuration options for vour office.
Reports [ select |
Print acks, mailing labels, bank reports, and old reports.
Print Check(s) ‘ Select |
Print ERC checks
Tax Year 2014 Returns [ select |
Review 2014 Returns
Tax Year 2013 Returns | select |
Review 2013 Returns
Tax Year 2012 Returns ‘ Select |
Review 2012 Returns

Start New Tax Return—Select to start a new return.
Client Search—Select to open an existing return.
Review Returns— This option allows the tax preparer to mark the return for further review.
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Pro Online Homepage (continued)

Configuration — Set up the configuration options for your office.
Reports - Select to generate acknowledgements and other reports.
Print Check(s) — This option isn’t used in the VITA/TCE Programs

Prior Year Returns — Select any of these options to view, edit, or create a return for the specific prior tax year

The Helpful Information section to the left of the Welcome Menu contains links to common websites and
forms.

Helpful Information

N-3



Starting a New Return

Helpful Information

Welcome to SUPPORT

Message Center @

Start New Tax Return
Create a brand new tax

Client

Review R

Returns th

Configuration
etup the configuration options for your office.

| oserest |

s )
=)

| osetect |

Reports | setect |
Print acks orts

Print Check(s| | selet |

RC checks.

Tax Year 2014 Retums | select |
Review 2014 Returns —
Tax Year 2013 Retums | selet |
Review 2013 Returns -

Tax Year 2012 Retums [ == ]
Review 2012 Returns: S

The Start a New Tax Return option
enables you to begin the data input
process for a client. When you select
this option you will be prompted to have
the client sign Form 7216 Consent to
Use Tax Return Information form. Before
continuing, you should have your client
sign the form if required. Select OK.

hake sure you get your 7116 Conzent to Use Tax Return Information
l'\ signed before starting a new tax return!

Social Security Number Entry

The next step in creating a new tax return is entering the taxpayer’s Social
Security number in the space provided. To ensure accuracy, you are required to
enter the SSN twice. Select Continue.

Enter Social Security Number -

Social Security Number

Confirm Social Security Number

Available Taxpayer Profiles ’
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Starting a New Return (continued)

If the SSN is already in use, ProWeb displays the following:

Enter Social Security Number -
Social Security Number
see B . - sene
Confirm Social Security Number

e - . - [TTT]

Available Taxpayer Profiles »

There is already an active return using this SSN.
Please use a new SSN or view the return via the
client status list

Start Return

If the SSN doesn’t match, Pro Online displays the following:

Enter Social Security Number -
Social Security Number
-ee - - - L1211 ]

Confirm Social Security Number
Auvailable Taxpayer Profiles ,

Please fix all fields with errors {marked in red)
before starting this return.

Start Return

Pulling Prior Year Data

If no prior year data is found for this SSN, you will see the message below. Select Continue.

No Prior Data

Sorry, there was no prior year data found for your return.

If the SSN is already in use, Pro Online displays the following:
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Starting a New Return (continued)

Pull Data To Current Return

TaxSlayer will automatically transfer your name, address and filing status from last year’'s return when you start this year's return.
Please review the additional information below before pulling it forward to your current return. Uncheck any item(s) that you do not
wish to pull forward. When you are done, choose "Continue to Next Step” at the bottom of the page.

@ Dependents:

Pull tem? SSN First Last Age
v 400-00-XXXX William Doe 5

**We have pulled the following information from last year: Social security number, first & last name, date of birth, number of
months they lived with you, and whether or not they were disabled or a full time student. When you get to the dependent
section of your return please verify all information.

@ W-2 ltems:
Pull ltem? SSN First
v Taxpayer Evans Financial

@ Form 1099R ltems:
Mo prior data found.

@ Schedule A Miscellaneous Deductions:
Mo prior data found.

@ Schedule B Items:
Mo prior data found.

@ Schedule K-1 ltems:

Mo prior data found.

@ Schedule C:

Mo prior data found.

Select what you would like to pull forward by checking the boxes to the left of the items
listed on the Pull Data to Current Return screen. When satisfied, check the Yes field
and then hit the continue button located at the bottom right of the screen. Your prior
year information will then be pulled to the current year tax return.

@ Yes, pull forward the prior year data selected to my current year tax return.

Mo, | would not like to pull the prior year data to my current year tax return.

Caution - Be sure to verify that all EINs and addresses on Forms W-2 and 1099-R
are still the same as the prior year when using carryforward.

N-6



Navigating TaxSlayer® Pro Online

Select the Begin button to enter other state data applicable to the taxpayer. The federal and state information
entered on the federal return will automatically pull into the state. When you have entered in all applicable state

data items select Continue.

To delete a state return, select State Return from the left side of your screen. Select the delete icon next to

the state that you would like to delete.

Summary/Print Page

The Calculation Summary screen is an overview of each section of the tax return. Select the show details link
located next to each item to view a breakdown of what items are included in the tax return. You can view and/or

edit each item of income, adjustments, tax, payments etc. by selecting the link from the expanded list.

Select View/Print the Return to create a PDF of the return that can be printed or reviewed.

Practice Lab S0 S0

Federal Refund MD Refund Amount

test return v Summary

Enter the Form Number..

Calculation Summary

REASONS FOR NO EARNED INCOME CREDIT (EIC)

# EIC Checklist was not Answered Correctly

Total Income show details

Adjusted Gross Income chow details
Tax and Credits snow details

Total Tax =now details

Payments show detsiis

Refund snow details

Amount You Owe show details

Maryland Refund

# Your Adjusted Gross Income or Earned Income is Less than or Equal to 50.

$0.00
$0.00
$0.00
$0.00
$0.00
$0.00

$0.00

0.00
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Navigating TaxSlayer® Pro Online (continued)

Begin IRS e-File Process

When the tax return is ready to be electronically filed, you will be taken through the IRS e-File process. The
client’s tax return will only be electronically filed after each step in the E-file process is complete based on the
type of return you are processing.

EFile K3

Return Type

Your return is now ready to be e-Filed to the IRS.
Please make sure that all information you enter belowis correct

In order for us to transmit your client's return to the IRS you must complete 31l Steps in the e-File Process.

CAUTION: Your client's retum wil not be sent o the IRS unless you complete ALL steps. None of the information is saved until all information is entered and the *Cantinue® button belov is cicked.

Te centinuz the =File process, plesse first select 2 ratum type and the form will ask for all required information

Send State Only

Federal Return Type | Paper Retum with Direct [ v

ERO Information

Efin#: 369258

EroName#:  Support

Tax Preparation and E-File Information
State Returnis)

Taxpayer Bank Account Information
Third Party Designee Info

Questions

Federal Return Type — Select an electronic return type from the drop down menu.
For returns containing a federal refund:

* Electronic Mailed Check — An e-filed return requesting the refund check be mailed to the taxpayer’s street
address that is included on the tax return.

» Direct Deposit — The taxpayer’s refund will be direct deposited by the IRS into their personal checking or
savings account.
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Navigating TaxSlayer® Pro Online (continued)

Paper Return - If the client wishes to mail their tax return, select this option. The return should be mailed to
the IRS processing center assigned to the client’s state of residence. See the Partner Resources tab for a
list of states and their assigned processing centers.

For returns containing a federal amount due:

Electronic Balance Due — If there is a balance due on the federal return, select this option to generate
Form 1040-V, Payment Voucher. The return will be filed electronically, and voucher should be mailed with
the accompanying payment to the address indicated on the top half of the form.

Electronic Direct Debit — If there is a balance due on the federal return, select this option to have the
amount automatically debited out of a checking or savings account. You will be prompted to enter the name
of the bank, the type of account (checking or savings), the bank routing transmit number and the bank
account number. You will also be prompted to enter the amount of the payment, the requested payment
date and the client’s day-time phone number. Note: If the requested payment date is after April 15th, or the
due date of the return, you must enter the current date.

Paper Return — If the client wishes to mail their tax return, select this option. The return, payment and
payment voucher should be mailed to the IRS processing center assigned to the client’s state of residence.
See the Partner Resources tab for a list of states and their assigned processing centers.

State Electronic Filing Menu: Choose how the taxpayer would like to receive their state refund or pay their
state balance due.

Once you have verified all the State e-File Information is correct, select the “Next” button to continue with the
e-File process. At this point, you should be complete with the e-file process and ready to continue to the e-file
Summary. Do this by selecting the “Save” button.

Submission: The last step of the IRS e-File process is to submit the return from the e-File Summary screen.
From this screen you will have the option to print the tax return and Form 8879 (federal and state). All
previously entered e-file information will also be displayed on this page.
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Navigating TaxSlayer® Pro Online (continued)

Completing the E-file Section (continued)

Return Type
E-File ) v s
Return Type -

Your return is now ready to be eFiled to the IRS.

Please make sure that all information you enter below is correct.

In order for us to transmit your clent’s return to the IRS you must complete all Steps in the e-File Process.

CAUTION: Your client's return will not be sent to the IRS unless you complete ALL steps. None of the info is saved until all

Select a return type

"~ for the federal

return.

information is entered and the "Continue” button below is clicked

H
Federal Return Type ectro 3ile
Direct Deposit
Paper Return with Direct Depor
ERO Informatior| Paper Retumn

Efiné:
EroMame#: Practice Lsb

To continue the e-File process, please first select a return type and the form will ask

3l required information,

Return Types with a Refund
Electronic Mailed = E-filed with refund check
mailed to taxpayer
Direct Deposit = E-filed with direct deposit
Paper Return with Direct Deposit
Paper Return = Paper return with check
mailed to taxpayer

E-File
Return Type

Tax Preparation and E-File Information

State Returnis) s

Choose how you would like to file your state returns:

Select a return
type for each
state return.

State Refund/Due Retumn Type

ID Refund: 5 232.00 § i
Direct Deposit

MT Due: S 268.00

Direct Debit

Return Types with an Amount Owed
Paper Return = Paper return to be
mailed with a check
Electronic Balance Due = E-filed with a voucher,
check to be mailed.

Direct Debit = E-filed with direct debit
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Navigating TaxSlayer® Pro Online (continued)
Completing the E-file Section (continued)

Bank Information For direct deposit or debit, enter bank

/ routing and account numbers twice.
E-File BB v s

Return Type

Tax Preparation and E-File Information
State Return(s) ’

-

Taxpayer Bank Account Information

Note: This bank information MUST be acourate for your retum to process comectly.

Name of Bank
Type of Account Checking
Savings TIP: Take care
Routing Transit Number to look at the
Confirm Routing Transit Number check and not
the screen while
Bank Account Number entering the

numbers the
second time.

Confirm Bank Account Number

Third Party Designee

E File =D

Return Type

Tax Preparation and E-File Information

State Returni(s) »

Taxpayer Bank Account Information >

Third Party Designee Info v

This information is optional

Third party designee info

Designee First Name

can be completed if the
Designee Last Name taxpayer wishes, but the
designee is never the
Designee Phone { |
volunteer preparer.
Designes Pin
[0 Click checkbox to easily remove the data from each field
N-11
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Navigating TaxSlayer® Pro Online (continued)

Submission

Ploase review all information o This screan. To finafize your reium piease dick on teesubimil bution located below

On Copy - Federal and State L -

Electronic Signature

Tsgiaseie
Spouse:

ERO Information
Efn: 359258

Company Name: Sugpor
Chient Information
Clieed Mane: M Taxpapar
Emal Addnisa:

Return Information

Typa of Raturn: State Ok - Fodersd Rt is NOT being submitied to e RS

Fecherad Fedund: 54,774.00

Tax Preparation Charges:

Bk Paid

Mark Complats

Farm BE79

State Retumn Information

Referrer

Solect Refamar, | Ro Answar

Difmar

Review Status
\ Review/Retransmit Status
N

Aoty lor Ratmnsit

Aaady For Raview

Use this status to mark the return for Quality Review
e-filing a State Only Return

Under most circumstances, both the federal and state returns are electronically filed together. There may be
occasions when it is necessary to electronically file only the state portion of a tax return. To e-file a state-only
return, place a checkmark in the Send State Only box on the “Return Type” section of the e-File process and
select “Next”. Note: Federal Return Type must be selected even though you are filing State Only.
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Navigating TaxSlayer® Pro Online (continued)

Tax Preparation and E-File Information

Taxpayer Bank Account Information
In this section, the Preparer inputs the bank routing and account number for direct deposit of refund or automatic

withdrawal of balance due.

E-File kX

Return Type »

Tax Preparation and E-File Information »

State Return(s) >

TNmeBbkkA’”;U:T: ; . ’ L — Input the name of the bank
ote: Thi bank information MUST be sccurstefor your refurn o process carecly - as stated on the check.
Name of Bank Bank
e st s : Input both the routing and
ARG S 1 ‘_7 account number twice on
Cont ot Tranck Number 123456729 this screen
Bank Account Number 087654321234
Confirm Bank Account Number 987654321234 /
- Caution: Use original

source document for input.

NOTE: See Pointers for Direct Deposit of Refunds in this tab.



Navigating TaxSlayer® Pro Online (continued)

uestions

The “Questions” filed is for sites use and are defined by the IRS, its partners and the site administrator. This field can also
be used to capture information from the partner surveys and track data to measure programs reach.

E-File ____EED
Return Type »
Tax Preparation and E-File Information »
State Return(s) »
Taxpayer Bank Account Information »
Third Party Designee Info »
Questions =

Are you or your spouse a Veteran from the US Armed Force? Please Select ¥

Do you or any member of your household have a disability? Please Select ¥
Other than English what language is spoken in your home? Please Select b
Required: What volunteer program are you preparing returns for? | Please Select v
REQUIRED: What is your favorite color? Please Select v

Use these fields for information that is helpful to your site. For example, these fields could be used to enter the preparer’s
name and/or new versus returning taxpayers. These fields are used by the military to report rank, grade, enlisted/retired,
etc.

After the end of the tax season a custom report can be created.



Navigating TaxSlayer® Pro Online (continued)

E-File

Return Type

Your return is now ready to be e-Filed to the IRS.
Please make sure that all information you enter below is correct.

In order for us to fransmit your client's return to the IRS you must complete all Steps in the e-File Process.

CAUTION: Your client's ret

To continue the e-File process, please first select a return type and the form will ask for all required information

+  Send State Only

Federal Return Type Mail Payment

Note: Federal Return Type must be selected even though you are filing State Only.

will not be sent to the IRS unless you complete ALL steps. None of the infarmation is saved until all information is entered and the "Continue® butten below is clicked.

Continue with the e-file process. Before you submit the return for electronic filing, review the e-file Summary

screen.

The Type of Return should read: State Only - Federal Return isn’t being submitted to the IRS. The state return
information should list the state(s) and the type of return for each state. Select Save and Transmit Return to

IRS to transmit the state only return.

Note: State only return

Note: State rules may differ; contact your state Volunteer e-file Coordinator for instructions on the

handling of any state signature documents for recordkeeping.



Printing the Tax Return

A copy of the return can be printed by selecting the Printer Icon located on the Client Tax Return row from the
Office Client List. A copy of the tax return can also be printed from within the return. The print location from
inside the return is located on the Submission page under the e-File section. After all required information has
been entered on the E-file page, you will click on Save. The program will display the Submission page. From
this page click on the drop down arrow, select the appropriate print set, and click on Print Return. Once the
PDF is generated you can choose the pages you wish to print and the number of copies you wish to print.



TaxSlayer Pro Classic (Desktop) Homepage

At the time of printing this publication TaxSlayer Pro Classic (Desktop) was not available.

For additional information refer to the TaxSlayer Desktop user guide.

-TaxSlayer Pro:
Classic

E-filel Returns

(’ Print Returns

Tax Returns
E-File

Print

Business
Client Status
View Returns
Configuration
Liilities
Reports

IU Updates

Enter Option -

VONO LA WD~
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Optional Contingency Plans for Maintaining VITA/
TCE Return Preparation Operations
(During Unexpected Circumstances)

In the event that the following situations occur:

* Software system outages
e The Site’s internet or equipment isn’t operating
e A Quality Reviewer isn’t available (see Quality Review Only Using the Virtual Model, below)

Partners may, at their discretion, choose among the following pre-approved options to continue
preparing tax returns in lieu of closing the site for the day:

e TaxSlayer® ProWeb Alternative Preparation Solution* using TaxSlayer® Desktop
e Offer Facilitated Self Assisted™™ (FSA) services, if available
e Temporary Virtual VITA/TCE Process—explained below

*This option should be established during the Pre-Planning Phase of site operations.

**This option should be established during the Pre-Planning Phase of site operations. Refer to Publication 1084 (Site
Coordinator's Handbook) for more detailed information.

Temporary Virtual VITA/TCE Process

Secure Taxpayer Consent:

* The taxpayer must present proof of identity, which includes a photo identification for him/her
and if applicable, their spouse.

* If the taxpayer agrees to use the virtual process for preparing their tax return, the volunteer will
prepare Page 1 of the Form 14446, Virtual VITA/TCE Site Model Taxpayer Consent, and the
taxpayer is required to complete Page 2. Taxpayer must answer “Yes” or “No” to the question
regarding “Request to Quality Review Your Tax Return.”

e  The appropriate virtual method(s) and step-by-step procedures will be explained to the
taxpayer and timeframes will be established for the taxpayer to return to the site and complete
the process.

A secure process for authenticating both the taxpayer and the volunteer must be provided to the
taxpayer, in the event that additional information is required to complete the tax return. Please refer to
Publication 4299, Privacy and Confidentiality-A Public Trust for more information.



Optional Contingency Plans for Maintaining Site
Operations (continued)

Intake/Interview:

The intake and interview process must be performed before the taxpayer leaves the site.

IRS tax law certified volunteers must conduct the initial interview following all the steps outlined in

Pub 5101, Intake/Interview and Quality Review Training.

The volunteer will need to make notes on the Form 13614-C indicating the appropriate filing

status and dependency exemptions.

» Eligibility determinations for deductions and credits will be made and documented on the Form
13614-C.

* All oral testimony must be thoroughly documented on the Form 13614-C for use during the
return preparation at a later time.

The verified SSN’s and/or ITIN’s will need to be written on the Form 13614-C for all persons that

will be included on the tax return.

A phone number where the taxpayer can be reached will be secured for use by the IRS certified

tax return preparer. Refer to Publication 4299, Privacy and Confidentiality-A Public Trust for more

information on establishing protocols to authenticate the identity of both the volunteer and the

taxpayer.

The taxpayer will leave their tax documents and the completed Form 13614-C for their tax return

to be prepared once the software can be accessed and/or when a non-face-to-face quality review

will be conducted.

The taxpayer will be given a date/time to return to the site to participate in the quality review and/

or sign the Form 8879, and secure a copy of their return. If a timeframe can’t be provided while

the taxpayer is still onsite, the Site Coordinator will provide this information to the taxpayer as

soon as a timeframe is available.

Quality Review Only Using the Virtual Model:

If the site is able to prepare the return using normal face-to-face procedures but the return isn’t able
to be Quality Reviewed during the taxpayer’s visit:

Follow all of the procedures above in the “Secure Taxpayer Consent”.
Complete the tax return as normal.
Explain that the taxpayer will be contacted by the Quality Reviewer.

Refer to Publication 4299, Privacy and Confidentiality-A Public Trust for more information.

For more detailed information on how to use a Virtual VITA/TCE process throughout the filing season
refer to the Virtual VITA/TCE process located in Publications 1084, Site Coordinators Handbook and
4396-A, Partner Resource Guide.
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Information for Assisting People with Disabilities

It is important to read and understand Publication 5192 Ten Key Points for Communicating with
People with Disabilities (refer to the link below) because there are many misconceptions (often
benevolent but misguided) about interacting with people with disabilities. Therefore, if one wants
to show concern and respect for a person with a disability, it is worth considering the guidelines in
Publication 5192.

http://www.irs.gov/pub/irs-pdf/p5192.pdf - Ten Key Points for Communicating with People with
Disabilities

The following videos describe the taxpayer experience at free tax preparation sites and explain basic
information about the return preparation process. This information is beneficial for the volunteers who

serve as American Sign Language interpreters at the sites across the country and useful for anyone
who wants to better understand the tax preparation process.

1. ASL: Get Free Tax Help — provides an introduction to the free tax preparation services available
to qualified taxpayers. https://www.youtube.com/watch?v=A3B6nAYh4oU

2. ASL:What to Bring at Tax Time — focuses on the process of completing the Intake/Interview &
Quality Review Sheet, and documents necessary for taxpayers to bring to VITA/TCE sites.
https://www.youtube.com/watch?v=zJtvIMIb5ss

3. ASL: Understanding Your Tax Return — provides information on completing the tax form 1040
and goes through the free tax return preparation process at VITA/TCE sites.
https://www.youtube.com/watch?v=ulgxP9u9YDQ

Veterans Crisis Line

The Veterans Crisis Line connects Veterans in crisis and their families and friends with qualified,
caring Department of Veterans Affairs responders through a confidential toll-free hotline, online chat,
or text. Veterans and their loved ones can call 1-800-273-8255 and Press 1, chat online, or send a
text message to 838255 to receive confidential support 24 hours a day, 7 days a week, 365 days a
year. Support for deaf and hard of hearing individuals is available. For more information go to www.
veteranscrisisline.net

IRS Taxpayer Assistance Center - Appointment Service

The IRS offers appointments at 44 Taxpayer Assistance Center (TAC) locations throughout the
United States. Taxpayers will call a new toll-free number to make an appointment for face-to-face
service. Taxpayers requiring an appointment at a TAC location should call 1-844-545-5640.


https://www.youtube.com/watch?v=A3B6nAYh4oU
https://www.youtube.com/watch?v=zJtvlMIb5ss
https://www.youtube.com/watch?v=uIgxP9u9YDQ
www.veteranscrisisline.net
www.veteranscrisisline.net
http://www.irs.gov/pub/irs-pdf/p5192.pdf

4 Identity Theft Job Aid for Volunteers

Being sensitive towards victims of identity theft is critical to assisting taxpayers through a confusing and frustrating

situation. Remember victims of identity theft are:
* Victimized by identity thieves-mostly through no fault of their own, and
* Trying to comply with tax laws— file tax return and pay their fair share of taxes

Every December, the IRS Identity Protection Specialized Unit (IPSU) mails Notice CPO1A to taxpayers previously
identified as identity theft victims. The notice includes a 6-digit Identity Protection Personal Identification Number (IP
PIN) to be entered on the tax return. Taxpayers are mailed Notice CPO1A every year as long as the identity theft
indicator remains on their account (usually 3 years) Use the most recent IP PIN regardless of the tax year.

When assisting taxpayers who are victims or may be victims of identity theft at VITA/TCE site:

If... Then...
Identity Protection PIN (IP) Ensure the IP PIN is input correctly on the tax return.
PIN was issued to primary
and/or, secondary and/or
dependent taxpayer(s)
Taxpayer received an IP PIN | 1. Complete a tax return for the taxpayer.
but didn’t bring it with them 2. Provide taxpayer with a complete copy of the tax return. (Provide two copies if the
taxpayer will mail the tax return.)
3. Refer to Replacing Lost or Missing IP PIN below.
4. |f taxpayer wants to e-file, arrange for the taxpayer to provide the IP PIN by
returning to the site or via telephone.
Taxpayer received an IP PIN [ 1. Complete a tax return for the taxpayer.
but misplaced or lost it 2. Provide taxpayer with a complete copy of the tax return. (Provide two copies if the
taxpayer will mail the tax return.)
3. Refer to Replacing Lost or Missing IP PIN below.
4. If the taxpayer receives original or a replacement IP PIN and wants to e-file, arrange
for the taxpayer to provide the IP PIN by returning to the site or via telephone.
Taxpayer didn’t receive IP 1. Refer to Replacing Lost or Missing IP PIN below.
PIN but IRS rejected the 2. Provide taxpayer with two complete copies of the tax return.
e-filed tax return because 3. If the taxpayer receives the original or a replacement IP PIN and taxpayer wants
the IP PIN wasn’t entered. to e-file, advise the taxpayer to provide the IP PIN by returning to the site or via
telephone.
4. If IPSU doesn’t provide the IP PIN, advise taxpayer to follow IPSU instructions
in mailing the tax return. There may be processing delays as IRS verifies the
taxpayer’s identity.
IRS rejected the taxpayer’s 1. Advise the taxpayer to contact the IPSU for assistance. If required, the IPSU will
tax return because the advise the taxpayer to complete Form 14039 and to mail it with their tax return to
taxpayer’s primary/ the IRS.
secondary/dependent SSN | 2.  Provide the taxpayers two copies of their tax return.
was previously used.

Replacing a Lost or Missing IP PIN
If a taxpayer didn’t receive his/her new IP PIN or the taxpayer misplaced it, the taxpayer has two options:

1. Ataxpayer can register and create a user profile to get his/her current IP PIN at https://www.irs.gov/individuals/get-
an-identity-protection-pin. The registration process will require the taxpayer to provide specific personal information
and answer a series of questions to validate his/her identity.

2. Contact IPSU at 1-800-908-4490, to receive a replacement IP PIN if the taxpayer is unable or unwilling to create an
account on IRS.gov. CAUTION: Using a replacement IP PIN will cause a delay in processing the tax return and the
issuance of any refund the taxpayer may be entitled to.

%
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Frequent Taxpayer Inquiries

KI'axpayers normally ask questions during the interview process about the topics covered in this section. Visit

www.irs.gov-keyword: 1040 Central or see Publication 17 for additional topics and information.

Instaliment Payment

Publication 594, The IRS Collection Process, explains
taxpayers’ rights and responsibilities regarding payment of
federal taxes.

Copies of Prior-Years’ Returns

Transcripts of prior-year returns may be obtained by going to
https://www.irs.gov/individuals/Get-Transcript or by filing Form
4506-T, Request for Transcript of Tax Return. The website can
be used to get prior-year information needed for this year's
return.

If an actual copy is needed, taxpayer should complete Form
4506, Request for Copy of Tax Return, and mail it with the
required fee to the IRS campus where the return was filed.

Amended Returns (See Other Returns Tab)

Form 1040X, Amended U.S. Individual Income Tax Return
should be used by taxpayers to amend their return. Many
mistakes are corrected in processing by the IRS and a letter of
explanation is mailed at the time an error is identified or when
a refund is issued. In these cases, taxpayers aren’t required to
file an Amended Return as the corrections have already been
made.

Preparation of amended returns has expanded in the VITA/TCE
programs. Sites can choose to file amended returns even if
they didn’t prepare the original return.

Taxpayer Address Changes

Taxpayers should use Form 8822, Change of Address, to notify
the IRS of any change of address. If taxpayers move after filing
the return and before a refund is received, they should notify
their old post office and the IRS of their new address.

Recordkeeping

Taxpayers should keep their tax documents until the statute of
limitations runs out for the return. Usually, this is three years
from the date the return was due or filed, or two years from the
date the tax was paid, whichever is later. Refer taxpayers to
Publication 17, Filing Information or at www.irs.gov — keyword:
Recordkeeping.

FREE Tax Preparation Locations

Consult your Site Coordinator for information about the location
of other VITA/TCE sites in your area. Taxpayers may call
1-800-829-1040 or visit AARP’s website at www.aarp.org/
taxaide or call 1-888-227-7669 for this information.

Problems Navigating the IRS
Taxpayers may contact the Taxpayer Advocate if their attempts
to deal with an IRS problem are unsuccessful.

Taxpayers can visit www.irs.gov/advocate or see Publication
1546, for details on what the Taxpayer Advocate Service
provides. Also suggest Publication 910, Guide to Free Tax
Services.

Refund Information

Taxpayers should be directed to www.irs.gov to obtain
information about their refund. Specific information is available
by clicking on “Where’s My Refund?”

Innocent Spouse Relief
Taxpayers who file a joint tax return are jointly and individually
responsible for the tax and any interest or penalty due on

the joint return even if they later divorce. In some cases, a
spouse (or former spouse) will be relieved of the tax, interest,
and penalties on a joint tax return. Spousal relief is granted in
certain situations when a taxpayer can prove he/she isn’t liable
for amounts due in joint filing situations.

Taxpayers should see Publication 971, Innocent Spouse Relief
which explains the types of relief, who may qualify for them,
and how to get them. Married persons who didn’t file joint
returns, but who live in community property states, may also
qualify for relief. (Out of scope for VITA/TCE prepared returns.)

Injured Spouse Relief

An injured spouse claim is different from an innocent spouse
relief request. An injured spouse can request the division of tax
overpayment attributed to each spouse. The injured spouse
must file Form 8379, Injured Spouse Allocation, to request his
or her portion of a joint refund.

Married Filing Separately

Unless required to file separately, married taxpayers may want
their tax figured on a joint return and on separate returns, to
make sure they are receiving the most advantageous filing
status. Filing separately may be advantageous for some
taxpayers in certain situations. Generally, however, married
taxpayers pay more combined tax on separate returns than
they would on a joint return. See Publication 17, Filing Status,
for Special Rules (which outlines the disadvantages).

Social Security Numbers and Account Information

Social Security no longer issues Social Security Number
verification printouts in their field offices. Taxpayers may get
this information using the my Social Security Account feature
on www.ssa.gov. Local Social Security offices would continue
to provide benefit verification letters.

Hardship Refund Request

A taxpayer’s tax refund will be offset (intercepted) to pay
outstanding Federal tax debts, child support, Federal non-

tax debts, state income tax debts, and unemployment
compensation debts. When a tax refund is offset, the taxpayer
will receive a letter explaining how the refund was applied to
his or her outstanding debt.

If a taxpayer would face a hardship from a tax refund offset
and has only outstanding Federal tax debts, he or she can
request an Offset Bypass Refund (OBR) from the IRS. Refer
the taxpayer to the Taxpayer Advocate Service to see if they
meet TAS case acceptance criteria. The OBR typically should
be requested before the return is filed because the OBR must
be approved before the refund is offset.

Requests for hardship relief from other debts must be made
to the agency to which the debt is owed. The Treasury Offset
Program (TOP) can confirm whether a tax refund will offset
for these other debts and provide details about the debt and

a contact phone number for the agency to which the debt is
owed. The TOP Call Center can be reached weekdays at 800-
304-3107, TTD 866-297-0517, between 8:30 a.m. and 6 p.m.
Eastern Time.

\
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Useful Publications and Forms

Tax Publications for Individual Taxpayers

General Guides
1 Your Rights as a Taxpayer 529
17 Your Federal Income Tax For 530
Individuals 531
334 Tax Guide for Small Business (For 535
Individuals Who Use Schedule C or 544
C-E2) 550
509 Tax Calendars for 2015
910 IRS Guide to Free Tax Services 551
Specialized Publications ggg
3 Armed Forces’ Tax Guide 556
54 Tax Guide for U.S. Citizens and
Resident Aliens Abroad 559
463 Travel, Entertainment, Gift, and Car
Expenses 561
501 Exemptions, Standard Deduction, and
Filing Information 570
502 Medical and Dental Expenses (Including
the Health Coverage Tax Credit) 571
503 Child and Dependent Care Expenses
504 Divorced or Separated Individuals
505 Tax Withholding and Estimated Tax
514 Foreign Tax Credit for Individuals 575
516 U.S. Government Civilian Employees 590
Stationed Abroad
517 Social Security and Other Information 594
for Members of the Clergy and 506
Religious Workers 721
519 U.S. Tax Guide for Aliens
521 Moving Expenses 9201
523 Selling Your Home 907
524 Credit for the Elderly or the Disabled
525 Taxable and Nontaxable Income 915
526 Charitable Contributions
527 Residential Rental Property (Including
Rental of Vacation Homes)

Commonly Used Tax Forms

Miscellaneous Deductions

Tax Information for Homeowners

Reporting Tip Income

Business Expenses

Sales and Other Dispositions of Assets

Investment Income and Expenses
(Including Capital Gains and Losses)

Basis of Assets

Tax Guide for Seniors

Community Property

Examination of Returns, Appeal Rights,
and Claims for Refund

Survivors, Executors, and
Administrators

Determining the Value of Donated
Property

Tax Guide for Individuals With Income
From U.S. Possessions

Tax-Sheltered Annuity Plans (403(b)
Plans) For Employees of Public
Schools and Certain Tax-Exempt
Organizations

Pension and Annuity Income

Individual Retirement Arrangements
(IRAs)

The IRS Collection Process

Earned Income Credit (EIC)

Tax Guide to U.S. Civil Service
Retirement Benefits

U.S. Tax Treaties

Tax Highlights for Persons with
Disabilities

Social Security and Equivalent
Railroad Retirement Benefits

925
926

929
936
946
947
969
970
971

972
974

1542

1544

1546

Passive Activity and At-Risk Rules

Household Employer’s Tax Guide For
Wages Paid in 2015

Tax Rules for Children and
Dependents

Home Mortgage Interest Deduction

How To Depreciate Property

Practice Before the IRS and
Power of Attorney

Health Savings Accounts and Other
Tax-Favored Health Plans

Tax Benefits for Education

Innocent Spouse Relief

Child Tax Credit

Premium Tax Credit

Per Diem Rates (For Travel Within the
Continental United States)

Reporting Cash Payments of Over
$10,000 (Received in a Trade or
Business)

Taxpayer Advocate Service — Your
Voice at the IRS

Spanish Language Publications

1SP
17SP

594SP

596SP
850

1544SP

Derechos del Contribuyente

El Impuesto Federal sobre los Ingresos
Para Personas Fisicas

El Proceso de Cobro del IRS

Crédito por Ingreso del Trabajo

English-Spanish Glossary of Words
and Phrases Used in Publications
Issued by the Internal Revenue
Service

Informe de Pagos en Efectivo en
Exceso de $10,000 (Recibidos en
una Ocupacién o Negocio)

Form Number and Title

1040 U.S. Individual Income Tax Return

Sch A ltemized Deductions

Sch B Interest and Ordinary Dividends

Sch C Profit or Loss From Business

Sch C-EZ Net Profit From Business

Sch D Capital Gains and Losses

Sch E Supplemental Income and Loss

Sch EIC  Earned Income Credit

Sch R Credit for the Elderly or the Disabled

Sch SE Self-Employment Tax

1040A U.S. Individual Income Tax Return

1040EZ Income Tax Return for Single and
Joint Filers With No Dependents

1040-ES Estimated Tax for Individuals

1040-V Payment Voucher

1040X Amended U.S. Individual Income Tax Return

1116 Foreign Tax Credit

2106 Employee Business Expense

2106-EZ Unreimbursed Employee Business
Expenses

2120 Multiple Support Declaration

2441 Child and Dependent Care Expenses

2848 Power of Attorney and Declaration of

Representative

3903
4137
4562
4868
5329

5405
5695
8332
8379
8453
8812
8822
8863

8879
8880
8949
8962
8965
9465

Moving Expenses
Social Security and Medicare Tax On Unreported Tip Income
Depreciation and Amortization
Application for Automatic Extension of Time
Additional Taxes on Qualified Plans (Including

IRAs) and Other Tax-Favored Accounts
First Time Homebuyer Credit and Repayment
Residential Energy Credits
Release of Claim to Exemption by Custodial Parent
Injured Spouse Allocation
Transmittal for an IRS e-file Return
Additional Child Tax Credit
Change of Address
Education Credits (American Opportunity,

and Lifetime Learning Credits)
IRS e-file Signature Authorization
Credit for Qualified Retirement Savings Contribution
Sales and Other Dispositions of Capital Assets
Premium Tax Credit
Health Coverage Exemptions
Installment Agreement Request

Form Number and Title



Where Do You Mail your return to the address shown

File? below that applies to you.

Envelopes without enough postage will be
@ returned to you by the post office. Your

envelope may need additional postage if it
contains more than five pages or is
oversized (for example, it is over ! / 4" thick).

Also, include your complete return address.

IF you live in...

THEN use this address if you:

Are not enclosing a check or
money order...

Are enclosing a check or
money order...

Florida, Louisiana, Mississippi, Texas

Department of the Treasury
Internal Revenue Service
Austin, TX 73301-0002

Internal Revenue Service
P.O.Box 1214
Charlotte, NC 28201-1214

Alaska, Arizona, California, Colorado, Hawaii, Idaho,
Nevada, New Mexico, Oregon, Utah, Washington,
Wyoming

Department of the Treasury
Internal Revenue Service
Fresno, CA 93888-0002

Internal Revenue Service
P.O. Box 7704
San Francisco, CA 94120-7704

Arkansas, Illinois, Indiana, lowa, Kansas, Michigan,
Minnesota, Montana, Nebraska, North Dakota, Ohio,
Oklahoma, South Dakota, Wisconsin

Department of the Treasury
Internal Revenue Service
Fresno, CA 93888-0002

Internal Revenue Service
P.O. Box 802501
Cincinnati, OH 45280-2501

Alabama, Georgia, Kentucky, New Jersey,
North Carolina, South Carolina, Tennessee, Virginia

Department of the Treasury
Internal Revenue Service
Kansas City, MO 64999-0002

Internal Revenue Service
P.O. Box 931000
Louisville, KY 40293-1000

Connecticut, Delaware, District of Columbia, Maine,
Maryland, Massachusetts, Missouri, New Hampshire,
New York, Pennsylvania, Rhode Island, Vermont,
West Virginia

Department of the Treasury
Internal Revenue Service
Kansas City, MO 64999-0002

Internal Revenue Service
P.O. Box 37008
Hartford, CT 06176-0008

A foreign country, U.S. possession or territory®, or use an
APO or FPO address, or file Form 2555, 2555-EZ, 4563,

or 8891, or are a dual-status alien

Department of the Treasury
Internal Revenue Service
Austin, TX 73301-0215

Internal Revenue Service
P.O. Box 1303
Charlotte, NC 28201-1303

*If you live in American Samoa, Puerto Rico, Guam, the U.S. Virgin Islands, or the Northern Mariana Islands, see Pub. 570.

Note: Mailing addresses for amended returns can be found in the instructions for Form 1040X.




Where's My Refund - It's Quick, Easy and v oS
Secure.

Available on irs.gov
En Espariol

You can generally expect the IRS to issue your refund in less than 21 calendar days
after we receive your tax return.

Less Than

21 Days Use this tool to check on the status of your refund. It provides the most up-to-date
information the IRS has. There's no need to call us unless Where's My Refund? tells
you to do so. Where's My Refund? is updated every 24 hours — usually overnight — so
you only need to check once a day.

How to Use Where's My Refund?

When to check... What you need...

e Within 24 hours after we've received e Social Security Number ¢ Get your refund status at.
your e-filed tax return » 5
« Filing status wheres, P
o 4 weeks after you mail your paper myfefund-
return e Exact refund amount

Interactive Tax Assistant (ITA)

Available on irs.gov and TaxSlayer®.

The ITA tool is a tax law resource that takes you through a series of questions and provides you
with responses to a limited number of tax law questions.

e Simply answer the questions and click the “Continue Button” to progress to the next question screen.

* You may need to collect information before the interview such as income amounts, taxes owed and credits you are
claiming.

e The tool includes a crossover feature that allows you to move from certain tax topics to another without needing to

enter the same answers multiple times. The “Review/Change Button” allows you to adjust responses to previously
asked questions.

¢ When you reach the response screen, you have the option to print the entire interview and the final response.

ITA Topics by Category
e Affordable Care Act e Income e Deductions

e Credits e General Filing Questions

For additional information on tax law resource tools refer to the links below.

https://www.irs.gov/Individuals/Tax-Trails-Main-Menu

https://www.irs.gov/taxtopics/
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TaxSlayer Pro Admin

TaxSlayer offers three software options:

. TaxSlayer Pro Online
. TaxSlayer Pro Classic (Desktop)
. TaxSlayer Pro.com (Self Prep)

TaxSlayer Pro Online
TaxSlayer Pro Online is a web-based professional application that is accessed via the internet. Refer
to Tab N for additional information.

Welcome to TaxSlayer Pro Online

Message Center e

Start New Tax Return | Select |

Create a brand new tax return for a client.

Client Search | Select |
Edit returns you previously started SR
Review Returns | Select |
Returns that are currently waiting to be reviewed

Configuration | e |
Setup the configuration options for your office

Reports | select |

Print acks, mailing labels, bank reports, and old reports
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TaxSlayer Pro Admin (continued)

TaxSlayer Pro Classic (Desktop)

TaxSlayer Pro is a client/server based professional application that can be run on a stand-alone
computer or in a local network environment. Refer to the user guide for additional information.

TaxSIayer Pro
Classic

I S E-file Returns \
View Returns
m . Configuration
AN . Utilities
‘ i L/\. Help Center \ (’ Print Returns Reports
. A \ IO Updates

Enter Option -

Tax Returns
E-File

Print
Business

VONO LA WN —~

TaxSlayer Pro.com

TaxSlayer.com is a web-based self-preparer application that can be accessed via the internet. Refer
to the user guide for additional information.

TaxSlayer
ﬁ com

User Options s

Your Account

Return Status Prior Years

return.
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www.taxslayer.com

Recommended System Requirements

TaxSlayer Pro Recommends The Following To Run The Software At Optimal Performance:

Computer: Quad Core Processor

Memory: 8 GB of Ram

Disk Space: 1 GB

Operating System: Windows 7 or 8 Professional

Removable Storage: USB or Flash Drive for backing up data
Printer: 100% HP Compatible Laser printer**

Display: 1024 X 768 screen resolution or higher

Internet Connection: High Speed Internet Connection*
Browser: Internet Explorer 11

Software: Adobe Acrobat Reader & Microsoft .NET Framework 4.5 or Higher Minimum System
Requirements

TaxSlayer Pro Will Run Using The Following As Minimum Requirements:

Computer: Dual Core Processor

Memory: 4 GB of Ram

Disk Space: 750 MB

Operating System: Windows Vista

Drives: 12x CDROM (For Program Installation)

Removable Storage: USB or Flash Drive for backing up data

Printer: HP Compatible Inkjet Printer (Inkjet not recommended for check printing)
Display: 1024x768

Internet Connection: Internet Explorer 8

Browser: High Speed Internet Connection

Software: Adobe Acrobat Reader & Microsoft .NET Framework 4.5 or Higher

Note: TaxSlayer Pro should not be installed on any computers running:

Windows 95, 98, ME, NT, 2000 or XP

Microsoft has ended all support for these operating systems and therefore the programming
languages used to develop TaxSlayer Pro are no longer compatible with these versions of Windows.
In addition, TaxSlayer Pro is not compatible with Mac computers. High speed Internet, such as cable,
is preferred. Inkjet printers are not recommended for check printing Windows Vista TaxSlayer Pro will
run on Microsoft Vista. TaxSlayer Pro must be run as an Administrative account or with User Account
Control turned off to function properly.



Security Templates

The options available to the user are based on the assigned security template. A user with a return
preparer security template will have the following options available:

Start New Tax Return
Client Search

Tax Year 2015 Returns
Tax Year 2014 Returns
Tax Year 2013 Returns

A user with an administrator security template will have the following options available:

Client Search

Review Returns
Configuration

Reports

Transmission

Tax Year 2015 Returns
Tax Year 2014 Returns
Tax Year 2013 Returns

Networking TaxSlayer Pro Desktop

Many sites are now successfully using simple Local Area Networks (LANSs) for improved productivity
and security. Using LANs at sites is strongly encouraged. For TaxSlayer Pro software, a sub-network
with its own router creates a secure system, separate from your site host’s computers and simplifies
printer setup.

Using a LAN for Desktop software also has numerous advantages especially for the e-file site
manager, as listed below:

Better security - only one computer actually holds the data;

Only one computer requires TaxSlayer Pro Desktop updates;

Only one computer needs to be backed up;

All networked computers have access to all returns when the network is running;
Quality Review can be conducted from any one of the networked workstations;
Printer sharing is easy as printer switches are not required.

Note: When using network printers, always set them up with a “static IP address” to ensure the
printer will not be “lost” by the network when a router is allowed to randomly reassign IP addresses
each time the network is setup.
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Use of Wireless Technology

IRS recommends partners/volunteers use wired connections when transmitting taxpayer information
via the internet. If partners/volunteers, after assessing their individual risks, still decide to use wireless
devices to transmit taxpayer information to TaxSlayer, LLC, at a minimum, partners/volunteers should
use:

1. Wi-Fi Protected Access — (WPA2) certified equipment and software. WPA2 uses government
strength encryption in the Advanced Encryption Standard (AES); and

2. AES with a minimum of 256-bit encryption; and

3. WPA2 Robust Security Network (RSN) framework should be used with authentication to
establish a secure wireless connection between WLAN (Wi-Fi Local Area Networks) devices;
and

4. The default network name or SSID (Service Set Identifier) should not be used. The SSID
character string should not reflect names associated with VITA, TCE, IRS, or tax preparation.
(i.e. do not use TCE Library site, Tax Prep Network, etc.)

Partners/volunteers are encouraged to use TaxSlayer Pro when using wireless devices since all
taxpayer data is stored on a secure server located in the TaxSlayer, LLC data center.

Contingency Plan

TaxSlayer makes a contingency procedure available in the rare event that the web site becomes
unavailable. If that happens, you can use TaxSlayer Pro’s desktop application to prepare and e-file
returns.

Download the desktop application in advance so that your site does not have any downtime. Do not
install TaxSlayer Pro on a network as a contingency plan. Instead, install on a stand-alone computer
with an internet connection.

To download the desktop application, use the following steps:
1. Log in to TaxSlayer Pro Online.
2. Click Contingency Software

TaxSlayer Pro Online begins downloading the setup file:
3. When TaxSlayerPro.com completes the download, click the file.

Windows displays the InstallShield Wizard for TaxSlayer Pro:
4. Complete installation and setup as described in the Installing TaxSlayer Pro Desktop section.

TIP: For a complete listing of contingency options, refer to IRS Publication 4396-A, Partner Resource
Guide.


https://online.taxslayerpro.com

Contingency Plan (continued)

In order for the TaxSlayer Pro Desktop contingency plan to work successfully, it is important to keep
the designated computers updated with the latest desktop software versions. TaxSlayer Pro Desktop
automatically updates the first time you open it each day. We recommend that you do this daily or
weekly.

If a software system outage necessitates the use of a temporary contingency plan, you can use the
installed and updated version of TaxSlayer Pro Desktop to complete any returns you need to prepare
during the outage. Sites will be able to work the return completely from the desktop application,
including e-filing and getting acknowledgments. The return will remain in the desktop application for
the duration of the filing season.

TIP: Returns prepared using the desktop software during a contingency plan will be transmitted
from the desktop software. You will also use the desktop software to retrieve any acknowledgement
associated with the returns transmitted from the desktop software.

When TaxSlayer Pro Online is available again, use it to prepare new returns and complete any
returns you started previously in TaxSlayer Pro Online.

Rejected Returns

The most common rejects involve errors in either the taxpayer(s) or their dependents’ Social Security
Number (SSN) and the Employer Identification Number (EIN) that appears on the Forms W2 and
Forms 1099. The IRS performs a name match on these numbers that can cause a return to be
rejected. Typographical and other errors can often be easily resolved. The Taxpayer may need to be
contacted to determine the correct EIN or SSN numbers. Neither the IRS nor TaxSlayer Pro® can
resolve these rejects
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(Top) Reject Codes

Top Reject Codes

Suggested Solutions

506 Qualifying child’s SSN listed for the purpose
of claiming Earned Income Credit (EIC) has been
used on another tax return.

Verify SSN of the dependent. If correct, the
return will need to be mailed. Explain that this
could be inadvertent error on a mailed return OR
it is possible someone else may have knowingly
claimed this dependent.

504 Dependent’s Social Security Number (SSN)
must match data from the IRS Master File.

Verify NAME & SSN or ITIN. Check Spelling &
Data Entry. Verify info with client - have client
contact SSA to verify information. Ask to see the
Social Security Card(s).

503 Last name for the secondary taxpayer on the
return does not match the IRS Master File and/or
Social Security Administration (SSA) records.

Verify the name, SSN or ITIN. Ask to see the
Social Security card of the spouse. Check for
spelling and transposition errors. If the data
entered is incorrect, make the corrections and
retransmit the return.

501 Qualifying SSN on Schedule EIC and the
corresponding Qualified Name Control must
match data from the IRS Master File.

Can be a companion to Reject Code 504.
However if the Qualifying Child listed for EIC is
a dependent on page one of tax return and only
Reject Code 501 verify source data for year of
birth or verify with client the year of birth. IRS
only verifies year — not month or day — of birth.

541 Taxpayer must be older than qualifying child
on Schedule EIC.

Verify birthdays of taxpayer and child.

500 Primary SSN and Primary Name Control
of the Tax Form must match data from the IRS
Master File.

Verify NAME & SSN or ITIN. Double Check
Source Document. Review NAME Control.

535 Qualifying SSN on Schedule EIC and the
corresponding Year of Birth must match data
received from the Social Security Administration.

Verify birthday of child. Verify NAME & SSN.

502 Employer Identification Number of Form
W-2,W-2G, or 1099-R must match data from the
IRS Master File.

Based on the ACK Report determine if W-2,
W-2G or 1099R. If more than one, determine
from ACK Report which number. Double check
the source document. If still incorrect contact
payer or have client contact payer. If still unable
to resolve will have to mail the return.

600 Taxpayer must file Form 8862 to claim EIC
after disallowance.

Complete Form 8862.

507 Dependent’s SSN of the Form 1040/A was
previously used for the same purpose.

Verify SSN of the dependent. If correct, the
return will need to be mailed. Explain that this
could be inadvertent error on a mailed return or
it is possible someone else may have knowingly
claimed this dependent.




Notes
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Taxpayer Civil Rights

The Department of the Treasury-Internal Revenue Service will not tolerate discrimination based on race,
color, national origin (including limited English proficiency), disability, reprisal, sex (in education programs
or activities) or age in programs or activities receiving federal financial assistance from the Internal Revenue
Service.

Persons with disabilities and/or limited English proficiency should be able to participate in or benefit

from programs and services that IRS supports. Taxpayers with a disability may request a reasonable
accommodation and taxpayers with limited English proficiency may request language assistance to access
service. For additional Information refer to https://www.irs.gov/uac/Your-Civil-Rights-Are-Protected for
reasonable accommodation.

If a taxpayer believes that he or she has been discriminated against, a written complaint should be sent to:

Operations Director, Civil Rights Division
Internal Revenue Service Room 2413
1111 Constitution Avenue, NW
Washington DC 20224

Email edi.civil.rights.division@irs.gov
Do not send tax returns, payments or other non-civil rights information to this address.

Low Income Tax Clinics

Low Income Taxpayer Clinics (LITCs) represent low income individuals in disputes with the Internal Revenue
Service, including audits, appeals, collection matters, and federal tax litigation. LITCs can also help taxpayers
respond to IRS notices and correct account problems. Some LITCs provide education for low income
taxpayers and taxpayers who speak English as a second language (ESL) about their taxpayer rights and
responsibilities.

LITC services are free or low cost for eligible taxpayers. LITCs are independent from the IRS but receive some
of their funding from the IRS through the LITC grant program. Each clinic determines whether prospective
clients meet income guidelines and other criteria before agreeing to represent them.

Find a clinic near you on the LITC Map or IRS Publication 4134, Low Income Taxpayer Clinic List. This
publication is also available at www.irs.gov/orderforms or at your local IRS office.

Taxpayer Advocate Service

The Taxpayer Advocate Service (TAS) is an independent organization within the IRS, led by the National
Taxpayer Advocate. Its job is to ensure every taxpayer is treated fairly and that taxpayers know and
understand their rights. TAS offers free help to taxpayers in dealing with the often confusing process of
resolving tax problems they haven’t been able to resolve on their own. TAS has at least one taxpayer
advocate office located in every state, the District of Columbia, and Puerto Rico. The local advocate’s number
is in the local directory and at taxpayeradvocate.irs.gov.

The Taxpayer Advocate Service’s website, taxpayeradvocate.irs.gov, is a resource for all taxpayers. The
website covers a variety of tax-related concepts and problems, breaking each down to describe what the
taxpayer should know, what they should do, and where they can get more help if needed. Taxpayers can also
learn about their taxpayer rights. The site is mobile-responsive, so it’s easy to use on any device.

If a taxpayer comes into a VITA/TCE site with a tax problem for which they have been unsuccessful in
resolving with the IRS, TAS may be able to help.

For more information, the taxpayer can call toll-free 1-877-777-4778 (1-800-829-4059 for TTY/TDD) or locate
the closest advocate at taxpayeradvocate.irs.gov.


mailto:edi.civil.rights.division%40irs.gov?subject=
http://www.irs.gov/Advocate/Low-Income-Taxpayer-Clinics/Low-Income-Taxpayer-Clinic-Map
http://www.irs.gov/pub/irs-pdf/p4134.pdf
https://www.irs.gov/uac/Your-Civil-Rights-Are-Protected
http://taxpayeradvocate.irs.gov
http://taxpayeradvocate.irs.gov
http://www.irs.gov/orderforms
http://taxpayeradvocate.irs.gov/

Contact Information for Volunteers

TaxSlayer

TaxSlayer Volunteer Support

1-800-421-6346 (Do not give to the public)

TaxSlayer via E-Mail

support@taxslayerpro.com

Tax Year Website

https://vita.taxslayerpro.com

Current and 3 previous years accessible from one
URL

Internal Revenue Service

VITA/TCE Hotline (for volunteer use only)

1-800-829-8482 (800-TAX-VITA)

IRS SPEC Territory Office

Enterprise Service Desk (Help Desk)

IRS e-file Help Desk

1-866-255-0654

Identity Theft

1-800-908-4490

VolTax (To Report Unethical Behavior to IRS)

wi.voltax@irs.gov

Volunteer Tax Alerts

https://www.irs.gov/Individuals/Quality-and-Tax--
Alerts-for-IRS-Volunteer-Programs

State Department of Revenue

State Volunteer Hotline

State e-file Help Desk

State General Information

State Website

Partner Point of Contact

Contact Information for Taxpayers

IRS Tax-Help

WWW.irs.gov

Where’s My Refund Website

www.irs.gov/refunds

IRS Forms and Publications

www.irs.gov/orderforms

IRS Taxpayer Advocate

www.irs.gov/advocate

IRS Tax-Help for Deaf (TDD)

1-800-829-4059

Social Security Administration

www.ssa.gov/

Refund Offset Inquiry (Financial Management
System)

1-800-304-3107
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